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EKTRON, INC. SOFTWARE LICENSE AGREEMENT

** READ THIS BEFORE LOADING SOFTWARE**

YOUR RIGHT TO USE THE PRODUCT DELIVERED IS SUBJECT TO THE TERMS AND CONDITIONS SET OUT IN THIS 
LICENSE AGREEMENT. USING THIS PRODUCT SIGNIFIES YOUR AGREEMENT TO THESE TERMS. IF YOU DO NOT 
AGREE TO THIS SOFTWARE LICENSE AGREEMENT, DO NOT DOWNLOAD.

CUSTOMER should carefully read the following terms and conditions before using the software program(s) contained herein 
(the “Software”). Downloading and/or using the Software or copying the Software onto CUSTOMER’S computer hard drive 
indicates CUSTOMER’S acceptance of these terms and conditions. If CUSTOMER does not agree with the terms of this 
agreement, CUSTOMER should not download.

Ektron, Inc. (“Ektron”) grants, and the CUSTOMER accepts, a nontransferable and nonexclusive License to use the Software on 
the following terms and conditions:

1. Right to use: The Software is licensed for use only in delivered code form. Each copy of the Software is licensed for use only 
on a single URL. Each license is valid for the number of seats listed below (the “Basic Package”). Any use of the Software 
beyond the number of authorized seats contained in the Basic Package without paying additional license fees as provided 
herein shall cause this license to terminate. Should CUSTOMER wish to add seats beyond the seats licensed in the Basic 
Package, the CUSTOMER may add seats on a block basis at the then current price for additional seats (see product pages for 
current price). The Basic Packages are as follows:

Ektron CMS400.NET — Licensed for ten seats (10 named users) per URL.

Ektron eWebEditPro — Licensed for ten seats (10 named users) per URL. 

Ektron eWebEditPro+XML — Licensed for ten seats (10 named users) per URL.

For purposes of this section, the term “seat” shall mean an individual user provided access to the capabilities of the Software.

The CUSTOMER may not modify, alter, reverse engineer, disassemble, or decompile the Software. This software product is 
licensed, not sold.

2. Duration: This License shall continue so long as CUSTOMER uses the Software in compliance with this License. Should 
CUSTOMER breach any of its obligations hereunder, CUSTOMER agrees to return all copies of the Software and this License 
upon notification and demand by Ektron.

3. Copyright: The Software (including any images, “applets,” photographs, animations, video, audio, music and text incorporated 
into the Software) as well as any accompanying written materials (the “Documentation”) is owned by Ektron or its suppliers, is 
protected by United States copyright laws and international treaties, and contains confidential information and trade secrets. 
CUSTOMER agrees to protect the confidentiality of the Software and Documentation. CUSTOMER agrees that it will not provide 
a copy of this Software or Documentation nor divulge any proprietary information of Ektron to any person, other than its 
employees, without the prior consent of Ektron; CUSTOMER shall use its best efforts to see that any user of the Software 
licensed hereunder complies with this license.

4. Limited Warranty: Ektron warrants solely that the medium upon which the Software is delivered will be free from defects in 
material and workmanship under normal, proper and intended usage for a period of three (3) months from the date of receipt. 
Ektron does not warrant the use of the Software will be uninterrupted or error free, nor that program errors will be corrected. This 
limited warranty shall not apply to any error or failure resulting from (i) machine error, (ii) Customer's failure to follow operating 
instructions, (iii) negligence or accident, or (iv) modifications to the Software by any person or entity other than Company. In the 
event of a breach of warranty, Customer’s sole and exclusive remedy, is repair of all or any portion of the Software. If such 
remedy fails of its essential purpose, Customer’s sole remedy and Ektron’s maximum liability shall be a refund of the paid 
purchase price for the defective Products only. This limited warranty is only valid if Ektron receives written notice of breach of 
warranty within thirty days after the warranty period expires.



5. Limitation of Warranties and Liability: THE SOFTWARE AND DOCUMENTATION ARE SOLD “AS IS” AND WITHOUT ANY 
WARRANTIES AS TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF THE SOFTWARE. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION 4, ALL 
WARRANTIES EXPRESS AND IMPLIED ARE HEREBY DISCLAIMED.

NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR 
GOODWILL, LOSS OF DATA OR USE OF DATA, INTERRUPTION OF BUSINESS NOR FOR ANY OTHER INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR ARISING OUT OF, OR IN ANY 
RELATED TO THIS AGREEMENT, HOWEVER, CAUSED, WHETHER FOR BREACH OF WARRANTY, BREACH OR 
REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE, EVEN IF COMPANY OR ITS REPRESENTATIVES 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.

6. Additional Terms and Conditions apply

When using the CMS400 map control, Subject to the terms and conditions of the Map provider (Microsoft Virtual Earth or 
Google maps)

Microsoft Virtual Earth - http://www.microsoft.com/virtualearth/product/terms.html

If you have any questions would like to find out more about a MWS/VE Agreement, please contact maplic@microsoft.com for 
information.

Google Maps - http://code.google.com/apis/maps/terms.html

7. Miscellaneous: This License Agreement, the License granted hereunder, and the Software may not be assigned or in any way 
transferred without the prior written consent of Ektron. This Agreement and its performance and all claims arising from the 
relationship between the parties contemplated herein shall be governed by, construed and enforced in accordance with the laws 
of the State of New Hampshire without regard to conflict of laws principles thereof. The parties agree that any action brought in 
connection with this Agreement shall be maintained only in a court of competent subject matter jurisdiction located in the State 
of New Hampshire or in any court to which appeal therefrom may be taken. The parties hereby consent to the exclusive 
personal jurisdiction of such courts in the State of New Hampshire for all such purposes.. The United Nations Convention on 
Contracts for the International Sale of Goods is specifically excluded from governing this License. If any provision of this License 
is to be held unenforceable, such holding will not affect the validity of the other provisions hereof. Failure of a party to enforce 
any provision of this Agreement shall not constitute or be construed as a waiver of such provision or of the right to enforce such 
provision. If you fail to comply with any term of this License, YOUR LICENSE IS AUTOMATICALLY TERMINATED. This License 
represents the entire understanding between the parties with respect to its subject matter.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT YOU UNDERSTAND THIS AGREEMENT, AND 
UNDERSTAND THAT BY CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR RUNNING THE 
SOFTWARE, OR BY PLACING OR COPYING THE SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO 
BE BOUND BY THIS AGREEMENT’S TERMS AND CONDITIONS. YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN 
SEPARATE AGREEMENTS BETWEEN EKTRON AND YOU, THIS AGREEMENT IS A COMPLETE AND EXCLUSIVE 
STATEMENT OF THE RIGHTS AND LIABILITIES OF THE PARTIES.

Copyright 1999 - 2008 Ektron, Inc. All rights reserved.

LA10031, Revision 2.0
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What’s New in the 7.5 Release

The following 7.5 features are documented in the Ektron 
CMS400.NET Administrators Manual.

• The Community Platform features allow users to network 
socially on the site. Access to the Community Platform is 
available from the Web site or the Workarea. As an 
Administrator, you can manage Community Platform features 
from the Workarea > Modules > Community Management. See 
”Community Management” on page 868.

- For 7.5.1 - ”Distributing Content to Another Ektron 
CMS400.NET Folder” on page 880 

• Two new features enhance the search. They can be used 
separately but are more powerful when used together.

- You can create any number of Synonym Sets to work with 
the search. If a site visitor enters a term from the set into 
the search field, all content that includes any term in the set 
is returned. See Also: ”Synonym Sets” on page 422

- For any term or Synonym Set, you can create a list of 
Suggested Result links that appear whenever someone 
searches for a selected term. These links, which can jump 
to your Web site or an external Web site, appear in a 
special area of the Search Results page. You can use 
Suggested Results to provide sponsored links to business 
partners or sell advertising on your site. See Also: 
”Suggested Results” on page 425

• When a user logs in to an Ektron CMS400.NET Web site, 
editable server controls are now indicated by a pinhead.
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The user clicks the pinhead to display a menu of relevant 
options. Previously, such areas were surrounded by a green 
border. The Ektron CMS400.NET administrator has three 
options for indicating such areas. See ”Using the Web Site 
Interface” on page 14

• Added the following features to Discussion Boards:

- Permissions can now be applied to forums. Previously, you 
could only apply them to boards. See Also: ”Assigning 
Permissions to a Discussion Board” on page 518

- A new icon ( ) indicates new topics since the last log-in. 
As you view a post within the topic, its icon changes to the 
previously-viewed icon ( ).

- Any thread can now be printed. 

- A dropdown list of forums lets a site visitor quickly switch to 
any forum in a board. A new server control property, 
enableforumquickselect, enables this.

- You can now create emoticons, that is, assign an image to a 
string of characters. If people insert the character string into 
a post, Ektron CMS400.NET replaces it with the assigned 
image. See Also: ”Creating and Editing Emoticons” on 
page 513
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- You can add a rating control to a thread (enabled in the new 
EnableThreadRating server control property). The average 
rating appears in the corresponding thread's row.

- You can now lock a Discussion Board. If a board is locked, 
all of its forums are locked. Previously, you could only lock 
at the Forum level.

- You can now apply a taxonomy to a Discussion Board. You 
can also require the user creating a new topic to apply a 
taxonomy category to that topic. As a result, site visitors 
have an additional search option: searching posts by 
taxonomy categories. See Also: ”Taxonomy: All taxonomies 
appear” on page 481

- The Category level of the hierarchy was changed to 
Subject. This was changed to avoid confusion, since the 
term category is also used in the Taxonomy feature.

- If you sign in to the Web site as an administrator or 
moderator and navigate to a page with a Discussion Board, 
a Move to dropdown box lets you move all postings to a 
different topic. See Also: ”Moving All Posts to Another 
Topic” on page 509

- For 7.5.1 - You can create ranks that are independent of the 
ladder system, that is, they are not determined by the 
user’s number of posts. For example, after a Forum user 
acquires Ektron Developer Certification, he is assigned the 
Ektron Developer rank. Users can be moved between a 
non-ladder rank and the ladder system. See Also: ”Ranks 
Independent of the Ladder System” on page 492

• Several changes were made to the XML Index Search. They 
are described in the Ektron KB article “7.5 Upgrade: Changes 
to 7.5 XML Index Search” (http://dev.ektron.com/
kb_article.aspx?id=13708)

http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708


What’s New in the 7.5 Release

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 vii i

• For 7.5.1 - A new Distribute menu option lets users copy 
content from a private collaboration folder to a public content 
folder. Once there, the document can pass through an approval 
chain or be published immediately. See Also: ”Distributing 
Content to Another Ektron CMS400.NET Folder” on page 880

• For 7.5.1 - The Search screen now has an optional Filter by 
Category link. If the link is enabled, and a site visitor clicks it, 
he can then select taxonomy categories. Only content that 
includes the search term and is assigned to the selected 
categories appears. See Also: ”Display of Search Results” on 
page 417

• For 7.5.2 - eWebEdit400 has been added as an option for 
Editing in CMS400.NET. In this new editor, there are changes 
to the way Validation is handled. See ”Validating with 
eWebEdit400” on page 108.

• For 7.5.3 - The search finds metadata along with other content. 
Previously, you had to precede the search text with an at sign 
(@) followed by the name of the metadata field. See Also: 
”Searching for Metadata” on page 450

• For 7.5.3 - The Ektron Explorer has been removed from Ektron 
CMS400.NET. It is no longer necessary, since users can drag 
and drop files into a mapped network folder without signing into 
the Workarea. This feature is described in the Ektron 
CMS400.NET User Manual section “Using the Document 
Management System” > “Importing Office Documents” > 
“Adding Documents to a Mapped Network Folder.”
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Security Checklist
The following is a checklist of things an Administrator must do to 
secure Ektron CMS400.NET.

 Change Admin user password

 Change builtin user password

IMPORTANT! If you changed the builtin user password during the site setup, you do not need to 
change it again. See ”Editing Builtin” on page ii for additional information.

 Remove Sample Users and Sample 
Membership Users

IMPORTANT! Some users in this list might not appear in your User list. This depends on which 
version of the software you have installed.

Securing Ektron 
CMS400.NET

CMS400.NET Users Membership Users

 jedit

 tbrown

 jsmith

 vs

 jmember

 member@example.com

 north

 supermember

 west
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Additional Information
You do not need to make these changes if you are using the 
CMS400.NET for demonstration or evaluation purposes. These 
changes should be completed once the decision is made to 
purchase the product and go live with your site.

IMPORTANT! Ektron recommends creating your own Administrator user and deleting the Admin 
user.

IMPORTANT! Ektron recommends deleting any users from the CMS400.NET that are not 
needed on the system.

The Everyone Group
By default, the root folder in Workarea provides the Everyone 
Group with all permissions except Overwrite Library. Ektron Inc. 
recommends reviewing the permission needs of the Everyone 
Group when you add a folder. For information on Permissions, see 
the Administrator Manual section “Managing User and 
Permissions” > “Setting Permissions.”

Editing Builtin

IMPORTANT! The “builtin” user does not appear in the Users list. This user appears on the 
application setup screen.

To change the builtin account information, follow these steps.

1. In the Workarea, click Settings > Configuration > Setup.

2. Click the Edit button ( ).

3. Locate the Built In User field.
4. Edit the built in user information by changing the username and 

password.

5. Click the Update button ( ).

NOTE If you cannot sign in to Ektron CMS400.NET because the builtin user 
password was changed and you don’t know the new password, use the 
BuiltinAccountReset.exe utility. This resets your Ektron CMS400.NET user \ 
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password to Builtin \ Builtin. This utility is located in C:\Program 
Files\Ektron\CMS400versionnumber\Utilities.

ServerControlWS.asmx

ServerControlWS.asmx is the Web service that lets the server controls talk to 
Ektron CMS400.NET. The path is coded in the web.config file. This is how it 
appears:

<!-- Web Service URL for Server Controls design time  --> <add key="WSPath" value="http://
localhost/CMS400Developer/Workarea/ServerControlWS.asmx" />

You will need to edit this line if you change the location or name of the 
ServerControlWS.asmx file.

Best Practice
For improved security, Ektron recommends renaming or removing the 
Web services file when you move it to your production server. After 
installation, this file is named ServerControlWS.asmx and resides in the 
webroot/siteroot/Workarea folder.
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Introduction to Ektron 
CMS400.NET

Thank you for purchasing Ektron CMS400.NET, the best and most 
affordable solution for Web content management. We welcome 
you to use Ektron CMS400.NET to maintain, update, and modify 
the contents of your Web site. All these efforts are easily achieved 
while preserving the look and feel that you originally designed for 
your site. With Ektron CMS400.NET, the tasks of maintaining your 
site and updating content are passed on to subject experts. Based 
on the page layouts and processes that you create, the highest 
level of quality is preserved and maintained throughout the life 
cycle of the site.

See Also: 

• ”About Ektron CMS400.NET” on page 1

• ”Who Should Read This Documentation?” on page 2

• ”Online Learning Center” on page 2

• ”Sample Site Used in this Document” on page 2

• ”Types of Users” on page 2

• ”Management of Content” on page 3

• ”Conventions of the Documentation” on page 4

About Ektron CMS400.NET
Ektron CMS400.NET is a powerful, easy-to-use, and affordable 
XML content management solution that empowers anyone to take 
an active role in managing Web content and optimizing online 
strategies. It streamlines site management, automates workflow 
processes, and supports collaboration. Ektron CMS400.NET 
reduces costs, saves time and makes Web sites, extranets, and 
intranets more effective – while generating rapid ROI.
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Business users, like marketing or PR pros, can author, manage 
and publish Web content, build and deploy Web forms, and collect 
and leverage visitor info. Our browser-based editor, 
eWebEditPro+XML, supports the industry’s best in-context editing 
environment – ensuring user adoption and project success.

Ektron CMS400.NET also helps to move paper-based forms 
processes to the Web. Our editor lets users create Web forms 
such as expense reports, health records, and insurance forms, 
deploy them to internal users, collect data, apply validation and 
math functions, and run forms through workflow – all within a 
browser.

Who Should Read This Documentation?
This document introduces all the concepts, features, and 
instructions for using Ektron CMS400.NET as a Web administrator. 

The Web administrator is the person who is responsible for 
adjusting the setup of the Web site, and alters the site as 
institutional changes require. New areas needing to be added to 
the Web site, the changing of personnel and processes over time 
may cause these adjustments.

Online Learning Center
Much of the information in this documentation is also presented in 
a tutorial, animated format on Ektron’s Web site. To access 
Ektron’s CMS400.NET Web Training, go to http://www.ektron.com/
cms400-web-cms.aspx?id=922.

Sample Site Used in this Document
This documentation uses the sample ASPX Web site installed with 
Ektron CMS400.NET to explain and demonstrate functionality in a 
Ektron CMS400.NET controlled Web site.

Types of Users
Ektron CMS400.NET lets you control the content of your Web site. 
The tasks of creating and maintaining your Web site are allocated 

http://www.ektron.com/cms400-web-cms.aspx?id=922
http://www.ektron.com/cms400-web-cms.aspx?id=922
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among different types of users. The types of Ektron CMS400.NET 
users are:

You assign privileges to Ektron CMS400.NET users based on the 
actions for which they are responsible. Each user may be assigned 
any or all types of privileges. Users without administrative 
permissions are known as content contributors.

This document describes features and actions available to a user 
with administrative privileges. Information about Ektron 
CMS400.NET’s editing and publishing features may be found in 
the Ektron CMS400.NET User Documentation.

Management of Content
The Ektron CMS400.NET content manager uses database 
technology to store, build, and retrieve Web page content. The 
placement of the content on a Web page is determined by 
templates, which you can build with external tools. Ektron extends 
VisualStudio to support the template design process.

Templates can be thought of as mechanical layouts of your Web 
pages. They incorporate powerful custom functions that Ektron 
CMS400.NET uses to manage your content. Each content item is 

User Job

Developer Builds templates

Administrator Sets up the site, adds users and user groups, 
sets permissions, and maintains the library

Content 
Contributor

Maintains Web site by adding, modifying, and 
publishing content.
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assigned a unique ID. Ektron CMS400.NET uses the ID to retrieve 
content from the database.

If during the evolution of your site the need for a new template 
arises, you simply create a new one, store it in a directory 
accessible to Ektron CMS400.NET, and create new content that 
uses the new template. You can even modify the layout of an 
existing template, reincorporate it, and the content automatically 
flows into and adjusts to the new layout.

For more information, see ”Creating/Updating Templates” on 
page 64.

Conventions of the Documentation
This document‘s typographic styles and conventions are explained 
below.

Convention Explanation

Bold Bold type indicates a menu selection, field or text that you must 
select.

Courier New Courier New font indicates code that you may enter.

Note: Notes indicate special conditions or issues that the reader should be 
aware of.
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WARNING! A warning indicates very important information that should be 
followed. Inattention to a warning can produce undesirable results.

Italic Italic text indicates either a title that is being cited or a special use of 
a word that might be confused with common world terms.

Convention Explanation
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Getting Started

Now that you have installed Ektron CMS400.NET, what’s next? 
This chapter explains several resources supplied by Ektron to help 
get your Ektron CMS400.NET Web site up and running.

This section has the following topics:

• ”Logging Into an Ektron CMS400.NET Web Site” on page 6

• ”Accessing the Workarea” on page 11

• ”Workarea Navigation” on page 13

• ”Using the Web Site Interface” on page 14

• ”Site Preview” on page 17

Logging Into an Ektron CMS400.NET Web Site
See “Logging In and Out” in the Ektron CMS400.NET User Manual.

Note If needed, you can adjust the width of the login screen. This may be necessary if 
you use Active Directory and have long database names. Use the 
ek_LoginScreenWidth element of the web.config file to adjust the width.

Making Passwords Case Sensitive
By default, passwords are case insensitive. So for example, if the 
password is TOKEN and the user enters token, the signon is 
successful.

If you want to make passwords case sensitive, change the value of 
the ek_passwordCaseSensitive element of the web.config file from 
false to true. (The web.config file is located in your site’s root 
directory.)
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If you do, and the password is TOKEN and the user enters token, 
the signon is unsuccessful. The user would have to enter TOKEN 
to successfully sign on.

Restricting Login Attempts
Ektron CMS400.NET has a login security feature that, by default, 
locks out a user after five unsuccessful attempts to log in by a user 
on one computer. This section explains the flexibility you have in 
controlling this feature.

You can control the following capabilities.

• ”Changing the Number of Unsuccessful Login Attempts” on 
page 8

• ”Disabling the Login Attempts Feature” on page 9

• ”Unlocking a Locked Account” on page 8

• ”Preventing CMS Users from Signing On” on page 9 

• ”Preventing All Users from Signing On” on page 9

You control login security feature by changing the value of the 
ek_loginAttempts element in the web.config file. The following table 
summarizes your options.

Value Description

any number 
between 1 
and 254

The number of times a user can try to log in before he is 
locked out.

0 Lock out all users

-1 Disable feature; unlock all locked users

-2 Lock out CMS users only; membership users can still 
log in
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Changing the Number of Unsuccessful Login Attempts

By default, if a user unsuccessfully tries to log in five times, the 
following error message appears: The account is locked. Please 
contact your administrator. Afterwards, even if the user enters 
the correct password, he is locked out, and the error message 
reappears.

NOTE You can change the text of the error message in the resource file. To learn about 
editing the resource file, see ”Procedure for Translating Workarea Strings” on 
page 848

To change the number of unsuccessful login attempts that occur 
prior to lockout, edit the value of the ek_loginAttempts element in 
the web.config file. (The web.config file is located in your site’s root 
directory.) For example, to allow only three unsuccessful logins, 
change the value to 3. You cannot enter a value greater than 254.

Unlocking a Locked Account

Once an account is locked out, the Account Locked field is 
checked in the user settings.

To unlock the account, an administrator user (or a user assigned to 
the user-admin role) accesses the Edit User screen and unchecks 
the box. At this point, the user can attempt to sign in again.
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NOTE If you want to unlock all locked users at once, set the value of the 
ek_loginAttempts element in the web.config file to -1. For more information 
about the effects of this setting, see ”Disabling the Login Attempts Feature” on 
page 9.

Manually Locking a User from Signon

You can use the Account Locked field (described above) to 
manually lock a user out of Ektron CMS400.NET. To do so, go to the 
Edit User screen, identify the user, and check the Account 
Locked field. 

That user cannot sign in until either you reverse the above 
procedure and uncheck the box, or you change the value of the 
ek_loginAttempts element in the web.config file to -1.

Disabling the Login Attempts Feature

To disable the Login Attempts feature, set the value of the 
ek_loginAttempts element in the web.config file to -1. If you do, any 
user can try to log in as many times as he wants. The error 
message never appears, and he is not prevented from entering a 
password.

NOTE Setting the value of the ek_loginAttempts element in the web.config file to -1 
automatically unlocks all locked accounts.

Preventing CMS Users from Signing On

If you want to lock out all CMS users, set the ek_loginAttempts 
element in the web.config file to -2. If you do, only membership 
users can sign in. 

NOTE The builtin user cannot sign in if ek_loginAttempts is set to -2.

Preventing All Users from Signing On

If you want to lock out all users (including membership users), set 
the ek_loginAttempts element in the web.config file to 0. If you do, 
no one can sign in to Ektron CMS400.NET until you change the 
value.

NOTE The builtin user cannot sign in if ek_loginAttempts is set to 0.
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Changing Images Used for Logging In and Out
You can change the images used for the login and logout buttons. 
To do so, follow these steps.

1. Move the new images to the following folder: webroot\your 
site’s root directory\Workarea\images\application.

2. Open the web.config file in your Web site’s root directory. 
3. Change the images referenced in this section of the file:
<add key="ek_Image_1" value="btn_close.gif" />

<add key="ek_Image_2" value="btn_login.gif" />

<add key="ek_Image_3" value="btn_login_big.gif" />

NOTE You must update the images and web.config each time your system is updated.

Resolving Problem with Sign in Screen
You may find that in certain browsers, the login screen occupies 
the entire browser window instead of just a small box (see 
illustration below).
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Browsers such as Netscape 8 and Firefox have a feature called 
tabs. When the login window pops up, it appears as a new tab as 
shown above.

You can fix this problem by turning off tabs within the browser.

Accessing the Workarea
Once logged into Ektron CMS400.NET, you can edit content by 
navigating to the page or accessing the Workarea. From there, you 
can perform all activities, such as configuring and viewing every 
setting of Ektron CMS400.NET. 

NOTE To learn about editing content by navigating to its page, see ”Using the Web Site 
Interface” on page 14.
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To access the Workarea, follow these steps.

1. Log in to your Web site, as described in ”Logging Into an 
Ektron CMS400.NET Web Site” on page 6.

2. Click the Workarea button ( ) on a login page or a 

Workarea toolbar button ( ).

The Workarea has a Windows Explorer-like interface.

When you first access your Workarea, your Smart Desktop is 
displayed. The Smart Desktop contains useful information that 
pertains to you.

NOTE In the Application Setup screen, you can determine which screen appears when 
you access the Workarea. See Also: ”Set smart desktop as the start location in 
the Workarea” on page 22

For more information about the Smart Desktop, see the Ektron 
CMS400.NET User Manual section “The Workarea and Smart 
Desktop” > “Understanding the Smart Desktop.”
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Workarea Navigation
The Ektron CMS400.NET administrator Workarea is divided into two 
frames:

• the left frame displays the system’s folders

• the right frame displays common reports (For more information, 
see ”Content Reports” on page 145)

NOTE Each category in the right frame is followed by a number indicating how many 
content items are in that status. Content to Expire lists how many content items 
will expire within ten days. By going to the report (Smart Desktop > Reports > 
Content To Expire) and changing the number of days, you can view a list of 
content to expire in that amount of time.
The number next to Tasks indicates how many open tasks are assigned to, or 
have been assigned by, you. Open tasks are those in one of the following states: 
not started, active, awaiting data, on hold, pending, reopened.

To learn more about the Workarea, see the section of the Ektron 
CMS400.NET User Manual titled “Understanding the Smart 
Desktop.”
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Closing the Workarea
To close the Workarea, click the ( ) button in the upper right 
corner. 

When you close the Workarea, you return to the Ektron 
CMS400.NET view of your Web site but do not exit Ektron 
CMS400.NET.

Using the Web Site Interface
As mentioned in the Ektron CMS400.NET User Manual section 
“Introduction to Ektron CMS400.NET” > “Working with Content 
from your Web Site”, users and administrators can perform actions 
using either the Workarea or the Web site. The Web site has two 
types of dropdown menus that appear after users sign in and 
enable users to perform actions.

NOTE The menus only appear if you are not in site preview mode. To learn about Site 
Preview mode, see “Logging In and Out” > “Site Preview” in the Ektron 
CMS400.NET User Manual. “Site Preview” on page 14.

Menu Type Illustration For more information, see

Content - triangle 
appears to right of 
content. Click it to 
display menu.

Ektron CMS400.NET  User 
Manual section “Working with 
Folders and Content” > “Viewing 
a Folder” > “Content Dropdown 
Menu”

Note: To change the styling of 
the content menu, edit 
EktronEditorsMenu.css in your 
site root’s Workarea/csslib 
folder.
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The Server Control Web Site Menu
A menu of dropdown options is available from most server 
controls, such as Content Block, Collection, List Summary and 
Metadata List. The options depend on the control and user’s folder 
permissions.

You have three choices for determining the appearance of the 
Server Control Web site menu. Set your choice via the 
ek_UserMenuType element of the siteroot/web.config file. By default, 
ek_UserMenuType is set to 2.

Server control - small 
gray circle appears in 
upper left corner of 
server control. Click it 
to display menu.

”The Server Control Web Site 
Menu” on page 15

Menu Type Illustration For more information, see
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Value set in 
ek_UserMenuType

Description Illustration

2 (default) Dropdown Interface - No 
borders; dropdown menu 
appears when user clicks 
pinhead in top left corner of 
server control

1 Classic Interface - Colored 
borders and menus always 
appear; menu options 
appear as icons in the top 
row

Note: If you use this 
interface, the page layout is 
not depicted accurately 
because of the fixed 
toolbars.
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Site Preview
To learn about Site Preview mode, see “Logging In and Out” > 
“Site Preview” in the Ektron CMS400.NET User Manual. 

0 Hover Interface - Colored 
border appears when user 
hovers mouse over area; 
menu appears when user 
right clicks mouse inside 
border.
This interface has two 
display options: vertical 
(shown on right) and 
horizontal.
To change: 

1. Open the siteroot/
web.config file.

2. Find 
ek_MenuDisplayType.

3. Change its value:
0 (zero) = horizontal
1 = vertical

Value set in 
ek_UserMenuType

Description Illustration
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Modifying the Application Setup 
Screen

In the setup section of the configuration folder, you can enter or 
edit information for the Ektron CMS400.NET Web site including:

• License keys

• Default language

• Maximum content and summary sizes

• email notification

• Physical library folders on file server

• Builtin user information

• Editor options

• Work page size settings

You must complete this before any user can access your Ektron 
CMS400.NET Web site.

• ”Enabling WebImageFX” on page 23

• ”Enabling CMS to Create File System Folders” on page 24

• ”BuiltIn User” on page 25

• ”Editor Options” on page 25

NOTE Only members of the Administrator User Group can view and edit the Application 
Setup screen.

Viewing Application Setup Information
To view Ektron CMS400.NET setup information, follow these 
steps.
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1. Access the Workarea. See Also: ”Accessing the Workarea” on 
page 11

2. Click Settings > Configurations > Setup.
3. The Application Setup screen is displayed. 

Updating Setup Information
To update setup information, follow these steps.

1. Access the Application Setup screen, as described in ”Viewing 
Application Setup Information” on page 18.

2. Click the Edit button ( ).

3. The Application Setup screen appears. Update the fields as 
needed. The following table explains the fields.

.

Field Description

License Key(s) Enter the license key sent to you from Ektron via email into this field.

Module Licenses Enter the license key for WebImageFX that was sent to you via email. 
See ”Enabling WebImageFX” on page 23 for more information.

Default Application 
Language

Select a default language for Ektron CMS400.NET.
How a User’s Application Language Affects His Use of Ektron 
CMS400.NET

This user’s language determines the screens and messages that 
appear in Ektron CMS400.NET .
How the System Default Language Relates to a User’s Language 
Setting
In the user profile, you can set each user’s language. You can set any 
user’s language to system default. Each user whose language is set 
to system default uses the language assigned here.

Note: Do not confuse this default application language with the ek_ 
DefaultContentLanguage variable in web.config. For more information 
on that variable, see ”The Default Language” on page 816.
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Maximum Content Size In characters, limit the size of each content item by specifying a 
maximum size. If a user’s changes to content result in exceeding this 
limit, the user is told to reduce the content before he can save it.
It cannot exceed 1,000,000 characters.

Maximum Summary Size In characters, limit the size of each summary by specifying a 
maximum size. If a user’s changes to a summary result in exceeding 
this limit, the user is told to reduce the summary before he can save it.
It cannot exceed 65,000 characters.

System email Address Enter a valid email address. This address will appear in the From field 
in the notification emails.

Enable Sending of System 
Notification Email 

Check the box to enable email notification for the entire CMS. Un-
checking this box disables email notification, regardless of whether 
individual users have their email enabled.

Asynchronous Processor 
Location

If your site uses the Web Alerts feature, enter or update the location of 
the asynchronous processor Web Services file. The default location 
appears below. See Also: ”Setting Up the Message Queue and 
Asynchronous Processor” on page 937

This is a Staging Server 
(Only used with Site 
Replication)

Check this box if you use the Site Replication feature, and Ektron 
CMS400.NET  resides on a staging server.
If you check this box, Web alerts are not generated when content is 
updated. Web alerts should only be created on a production server.
See Also: The Ektron CMS400.NET  Site Replication Manual

Publish in Other Format: 
Enable Office documents to 
be published in other format

Check the box to allow Ektron CMS400.NET  to render Office 
documents in PDF format. When a checked, PDF generation is 
available for individual folders.
See Also: ”Should Office documents added to this folder be published 
in other format?” on page 39

Library Folder Creation:
Enable CMS to create file 
system folders for library 
assets

Check the box if you want to create physical folders on your file 
system server that match the Ektron CMS400.NET library folder tree. 
See Also:  ”Enabling CMS to Create File System Folders” on page 24

Field Description
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Built - in User Edit the username and/or password for the built in user. By default, the 
username and password combination is builtin/builtin. 

Important! Ektron strongly urges you to change the default password 
assigned to the builtin user. An opportunity to do this is presented 
during installation.

See Also: ”BuiltIn User” on page 25

Editor Options Toggle between displaying and not displaying font related buttons in 
the editor. Also choose to remove styles and preserve MS Word styles 
and classes. See Also: ”Editor Options” on page 25

Accessibility/Section 508 
Evaluation

”Validating Content For Compliance with Accessibility Standards” on 
page 99

Work Page Size
The following fields change the 

• default editor screen size

• whether button text appears in the title bar

• default Web page after sign-in

• default Workarea page 

The default values are automatically applied to all new users, and to all existing users when you 
upgrade.
Normally, you can modify these values for any user via the Edit User screen. But, you can force these 
values on all users, removing the ability to personalize them.

Width If desired, change the width of the screen in which Ektron 
CMS400.NET  appears. The width in pixels must be between 400 and 
2400.
This field accommodates users who have larger monitors and/or 
prefer a higher resolution, such as 1280 x 1024.
The default value for this setting is 790.

Height If desired, you can change the height of the screen in which Ektron 
CMS400.NET  appears. The height in pixels must be between 300 
and 1800.
This field accommodates users who have larger monitors and/or 
prefer a higher resolution, such as 1280 x 1024.
The default value for this setting is 580.

Field Description
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Display button text in the 
title bar

Check this box if you want any button’s caption text to appear in the 
screen title’s bar whenever a user moves the mouse over the button. 
Note the word Update, describing the button, in the illustration below

If you do not check this box, the screen’s title remains in the title bar 
when the user moves the mouse over the button, as illustrated below.

Landing Page after login If you want one page in your Web site to appear after users sign in, 
enter the URL to that page. You can click Select Page to browse to 
the landing page. The last published version of the page appears. If 
the page has never been published, nothing appears.
By default, the page from which the user logged in reappears.

Set smart desktop as the 
start location in the 
Workarea

If you want the Smart Desktop to appear as soon as users enter the 
Workarea, click inside this check box.
See Also: ”Workarea Navigation” on page 13
By default, the user sees the Smart Desktop after sign in.
If you leave this check box blank, when you enter the Workarea, you 
go to the folder of the content specified at the Landing Page after 
login field.

Force preferences to all 
users

To force these settings on all Ektron CMS400.NET  users, check this 
box. If you do, users can see the values in the user profile screen but 
not change them.
If you leave this box blank, users can personalize these values in their 
User Profile.

Enable Verify email? Check this box if users should be notified whenever they subscribe to 
an email notification list. See Also: ”What Happens if Verification email 
is Used” on page 965

Field Description
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4. Make the necessary changes.

5. Click the Update button ( ).

Enabling WebImageFX
When purchasing Ektron CMS400.NET, you had the option to 
purchase Ektron WebImageFX as well. WebImageFX is an 
imaging application that allows users to edit images online.

If you purchased WebImageFX when you purchased Ektron 
CMS400.NET, you should have received an email with a license 
key for WebImageFX as well. 

To enable WebImageFX within Ektron CMS400.NET, from the 
application setup page, insert the WebImageFX license key in the 
Module License field.

Enable PreApproval Group Use this field to enable Automatic Task Creation. See Also: ”Automatic 
Creation of Tasks Associated with Content” on page 376

Field Description
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Enabling CMS to Create File System Folders
If this option is enabled, each time a new content/library folder is 
created in Ektron CMS400.NET, a corresponding physical folder is 
created on the file system. This helps organize library assets on 
your file server.

The following illustration compares the library folder tree with the 
file system’s folder structure.

NOTE If upgrading, the installation does not create sample Web site’s folders on the file 
server. These folders must be added manually. However, all folders created by 
you are also created on the file server when enabled.
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BuiltIn User
The builtin user is a user that is defined in the Ektron CMS400.NET 
setup screen. Primarily, he’s an emergency user if you cannot log 
in to Ektron CMS400.NET as the administrator.

NOTE The builtin user can log in to Ektron CMS400.NET whether or not Active Directory 
or LDAP is enabled.

Only use the builtin user to correct a bad or expired license key. It 
is not designed for regular CMS operations. If you try to edit 
content while signed on as this user, you see errors.

IMPORTANT! By default, the username and password combination for the builtin user is builtin/
builtin. For security reasons, Ektron recommends changing the username and 
password upon installation.

Editing the BuiltIn User
To edit the builtin user’s information, follow these steps.

1. Accessing the Edit Application Setup Information screen, as 
described in ”Updating Setup Information” on page 19.

2. Locate the Built In User field.
3. Edit the built in user information by changing the username and 

password.

4. Click the Update button ( ).

NOTE If you cannot sign in to Ektron CMS400.NET because the builtin user 
password was changed and you don’t know the new password, use the 
BuiltinAccountReset.exe utility. This resets your Ektron CMS400.NET user \ 
password to Builtin \ Builtin. This utility is located in C:\Program 
Files\Ektron\CMS400versionnumber\Utilities.

Editor Options
Style sheets greatly reduce the source code (and thereby the size 
of) a content. For this reason, they are becoming more popular 
than font-related tags for marking up content. The editor options 
section lets you determine how the editor handles this issue.

The following table explains the editor options you may set.
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.

Enable Font Buttons
Here is the editor with font related buttons enabled.

Editor Option Description

Enable Font Buttons This option displays the following font-related buttons on the 
editor toolbar:

• Font Face

• Font Size

• Font Color

• Font Background Color

See Also: ”Enable Font Buttons” on page 26

Preserve MS-Word Styles When content from MS Word is cut and pasted into the editor, the 
editor, by default, removes some MS Word styles. Checking this 
box prevents the editor from removing them.

Note: Ektron does not recommend enabling this feature.

Preserve MS-Word Classes Similar to styles, when content from MS-Word is cut and pasted 
into the editor, the editor, by default, removes some MS-Word 
classes. Checking this box prevents the editor from removing 
them.
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Disable Font Buttons
Here is the editor with the font buttons disabled.
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Managing Content

Ektron CMS400.NET’s User Manual provide extensive information 
about how users create and work with content. This section 
explains content topics that only administrators can manage. 

So, you should familiarize yourself with the User Manual chapter 
“Working with Folders and Content” before reading this.

See Also: ”Managing Content Folders” on page 28

Managing Content Folders

An administrator can control every aspect of the content and the 
folders that hold them. The controls include setting permissions, 
approvals, and adding, editing, publishing, and deleting content. 
Below is the content folder.
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This chapter explains how to add, edit, publish, and delete content. 
It includes the following information:

• ”Accessing the Content Folder” on page 29

• ”Folder Properties” on page 36

• ”Adding Subfolders” on page 42

• ”Deleting Folders” on page 43

• ”Community Folders” on page 43

• ”Purge History” on page 49

• ”Smart Forms” on page 50

• ”Breadcrumbs” on page 53

• ”Search Content Folder” on page 62

Accessing the Content Folder
To access a content folder, follow these steps.

1. Access the Workarea.
2. Click the Content folder in left side of the Workarea.
3. All content in the root content folder appears in the right frame. 

In the left frame, the content folder expands to display its 
subfolders.
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NOTE To learn about modifying the folder display, see ”Modifying the Folder Display” on 
page 35.

From this screen, you can perform administrative actions and 
maintain content. Each folder displays the following information 
about its content. 

Field Description

Title The name given to the content by the creator.

Language The content’s language. See Also:  ”Working with Multi-
Language Content” on page 809
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Additionally, each folder has the following menus.

• ”New Menu” on page 31

• ”View Menu” on page 32

• ”Delete Menu” on page 34

• ”Action Menu” on page 34

• ”Add Assets Button” on page 34

New Menu

ID The number Ektron CMS400.NET assigns to the 
content. It is used to retrieve the content from the 
database.

Status The content’s status.

Date 
Modified

The most recent date that the content was added, 
edited, or published.

Last Editor The last user who accessed the content.

Field Description

Menu 
Option

Creates the following new item 
within selected folder

For more information, see

Folder folder ”Search Content Folder” on page 62

Blog Blog “Blogs” in the Ektron CMS400.NET  
User Manual 

Discussion 
Board

Discussion Board ”Discussion Boards” on page 471

Community 
Folder

Community Folder ”Community Folders” on page 43
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View Menu
The View Menu provides the following functions.

HTML 
Content

HTML content ”Adding Content” on page 73

HTML Form/
Survey

HTML Form, Poll, or Survey ”Managing HTML Forms” on page 297

Smart Form Smart Form ”Smart Forms” on page 50

Office 
Documents

Office Document Ektron CMS400.NET  User Manual 
Section “Using the Document 
Management Functionality” > “Working 
with Microsoft Office Documents” 

Managed 
Files

Managed file, any supported type Ektron CMS400.NET  User Manual 
Section “Using the Document 
Management Functionality” > “Working 
with Managed Files” 

Multimedia Multimedia file, any supported type ”Managing Multimedia Assets” on 
page 317

Collection Collection ”Collections” on page 606

Menu Menu ”Menu Feature” on page 618

Menu 
Option

Creates the following new item 
within selected folder

For more information, see

Menu Option Function For more information, see

All types Displays all content types of selected 
language.
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• HTML content

• HTML Form/Survey

• Office Documents

• Managed Files

• Multimedia

Limits folder display to selected content 
type. For example, choose View > Office 
Documents, and see only Office 
Documents in the folder -- other content 
types are suppressed.
This is especially helpful if the folder has 
a lot of items, and you are looking for 
only one type of content.

• ”Adding Content” on page 73

• ”Managing HTML Forms” on 
page 297

• Ektron CMS400.NET  User Man-
ual Section “Using the Docu-
ment Management 
Functionality” > “Working with 
Microsoft Office Documents” 

• Ektron CMS400.NET  User Man-
ual Section “Using the Docu-
ment Management 
Functionality” > “Working with 
Managed Files” 

• ”Managing Multimedia Assets” on 
page 317

Language Limits display within a folder to one 
language.
The language setting also determines the 
language of any new items you create in 
the folder.

Menus Lets user view and work with menus Ektron CMS400.NET User Manual 
section “Working with Menus” > 
“Adding a New Menu” “Adding a 
New Menu” > “Adding a Menu via 
Content Folder” ”Adding a Menu via 
Content Folder” on page 450

Collections Lets user view and work with Collection ”Collections” on page 606

Archived Content Lets user view and work with Archived 
content. That is, content that passed its 
scheduled End Date and whose archive 
option is either Archive and remove 
from site or Archive and remain on 
Site.

Ektron CMS400.NET User Manual 
section “Scheduling Content to 
Begin and End” > “Setting Archive 
Options” ”Setting Archive Options” 
on page 70

Folder Properties Lets user view and edit a folder’s 
properties. In the properties screens, you 
can set permissions, approvals, etc.

”Folder Properties” on page 36

Menu Option Function For more information, see
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Delete Menu
This menu lets you perform the following functions.

. 

Action Menu
This menu lets you perform the following functions.

Add Assets Button
Click this button to enable a screen into which users can drag and 
drop assets. For more information, see the Ektron CMS400.NET 
User Manual Section ”Using the Document Management System” 
> “Adding Documents Using Drag and Drop.”

Menu option Lets you More Information

Delete this 
folder

Delete current folder and all of its content ”Deleting Folders” on page 43

Delete content Delete one, some, or all content items 
within folder

Ektron CMS400.NET User Manual 
section “Working with Folders and 
Content” > “Deleting Content” 

Menu option Lets you More Information

Export for 
translation

Prepare content for translation by a 
translation agency

”Using the Language Export Feature” on 
page 824

Move/Copy 
Content

Move or copy content to another folder. ”Moving or Copying Content” on page 78

Search Search through content in the Workarea. ”Search Content Folder” on page 62
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Modifying the Folder Display
Ektron CMS400.NET provides two techniques for displaying the 
folder tree. (The folder tree appears in the left frame when the 
Content tab is selected, as shown below.)

• Classic - used in previous versions of Ektron CMS400.NET

• Ajax - available in version 5.1 or higher

The following table contrasts the two techniques.
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By default, Ektron CMS400.NET uses the Ajax technique. To 
change it to Classic, open the web.config file in your site root and 
add the following key between <appSettings></appSettings>.

<add key="ek_treemodel" value="0"/>

To change the technique back to Ajax, either remove the key or 
change the value of the ek_treemodel setting from zero (0) to one 
(1).

Folder Properties
The folder properties screen lets you set permissions and 
approvals for a folder. You can also assign or modify the folder’s 
metadata, Web Alerts, and Smart Forms.

NOTE Only members of the Administrator User Group and those defined in the Manage 
Members for Role: Folder User Admin screen can view, add, or edit folder 
properties. (See Also: ”Defining Roles” on page 735) In addition, if a user is not a 
member of the Administrators group, he must be given permission for individual 
folders on the Folder Properties > View Permissions for Folder screen. (See Also: 
”Setting Permissions” on page 716)

Accessing the Folder Properties Screen
To access the folder properties screen, follow these steps.

1. Click View > Folder Properties.
2. The folder’s View Properties screen appears.

Technique How it Works Advantage

Classic Fetches all folders and subfolders while 
initially displaying the Workarea

While initial wait time may be longer, the 
wait time for opening child folders is 
shorter

Ajax Initially fetches only folders one level 
below Content (root) folder. Subsequent 
levels are fetched when user clicks the 
parent folder.

Can reduce initial wait time when 
displaying the Workarea
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If you want to change any properties, click the Edit button ( ) to 
proceed to the edit screen.

The table below describes the fields on the Folder Properties 
screen.
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Fields on the Folder Properties Screen

Tab Field Description

Properties Foldername Edit the name of the content folder. 

Note: You cannot change the root folder name.

Description Edit the description of the content folder.

Style Sheet filename 
for this folder: (leave 
blank to inherit)

Specify a style sheet that defines the styles of the content 
within the content folder. Or, leave this field blank to inherit 
the style sheet from the parent content folder.

Note: This style sheet affects content while being edited but 
has no effect on how the content appears on your Web site. 
To set or edit the style sheet that determines how your Web 
pages display, open the page’s Web form and place a 
<link rel=”stylesheet”... tag within its <HEAD> tags.

Page Templates Lets you specify one or more templates for content in this 
folder. This folder’s content uses the specified template 
when appearing on your Web site. See Also: ”Inheritance of 
Folder Templates” on page 69

Inherit Parent 
Template 
Configuration

Check this box to inherit the template from the parent 
content folder.
Or, do not check this box and specify one or more 
templates below. See Also: ”Inheritance of Folder 
Templates” on page 69

Taxonomy • If you want this folder to inherit taxonomy configura-
tions from the parent folder, check Inherit Parent Tax-
onomy Configuration.
If you uncheck Inherit Parent Taxonomy 
Configuration, you can then select taxonomies that 
can be applied to content in this folder.

• If you want all content in this folder to be assigned at 
least one taxonomy category, check Required at least 
one category selection. 

See Also: ”Inheriting Taxonomies from a Parent Folder” on 
page 640; ”Taxonomy” on page 626
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Tabs on the Folder Properties Screen

Flagging Check this box if content in this folder inherits a flagging 
definition from its parent folder. If you do not check the box, 
use the dropdown list to apply a flagging definition to 
content in this folder.
See Also: ”Flagging” on page 892, ”Assigning a Flagging 
Definition to a Folder” on page 895

Multi-Site Domain 
Configuration

Lets you set up and manage several Web sites under one 
CMS. See Also: ”Support for Multiple Sites” on page 918

Should Office 
documents added to 
this folder be published 
in other format?

Note: This field only 
appears if the Enable 
Office documents to 
be published in other 
format property is 
checked in the 
Settings > 
Configuration > Setup 
screen. See Also: 
”Updating Setup 
Information” on 
page 19 

Publish Office documents as PDF
Check this option if Office documents in this folder are 
published as PDF files. See Also:  ”PDF Generation” on 
page 324

Note: This property is not inherited from a parent folder, nor 
is it inherited by any subfolders below this folder.

Tab For more information, see

Metadata  ”Assigning Metadata to a Folder” on page 139

Web Alerts  ”Assigning Web Alert Information to Folders and Content” 
on page 956

Smart Forms  ”Smart Forms” on page 50

Breadcrumb  ”Breadcrumbs” on page 53

Category  ”Making a Taxonomy Available to a Folder” on page 638

Tab Field Description
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Folder Properties Toolbar
The Folder Properties screen contains these toolbar buttons.

Editing Folder Properties
A content folder’s properties consist of

• name

• description

• style sheet

• template (See Also: ”Creating/Updating Templates” on 
page 64)

• Metadata (See ”Assigning Metadata to a Folder” on page 139)

• Web Alerts (see ”Assigning Web Alert Information to Folders and 
Content” on page 956)

• ”Smart Forms” on page 50

Button Name Description More Information

Edit Properties Access the Edit Folder Properties 
screen

”Editing Folder Properties” 
on page 40

Permissions Access the folder’s Permissions 
Table

”Setting Permissions” on 
page 716

Modify 
Preapproval 
Group

Set or update preapproval group 
assigned to folder

”Automatic Creation of 
Tasks Associated with 
Content” on page 376

Approvals Access the folder’s approvals table ”Setting Approval Chains” 
on page 726

Purge History Access the folder’s purge history 
table

”Purge History” on page 49

Restore Web Alert 
Inheritance

Assigns the folder’s Web Alert 
properties to all content in folder

”Inheriting Content-Level 
Web Alert Information from 
Its Folder” on page 963

Back Go to previous screen
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• ”Breadcrumbs” on page 53

To edit any properties for a folder, follow these steps.

1. Access the View Properties screen for the folder you want to 
edit, as described in ”Accessing the Folder Properties Screen” 
on page 36.

2. Click the Edit button ( ).

3. The folder’s Edit Properties screen appears.

4. Make the necessary changes to the content folder’s properties. 
See ”Fields on the Folder Properties Screen” on page 38.

5. Click the Update button ( ).
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Adding Subfolders
To further organize content on your Web site, create subfolders to 
store related content. To add a sub folder, follow these steps.

1. Navigate to and click the folder within which you want to create 
a subfolder (that is, the parent folder).

2. Each folder has a default language. By default, it is inherited 
from its parent folder. To change a folder’s default language, 
use the parent folder’s View > Language selection (shown 
below).

Effect of a Folder’s Default Language

By default, when a user adds content to a folder, the default 
language is applied to the content unless the user explicitly 
changes the language. So, you should select a default 
language in which you expect the majority of folder’s content to 
be created.

3. Click New > Folder.
4. The Add a Subfolder screen appears.



Managing Content Folders

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 43

5. Complete the fields. See ”Fields on the Folder Properties 
Screen” on page 38.

6. Click the Save button ( ).
You can modify the subfolder’s properties, permissions, approval 
chain, etc. For a list of options, see ”Folder Properties Toolbar” on 
page 40.

If this is a Community Folder, see ”Community Folders” on 
page 43.

Deleting Folders
You can delete obsolete folders from the Ektron CMS400.NET 
Web site.

NOTE The top-level folder, Root, cannot be deleted nor renamed.

CAUTION! Deleting a content folder permanently deletes the content and Quicklinks that 
belong to the content folder, as well as its subfolders.

To delete a content folder, follow these steps.

1. In the Workarea, navigate to the content folder you want to 
delete.

2. From the options across the top of the screen, click Delete > 
This Folder.

3. A confirmation message is displayed.
4. Click OK.

Community Folders
IMPORTANT! This feature is an optional add-on. See your Ektron sales consultant for 

information.
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Community folders resemble regular folders in most ways. The 
only difference is that membership users can add and edit content 
in these folders only. Community folders have a unique icon, which 
looks like two houses ( ).

Membership users add and edit Community folder content after 
signing in to the Web site. They do not use the Workarea to add or 
edit content.

NOTE Authorized CMS users can also create and update Community folder content.

Creating a Community Folder
1. In Workarea > Content, go to the folder in which you want to 

create the community folder.
2. Select New > Community Folder.
3. Assign properties as you would any other folder. See ”Folder 

Properties” on page 36

NOTE The folder properties screen lets you require metadata for any content item. 
However, membership users cannot enter metadata. Therefore, this requirement 
is ignored when membership users edit community folder content. If an Ektron 
CMS400.NET user tries to edit that content, he is required to enter a metadata 
value.

Assigning Permissions for a Community Folder
Since Community folders are intended for membership users, this 
section explains how to assign permissions for them. To assign 
folder permissions for regular users, see ”Setting Permissions” on 
page 716.

1. Navigate to the folder.
2. Click View > Folder Properties.

3. Click the View Permissions button ( ).
4. If necessary, uncheck the Allow this object to inherit 

permissions checkbox.
5. Click View Membership Users.
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6. Click the Add button ( ).
7. Select the membership user or group to which you want to 

assign permission for this folder.
8. Check the permission boxes as appropriate.

How a User Views and Edits Community Folder Content
When a user with Read-only or higher permission navigates to a 
page whose content is in a community folder, he can view it. If he 
has edit permission, a green border surrounds it.
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IMPORTANT! Membership users can edit only HTML content and assets. They cannot edit other 
content types (HTML forms, Smart Forms, etc.).

When a membership user clicks the Edit button ( ), a new 
window displays the content within an editor.

Other membership buttons are View History ( ) and Log out 
( ). 

This editor has fewer capabilities than Ektron CMS400.NET’s editor. 
However, a membership user can 

• add images and files via the library button ( ) if the 
membership user has Add Images and Add Files permission. 
See Also: ”Library Folders and Permissions” on page 175
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• add a wiki using the page link button ( ). See Also: Ektron 
CMS400.NET User Manual section “Introduction to 
eWebEditPro+XML” > “Using Ektron CMS400.NET’s Wiki 
Feature”

• view the page’s HTML source by clicking the HTML tab in the 
lower left corner

• Assign a taxonomy category to the content by clicking the 
Category tab. See Also: ”Taxonomy” on page 626

NOTE The Category tab only appears if a Taxonomy is applied to the content’s folder.

• replace the content summary with the first 40 words of the 
content, using the Auto Generate New Summary check box. 
See Also: ”Auto Generating Summaries” on page 74
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When a membership user finishes editing, he clicks Publish. If the 
content’s folder has an approval chain, the content’s status 
changes to submitted, and the border color changes to yellow. If 
there is no approval chain, the content is published immediately.

How a Membership User Adds Community Folder Content
You will need the assistance of your developer to enable this 
feature. Instructions for doing so are in the developer sample site. 
After you install it, go to siteroot/developer/ContentBlock/
AddContentMembershipUser.aspx.

Or, from the developer home page (siteroot/developer/
default.aspx), go to Memberships > Membership Add Content.

How a Membership User Adds an Asset
First, your developer must create a template, then drop an Asset 
Server Control onto it. While adding the Asset Server Control, the 
developer specifies Add at the Upload Type property, and a 
community folder to which the asset will be saved at the 
DefaultFolderID property.

When a membership user authorized to add content navigates to 
the page with the server control, he sees an Asset control area like 
the one that appears when CMS users add assets. He can then 
drag and drop assets into Ektron CMS400.NET.

This is described in the Ektron CMS400.NET User Manual section 
“Using the Document Management Functionality” >“Importing Files 
via Drag and Drop.” 
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Additional information about administering assets is found in 
”Using the Document Management System” on page 222.

How a Membership User Updates an Asset
Your developer adds the Asset Server Control, as described in 
”How a Membership User Adds an Asset” on page 48. The only 
difference is that the developer specifies Update at the Upload 
Type property, and a community folder to which the asset will be 
saved at the DefaultFolderID property. 

Then, the developer specifies an asset ID number at the 
DefaultAsset ID property. Using that control, the membership user 
can update the identified asset only.

Purge History
The Purge History option lets you delete historical versions of 
content in a folder. When purging, your options are

• specify a date before which historical versions are purged

• indicate whether the purge includes a folder’s subfolders

• purge published as well as checked-in versions of content

NOTE Only Ektron CMS400.NET administrators and users identified on the Manage 
Members for Role: Folder User Admin screen can purge history.

To purge the history for a content folder, follow these steps.
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1. Access the View Folder Properties screen for the content folder 
you want to purge the history for, as described in ”Accessing 
the Folder Properties Screen” on page 36.

2. Click the Purge History button ( ).

3. The Purge History screen appears.
4. Use the following table to customize the Purge History options.

5. Click the Purge History button ( ).

6. A confirmation message is displayed.
7. Click OK to continue.
8. Ektron CMS400.NET executes the purge and displays a 

confirmation when complete.

Smart Forms
Use the Smart Forms screen to assign one or more XML 
configurations to a folder. (To learn about how Smart Forms are 
created, see ”Working with Smart Forms” on page 183.)

When creating new content in a folder, the New menu provides a 
Smart Form option. This option displays a secondary menu, which 
lists Smart Forms that you can use to create XML content. (See 
graphic below.)

Field Description Required?

Only purge historical 
versions before

Specify a date to limit the number of historical versions to 
purge. When specified, only historical versions with a 
date before this date are purged.

Yes

Recursive Purge Purges historical records for content in this folder’s 
subfolders.

No

Purge versions marked 
as Published

Purges published versions of content as well as checked-
in versions.

No
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This section explains how to determine the list of Smart Forms 
available when creating content.

Inheritance and Smart Forms
A folder’s Smart Forms can be inherited from the parent folder, or 
you can break inheritance and assign a unique group of Smart 
Forms. Use the Inherit Parent Configuration checkbox to retain 
or break inheritance.

Assigning Smart Forms to a Folder
If you break inheritance, you then select the Smart Forms that can 
be assigned to content in the folder using the Smart Forms 
dropdown list (shown below). 
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You can preview any Smart Form by clicking the Preview button 

( ). To add any Smart Form, select it from the dropdown list and 
click Add.

To remove a Smart Form, click Remove.

Requiring Smart Forms
You can require a Smart Form to be the only type of content that 
can be added within a folder. To enable this, click the Require 
Smart Forms check box on the Smart Forms tab.
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If you do, the user can only choose enabled Smart Forms when 
viewing that folder’s New menu -- all other content types are 
suppressed.

Breadcrumbs
WARNING! The information described in this section is for use with the FolderBreadcrumb 

server control, not the BreadCrumb server control. For additional information on 
each server control, see The Developer Manual sections “Introduction to Ektron 
CMS400.NET Server Controls” > “BreadCrumb Server Control” and 
“Introduction to Ektron CMS400.NET Server Controls” > “FolderBreadcrumb 
Server Control”.

Use the Breadcrumb tab to define a site map for the folder or to 
inherit one from the parent folder. Breadcrumbs improve the way 
site visitors can navigate around your site. Below is an example.
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The following topics explain Breadcrumbs in more detail.

• ”Inheritance and Breadcrumbs” on page 54

• ”Adding a Breadcrumb” on page 54

• ”Reordering Breadcrumb Items” on page 57

• ”Editing a Breadcrumb Item” on page 59

• ”Removing a Breadcrumb Item” on page 61

Inheritance and Breadcrumbs
A folder’s breadcrumbs can be inherited from the parent folder, or 
you can break inheritance and assign a path of breadcrumbs. Use 
the Inherit Parent Configuration checkbox to retain or break 
inheritance.

Adding a Breadcrumb
The example below adds three breadcrumbs to the trail.

1. Navigate to the folder for which you want to add the 
breadcrumbs. 

2. On the View Contents of Folder screen, click View > Folder 
Properties.

3. Click the Edit Properties button ( ).

4. Click the Breadcrumb tab.
5. The Edit Breadcrumbs screen appears.
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6. In the Add New Item section of the screen, add the following 
information.

• Title - the name of the breadcrumb as you want it to appear in 
the breadcrumb trail

• URL Link - the URL path to the breadcrumb’s destination, 
typically a Ektron CMS400.NET content item. For example, 
default.aspx.
If you are not sure what the file’s name is, click the Binoculars 
( ), and the library for quicklinks appears. Select the content 
item to add to the breadcrumb.
You can also enter a URL, for example, www.example.com.

• Description - add a description for the breadcrumb

7. Click the Add button ( ).

8. The first item in the breadcrumb path appears.
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.

9. Repeat steps 6 and 7 for each item in the breadcrumb path.
10. The items in the breadcrumb now appear like this.
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11. Click the Save button ( ).

Reordering Breadcrumb Items
1. Navigate to the folder for which you want to reorder 

breadcrumbs. 
2. On the View Contents of Folder screen, click View > Folder 

Properties.

3. Click the Edit Properties button ( ).

4. Click the Breadcrumb tab.
5. The Edit Breadcrumbs screen appears.
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.

6. Click a breadcrumb item.

WARNING! Do not click the red X. This deletes the breadcrumb item. See Also: ”Removing a 
Breadcrumb Item” on page 61.
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7. Click the green Up and Down buttons ( ) to move the item 
around in the list.

8. Once the items are in the correct position, click the Save button 
( ).

Editing a Breadcrumb Item
1. Navigate to the folder for which you want to edit breadcrumbs. 
2. On the View Contents of Folder screen, click View > Folder 

Properties.

3. Click the Edit Properties button ( ).

4. Click the Breadcrumb tab.
5. The Edit Breadcrumbs screen appears.
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.

6. Click a breadcrumb item.

WARNING! Do not click the red X. This deletes the breadcrumb item. See Also: ”Removing a 
Breadcrumb Item” on page 61.
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7. In the Add New Item section, edit the information.

8. Click the Save button ( ).

9. Click the Save button ( ).

Removing a Breadcrumb Item
1. Navigate to the folder for which you want to remove a 

breadcrumb. 
2. On the View Contents of Folder screen, click View > Folder 

Properties.

3. Click the Edit Properties button ( ).

4. Click the Breadcrumb tab.
5. The Edit Breadcrumbs screen appears.
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.

6. Click the Red X ( ) next to the breadcrumb item you want to 
remove.

7. The breadcrumb item is deleted.

8. Click the Save button ( ).

Search Content Folder
You can search a folder to locate content within your Web site. Use 
this feature to find content when you know the text that needs to be 
updated but are unsure of its folder or where it is on the Web site. 
The search only looks through the current folder and its subfolders. 
So if you want to search the entire site, begin with the root content 
folder.

To learn more about searching through folders on Ektron 
CMS400.NET, see “Searching the Workarea” in the Ektron 
CMS400.NET User Manual.
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Managing HTML Content

When you enter the Content folder in Ektron CMS400.NET as an 
administrator, you can control every aspect of the content and 
folders. Some controls include setting permissions, approvals, and 
adding, editing, publishing, and deleting content. Below is an 
example of the Content folder.

TIP! The “Working with Folders and Content” chapter of the Ektron CMS400.NET 
User Manual explains many details about how users interact with content. You 
familiarize yourself with that material before reading this chapter.

This chapter explains how to add, edit, publish, and delete content. 
Permissions and Approvals are explained in later chapters.
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See Also: 

• ”Creating/Updating Templates” on page 64

• ”Adding Content” on page 73

• ”Forming URLs For Ektron CMS400.NET Documents” on 
page 76

• ”Viewing Content” on page 77

• ”Editing Content” on page 78

• ”Moving or Copying Content” on page 78

• ”Viewing and Restoring Historical Versions of Content” on 
page 81

• ”Scheduling Content” on page 82

• ”Deleting Content” on page 82

• ”Content History” on page 82

• ”Content Permissions” on page 82

• ”Content Approvals” on page 82

• ”Content Workflow” on page 83

• ”Link Checking” on page 83

• ”Assigning Tasks to Content” on page 83

• ”Content Properties” on page 83

• ”Content Rating” on page 85

Creating/Updating Templates
During the setup of your Ektron CMS400.NET Web site, templates 
are created for your Web pages. A template typically includes page 
headers and footers as well as placeholders for content, forms, 
summaries, calendars, collections, or other page elements.

A template included with Ektron’s sample site appears below. 
Notice that the top of the screen contains headers that appear on 
several pages. Other areas contain links to Ektron CMS400.NET 
objects, such as menus and text. The developer can easily modify 
the content inside these areas.
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NOTE To learn more about creating templates, see the Ektron CMS400.NET 
Developer’s Manual section “Introduction to Ektron CMS400.NET Server 
Controls” > “Setting Up a Template.” Another good resource is the Ektron 
technical article “Templating in CMS400.NET” (http://dev.ektron.com/
articles.aspx?id=6724).

Templates are more fully explained through the following topics.

• ”How Templates are Used” on page 66

• ”Declaring Templates” on page 66

• ”Inheritance of Folder Templates” on page 69

• ”Assigning Templates to Folders” on page 70

http://dev.ektron.com/articles.aspx?id=6724
http://dev.ektron.com/articles.aspx?id=6724
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• ”Assigning Templates to Content” on page 71

How Templates are Used
Except for your Web site’s home page, all pages on your site are 
made accessible by hyperlinks. Hyperlinks can appear within 
content. They are also used to link content items from list 
summaries, menus, and collections.

The template is a key component of the hyperlink definition -- it 
defines the template in which to display the content. As seen in the 
example below, when the user selects Email, that content item (ID 
87) will display within the contactinformation.aspx template.

Declaring Templates
After creating your templates, declare them within Ektron 
CMS400.NET. To do this, go to the Active System Templates 
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screen, available from Settings > Configuration > Template 
Configuration.

From this screen, you can add new templates, or delete or update 
existing ones.

NOTE Only members of the Administrators group and users defined in the Manage 
Members for Role: Template Configuration screen have permission to add, delete 
or update templates. See Also: ”Defining Roles” on page 735

See Also: 

• ”Creating/Updating Templates” on page 64

• ”Adding a New Template” on page 67

• ”Deleting a Template” on page 68

• ”Updating a Template” on page 68

Adding a New Template

To add a new template, click the Add button ( ). The Add a New 
Template screen appears. 
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Enter the path to the new template and click the Save button ( ).

Deleting a Template

To delete a template, click Delete next to the template. 

You can only delete a template if it is not assigned as any folder’s 
default template. If you choose a template that is assigned as a 
default, a screen tells you why you cannot delete it and lists the 
folders for which it is the default.

If you delete a template that is not used as a default but is applied 
to content, that content’s template is changed to its folder’s default 
template.

Updating a Template

Use the update command to change all references from an old to 
a new template. For example, your old template is named 
MyTemplate.aspx. You can want replace all references to it to 
Updatetemplate.aspx. 

To do this, follow these steps.

1. Click Update next to the template. 
2. A new screen appears. 
3. Enter Updatetemplate.aspx.

4. Click the Save button ( ).
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Inheritance of Folder Templates
By default, all folders below the root folder inherit a template from 
their parent. However, you can override the default and assign a 
unique set of templates to any folder.

Before you can change a folder’s template assignment, you must 
break inheritance from the parent folder. To do this, go to the Edit 
Folder Properties screen and uncheck the box next to Inherit 
Parent Template Configuration (illustrated below). See Also: 
”Editing Folder Properties” on page 40

Each folder must have at least one template. Also, one template 
must be chosen as the default.
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If the folder’s default template is changed, all existing template 
assignments remain. However, any new content added or moved 
into the folder will assume the new default template.

Assigning Templates to Folders
If you break template inheritance, all inherited templates are 
initially assigned to the folder. You can then remove unwanted 
templates or add new ones.

All available templates appear in the template dropdown list 
(illustrated below). Select any that you want to be available from 
the folder and click Add.

The list of available templates is managed through the ActIve 
System Templates screen. See Also: ”Declaring Templates” on 
page 66
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Adding a Template to a Folder

To add a new template, click the Add button ( ). The Add a New 
Template screen appears. 

Enter the path to the new template and click the Save button ( ).

Removing a Template from a Folder

• If you try to delete a template that is the default for a folder, you 
are notified that you must assign a new default to that folder 
before you can delete it.

• If you try to delete a template that is assigned to a content 
block, you are notified via the following message If you wish to 
continue and delete this template, the above content will 
be set to their parent folder's default template. Do you wish 
to continue?

Assigning Templates to Content
A folder’s default template is automatically applied to all content in 
the folder. However, you can change a content item’s template to 
any of those assigned to the folder.

This relationship is illustrated below.
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To change the template applied to a content item, edit that content, 
and go to the Templates tab as shown above. Then, select a 
template to apply to the content. 

As explained in ”How Templates are Used” on page 66, the 
template assigned to the content will be used whenever a hyperlink 
is created to it.

See Also: ”Editing Content” on page 78

Adding Content
Ektron CMS400.NETallows for several types of content.

• HTML - Most typical type of Web content. User creates/edit this 
using WYSIWYG editor. Formatting is embedded as HTML 
code, which the user doesn’t need to see.

• HTML Form/Survey - Users can create and maintain HTML 
forms to collect information and opinions from visitors to your 
Web site

• Smart Forms - Content created using an XML configuration

• Multimedia Files - Files that include audio, video, or both

• Microsoft Office Documents - Content created in Microsoft 
Office and stored in CMS400.NET via the Document 
Management functionality

• Managed Files - Content created with software external to the 
CMS and stored in CMS400.NET via the Document 
Management functionality. These files are typically .pdf, .gif, 
.jpeg, .zip, and .txt files.

To learn about how Office documents and Managed files are added 
to the CMS, see the Ektron CMS400.NET User Manual section 
“Working with Folders and Content” > “Using the Document 
Management System” 

See Also: 

• ”Adding HTML Content” on page 74

• ”Adding XML Content” on page 75
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• ”Translating Content” on page 818

Adding HTML Content
See the Ektron CMS400.NET User Manual Section “Working with 
Folders and Content” > “Adding Content”.

Auto Generating Summaries

Ektron CMS400.NET automatically generates a new content item’s 
summary, if none exists. To do this, it checks the summary the first 
time new content is published. If the summary is blank, Ektron 
CMS400.NET copies the first 40 words of the content into the 
summary.

After the content is published, a CMS user can update or delete 
the summary. If it is deleted, the summary remains blank and is 
never again automatically generated for that content.

You can disable this feature in Ektron CMS400.NET if desired. See 
”Automatically Recreating a Catalog” on page 402.

Membership User Summary Editing

If a membership user edits content and wants to update the 
summary, he can automatically copy the first 40 words of the 
content into the summary. To do this, the membership user checks 
the Auto Generate New Summary field on the membership 
editing screen (shown below).
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There is no limit on the number of times a membership user can 
automatically generate a new summary.

Adding XML Content
If one or more Smart Forms are assigned to a content folder, users 
can create XML content within it. Any folder (other than the root 
content folder) can have a unique group of Smart Forms or inherit 
them from the parent folder. See Also: ”Working with Smart Forms” 
on page 183

To add XML content, follow these steps.

1. In the Workarea, browse to a folder to which at least one Smart 
Form is assigned.

2. Click New > Smart Form.
3. Select the Smart Form you will use for the content.

NOTE When selecting the folder to create the content in, keep in mind the permissions 
that are going to be set on it, and which users will have permissions for it.

NOTE Depending on the Smart Form assigned to the content, the default XML may 
appear differently.

4. The procedure for creating XML content is similar to that for 
creating HTML content. Follow the steps described in ”Adding 
HTML Content” on page 74.

The Smart Form formats the screen display. When that content is 
published and a site visitor completes the screen, the user’s input 
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is saved as XML. For more information, see ”Working with Smart 
Forms” on page 183.

Forming URLs For Ektron CMS400.NET 
Documents

Whenever content is created, Ektron CMS400.NET generates a 
unique identifier of that content. See Also: Ektron CMS400.NET 
User Manual > “Library Folder” > “Quicklinks and Forms”

The identifier for Ektron CMS400.NET content is made up of these 
elements: 

• Site address

• ”The Template” on page 76

• ”The Content Variable” on page 77

• ”The Language Identifier” on page 77

Warning! Only use the language identifier if you are forcing or changing the language.

The Template
The template determines much of the page layout. By itself, the 
template URL retrieves the empty template or the template with its 
default document. 

NOTE You can set a default document for a template in the content function by inserting 
an id number.

See Also: ”Creating/Updating Templates” on page 64
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The Content Variable
A question mark (?) separates the template URL from the content 
variable. The content variable indicates which document or content 
the server places in the template before displaying the page. 
Below is a description of the URL format.

The above variable’s name is based on the templates included in 
the Ektron CMS400.NET’s sample site. If your Web master 
changed the variable names in your site’s template, use the name 
of the corresponding variable in each template rather than the one 
above.

The Language Identifier
This part of the URL identifies the language selected by a visitor to 
your site. It only appears if your site supports multiple languages.

WARNING! Only use the language identifier if you are forcing or changing the language.

To learn more, see ”Multi-Language Support” on page 809.

Viewing Content
See the Ektron CMS400.NET User Manual Section “Working with 
Folders and Content” > “Viewing Content”.

NOTE You can use the ek_PageSize setting in the web.config file to determine the 
maximum number of items that can appear on a page before it “breaks.” When a 
page breaks, additional entries appear on another screen, and the following text 
appears near the bottom of the items list: 
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

Content
variable

Example Description

ID=n http://www.example.com /
index.aspx?ID=1

ID selects a single document to display. Use this 
variable for a single document template type. The 
value corresponds to the content’s id value.
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Editing Content
See the Ektron CMS400.NET User Manual Section “Working with 
Folders and Content” > “Editing Content”.

Moving or Copying Content
You can move content from any folder to any other folder. Or, you 
can copy content from one folder to another. At the end of both 
procedures, a copy of the content resides in the new folder. Moved 
content retains the original ID number, while new content gets the 
next available ID number.

When copying, you leave the content in its original folder, while 
moving deletes the content from the original folder. Other than that 
difference, the procedure for performing both actions is virtually 
identical.

Who Can Move or Copy Content?
Only members of the Administrators user group or those assigned 
in the Roles > Folder User Admins screen can move or copy 
content. See Also: ”Defining Roles” on page 735 and ”Guidelines 
for Using The Folder-User Admin Role” on page 738

Impact of Content Status on Moving and Copying
Your ability to move and copy content is affected by the content’s 
status, as described in the table below.

What is Moved Or Copied?
When content is moved or copied, the following changes are 
made.

Action Content Status

Move Approved, Checked in

Copy Approved
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• The content inherits permissions and the approval chain from 
the new folder. 

• The content’s Quicklink is moved or copied in the library to the 
destination folder. However, the Quicklink remains the same 
(that is, the default template doesn’t change). You can update 
this by editing the Quicklink. This procedure in described in the 
Ektron CMS400.NET User Manual section “Updating Default 
Template for Multiple Quicklinks.”

NOTE If the Link Management setting in the web.config file is set to true, you do not 
need to update the quicklink. Link Management automatically finds the correct 
template based on the current content folder.

• If the new folder already contains content with the same title, 
Ektron CMS400.NET appends a number to the title to make it 
unique. For example: ASP.NET Unleashed(2).

• The new folder’s default template is assigned to the content

• Library image paths inside the content remain the same

• If the content has a Smart Form, it remains assigned even if the 
Smart Form is not assigned to the new folder

Moving Or Copying One Content Item
To move or copy content to another folder, follow these steps.

1. Access the View Content screen for the content you want to 
move or copy, as described in the Ektron CMS400.NET User 
Manual section “Working with Folders and Content” > “Viewing 
Content.”

2. Click the Move/Copy Content button ( ).

3. The Move/Copy Content screen is displayed.
4. Select either Move or Copy.
5. If you choose Copy, and you want the content to be published 

as soon as the copying is complete, check Publish Copied 
Content. 
If you want the content status in the new folder to be checked 
in, uncheck the Publish Copied Content checkbox.

6. Enter the path to the destination folder. If you don’t know the 
path, click Select Folder and navigate to the destination folder.
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7. Click the Move/Copy Content button ( ).

8. A confirmation message is displayed.
9. Click OK to continue.
10. The content is moved or copied to the specified content folder. 

The destination folder appears with the new content.

Moving Or Copying Several Content Items
To move or copy several content items in the same folder at once, 
follow these steps.

1. Navigate to the folder that contains the content you want to 
move or copy.

2. Click Action > Move/Copy Content.

3. The Move/Copy Contents of Folder screen is displayed.
4. Select either Move or Copy.
5. If you choose Copy, and you want the content to be published 

as soon as the copying is complete, check Publish Copied 
Content. 
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If you want the content status in the new folder to be checked 
in, uncheck the Publish Copied Content checkbox.

6. Enter the path to the destination folder. If you don’t know the 
path, click Select Folder and navigate to the destination folder.

7. Check the boxes next to the content that you want to move or 
copy.

NOTE Check off the box in the header cell to select all or deselect all eligible content.

8. Choose the content folder to move or copy the selected 
content from the drop down list.

9. Click the Move/Copy Content button ( ).

10. A confirmation message is displayed.
11. Click OK.
12. The content is copied or moved to the destination folder.

Viewing and Restoring Historical Versions of 
Content

Each time a new version of content is published or checked in, the 
previous version is stored. Old versions of content may be 
accessed, and if desired, restored to the Web site.

For more information, see “Viewing and Restoring Previous 
Content” section of the Ektron CMS400.NET User Manual.
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Purging Historical Versions of Content
See ”Purge History” on page 49.

Scheduling Content
Scheduling content allows you to specify a future date and time 
when content will be visible on the Web site. Similarly, you can 
remove content from the Web site on a specified date and time. 

For more information, see “Scheduling Content to Begin and End” 
in the Ektron CMS400.NET User Manual.

Deleting Content
Seethe Ektron CMS400.NET User Manual Section “Working with 
Folders and Content” > “Deleting Content”. 

Content History
See the Ektron CMS400.NET User Manual section “Viewing and 
Restoring Previous Content”.

Content Permissions
See ”Setting Permissions for Content” on page 724.

Content Approvals
See ”Setting Approval Chains” on page 726.
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Content Workflow
To learn about the process content must pass through to get 
published to your Web site, see the Ektron CMS400.NET User 
Manual section “Approving/Declining Content.”

Link Checking
The link checker button locates all content with a link to the 
displayed content. This feature is useful if you decide to delete 
content. You can use this to remove those links, which will not work 
after the deletion.

To display all content that links to the selected content, follow these 
steps.

1. Access the View Content screen for the content you want to 
execute the link checker for, as described in ”Viewing Content” 
on page 77.

2. Click the Check Links button ( ).

3. A screen displays each content item with a link to the current 
content.

4. Click the content title to access the View Content screen for the 
selected content and perform the necessary actions on it.

Assigning Tasks to Content
See the Ektron CMS400.NET User Manual > “Managing Tasks” > 
“Creating Tasks via Content”.

Content Properties
The Content Properties screen lets you determine if this content is 
included in a search of your Web site, and which flagging definition 
is applied to this content. See Also: ”Flagging” on page 892
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The Content Searchable Check Box
If you uncheck this box, Ektron CMS400.NET excludes this 
content when a Web site search is performed.

The Content Searchable box has no effect on 

• the ability to find this content from the Workarea Advanced 
search

• a content item’s appearance on a Suggested Results list

See Also: 

• ”Suggested Results” on page 425 

• ”Searching Your Web Site” on page 395 

The View Content Properties screen
To view the Content Properties screen, follow these steps.

1. Access the View Content screen for the content whose 
properties you want to view, as described in ”Viewing Content” 
on page 77.

2. Click the Properties button ( ).

3. The View Properties for the Content screen appears.

4. Check the Content Searchable box to include this content in a 
search of your Web site.

5. Click the Update button ( ).

NOTE If you click the Properties button for content that is displayed on a Web page, the 
View Content screen opens in the Workarea window.
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Content Rating
Ektron CMS400.NET provides a rating system, based on stars, so 
site visitors can rate content on your Web site. A visitor can rate 
content on a scale of one through five stars. The ratings are 
collected from the Web page via the ContentReview server control.

Depending on the XSLT used with the ContentReview server 
control, you can allow half star rating increments and let site 
visitors submit comments (see illustration below).

NOTE If a visitor is not logged in as a CMS or membership user, his browser must have 
cookies enabled in order to submit a content rating.

In addition to consuming site visitors’ ratings and reviews and 
displaying the information in the Workarea, the ContentReview 
server control can be used to display reviews on your site. See 
Also: ”Displaying Reviews on the Site” on page 88

Reviews can be moderated from the “Workarea” > “Smart 
Desktop” or from the Content Rating screen associated with a 
content item. See Also: ”Moderating Reviews” on page 89
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The content review feature is explained through the following 
topics.

• ”Inserting the ContentReview Server Control” on page 86

• ”Limiting Visitors to One Review” on page 86

• ”Viewing the Content Rating Report” on page 86

Inserting the ContentReview Server Control
To allow site visitors to rate and review content on a Web page, 
your developer inserts a server control. This procedure is 
described in the Ektron CMS400.NET Developer Manual section 
“ContentReview Server Control.”

Limiting Visitors to One Review
Ektron CMS400.NET assumes you want to limit a user to rating a 
content item once. If a regular or membership user logs in before 
rating a piece of content, Ektron CMS400.NET remembers the user 
ID. For any other site visitor, Ektron CMS400.NET places a cookie 
on his computer.

So, whenever a page with a ContentReview server control is 
visited, Ektron CMS400.NET checks for the user ID or cookie. If 
neither exists, it displays a rating scale. If the page has already 
been rated by the user, the user can edit his existing rating and 
review by clicking a star, editing the comments, and clicking the 
submit button.

Viewing the Content Rating Report
All content rating and review data for a content item is maintained 
and can be displayed in detail and summary format. To view this 
data, follow these steps.

1. Sign in to Ektron CMS400.NET.
2. Do one of the following:

• Navigate to the content item in the Workarea

- Go to Workarea > Content.
- Navigate to the folder that contains the content.

- Navigate to the content item.
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- Click the View Rating Reports toolbar button ( ).

• If the review is awaiting moderation, use the Content Review 
section of the Smart Desktop.

- Go to the Workarea > Smart Desktop
- Click Content Reviews
- Select the content item

The Content Rating Report shows a summary of all ratings 
submitted for the content.

If desired, you can select a range of dates and limit the display of 
ratings data to those dates. Select start and end dates (using 
calendar buttons at the top of the screen) and click Get Result.

Viewing Content Rating Details

To view details of the ratings data, click Get Result (see illustration 
below).



Managing HTML Content

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 88

 

Displaying Reviews on the Site

Displaying reviews on your site allows visitors see how other 
people in your site’s community feel about a product or content 
article. It also helps build that community by empowering site 
visitors and allowing them to have voice.

If your site displays reviews and a user does not see his review, it 
is probably because moderation is enabled for the content reviews. 
If a user’s review is pending or rejected, it is not displayed. A site or 
membership user can determine the status of his review by logging 
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into the site and navigating to the Web page that hosts the content 
review. Next to the title of his review is Rejected or Pending. The 
user can then submit another review if his review was rejected or 
has been pending for too long.

The ContentReview server control’s DisplayXSLT property handles 
the displays of site visitor reviews on the site. The server control 
can display reviews for specific content or a specific user. For 
additional information on the DisplayXSLT property, see the Ektron 
CMS400.NET Developer Manual section “ContentReview Server 
Control.

Moderating Reviews

Since reviews can be displayed on your Web site, Ektron 
CMS400.NET lets you moderate reviews from the Content Ratings 
screen in the Workarea. This capability is handled by the 
ContentReview server control’s Moderate property. See the Ektron 
CMS400.NET Developer Manual section “ContentReview Server 
Control” > “ContentReview Server Control Properties” > 
“Moderate.”

A site visitor can change his rating and review at any time, even if 
its status is pending or rejected. When a visitor changes his rating 
or review, the information is updated immediately in the Workarea, 
and the review’s status changes to pending.

There are two ways to moderate reviews.

• from the Smart Desktop > Content Reviews area. See Also: 
”Moderating Reviews From the Smart Desktop” on page 89

• from the Content Rating screen associated with a content item 
See Also: ”Moderating Reviews From the Content Rating 
Screen” on page 95

Moderating Reviews From the Smart Desktop

To moderate reviews from the Smart Desktop, follow these steps.

1. Sign in to Ektron CMS400.NET.
2. Click the Smart Desktop button.
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3. From the Smart Desktop, click the Content Reviews link.

4. The five latest reviews awaiting moderation appear. Note the 
View all pending reviews link. Click it to see all pending 
reviews. See Also: ”Viewing All Pending Reviews” on page 91
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5. Select an Approve or Decline radio button for each item in the 
list.

6. Click the Update Reviews button.
Once the reviews are approved, they appear on the site.

NOTE A ContentReview server control set to display reviews must be on the page for 
reviews to be displayed. See the Ektron CMS400.NET Developer Manual section 
“ContentReview Server Control” > “ContentReview Server Control Properties” > 
“DisplayXSLT.”

Viewing All Pending Reviews

You can view all pending reviews by clicking the View all pending 
reviews link in the Smart Desktop > Content Review screen.
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From that screen you can:

• Approve or decline a review - select an Approve or Decline 
radio button for each item on the list. Then, click the Submit 
button( ).

• Mark all reviews approved or all declined - click the Mark all 
approved link to set all the radio buttons to Approve. Click the 
Mark all declined link to set all the radio buttons to Decline.
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.

• Edit the rating, review or status of an individual review - click a 
review’s title and the Edit screen appears. Change as needed. 
Click the Save button ( ).

NOTE After editing a rating, click the Back Arrow to return to the content item’s Content 
Rating screen.

• Print a report of all pending content reviews - click the Print 
button ( ) to create an HTML version of the pending content 
review report that is ready for printing.

• Email a pending content review report - click the Email button 
( ) to email a pending content review report to Ektron 
CMS400.NET users. Next, select the users to receive the 
report. Then, click the Email button ( ) to send the report.
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• Filter content reviews by folder - because reviews are 
associated with content items in a folder, you can filter reviews 
by folder. This makes it easier to moderate reviews if you are 
responsible for content in a specific folder. Click the Folder 
button ( ) and navigate to the folder by which the reviews will 
be filtered. Then, click the Save button ( ).

• Filter reviews by language - from the Language dropdown box, 
select the language by which the reviews are filtered.
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After you approve or decline reviews, click the Submit button ( ). 
Once reviews are approved, they appear on the site.

Moderating Reviews From the Content Rating Screen

To moderate content reviews from Content Ratings screen, follow 
these steps:

1. Navigate to the Content Ratings screen for the content item 
using one of the methods in ”Viewing the Content Rating 
Report” on page 86.

2. Click the Get Results button.
3. A list of reviews appear for the content.
4. Click the Date link of the content to be moderated.
5. The View Rating screen appears.
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- To change information on this screen, click the Edit button 
( ). From the Edit screen, you can change the rating, 
review, and status. When finished, click the Save button 
( ).

- To delete the review, click the Delete button ( ).

Exporting Details to Excel

If Microsoft Excel is installed on your computer, you can export the 
ratings detail to Excel for further manipulation of the data. To do so, 
the Click Export to Excel button.

Purging Rating Data

You can remove content rating data to free up space in your 
database. To do so, select the date range of the data you want to 
purge using Start Date and End Date. Then click the Purge 
button.
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Validating XHTML Content and 
Accessibil i ty

By validating XHTML content and accessibility, you can ensure 
your content is XHTML compliant and that individuals with 
disabilities can navigate and understand your site.

This chapter is divided into two sections: ”Validating with 
eWebEditPro+XML” on page 98 and ”Validating with 
eWebEdit400” on page 108.



Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 98

Validating with 
eWebEditPro+XML

Ektron CMS400.NET can check content for two types of 
compliance:

• XHTML standards - see ”Validating Content for Compliance 
with XHTML Standards” on page 105

• accessibility standards established by agencies such as 
W3C Markup Validation Service - see ”Validating Content 
For Compliance with Accessibility Standards” on page 99

This check is performed when a user tries to save, check in or 
(submit for) publish content.

In addition, some dialogs add accessibility data to Ektron 
CMS400.NET content. As examples, the Picture Properties is 
used to add an image’s <alt> attribute. When a user clicks OK 
to save these dialogs, Ektron CMS400.NET can check that 
compliance information is being added. See ”Dialogs that Allow 
Input of Accessibility Information” on page 104

This section explains how to enable these features, and how to 
customize them to meet your needs.

The rest of this section provides details about validating 
XHTML content through these topics.

• ”Validating Content For Compliance with Accessibility 
Standards” on page 99

• ”Dialogs that Allow Input of Accessibility Information” on 
page 104

• ”Validating Content for Compliance with XHTML Standards” 
on page 105
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Validating Content For Compliance with 
Accessibility Standards

To have Ektron CMS400.NET check content for compliance with 
accessibility standards, you enable <accessibility> in the 
configuration data and specify an XSLT or Web site to check 
against.

Enabling Accessibility
In Ektron CMS400 .NET, accessibility options appear on the 
Configuration Setup screen under Accessibility/Section 508 
Evaluation (below the Editor Options). The options are explained 
below.

• Do not validate - do not check content for compliance with 
accessibility standards

• Warn if fails - the user is warned but allowed to save content

• Enforce - the user must bring the content into compliance 
before submitting it for publication or publishing it; however, 
can save it or check it in after being warned.

Enabling Accessibility Validation in the Configuration Data
By default, content is not checked for compliance to accessibility 
standards. You enable such validation at the following 
configuration data attribute.

<validate accessibility="none"....

Enable compliance by setting the attribute to one of these options.

• loose - the user is warned but allowed to save content

• strict - the user must bring the content into compliance before 
saving it
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Defining the XSLT or Web Site
When a user tries to save content and <accessibility> is set to 
loose or strict, the content is checked against an XSLT, a Web site 
designed to validate content, or both.

If you enable both, the content is checked in this order.

1. XSLT
2. Web site
If the first check fails, the second check is not performed.

The XSLT File

Ektron CMS400.NET content can be checked against an XSLT that 
enforces W3C’s WCAG Level 1 requirement. This XSLT, 
ektaccesseval.xslt, resides in the folder to which Ektron 
CMS400.NET is installed.

The XSLT is identified in the following line (highlighted in red) of 
the configuration data. (In Ektron CMS400.NET, the configuration 
data is stored in site root 
folder\Workarea\ewebeditpro\cms_config.aspx.)

<!-- accessibility options are "strict", "loose" and "none" -->

<validate accessibility="none" suggestdefaultval="true">

<xslt enabled="true" src="[eWebEditProPath]/ektaccesseval.xslt" />

You can modify this XSLT as needed.

Or, you can place a different XSLT in the Ektron CMS400.NET root 
directory and refer to it in the src attribute shown above. If you use 
a different XSLT and validation fails, it should return a description 
of the problem(s) as HTML. If validation succeeds, it should return 
nothing.
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Validating Against a Web Site

You can also validate XHTML content against a Web site that 
evaluates its compliance with accessibility standards. Two such 
sites are listed in the configuration data: 

• hermish.com

• webaim.org

You can use either listed site or any other site designed to check 
for accessibility compliance. Regardless of the site’s origin, you 
can only use one.

The Web sites are specified in these lines of the configuration data. 
To activate a site, set enabled to true.

<online enabled="false" type="string" contentname="myHTML" src="http://www.hermish.com/
check_this.cfm">

<data name="URLtest">Your HTML</data>
<data name="CheckURL">1</data>
<data name="p1">1</data>
<data name="p2">1</data>
<data name="p3">1</data>
<data name="s508">1</data>

</online>

<online enabled="false" type="file" contentname="upload" src="http://wave.webaim.org/wave/
Output.jsp">

<data name="Submit">Submit</data>
<data name="IPAddress">127.0.0.1</data>

</online>

Enabling a Site Not Included in the Configuration Data

Ektron only supports sites listed in the configuration data by 
default. If you want to validate content against another Web site 
designed to do that, follow these guidelines.

• Web sites that perform validation typically accept input in this 
format.

<form action="http://www.example.com/validationaction.asp">

<textarea name="testcontent"></textarea>

<input type="submit" name="btnSubmit" value="Validate the 
content"/>
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</form>

To accommodate this format, define the configuration data’s 
<online> element as follows.

<online enabled="true" type="string" contentname="testcontent" 
src="http://www.example.com/ validationaction.asp" 
keywordsearchresult="failure" keyword="invalid">

<data name=" btnSubmit"> Validate the content</data>

</online>

The following table describes <online>’s attributes.

<Online> Attribute Description

type If the form accepts an HTML string as input, enter string.
If the form accepts a file name as input, enter file.

contentname Enter the value of the name attribute of the textarea or input 
element in the form.
For a form that accepts an HTML string, the textarea may 
appear as:
<textarea name="testcontent"></textarea>

In this case, the value for contentname would be 
testcontent.
For a form that accepts a file, the input element may appear 
as:
<input type="file" name="testfile" />

In this case, the value for contentname would be testfile.

src To obtain the URL of the Web page that validates HTML 
content, go to the site and view the source. From there, you 
should be able to obtain the form’s action attribute. Place 
that into this attribute.
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keywordsearchresult Takes one of two values: failure or success.

• If set to success and Ektron CMS400.NET finds the 
keyword (set in the keyword attribute) in the validating 
Web page’s response, the content is saved.

• If set to success and Ektron CMS400.NET does not 
find the keyword in the validating Web page’s 
response, the Web site’s failure page appears. Typi-
cally, the page explains why the content failed valida-
tion.

• If set to failure, and Ektron CMS400.NET finds 
the keyword (set in the keyword attribute) in the vali-
dating Web page’s response, Web site’s failure page 
appears. Typically, the page explains why the content 
failed validation.

• If set to failure, and Ektron CMS400.NET does 
not find the keyword in the validating Web page’s 
response, the content is saved.

If you do not define a keyword and keywordsearchresult, 
the validating Web page’s response (or report) appears.

keyword Enter a text string that Ektron CMS400.NET  searches for 
in the source of the Web site’s response to the validation 
check.
For example, if the site displays Congratulations when 
validation passes, enter Congratulations in this attribute. 
In this case, enter success as the keywordsearchresult.
As another example, if you know that a Web site displays 
the images/icon_violation.gif image when validation 
fails, enter that as the keyword. In this case, enter failure 
as the keywordsearchresult.

data Enter additional form fields to be posted to the Web site 
during form submission.

• The name attribute of the data tag specifies the name of 
the form field.

• The value between the data tags is the value of the 
form field when submitted.

You may specify as many data tags as needed. For 
example
<data name="btnSubmit">Validate the content</
data>

<Online> Attribute Description
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Dialogs that Allow Input of Accessibility 
Information

Several dialog boxes have fields that collect required accessibility 
data. An example of such a field is highlighted below.

When the configuration data’s suggestdefaultval property is set to 
true, Ektron CMS400.NET tries to ensure that a value exists in 
required accessibility fields of the following dialogs.

Dialog Field How filled if no value exists

Picture Properties Title Contents of File Selection field copied
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Validating Content for Compliance with XHTML 
Standards

Ektron CMS400.NET content can be validated against the XHTML 
1.0 schema, a Web site, or both. These are described in ”The 
Schema” on page 105 and ”The Web Site” on page 106.

NOTE This validation occurs when content is saved regardless of the value of the 
<accessibility> attribute.

Besides specifying a schema or Web site, you need to uncomment 
the following line in ektfilter.xslt (located in the webroot/ewebeditpro5 
directory). This XSLT removes non-W3C-compliant tags and 
attributes.

<xsl:include href="ektfilterxhtml10.xslt"/>

The Schema
Two schemas from the W3C site are provided with Ektron 
CMS400.NET.

• www.w3.org/2002/08/xhtml/xhtml1-strict.xsd 

• www.w3.org/2002/08/xhtml/xhtml1-transitional.xsd

The schemas are installed to the siteroot/workarea/ewebeditpro 
directory. You identify a schema in the following lines of the 
siteroot/workarea/ewebeditpro/config.xml file.

<schema enabled="false" src="[eWebEditProPath]/xhtml1-strict.xsd"/>
<schema enabled="false" src="[eWebEditProPath]/xhtml1-transitional.xsd"/>

Hyperlink Title Contents of Text field copied

Group Box Caption Contents of Descriptive Name field copied to 
Caption field

Several Data Designer dialogs, 
such as Plain Text Field, Image 
Only field, Link Field, Select List 
Field

Tooltip text Contents of Descriptive Name field copied

Dialog Field How filled if no value exists



Validating with eWebEditPro+XML

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 106

To specify a schema against which to validate content, set enabled 
to true.

The options are explained below.

• Both schemas disabled- do not check content for compliance 
with XHTML standards

• Transitional or strict enabled - the user must bring the 
content into compliance before submitting it for publication or 
publishing it; however, he can save it or check it in after being 
warned.

You can modify either .xsd file as needed. Or, you can use your 
own .xsd file.

Using Your Own Schema

The src attribute can reference any URL. If you want to place your 
own .xsd file in the siteroot/workarea/ewebeditpro directory, use 
[eWebEditProPath]. To place the .xsd file in another location, enter 
the path to it relative to the site root directory. For example, src=”/
siteroot/schemas/myschema.xsd”.

IMPORTANT! If you are using a different .xsd file, you must add 
elementFormDefault="qualified" to the schema as shown below. 
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" 
elementFormDefault="qualified">

IMPORTANT! Because of an error in XML parser 4 (see http://support.microsoft.com/
default.aspx?scid=kb;EN-US;q262585), Ektron has removed the namespace from 
the schemas. If you design your own schema, do not use 'xml' to begin user-
defined namespace prefixes.

The Web Site
You can validate content against any Web site that enforces W3C’s 
XHTML standards. One site is listed in the configuration data: 
validator.w3.org.

You can use that site or another site designed to check for XHTML 
compliance.

To activate the site in the siteroot/workarea/ewebeditpro/config.xml 
file, set enabled to true in the code snippet shown below.

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q262585
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<online enabled="false" type="string" contentname="fragment" src="http://validator.w3.org/
check"/> 

If you want to use a different Web site, follow the directions in 
”Enabling a Site Not Included in the Configuration Data” on 
page 101.
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Validating with eWebEdit400

Ektron CMS400.NET can check content for the following types of 
compliance:

• XHTML standards - see ”Validating Content for Compliance 
with XHTML Standards” on page 112.

• Design - checks for the same design standards as 
eWebEditPro. For example, proper closing tags and unique 
field names. When using the Design selection, Section 508 
Validation is included.

• Smart Form Data - makes sure that data entered into a 
smart form’s field is the correct type and format. This 
selection only checks smart form fields if validation for the 
field was turned on when it was added to the Smart Form. 
Validation for each field type is explained in ”Data Designer 
Field Types” on page 229.

• Section 508 Validation - accessibility standards 
established by agencies such as W3C Markup Validation 
Service - see ”Validating Content For Compliance with 
Accessibility Standards” on page 109.

NOTE There is an additional type of validation that happens when information is 
entered into a form on a Web site. This field level validation makes sure the 
site visitor has entered information in the correct pattern. For example, when 
a user enters a Social Security number, it must have: three numbers, a dash, 
two numbers, another dash and the final four numbers. This type of validation 
is explained in Ektron CMS400.NET’s User Manual section “Introduction to 
eWebEdit400” > “Working with HTML Forms” > “Form Validation”

These standards can be checked while a user is creating 
content. CMS400.NET can also perform an Accessibility/
Section 508 evaluation when a user tries to save, check in or 
(submit for) publish content. See Also: ”Enabling Accessibility” 
on page 110

In addition, some dialogs add accessibility data to Ektron 
CMS400.NET content. For example, the Image Properties dialog 
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is used to add an image’s <alt> attribute. See ”Dialogs that Allow 
Input of Accessibility Information” on page 110

This section explains how to enable these features, and how to 
customize them to meet your needs.

The rest of this section provides details about validating XHTML 
content through these topics.

• ”Validating Content For Compliance with Accessibility 
Standards” on page 109

• ”Validating Content for Compliance with XHTML Standards” on 
page 112

Validating Content For Compliance with 
Accessibility Standards

A user can check content for compliance with accessibility 
standards while a he is creating content. To do this, the user 
selects Section 508 Validation from the drop down list at the 
bottom of the editor screen and clicks the Validate Content button.

Once the Validate Content button is clicked, the Report Pane 
expands. If there are validation errors, they are listed in report 
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pane. If the content passes validation, a message is displayed that 
states, “The content is valid.”

To have Ektron CMS400.NET automatically check content for 
compliance with accessibility standards, enable accessibility in the 
settings section of the Workarea.

See Also: 

• ”Enabling Accessibility” on page 110

• ”Dialogs that Allow Input of Accessibility Information” on 
page 110

Enabling Accessibility
In Ektron CMS400 .NET, accessibility options appear on the 
Configuration Setup screen under Accessibility/Section 508 
Evaluation (below the Editor Options). The options are explained 
below.

• Do not validate - do not check content for compliance with 
accessibility standards

• Warn if fails - the user is warned but allowed to save content

• Enforce - the user must bring the content into compliance 
before submitting it for publication or publishing it; however, 
can save it or check it in after being warned.

Dialogs that Allow Input of Accessibility Information
Several dialog boxes have fields that collect required accessibility 
data. An example of such a field is highlighted below.
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The table below lists additional dialog boxes where accessibility 
information can be entered.

Dialog Field How filled if no value exists

Image Properties Image Alt Text: Uses the title of the image.

Table Wizard - Cell 
Properties Tab

Abbreviation:
Categories:

These fields are not automatically filled 
when no value exists.

Table Wizard - Accessibility 
Tab

Caption:
Summary:

These fields are not automatically filled 
when no value exists.
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Validating Content for Compliance with XHTML 
Standards

Ektron CMS400.NET content can be validated against the following 
XHTML standards:

• XHTML 1.0 Strict

• XHTML 1.0 Transitional

• XHTML 1.1

By default, eWebEdit400 allows you to validate against these 
standards using the WC3’s Markup Validation Service located at: 
http://validator.w3.org.

Information explaining these standards can be found at http://
www.w3.org.

A user can validate content while they are working on it. The 
validation options and submit button are located at the bottom of 
the editor.

.

Hyperlink Manager
(Includes Quicklinks)

Tooltip: Contents of Link Text field copied.

Dialog Field How filled if no value exists

http://www.w3.org
http://www.w3.org
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When a user sets the Validation selector to an XHTML selection 
and clicks the Validate Content button, the content is checked for 
validation and a report is displayed in the Report pane detailing 
whether the page is valid or not.

The Web Site
You can validate content against any Web site that enforces W3C’s 
XHTML standards. The default site listed in the configuration data 
is validator.w3.org.

To change the site, open the siteroot/workarea/contentdesigner/
ValidateSpec.xml file and change the appropriate information 
between the <online> tags.

IMPORTANT! Because each site requires different information and data, you may need to add 
change or remove parameters and data name information for the new validation 
service to work correctly.

<online id="XHTML10Strict" name="XHTML 1.0 Strict" type="string" contentname="fragment" 
site="validator.w3.org" src="http://validator.w3.org/check" doctype="!DOCTYPE html PUBLIC 
&quot;-//W3C//DTD XHTML 1.0 Strict//EN&quot; &quot;http://www.w3.org/TR/xhtml1/DTD/xhtml1-
strict.dtd&quot;" keywordsearchresult="failure" keyword=" id=&quot;results&quot; 
class=&quot;invalid&quot;">

<data name="verbose">1</data>
<data name="sp">1</data>
<data name="ss">1</data>

</online>

This table explains the attributes passed in the above example.

Attributes Description

id A unique ID for the group of attributes being passed.

name The name of the Validation taking place. This appears in the Validation 
drop down list.

type If the form accepts an HTML string as input, enter string.
If the form accepts a file name as input, enter file.
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contentname Enter the value of the name attribute of the textarea or input element in 
the form.
For a form that accepts an HTML string, the textarea may appear as:
<textarea name=”testcontent”></textarea>
In this case, the value for contentname would be testcontent.
For a form that accepts a file, the input element may appear as:
<input type=”file” name=”testfile” />
In this case, the value for contentname would be testfile.

site The name of the site being used to perform the validation.

src The URL to which you are submitting content for validation. To obtain 
the URL, go to the site and view the source. From there, you should be 
able to obtain the form’s action attribute. Place that into this attribute.

doctype Specify the Document Type (DOCTYPE) to use when parsing the 
document.

keywordsearchresult Takes one of two values: failure or success.

• If set to success and Ektron CMS400.NET finds the keyword (set 
in the keyword attribute) in the validating Web page’s response, 
the content is saved.

• If set to success and Ektron CMS400.NET does not find the key-
word in the validating Web page’s response, the Web site’s failure 
page appears. Typically, the page explains why the content failed 
validation.

• If set to failure, and Ektron CMS400.NET finds the keyword (set 
in the keyword attribute) in the validating Web page’s response, 
Web site’s failure page appears. Typically, the page explains why 
the content failed validation.

• If set to failure, and Ektron CMS400.NET does not find the key-
word in the validating Web page’s response, the content is saved.

If you do not define a keyword and keywordsearchresult, the validating 
Web page’s response (or report) appears.

Attributes Description
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keyword Enter a text string that Ektron CMS400.NET searches for in the source 
of the Web site’s response to the validation check.
For example, if the site displays Congratulations when validation 
passes, enter Congratulations in this attribute. In this case, enter 
success as the keywordsearchresult.
As another example, if you know that a Web site displays the images/
icon_violation.gif image when validation fails, enter that as the 
keyword. In this case, enter failure as the keywordsearchresult.

data Enter additional form fields to be posted to the Web site during form 
submission.
The name attribute of the data tag specifies the name of the form field.
The value between the data tags is the value of the form field when 
submitted.
You may specify as many data tags as needed. For example
<data name=”btnSubmit”>Validate the content</data>

Attributes Description
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Metadata

Metadata is information about a content item, such as its title 
and language. Ektron CMS400.NET provides extensive and 
flexible support for metadata, which it uses in both standard 
and innovative ways.

This section explains the types of metadata available, and 
procedures for working with metadata through the following 
subtopics.

• ”Types of Metadata” on page 116

• ”Working with Metadata Definitions” on page 126

Types of Metadata
Five kinds of metadata can be added to Ektron CMS400.NET 
content.

Metadata type Description For more information, 
see

Meta tag Resides in the source code. Helps search engines 
find a Web page.

”Meta Tags” on page 117

HTML tag Information about the page to be used by a Web 
browser. For example, <title> identifies the 
content in the screen title, the favorites list, and 
the browser’s history.

”Title Tag” on page 119

Searchable Metadata that can be found by Ektron 
CMS400.NET ’s search.

”Searching Your Web Site” 
on page 395

Related content A related content item, collection, List Summary, 
or library item that accompanies a content item on 
a Web page.

”Related Content 
Metadata” on page 121
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Meta Tags
The META element is an extensible container for use in identifying 
specialized document meta-information. Meta-information has two 
main functions:

• to provide a means to discover that a data set exists and how it 
might be obtained or accessed

• to document the content, quality, and features of a data set, 
indicating its fitness for use

(Above copied from www.w3.org/MarkUp/html-spec/html-spec_5.html.)

Simple Dublin 
Core

A set of fifteen standard fields that cover the most 
useful information about content.

”Simple Dublin Core 
Metadata” on page 124

Metadata type Description For more information, 
see

Best Practices

• When anyone creates a new Metadata definition, it is 
assigned the next available ID number. The ID numbers 
determine the order in which metadata definitions are 
arranged on the Folder Properties screen’s Metadata 
tab.
So, by planning ahead, you can enter metadata 
definitions in logical groupings, which will make it more 
intuitive for the person assigning the metadata to pick 
the correct ones.

• Metadata can be used as a search criterion to find 
content on your Web site. In order for this to work, the 
metadata definition name cannot include a space. So, it 
is a good idea to eliminate spaces from metadata 
definition names.
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Example Meta Tags

Creating and Deploying Meta Tag Definitions

1. While creating a metadata definition, enter the metadata name 
at the Name field. For example, Description and Keywords. 
See Also:  ”Adding a Metadata Definition” on page 127

2. Reply to the standard fields. See ”Metadata Definition Fields” 
on page 129.

3. Respond to the additional fields for meta tags. See ”Meta Tag 
Additional Fields” on page 130

4. Add the definition to all applicable folders. See ”Assigning 
Metadata to a Folder” on page 139

5. Add the definition to applicable content within the folder. See 
”Adding Metadata to Content” on page 142

6. Add a Metadata server control to every Web form (.aspx page) 
on which the content will appear.
To learn how to do this, see the Ektron CMS400.NET 
Developer Manual section “Custom Functions (for your server 
platform)” > “Metadata Function”, “MetaData Server Control” 
and “MetaDataList Server Control.”
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Title Tag
The title should identify the contents of the document in a global 
context. A browser may display the title of a document in a history 
list or as a label for the window displaying the document.

(Above text copied from www.w3.org/MarkUp/html-spec/html-
spec_5.html.)

Creating and Deploying Title Tag Definitions

1. While creating a metadata definition, enter Title at the Name 
field. See Also: ”Adding a Metadata Definition” on page 127

2. Reply to the standard fields. See ”Metadata Definition Fields” 
on page 129.

3. Respond to the additional field for HTML tags. See ”HTML Tag 
Additional Field” on page 130

4. Add the definition to a folder. See ”Assigning Metadata to a 
Folder” on page 139

5. Add the definition to content within the folder. See ”Adding 
Metadata to Content” on page 142

6. Add a metadata control to every Web form (.aspx page) on 
which this content will appear. 
To learn how to do this, see the Ektron CMS400.NET 
Developer Manual section “Custom Functions (for your server 
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platform)” > “Metadata Function”, “MetaData Server Control” 
and “MetaDataList Server Control.”

Creating and Deploying Search Tag Definitions

1. While creating a metadata definition, in the Name field, enter a 
description of the kind of data to be searched. (See examples 
circled above.) This title describes the search data on the

•Metadata tab of the Folder Properties screen

•Metadata tab of the View Content Screen

•Workarea search screen

NOTE Searchable metadata field names should not include a space. If they do, the 
search cannot find the metadata.

See Also:  ”Adding a Metadata Definition” on page 127
2. Reply to the standard fields. See ”Metadata Definition Fields” 

on page 129.
3. Respond to additional fields for Searchable Property 

definitions. See ”Searchable Additional Fields” on page 131.
4. Add the definition to a folder. See ”Assigning Metadata to a 

Folder” on page 139.
5. Add the definition to content within the folder. See ”Adding 

Metadata to Content” on page 142.
6. The next time you visit the Workarea search screen, you will 

see the new field.
7. If you want site visitors to use this field when searching your 

Web site, ask your developer to set the ShowExtendedSearch 
property of the Search Server Control to true. This value 
enables the Web site search to find searchable metadata.
See Also: Ektron CMS400.NET Developer Manual > 
“Introduction to Ektron CMS400.NET Server Controls” > 
“Search Server Control” > “Search Server Control Properties” > 
“ShowExtendedSearch”
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Related Content Metadata
You can associate the following types of content with a content 
item.

• a content item

• a collection

• a list summary

• a menu

• a user

• one of the following types of library items

- image

- hyperlink

- file
Then, you can set up a Web page so that whenever the source 
content item appears, the related information appears next to it. 
For example, your Web site sells motorcycle helmets. On a page 
that shows a particular helmet, the left column lists a collection of 
motorcycle drivers who wear that helmet. Another example might 
be that you want to show the profile of a user when a given content 
item is displayed.

Related Content vs. MetadataList Server Control

This capability is similar to the MetadataList Server control. The 
difference is that MetadataList shows a link to every content item 
with a selected term in the keywords or title. Also, a MetadataList is 
associated with a Web form (.aspx page), not a content item.

Related content lets you connect a content item with several types 
of related content (see list above), and is associated with a content 
item, not a web form. For example, you can display a library image 
of the company logo on a page whenever content in a certain 
folder appears. For content in a different folder, a different logo 
could appear.
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Creating and Deploying Related Content Definitions

1. While creating a metadata definition, in the Name field, enter a 
title for this kind of data. This title describes the metadata on 
the

•Metadata tab of the Folder Properties screen

•Metadata tab of the View Content screen

See Also: ”Adding a Metadata Definition” on page 127
2. Reply to the standard fields. See ”Metadata Definition Fields” 

on page 129. 
The Type must end with the word Selector. Choices are 
highlighted below.

For example, if you choose ListSummary Selector, a 
specified List Summary will appear on the page along with its 
associated content item.
Your choices are

•Collection Selector

•ListSummary Selector

•Content Selector



Metadata

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 123

•Image Selector (associates a library image with content)

•Hyperlink Selector (associates a library hyperlink with 
content)

•File Selector (associates a library file with content)

•Menu Selector

•User Selector

3. Add the metadata definition to all appropriate folders. See 
”Assigning Metadata to a Folder” on page 139

4. For each content item with which you want to associate related 
content, access its Metadata tab and identify the related 
item(s).

WARNING! If you are using Collection Selector type, only users with permission to work with 
collections can select a collection. Also, if you are using Image, Hyperlink or File 
Selector type, only users with permission at least read-only Library permissions 
can select a library item. See Also: ”Setting Permissions” on page 716

For example, a collection of pages describes motorcycle 
helmets. You want this collection to appear whenever a helmet 
is being viewed.
To set this up, you would

- edit the helmet content item

- click its Metadata tab

- find the metadata definition for the collection

- click Change
- select the Helmet Collection



Metadata

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 124

5. Have your Web developer add code to each page on which the 
related item appears. To learn how to do this, access the 
developer sample page (http://localhost/cms400developer/
default.aspx) and read the Metadata > Meta Associations 
description.

Simple Dublin Core Metadata
Simple Dublin Core is a set of fifteen standard names for metadata 
fields designed to cover the most useful items of information on a 
document. From the Dublin Core site FAQ: “Dublin Core metadata 
provides card catalog-like definitions for defining the properties of 
objects for Web-based resource discovery systems.” For more 
information, refer to the Usage Guide: http://www.dublincore.org/
documents/usageguide/.

By using the Metadata Server Control, you automatically create 
seven of the fifteen Dublin Core metadata fields. These fields are 
automatically filled with the information from the equivalent Ektron 
CMS400.NET property. Below is a list of the seven fields and their 
Ektron CMS400.NET equivalent. For more information on the 
Metadata Server Control, see the Developer’s Manual section 

http://www.dublincore.org/documents/usageguide/
http://www.dublincore.org/documents/usageguide/
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“Introduction to Ektron CMS400.NET Server Controls” > “MetaData 
Server Control”

Creating the Additional Eight Fields

To fully comply with the Simple Dublin Core metadata element set, 
the administrator must create the remaining eight Dublin Core 
fields as standard CMS400.NET Metadata definitions and apply 
them to all CMS400.NET folders. Next, CMS users complete the 
appropriate values for each content block.

WARNING! When creating the Dublin Core metadata fields in the Metadata section of the 
Workarea, you do not need to create the first seven fields in the table above. In 
addition, the names of the fields you create must match the names below. For 
example, in the name field, enter “DC.subject”. The DC identifies the metadata as 
Dublin Core metadata.

The remaining eight Simple Dublin Core fields are described 
below:

Dublin Core Field Name Ektron CMS400.NET Property

DC.title Content block title

DC.description Plain text version of a content sum-
mary

DC.contributor Content block last editor name

DC.date Content block last edit date

DC.format “text/html”

DC.identifier URL of current page (from ASP.NET 
Server.Request object)

DC.language CMS language cookie / current site 
language, expressed as a .NET 
System.Globalization Culture Name
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NOTE These descriptions are from the Dublin Core Metadata Initiative site. For a more 
detailed description, visit http://www.dublincore.org.

• DC.subject - The topic of the content of the resource. 
Typically, a Subject is expressed as keywords, key phrases, or 
classification codes that describe the topic of the resource.

• DC.type - The nature or genre of the content of the resource. 
Type includes terms describing general categories, functions, 
genres, or aggregation levels for content.

• DC.source - A reference to a resource from which the present 
resource is derived. For example, DC.source=”Image from 
page 54 of the 1922 edition of Romeo and Juliet”

• DC.relation - A reference to a related resource.

• DC.coverage - The extent or scope of the content of the 
resource. Coverage typically includes spatial location (a place 
name or geographic co-ordinates), temporal period (a period 
label, date, or date range) or jurisdiction (such as a named 
administrative entity). Examples: DC.coverage=”1995-1996”, 
DC.coverage=”Boston, MA”, DC.coverage=”17th century” or 
DC.coverage=”Upstate New York”.

• DC.creator - An entity primarily responsible for making the 
content of the resource.

• DC.publisher - The entity responsible for making the resource 
available.

• DC.rights - Information about rights held in and over the 
resource. Typically, a Rights element contains a rights 
management statement for the resource, or reference a service 
providing such information.

Working with Metadata Definitions
NOTE Only members of the Administrator User Group and those defined in the Manage 

Members for Role: Metadata-Admin screen can view, add, or edit metadata 
definitions. See Also: ”Using the Roles Screens” on page 736

Procedures for creating, updating and deleting metadata 
definitions are explained in the following sections.

• ”Adding a Metadata Definition” on page 127

• ”Viewing Metadata Definitions” on page 137

http://www.dublincore.org
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• ”Editing a Metadata Definition” on page 137

• ”Deleting a Metadata Definition” on page 138

• ”Assigning Metadata to a Folder” on page 139

• ”Adding Metadata to Content” on page 142

Adding a Metadata Definition
Use the Add Metadata Properties screen to define metadata (such 
as keywords and title). You can define as many instances of 
metadata as you wish.

If your site supports multiple languages, you create metadata 
definitions for each supported language.

To define one instance of metadata, follow these steps.

WARNING! After creating a definition, you must assign it to all folders whose content should 
use it. You assign a metadata definition to a folder in the folder’s properties. See 
”Assigning Metadata to a Folder” on page 139.

1. From the Workarea’s left frame, click Settings > 
Configuration > Metadata Definition.
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2. The View Metadata Definitions screen appears.
3. Select the language for the metadata you are about to define. 

This metadata will only be available to content in this language.

4. Click the Add Metadata Definition button ( ).

5. The Add Metadata Definition screen appears. Using the 
following table, add the needed information.

After you create a metadata definition, you may see the following 
error in the Windows Event Viewer Log. 

To learn more about this problem and how to resolve it, see the 
following Microsoft KB article: http://support.microsoft.com/kb/
310680.

http://support.microsoft.com/kb/310680
http://support.microsoft.com/kb/310680


Metadata

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 129

Metadata Definition Fields

Field Description

Name Enter a name to identify this metadata.

Note: Searchable metadata field names should not include a space. If they do, 
the search cannot find the metadata.

Ektron CMS400.NET  reserves a list of names that you cannot use. If you 
enter one of them, the following error message appears when you try to save 
the definition.

Type From the drop-down list, select whether this tag is

• a searchable property - See Also:  ”Searchable Additional Fields” on 
page 131

• an HTML tag (for example, <title>) - See Also: ”HTML Tag Additional 
Field” on page 130 and ”Title Tag” on page 119

• a Meta tag (<meta>) - See Also:  ”Meta Tag Additional Fields” on 
page 130 and ”Meta Tags” on page 117

• Collection Selector, ListSummary Selector, Content Selector, Image 
selector, Hyperlink Selector, File Selector - See Also: ”Related Content 
Metadata” on page 121

Editable Check this box if you want to allow users to edit the contents of the metadata 
when creating or editing the metadata’s content.
Uncheck this box if you want uniform metadata text for each content item that 
uses this metadata.
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HTML Tag Additional Field

See Also: ”Title Tag” on page 119

Meta Tag Additional Fields

NOTE For background information about metadata, see http://www.w3.org/TR/REC-
html40/struct/global.html#edef-META.

See Also: ”Meta Tags” on page 117

Field Description

Default Text Enter default content for the HTML tag. For example:
content="document management web content management content 
management cms"

http://www.w3.org/TR/REC-html40/struct/global.html#edef-META
http://www.w3.org/TR/REC-html40/struct/global.html#edef-META
http://www.w3.org/TR/REC-html40/struct/global.html#edef-META
http://www.w3.org/TR/REC-html40/struct/global.html#edef-META
http://www.w3.org/TR/REC-html40/struct/global.html#edef-META
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Searchable Additional Fields

Field Description

Style Select from the drop-down list to indicate whether you want the style to 
be name or http-equiv.
For more information, see http://www.w3.org/TR/REC-html40/struct/
global.html#h-7.4.4.2

Remove Duplicates Check this box to remove duplicate words or phrases from the metadata.

Case Sensitive Check this box to remove duplicates only if the letters and case of each 
letter match.

Separator Enter a character to separate the metadata values. The default is a 
semicolon (;).

Selectable Metadata Check this box to force users to select from the options specified in the 
Allow Selectable Text and Default Text fields.
If you do not check this box, users can create their own metadata.

Allow Multiple 
Selections

Check this box to let users select multiple metadata values instead of 
one. If multiple values are allowed, use the separator character to delimit 
them.
If this box is not checked, all values appears in a drop-down list, and the 
user selects the correct one.
This field is only active if the Selectable Metadata box is checked.

Allowed Selectable 
Text

Enter standard metadata that can be selected by users. Separate each 
option by the separator specified for the metadata definition.
This field is only active if the Selectable Metadata box is checked.

Default Text Enter default content for the metadata tag.

http://www.w3.org/TR/REC-html40/struct/global.html#h-7.4.4.2
http://www.w3.org/TR/REC-html40/struct/global.html#h-7.4.4.2
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Field Description

Publicly Viewable If you check the box, site visitors can find the metadata value when 
searching your Web site. Otherwise, site visitors cannot find the metadata 
value.

Note: Regardless of whether this is checked, this metadata value can be 
found using the Workarea’s Search Content Folder screen. Only logged-
in users can access the Workarea.



Metadata

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 133

Style Select the style of the response field from these choices (available in a 
dropdown list). You are specifying the kind of information that a user 
adding searchable properties to content will enter to describe the data. 
Later, anyone using the search can search on that information.
See Also: ”Assigning Metadata to a Folder” on page 139

• Text - The user enters free text to describe the content.

• Number - The user enters a number to describe the content.

• Byte - 1 byte. 0 through 255 (unsigned)

• Double - 8 bytes. -1.79769313486231570E+308 through -
4.94065645841246544E-324 † for negative values; 
4.94065645841246544E-324 through 1.79769313486231570E+308 
† for positive values

• Float - (single-precision floating-point) 4 bytes. -3.4028235E+38 
through -1.401298E-45 † for negative values; 1.401298E-45 through 
3.4028235E+38 † for positive values

• Integer - 4 bytes. -2,147,483,648 through 2,147,483,647 (signed)

• Long - 8 bytes. -9,223,372,036,854,775,808 through 
9,223,372,036,854,775,807 (9.2...E+18 †) (signed)

• Short - 2 bytes. -32,768 through 32,767 (signed)

• Date - The user enters a date to describe the content.

• Yes or No - The user answers yes or no to describe the content. For 
example, if the content describes automobile parts, the user could 
answer yes to include new and used parts or no to search for new 
parts only.

• Select from a list - The user picks a from a list to describe the con-
tent.
For an illustration of this style on the Edit Content screen/Searchable 
Properties tab and the Web site search screen, see ”Select from a 
List” on page 134.

• Multiple selections - The user selects an item from a dropdown list.

For an illustration of this style on the Edit Content screen/Searchable 
Properties tab and the Web site search screen, see ”Multiple 
Selections” on page 135.

See Also: ”Converting the Style of a Metadata Definition” on page 135

Field Description
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Select from a List

NOTE The following graphics depict searchable metadata when using the Site Search 
server control. They do not appear when using the Web Search server control.

Appearance on Edit Content Screen > Metadata Tab

Appearance on Search Screen

Default If desired, enter the most common response to this definition.
The default value is automatically applied to all existing content within 
folders to which this definition is assigned.
While editing content that uses this definition, a user can accept the 
default value or change it.
See Also: ”Effect of a Default Value on Required Metadata” on page 141

Field Description
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Multiple Selections

Appearance on Edit Content Screen > Metadata Tab

Appearance on Search Screen

Converting the Style of a Metadata Definition
This section explains how Ektron CMS400.NET handles changing 
the style of a searchable property type of metadata. For example, 
you create a definition to collect Part Number. Originally, the style 
is text, but you later decide its style should be number.

When you change the style of searchable property type metadata, 
Ektron CMS400.NET attempts to maintain any data stored in 
content blocks that use the definition. For example, if the data style 
was number and you change it to text, the number stored for that 
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metadata definition is converted to text and maintained in all 
content that uses it. 

However, sometimes Ektron CMS400.NET cannot maintain the data 
when you change the style. For example, if you change a metadata 
definition style from number to date, Ektron CMS400.NET cannot 
convert those styles. In this case, any data stored in metadata 
definitions is lost.

The following table illustrates all conversion scenarios and how 
Ektron CMS400.NET handles each one. It indicates whether data is 
maintained after you convert from a data style in the left column to 
a style to its right.

Table legend

• OK - Data is maintained

• NO - Data is lost during conversion

When you change the style of a metadata definition, the screen 
often gives you these choices:

Text Number Date Boolean Single 
Select

Multiple 
Select

Text - OK OK NO NO NO

Number OK - NO NO NO NO

Date OK NO - NO NO NO

Boolean OK NO NO - NO NO

Single Select OK NO NO NO - OK

Multiple Select OK NO NO NO NO -
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• Use existing data if possible, else default

• Use default value

Following these choices is a field that lets you define a default 
value. If you want to simply replace any existing data, select Use 
default value and enter the new value in the Default field.

If the data is convertible (according to the table above), and you 
want to maintain existing data if possible, select Use existing data 
if possible, else default. Then, enter a default value below. If the 
existing data cannot be maintained, the default value replaces it.

Viewing Metadata Definitions
You may view any metadata definition. To do so, follow these 
steps.

1. From the Workarea’s left frame, click Settings > 
Configuration > Metadata Definition.

2. The View Metadata Definitions screen appears.
3. Select a language from the drop-down list.
4. Click the Metadata definition you want to view.
5. The View Metadata Definition screen appears. From here, you 

can edit and delete this definition.
See Also: ”Metadata Definition Fields” on page 129

Editing a Metadata Definition
To edit a metadata definition, follow these steps.
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1. Access the View Metadata Definition screen whose definition 
you want to edit, as described in ”Viewing Metadata 
Definitions” on page 137.

2. Click the Edit button ( ).

3. The Edit Metadata Definition screen is displayed.
4. Make the necessary changes to the definition.
See Also: ”Metadata Definition Fields” on page 129

5. Click the Update button ( ).

What Happens When a Metadata Definition is Edited?

If you create a metadata definition, assign it to a folder, then users 
insert metadata information into their content, the collected 
information takes on the characteristics of the metadata definition. 
For example, if the metadata is title and its type is HTML tag, this 
is how it appears in the Web page’s source code.

<title>CMS Developer</title>

If you later change its type to Meta, the following effects occur:

• metadata to which the definition has already been assigned 
maintains the previous style definition. For example, <title>CMS 
Developer</title>.

• when you create a new content item that uses the metadata 
definition, its metadata takes on the new style. For example, 
<meta name="title" content="CMS developer">.

Deleting a Metadata Definition
You can remove metadata definitions that are no longer used from 
the Ektron CMS400.NET site. When you delete a definition, it is 
removed from every content item that uses it.

To delete a definition, follow these steps.

1. Access the View Metadata Definition screen for the definition, 
as described in ”Viewing Metadata Definitions” on page 137.

2. Click the Delete button ( ).
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3. A confirmation message is displayed.
4. Click OK.
5. Another confirmation message is displayed.
6. Click OK.

Assigning Metadata to a Folder
After creating a metadata definition (see ”Adding a Metadata 
Definition” on page 127), assign it to folders whose content will use 
it.

On each folder’s properties screen, you determine which metadata 
definitions can be used.The section of the folder properties screen 
used to assign metadata appears below. Only metadata definitions 
whose Assigned box is checked can be completed by users 
working with content in the folder.

Then, while creating or updating content, the user can insert the 
metadata information via the Metadata tab (illustrated below).
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Requiring Users to Enter Metadata

You can determine that a metadata value must be inserted before 
content can be saved (see the Required checkboxes in the 
illustration above). This occurs both when new content is added 
and existing content is edited.

If you set a kind of metadata to be required, its label is red and 
includes an asterisk (*) on the Metadata tab of the Edit Content 
screen, as shown below.

If the user does not complete a required metadata field, a message 
informs him that it must be completed before he can save the 
content.
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Effect of a Default Value on Required Metadata

A default value can be defined when creating or editing a field 
within a metadata definition. See Also: ”Adding a Metadata 
Definition” on page 127

If a default value is defined for a required metadata field, the 
default value is used when the user saves the content. In this case, 
the user is not prompted to enter a value because the default value 
is sufficient.

Inheritance of Metadata by Folder
Each folder can inherit metadata fields from its parent folder or 
have a unique set of them. The information includes the kinds of 
metadata that are assigned and which of those are required. For 
example, you could assign the top folder (Content) all metadata 
definitions, while you assign the Contacts folder (directly below it) 
none.

On every folder’s Metadata tab, use the Break Inheritance check 
box (illustrated below) to determine if metadata definitions are the 
same as the parent folder or unique. 

By default, Break Inheritance is not checked, which means that all 
folders inherit metadata definitions from the root folder (Content).

When you check Break Inheritance, all inherited values appear by 
default (that is, Assigned and Required boxes are either checked 
or unchecked). You can then change the settings as desired.
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Adding Metadata to Content
When a user creates or updates content, he can define its 
metadata within the assignments specified for its folder.

Default metadata values are applied without user intervention. 
Instructions for adding metadata are found in the Adding or Editing 
Data Metadata section of the Ektron CMS400.NET User Manual.
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Adding Content 
Programmatically

Content can be created using a special function which lets 
users add new content without logging in. To accomplish this, 
your Web site developer places a form on your Web site which 
lets users submit content without logging in. Here is a sample 
Add Content form.
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Your Web site developer can customize this form to better suit your 
needs. See the Ektron CMS400.NET Developer Manual for 
additional information.
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Content Reports

The reports folder contains several reports to help you manage the 
workflow of content through Ektron CMS400.NET. In most cases, 
you choose a report that corresponds to the content’s status, then 
view all content in that status. If appropriate, you can perform tasks 
on selected content. For example, you can check in checked-out 
content.

This chapter explains how to access the reports folder in your 
Workarea, set criteria that determine the information on the 
reports, and actions you can perform on them.

See Also: 

• ”Accessing the Reports Folder” on page 145

• ”List of Standard Reports” on page 146

• ”Common Report Topics” on page 147

Accessing the Reports Folder
To access the Reports folder, follow these steps.

1. From the Ektron CMS400.NET Workarea, click the Smart 
Desktop button in the top left corner (circled below).

2. Click the Reports folder.
3. A list of available reports appears.
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NOTE The Approvals, Checked Out, and Content to Expire Reports are also available 
from the Workarea.

The reports are described below.

List of Standard Reports

Report Displays content in this 
status

For more information, see

Approvals Requiring your approval ”Approvals Reports” on page 155

Checked In Content Checked in ”Checked In Report” on page 157

Checked Out Content Checked out ”Checked Out Report” on page 158

New Content New (that is, created and saved 
but never published)

”New Content Report” on page 159
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Common Report Topics
The following topics apply to the reports.

• ”Information on the Reports” on page 148

• ”Report Toolbar Options” on page 148

• ”Selecting Content by Folder” on page 149

• ”Selecting Content by Type” on page 150

• ”Sorting and Filtering Content Reports” on page 150

• ”Performing an Action on Several Content Items” on page 151

Submitted Content Submitted for publication ”Submitted Report” on page 159

Content Pending Start Date Approved and pending a start date ”Content Pending Start Date Report” 
on page 160

Refresh Reminder Report End date has been reached ”Refresh Reminder Report” on 
page 161

Expired Content Expired date has been reached ”Expired Content Report” on page 162

Content to Expire Will expire within specified number 
of days

”Content to Expire Report” on 
page 163

Site Update Activity 
Content Report

Content created or updated in 
selected folders and within a 
selected date range

”Site Update Activity Report” on 
page 164

Asynchronous Log File 
Report

A log report of the Asynchronous 
process

”Asynchronous Log File Reporting” on 
page 945”

Search Phrase Report Frequency of search terms ”Search Phrase Report” on page 168

Preapproval Groups User groups that have been 
assigned to folders in order to 
preapprove content

”Preapproval Groups Report” on 
page 380

Bad Link Report Invalid links to external URLs ”Bad Links Report” on page 170

Report Displays content in this 
status

For more information, see
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• ”Viewing/Editing Content on the Report” on page 152

• ”emailing Reports” on page 152

Information on the Reports
Each report displays the following information about its content.

Report Toolbar Options

Field Description

Title Title of content.

ID Internal number assigned to content by Ektron 
CMS400.NET .

Date Modified If a Start Date was assigned to the content, it 
appears here.

Last Editor The user who last edited the content.

Path Folder location of content.

Toolbar Button Description For more information, see

email this report to selected users ”emailing Reports” on page 152

Select a folder whose content appears on 
the report. Content in other folders is 
ignored.

”Selecting Content by Folder” 
on page 149

 Go to previous screen

 

Select the language of the content you 
want to see on the report
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Selecting Content by Folder
You can select a folder and only view the content in that folder that 
satisfies the other report criteria. For example, the Checked in 
Content Report can show only content whose status is checked in 
and which resides in the Contacts folder.

Only content in the selected folder appears. The report does not 
include content from subfolders of the selected folder.

To select content by a folder, follow these steps.

1. From the Smart Desktop, select a report.

2. Click the Select a Folder button ( ).

Select the type of the content you want to 
see on the report

Toolbar Button Description For more information, see
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3. The top level folders appear.
4. If the folder you want is on the list, click the corresponding 

checkbox.
If the folder you want is a subfolder, click the parent folder’s 
name. A new screen appears, showing the selected folder’s 
subfolders. Click the corresponding checkbox.

5. Click the Save button ( ) to finalize your folder selection.
6. The screen displays all content items in the selected folder that 

satisfy all report criteria.

Selecting Content by Type
After viewing any report, you can select a content type and only 
view the content of that type that satisfies the other report criteria. 
For example, the Checked in Content Report can show only Office 
documents.

To select a content type, follow these steps.

1. From the Smart Desktop, select a report.
2. Use the file types pull-down to select a file type. 
3. The screen refreshes and only displays files of that type.

Sorting and Filtering Content Reports
Upon viewing a report’s content, you have additional options for 
filtering report data by user and content folder.
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The filtering options for each content report are identical. The 
following section uses the Checked-In Content report as an 
example.

Filter by User

To display only content that was checked in by a user, click the 
name of the user in the report display. When you do, the report 
redisplays, showing only content which that user checked in.

Filter by Content Folder

To display only content checked in to a selected folder, click the 
folder on the report display. When you do, the report redisplays, 
showing only content in that folder.

NOTE You can also select a folder and view reports in that folder only. See Also: 
”Selecting Content by Folder” on page 149

Performing an Action on Several Content Items
You can perform the following actions on several or all content 
items in the Approvals, Checked in, and Checked out reports.

To select several reports, check the relevant checkboxes 
(illustrated below). To select all reports, click Select All.

Report Action you can perform

 Approvals Approve

Checked in Submit for publication

Checked out Check in
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Then, click the button at the top left to perform the action on the 
selected content items.

Viewing/Editing Content on the Report
To view (and possibly edit) any content on a report, click it. It 
appears on the View Content screen (illustrated below).

The View Content screen provides several toolbar options that you 
can perform on the content.

emailing Reports
You can email any report. You might do this, for example, to notify 
a user that several content items are checked out to him. All 
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information in the report appears in the email. A sample appears 
below.

You can click any content item on the report and proceed to that 
page of your Web site.

To email any report, follow these steps.

1. Display the report you want to email.

2. Click the email button ( ).

3. A list of all users and user groups in your Ektron CMS400.NET 
appears.
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NOTE Users appear fIrst in alphabetical order (by username), followed by user groups. 
The icon for user groups has two heads (see below).

4. Click inside the checkbox of every user or group to receive a 
copy of the report.

Searching for Report Recipients

If you cannot easily find a user, a search of all users and groups is 
available. To use it, follow these steps.

1. Display the report that you want to email.

2. Click the email button ( ).

3. A list of all users and user groups in your Ektron CMS400.NET 
appears.

4. Click the Search for User button ( ).

5. The following screen appears.

6. Enter whatever information you know about the users.
7. Click the Send email button.
8. All users that satisfy the search criteria appear on a new 

screen.
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9. Click the checkbox of every user or group to receive the report.

Approvals Reports
Each content item awaiting your approval appears on this report. 
Thus, you can quickly find all such content without searching 
through every folder.

The View All Content Awaiting Approval screen displays the 
following information about this content.

Below is an example of the View All Content Awaiting Approval 
screen.

Field Description

Title Title of content.

Request Type Request made for the content. Either Publish or 
Delete.

Start Date Start date, if any, assigned to the content. 
Determines when content will go live on Web 
site.

Date Modified Date the content was most recently changed

Submitted By User who submitted content for approval.

ID The ID number if the content.

Language The language of the content.

Path Path to content folder where content resides.
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Approving/Declining Content
From the approvals report, you can approve or decline content that 
was submitted to you. The steps below explain how to do so.

Approve/Decline One Content Item

1. Access your Approvals report in the Workarea (see ”Approvals 
Reports” on page 155).

2. Click the content you want to approve or decline.
3. The View Content Awaiting Approval page is displayed.
4. Perform an action using the following table as a reference.

Button Name Description

Publish Accept changes to content and publish it to site.

Note: If there is a subsequent approver in the content’s approval chain, this 
button is replaced by a Submit button.

If you click Publish but the content item has an incomplete task assigned to 
another user, the content cannot be published. Instead, the following error 
message appears.

The user to whom the task is assigned must complete it before you can 
publish the content.

Decline Reject changes and keep current version of content live on Web site. You are 
prompted to enter a comment that provides a reason for the decline. The 
author who made the change is notified by email of the decline.
The content inserted by the last editor remains in the file. If you do not want it 
to remain, choose the Edit option. 

Edit Check out content and make changes to it if desired.
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Approving Multiple Content Items

See ”Performing an Action on Several Content Items” on 
page 151.

The selected content is either submitted to the next publisher, 
published immediately, or deleted, depending on the content’s 
approval chain.

Checked In Report
The Checked In Content report displays all the content currently in 
a checked-in status.

The report displays the following information.

View 
Published/
Staged

Toggle between published and submitted versions of content. This can help 
you compare differences.

Back Go back to previous screen.

Button Name Description

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time content was last edited.
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Submitting Multiple Content Items
After selecting content, use the submit toolbar option ( ) to 
submit it for approval or publication, depending on your position in 
the approval chain.

Checked Out Report
The Checked Out Content report displays all content currently in a 
checked out status. 

The report displays the following information.

After selecting content, check it in using the Checkin button ( ).

Path Folder location of content in Ektron CMS400.NET Web 
site.

Column Description

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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New Content Report
The New Content report displays content in a new state, that is, it 
was created and saved but never published. The new content 
report contains the following information.

Submitted Report
The Submitted Content report displays all content in a submitted 
state. The report contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web 
site.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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Viewing Position in Approval Chain
While viewing the Submitted Content report, you can view the 
content’s position is its approval chain. You can use this 
information to contact the individuals in the chain and ask them to 
complete their approval. To do so, follow these steps.

1. From the Submitted Content Report, click the content’s title.
2. The View Content page is displayed.
3. Click the Properties tab.
4. The content’s position in the approval chain is indicated by red 

text on the Approvals line.

Content Pending Start Date Report
The Pending Start Date Report displays all content that was 
approved, but whose start dates haven’t occurred. Each content 
item on the report contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Start Date Date and time content will go live on Web site.
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Editing Content with a Pending Start Date
You may edit content on the Pending Start Date Content report. To 
do so, follow these steps.

1. Click the content you want to view.
2. The View Content page is displayed.
3. Using the toolbar at the top of the page, perform any action 

available.

Refresh Reminder Report
The Refresh Report displays all content whose end date has 
passed and whose archive option is set to Refresh Report. This 
content is still visible on the Web site. Its appearance on this report 
indicates that it is due for review. See Also: The Ektron 
CMS400.NET User Manual section “Scheduling Content to Begin 
and End” >“Setting Archive Options.”

Each item on the report contains the following information.

Path Folder location of content in Ektron CMS400.NET Web 
site.

Column Description

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time the content was last updated.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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Removing Expired Content from Site
If you review content and decide it should no longer appear on 
your site, follow these steps to remove it. The content will be visible 
if you browse to it through the Workarea, but won’t appear to site 
visitors.

1. From the Expired Content Report, click the content.

2. From the View Content screen, click the Edit button ( ).

3. Click the Schedule tab.
4. Under Action on End Date:, click Archive and remove from 

site (expire).

Expired Content Report
The Expired Content report displays all content whose end date 
has passed. Such content is no longer visible on the Web site.

Each item on the list contains the following information.

Editing Expired Content
You may edit any content on the Expired Content report. To do so, 
follow these steps.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

End Date Date and time the content expired.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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1. Click the content you want to view.
2. The View Content page is displayed.
3. Using the toolbar at the top of the page, perform any action 

available.

Content to Expire Report
The Content to Expire report lists all content whose end date will 
occur between today and a number of days that you specify. For 
example, if today is January 1 and you select 10 days, the report 
lists all content whose end date is January 1 through January 10.

After viewing the report, you can click any content and proceed to 
the View Content screen for it. From there, you can edit information 
about it, including its end date if desired.

Each item on the list contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

End Date Date and time the content expired.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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Selecting the Report’s Date Range
To select the report’s date range, you have two options:

After selecting a number of days, click the view icon ( ) to see all 
content that will expire within that time frame.

Site Update Activity Report
The Site Activity Report provides a snapshot of the freshness of 
the content on your Web site. Specifically, it lists how many content 
items were published within a folder and date range you select, 
broken down by folder.

A sample report appears below.

Option Illustration

Enter a number in the Days field. 
Then click the View Reports button 

( ).

Select a number from the dropdown 
list below the Days field
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Selecting Information to Appear on the Report
To choose which content items will appear on the report, follow 
these steps.

1. By default, only content in the default language appears on the 
report. To change the language, use the language pull-down 
near the top of the screen.

2. Choose a Start Date by clicking the calendar icon ( ).



Content Reports

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 166

3. A calendar appears. You can move to another month or year by 
clicking it. When you get to the desired month, click inside the 
day. The selected date turns red (see below).

4. Click Done.
5. If desired, select an End Date using the same procedure.

NOTE If you do not select an end date, the report uses today as the end date.

6. At the Select field, choose a folder. The Root folder is the 
default selection.

NOTE Only folders for which you have read-only or greater permission appear.

To change that selection, click the folder name. When you do, 
the Select Folder screen appears.
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To select all folders on the screen, click the Select All 
checkbox. Otherwise, select folders by clicking the 
corresponding checkbox. There is also an option to Include 
Sub-folders of the selected folders.

7. Choose the Report type, which determines the information you 
will see on the report. Options are explained below.

Report 
Type

Description Example

Executive 
View

• folder name

• how many times 
content in folder 
was published

• how many pages 
were published

• number of con-
tent items in folder
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8. If you would like to exclude users or use groups from the 
report, use the Exclude Users field. For example, you want to 
see all updates other than those you have completed.
When you click Exclude Users, an alphabetical list of users 
appears, followed by user groups. (User groups have a two- 

headed icon (  )).

9. Click Get Result.

Search Phrase Report
This report displays all terms that were entered into the Search 
Text Field within a selected range of dates. You can use it to 
discover the kind of information site visitors are searching for.

Detail View • name of each 
page that was 
published

• how many times it 
was published

• date it was last 
published

• users who pub-
lished page

• total numbers are 
not provided

Combined 
View

information from 
Executive and Detail 
views

Report 
Type

Description Example
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Selection Criteria
You can narrow down the search by selecting any combination of 
these criteria.

• language - the language of the search page (either Workarea 
or Web site search). The user performing the search can 
choose a language before inserting the search text. If he does 
not explicitly choose a language, the search uses the default 
one. This report can show results from all languages or any 
one that you select.

• a minimum number of occurrences of the word or phrase to 
return. For example, you only want words or phrases entered 
into the Search Text field at least 10 times during the last 
month.

• whether to include words or phrases entered into the Web site 
search (the search page that site visitors use)
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• whether to include words or phrases entered into the Workarea 
search (accessed from the View Contents of Folder screen, 
this search page is used by authorized CMS users to find 
content)

• date range

Display of Search Results
The search results show the number of times each word or phrase 
that satisfies the selection criteria appears. They are arranged in 
this order.

• words or phrases with the most occurrences appear first

• if several words or phrases have the same number of 
occurrences, they are arranged alphabetically

Also, terms entered into the Web site search or the Basic 
Workarea search are surrounded by parentheses (). Terms entered 
into the Advanced Workarea search have no parentheses. The 
Microsoft search engine uses this syntax to find content.

Bad Links Report
The Bad Links Report notifies you of any invalid links to external 
URLs within your content. (An invalid link returns an error code to 
your browser.) 

NOTE The report does not check quicklinks embedded in the content.

To accomplish this, the report scans the following types of content.

• published HTML content

• published XML content

• HTML forms

• XML Smart Forms

• menus

• active system templates
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When the scan is complete, the report lists any item that includes 
an invalid URL. From the list, you can click a button to access the 
item, then update or remove the bad link.

Running the Bad Links Report
To run the Bad Links Report, go to Smart Desktop > Reports. 
When you select Bad Link Report, you immediately see its status, 
either Done or Running.

To begin scanning for bad links, click the Check Links Now button 
( ). When you do, existing data is replaced by new data being 
collected as the report progresses.

While the report scans content, you are free to work in other areas 
of Ektron CMS400.NET. You can even sign off Ektron CMS400.NET. 
These actions have no effect on the report’s collection of data.

If you want to stop the Bad Links Report at any time, click the 
Cancel button ( ).

After all content is scanned, the report’s status changes to Done. If 
desired, you can print the report by clicking the print button ( ). 

You can also launch the broken link in a browser by moving the 
cursor over it then clicking when the cursor turns into a hand.
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Fixing Errors
The report lists the following information about each item that 
contains a bad link.

• title

• error description

• Source, that is, item type (content, menu, etc.) followed in 
parentheses by information about the item that has the error. 
As examples

- if the error is in a content block, you see Content followed 
by its id number and language locale id

- if the error is in a Smart form, you see Smart form followed 
by its ID number

- If it’s a menu, you see Menu Item (11,0,1033). The three 
parameters are menu ID, menu item ID, and language ID. 

- An error in a template looks like this: 
ASPX Template (therapies.aspx)

Invalid Link: http://localhost/websrc/WorkArea/therapies.aspx 

- The beginning of the bad link’s source code. Use this to help 
you find the bad link from Source View.

• the anchor (<a>) tag to which the bad link is assigned

• URL that could not be resolved (labeled Invalid Link)

To fix an error, click the edit button next to the title (highlighted 
below). The item opens in edit mode, so you can fix the bad link.

The error report’s Source: field also indicates the text to which the 
bad link is assigned. See content highlighted in the above graphic.
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Within the content, you select the indicated text, right click the 
mouse, and select Hyperlink to access the hyperlink dialog. From 
here, you can update or remove the bad link.

Running the Bad Links Report on a Schedule
You can set the Bad Links Report to run in the background at 
predetermined times. If you do, you can view the report‘s latest 
results at your convenience without having to wait while it 
compiles.

To set up a schedule, follow these steps.
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1. Open the following configuration file: 
C:\Program Files\Ektron\EktronWindowsService20\Ektron.ASM.EktronServices.exe.config

2. Within that file, go to the following line:
<add name="RunJob" type="Ektron.ASM.EktronServices.RunCMSJobManager.JobService, 
Ektron.ASM.EktronServices" AbsoluteTime="Weekly|5, 2:27:00 PM"  Enabled="true" />

3. Use the absoluteTime property to set the Bad Links Report’s 
start time and frequency. By default, the report is scheduled to 
run every Thursday at 2:27 p.m. The following table lists ways 
to indicate a schedule.

Frequency How to indicate Example

Hourly Comma-separated list of 
integers representing the 
number of minutes, seconds 
and ms between jobs

360,0,0 (every 360 minutes or 6 hours)

Daily A time in hh:mm:ss AM/PM 
format

11:30:00 PM (every day 11:30 pm)

Weekly Weekly | followed by an 
n is an integer that corresponds 
to a day of the week, followed 
by time. Use the time format 
described for the Daily 
frequency.
Use zero (0) to indicate Sunday, 
1 for Monday, etc., through 7 for 
Saturday.

Weekly| 0 12:00:00 PM (every Sunday at noon)

Monthly Monthly | followed by an 
integer that corresponds to a 
day of the month, followed by 
time. Use the time format 
described for the Daily 
frequency.
Use zero (0) to indicate Sunday, 
1 for Monday, etc., through 6 for 
Saturday.

Monthly| 15 11:30:00 (the 15th of every month at 11:30 
PM)
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Managing Library Items

Before users can insert images and files into their content, they 
must be uploaded to the server that contains Ektron CMS400.NET. 
Each user, depending on their permissions, can upload images 
and files through the library in their Workarea.

In the library, you determine the types of files that can be uploaded 
and each user’s library permissions.

What’s In This Chapter?
This chapter assumes you are familiar with the Library Folder 
chapter of the Ektron CMS400.NET User Manual. As a result, the 
chapter only provides information that is unique to administrators.

The following topics are covered in this chapter:

• ”Library Folders and Permissions” on page 175

• ”Folder Properties” on page 176

• ”Performing Actions on Library Items” on page 178

• ”Load Balancing” on page 178

• ”If You Have an Ektron WebImageFX License Key...” on 
page 182

Library Folders and Permissions
Whenever a new content folder is created and permissions given 
to it, a corresponding library folder is created. The new folder 
inherits permissions from the content folder.

Items added to library folders are only accessible by users with 
permission to the corresponding content folder. If items are added 
to a library folders directly under the main library folder, all users 
with at least library Read-Only permissions can use those library 
items in their content.
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Conversely, if a library item is uploaded to a folder to which only 
one person has permissions, that is the only user who can use that 
library asset.

Folder Properties
The library folder properties contains library-related information, 
including load balance settings, image and file types that are 
allowed to be uploaded, as well as other settings.

The following buttons indicate actions you can perform on a library 
folder.

Accessing the Library Properties Screen
As an administrator, you have permission to change the library 
properties. To view the properties of the library folder, follow these 
steps.

1. Access a library folder, as explained in ”Folder Properties” on 
page 176.

2. Click the Properties button ( ).
3. The Library Management window appears, displaying the 

following settings.

Button Description For more information, see

Folder properties ”Accessing the Library Properties Screen” on 
page 176

Search Ektron CMS400.NET User Manual section 
“Library Folder” > “Searching the Library”

Back to previous screen
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The Library Management Settings

Editing Library Properties
To edit library properties, follow these steps.

1. Go to the Library Properties screen, as explained in ”Accessing 
the Library Properties Screen” on page 176.

2. Click the Edit button ( ).

Field Description

Image Extensions The types of image files that a content contributor can upload to the 
library. You can add as many image file extensions as you want, or have 
none. If no extensions appear, no one can upload image files to the 
specified folder.

Image Upload Directory Specifies where the uploaded images are saved on the Web server. By 
default, the image upload directory is Web root/ek_sitepath/
uploadedimages. The ek_sitepath value is set in the Web.config file.
See Also: Ektron CMS400.NET  Setup Manual section “Managing the 
web.config File.”

Make Directory Relative 
to this Web site

If you want to specify the image upload directory’s location as relative to 
your Web site root, check this box. (Your Web site root’s location appears 
to the right of Make Directory Relative to this Web site.)

File Extensions Specify the types of non-image files that a content contributor can upload 
to the library. You can add as many non-image file extensions as you 
want, or have none. If no extensions appear, no one can upload non-
image files to the specified folder.

File Upload Directory Specifies where the uploaded files are saved on the Web server. By 
default, the file upload directory is Web root/ek_sitepath/
uploadedfiles. The ek_sitepath value is set in the Web.config file.

Note: You must create the directory in your Web root manually, before 
adding it in CMS400.NET.

See Also: Ektron CMS400.NET  Setup Manual section “Managing the 
web.config File.”

Make Directory Relative 
to this Web site

If you want to specify the file upload directory’s location as relative to your 
Web site root, check this box. (Your Web site root’s location appears to 
the right of Make Directory Relative to this Web site.)
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Library properties are described in ”The Library Management 
Settings” on page 177.

Performing Actions on Library Items
The library is made up of images, files, form Quicklinks, hyperlinks, 
and regular Quicklinks that were added by Ektron CMS400.NET 
users. The following table displays the actions that can be 
performed for each library item type.

Most actions can be performed by a user who is granted 
permission to do so. See Also:  ”Setting Permissions” on page 716 

Load Balancing
This section explains how to create load balancing paths in Ektron 
CMS400.NET. For further information about the steps needed to 

Action Files Images Hyperlinks Quicklinks Form 
Quicklinks

Add

Edit

View

Overwrite

Delete

Remove from 
server

Check links

Update URL
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set up load balancing outside of Ektron CMS400.NET, see ”Load 
Balancing” on page 980.

Load Balancing and Ektron CMS400.NET
Ektron CMS400.NET does not need to be aware that load 
balancing is taking place. However, the library items on all servers 
must be identical. Therefore, when a user uploads a new item to 
the Ektron CMS400.NET library, it must be replicated on all other 
servers in your load balancing model. To achieve this, Ektron 
CMS400.NET uploads the items to a default upload directory and 
any other folder defined in the library.

Ektron CMS400.NET provides an interface for adding load balance 
folders to the application. These folders needs to be either a virtual 
or physical folder under the Ektron CMS400.NET Web site. 
Typically, this is a virtual folder that points to another server.

NOTE See ”Configuring Load Balancing without Site Replication” on page 982 for more 
information about this feature.

Accessing Library Load Balancing Screen
To access the load balancing section in the library, follow these 
steps.

1. From the Ektron CMS400.NET Workarea, click the Library 
folder button.

2. Click the View Properties button ( ).

3. Click the View Load Balance Settings button ( ).

4. The View Library Load Balance Settings screen is displayed.
The screen’s columns are described in the following table.

Column Title Description

Web Path The path of the folder under your server’s Web site.

Type • Images - load balance folder for uploaded images.

• Files - load balance folder for uploaded files.
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Adding a New Load Balancing Folder
To add a new load balancing folder in the Ektron CMS400.NET 
library, follow these steps.

1. Access the view load balance settings screen, as described in 
”Accessing Library Load Balancing Screen” on page 179.

2. Click the Add button ( ) on View Library Load Balance 
Settings screen.

3. The Add a Library Load Balancing Path screen is displayed.

4. Use the following table to help you complete the form.

Relative An x indicates if the folder is relative to your Ektron CMS400.NET Web site.

Verified If the load balance folder exists in the proper location, a green check appears. A 
red x is displayed when the folder does not exist in the specified location.

Physical Path The physical location of the folder to which items will be uploaded.

Column Title Description

Field Description

Images/Files Specify if the load balance path folder will be for images or files.

Load Balance Path Enter the path of the folder.
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5. Click the Save button ( ).

Editing a Library Load Balance Path
If the Web path for a load balance folder has changed, you may 
edit it at any time. 

To edit a load balance path, follow these steps.

1. Access the View Library Load Balance Settings screen, as 
described in ”Accessing Library Load Balancing Screen” on 
page 179.

2. Click the Web Path of the load balance path you want to edit.
3. The Edit Library Load Balancing Path is displayed.
4. Make the necessary changes to the load balance path.

5. Click the Update button ( ).

Deleting a Library Load Balance Path
Library load balance paths that are no longer needed may easily 
be deleted. 

To delete a library load balance path, follow these steps.

1. Access the View Library Load Balance Settings screen, as 
described in ”Accessing Library Load Balancing Screen” on 
page 179.

2. Click the Remove ( ) button.
3. The Remove Library Load Balance Path is displayed.
4. Check off the box(es) of the load balance paths you want to 

delete.

5. Click the Remove button ( ) to delete the load balance path.

Make Relative If the folder (or virtual folder) resides under your Ektron CMS400.NET 
site root, check the box to make the path relative to that. Otherwise, 
remove the check.

Field Description
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6. A confirmation message is displayed.
7. Click OK.

If You Have an Ektron WebImageFX License Key...
If you purchased and inserted an Ektron WebImageFX license key 
into Ektron CMS400.NET, the images folder is enhanced 
automatically.

Since Ektron WebImageFX has a built-in thumbnail creator for 
images, each uploaded image in the library also has a thumbnail 
created for it, allowing you to locate uploaded images faster and 
easier.

Here is an example of the images folder for an Ektron 
CMS400.NET Web site with an Ektron WebImageFX license key.

NOTE For information about acquiring an Ektron WebImageFX license key for Ektron 
CMS400.NET, contact the Ektron Sales Department.

mailto:sales@ektron.com?subject=Looking for information about Ektron Web Image FX license key
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Working with Smart Forms

WARNING! Ektron CMS400.NET does not support the use of eWebEdit400 to create and 
edit Smart Form configurations. You must use eWebEditPro+XML. However, 
eWebEdit400 is the default editor for creating/editing content based on a Smart 
Form. 

Ektron CMS400.NET’s Smart Forms give you access to the power 
of XML by separating Web content from presentation. In addition to 
hiding the XML tags from users, Ektron CMS400.NET can serve 
content to various presentation devices (PDAs, mobile phones, 
WebTV), saving users from the tedium of creating duplicate 
content. Review and revision are drastically reduced because the 
accuracy and format of your Web content are managed using XML 
schema validation.

Using Smart Forms with Ektron CMS400.NET provides the 
following benefits:

• Strictly enforce content and page layout with Ektron's editor 
(Ektron eWebEditPro+XML), XSLT, and WYSIWYG templates 
for content contributors

• Deliver content to multiple devices (e.g., PDAs, mobile phones, 
WEB TV)

• Easily share content across B2B transactions

• Advanced XML authoring: Ektron's highly-acclaimed XML 
editor—Ektron eWebEditPro+XML—lets developers hide XML 
tags from content contributors and provides an easy-to-use 
WYSIWYG editing interface

The following are examples of industries that can benefit from XML 
Indexing.

Industry Use XML indexing to find

Health Care A cardiologist whose practice is located in 
your city
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Smart Forms are used in Ektron CMS400.NET to define the 
necessary files to display, save, and validate the content properly. 
This section explains how to take advantage of Ektron 
CMS400.NET’s Smart Forms.

See Also: 

• ”Benefits of Using XML Data” on page 184

• ”Before You Manage Smart Forms” on page 185

• ”Adding a New Smart Form” on page 187

• ”Assigning Smart Forms” on page 193

• ”Viewing Smart Forms” on page 193

• ”Editing Smart Forms” on page 198

• ”Creating Smart Forms Based on Existing Configurations” on 
page 201

• ”Viewing Data Designer XSLTs” on page 202

• ”Deleting Smart Form Configurations” on page 203

• ”XML Indexing” on page 205

Benefits of Using XML Data
This section explains why you should use XML as opposed to 
HTML content for your Web site. Because of XML’s advantages, 
Ektron recommends using XML content whenever possible. Below 
are several reasons why XML is the preferred format for managing 
content.

Human Resources Sick time policy

Real Estate A house with a zip code of 03031 priced 
under $200,000

Hospitality A hotel in Boston

Online Retail Fleece gloves for men

Educational A course in .NET programming

Industry Use XML indexing to find
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• Standardized format for capturing content
- You can create an XML Smart Form then require anyone 

creating content in a folder to use the form. The result is 
more uniform and consistent information.

- Within an XML Smart Form, you can require authors to 
complete fields in a specified format. So, for example, if you 
want the author to enter a date, XML can ensure that it’s 
captured in a standard format. Several standard formats 
are provided (email address, zip code), and you can create 
your own.

• Superior control over content display 

- Authors contribute XML content but have virtually no control 
over its format. The Web administrator determines the 
format through an XSLT file. By customizing the XSLT, you 
can exert maximum control over your Web site’s 
appearance.

- Since one file controls several (even hundreds of) pages, 
you can update just that file to efficiently change the look of 
all pages whose content is based on the Smart Form.

• Improved search capabilities
- Because XML data is captured in individual fields, you can 

focus a search on relevant fields. For example, if your XML 
content captures data about books, you can place an 
author search on your Web site. Since that search only 
looks through content in the Author field, it is much faster 
and returns more reliable results than a search of HTML 
content.

Before You Manage Smart Forms
You must define each Smart Form that will be used in your Web 
site. Each form is assigned to a content folder or content item and 
lets you specify how XML content appears in the editor, is 
validated, and is displayed in an output device.

There are two ways to create a Smart Form.

• Using external XML files

• Using the WYSIWYG Data Designer
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This section explains how to create and manage Smart Forms 
using both methods.

The Smart Form Toolbar
During the process of creating and managing Smart Forms, 
several toolbar buttons are available. The following table describes 
the buttons and their actions.

Accessing Smart Forms

NOTE Only members of the Administrators group or those defined in Manage Members 
for Role: Smart Forms Admin screen can create or edit Smart Forms. See Also: 
”Defining Roles” on page 735

To access the Smart Form section of the Workarea, follow these 
steps.

Button Name Description More Information

Add Smart 
Form

Create a new Smart Form from 
scratch or based on properties of an 
existing one

”Adding a New Smart Form” on 
page 187

Back Return to previous screen

Delete Delete a Smart Form ”Deleting Smart Form 
Configurations” on page 203

Edit Edit a Smart Form created with 
external files

”Editing Smart Forms” on 
page 198

Edit Data 
Design

Edit a Smart Form created with the 
Data Designer

”Editing Data Design Packages” 
on page 198

Save Save changes

Update Save and update changes

View XSLT Display the XSLT for a Smart Form ”Viewing Data Designer XSLTs” 
on page 202
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1. In the Workarea, go to Settings > Configuration > Smart 
Form Configuration.

2. The View Smart Forms screen is displayed.

From here, you can view, add, edit, and delete Smart Forms.

• See Also: ”Working with Smart Forms” on page 183

Adding a New Smart Form
When adding a new Smart Form, you have two options. The 
following sections explain both.

• ”Adding a Smart Form Using the Data Designer” on page 187 
(recommended)

• ”Adding a Smart Form Using External XML Files” on page 189 
(for example, XSLTs, schemas, etc.)

Note To create a new Smart Form by copying and editing an existing one, see 
”Creating Smart Forms Based on Existing Configurations” on page 201.

Adding a Smart Form Using the Data Designer
To add a Smart Form using the WYSIWYG Data Designer, follow 
these steps.

1. In the Workarea, go to Settings > Configuration > Smart 
Form Configuration.

2. Click the Add Smart Form button ( ).

3. The Add Smart Form screen is displayed.
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4. Enter a Title for the Smart Form.

5. Click the Save button ( ).
6. The Smart Form Data Designer screen appears.

NOTE Ektron CMS400.NET checks to see if eWebEditPro+XML is installed on your 
computer. If it is not, you are prompted to install it.

7. You may get the following error dialog.
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To learn about why the dialog is appearing and help decide 
whether to click Yes or No, click the link More information 
about Local Machine Lockdown. A Windows Help topic 
appears and explains your options.

8. If desired, you may specify a style sheet for the Smart Form. 
Use the field on the right above the editor.
To do so, either type the path and file name of the CSS file, or 
select an Ektron CMS400.NET-registered style sheet from the 
drop down list.

9. Design your XSLT in the Data Designer.
See ”Using the Data Designer” on page 211 for information 
about creating XSLTs using the Data Designer.

10. Click the Update button ( ).

You are ready to assign the Smart Form to a folder or content item. 
See ”Assigning Smart Forms” on page 193 for more information.

Adding a Smart Form Using External XML Files

WARNING! Release 7.5.2 and up of Ektron CMS400.NET supports two editors: 
eWebEditPro+XML and eWebEdit400. If you want users to insert Smart Form 
information using eWebEdit400, you cannot create or edit Smart Forms using 
external files. You must create and edit them using Ektron CMS400.NET’s Data 
Designer.

To add a Smart Form using external XML files, follow these steps.
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1. In the Workarea, go to Settings > Configuration > Smart 
Form Configuration.

2. Click the Add Smart Form button ( ).

3. The Add Smart Form screen is displayed.
4. Enter a Title for the Smart Form.

5. Click the Save button ( ).
6. The Smart Form Data Designer screen is displayed.

7. Click the Back arrow ( ) to exit.

8. The View Smart Form screen for the new Smart Form is 
displayed.

9. Click the Edit button ( ).

10. The Edit Smart Form screen is displayed.
11. Enter the necessary information using the following table as a 

reference.
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Smart Form Fields

NOTE When a Smart Form is created using the Data Designer, a default display XSLT is 
created which resembles the edit XSLT created in the editor. This default XSLT 
can be applied to the XML content.

Section Field Description

Generic Information Title Name given to Smart Form.

ID (display only) ID number assigned when configuration is 
created.

Description Detailed description given to configuration by 
its creator or last editor.

Editor Information Edit XSLT XSLT applied to content while being edited.

Save XSLT XSLT used to transform the XML when saved 
to the database.

Advanced Configuration XML file that contains display information, 
schema validation, and other advanced XML 
data.

Validation Information XML Schema The .xsd file used to validate the XML content

Target Namespace The default namespace used for outgoing 
XML

DIsplay Information XSLT1 XSLT 1 applied to XML data when viewed on 
a device

XSLT2 XSLT 2 applied to XML data when viewed on 
a device

XSLT3 XSLT 3 applied to XML data when viewed on 
a device

XSLT Packaged XSLT package applied to XML data when 
viewed on a device
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12. Specify the default display XSLT for the configuration by 
clicking the corresponding radio button.

13. Click the Save button ( ).

XML File Verification

A verification button ( ) appears to the right of some fields on the 
Add Smart Form screen. After you identify an XSLT or schema, 
you can click this button to verify that the file:

• exists in the location specified

• contains well-formed XML

NOTE The XML Verification feature does not validate the contents of the XML file.

The following table explains possible results when clicking the 
verification button.

Display Result Description

Verified The file passes all verification parameters

Not Verified The file either:

• Does not exist in the specified loca-
tion 

• Does not contain well-formed XML

Review current settings. Ensure the file is 
in the proper location, and that it contains 
well-formed XML
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Assigning Smart Forms
After you create a Smart Form, you can assign it to a folder’s 
Properties screen. (See Also: ”Smart Forms” on page 50) Content 
in the folder can then use the configuration.

A Smart Form can be inherited from a parent folder, or you can 
assign a different one.

Viewing Smart Forms
To view a Smart Form, follow these steps.

1. In the folder tree on the left side of the Workarea, go to 
Settings > Configuration > Smart Form Configuration.

2. Click the form you want to view.

.

The View Smart Forms screen appears with a more detailed 
description of the configuration.
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The View Smart Form screen has three tabs.

• ”Properties Tab” on page 195

• ”Display Information Tab” on page 198

• ”Preview Tab” on page 197

Each tab is explained below.

After viewing, you can perform the following actions on the Smart 
Form.

Smart Form Created with...

Data Designer External Files
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Properties Tab

If the Smart Form was created using external XML files (instead of 
the Data Designer), the following information also appears:

Button Name Description More Information

Configure Full 
Text Search

Edit search screen labels ”Editing Smart Forms” on 
page 198

Edit Edit a Smart Form ”Editing Smart Forms” on 
page 198

Edit Data 
Design

Open Data Designer ”Editing Data Design Packages” 
on page 198

Add Smart 
Form

Create a new Smart Form from 
scratch or based on an existing one

”Adding a New Smart Form” on 
page 187

View XSLT Display a Smart Form’s XSLT ”Viewing Data Designer XSLTs” 
on page 202

Delete Delete a Smart Form ”Deleting Smart Form 
Configurations” on page 203

Back Return to previous screen

View online help View online help ”Accessing Online Help” on 
page 484

Field Description

Title Name given to Smart Form.

ID ID number assigned by Ektron CMS400.NET upon 
creation of the configuration.

Description Detailed description of configuration given by creator or 
last editor.
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• ”Editor Information” on page 196

• ”Validation Information” on page 196

Editor Information

NOTE This section only appears if you do not use the Data Designer to create your 
Smart Form.

The editor information contains the file names of the XSLTs used 
when editing and adding content in the editor.

Validation Information

NOTE This section only appears if you do not use the Data Designer to create your 
Smart Form.

You can validate the content created and edited with Ektron 
CMS400.NET with a schema if desired. The validation information 
contains information about the schema.

Field Description

Edit XSLT XSLT applied to the content when being edited.

Note: If no edit XSLT is specified, the Edit Data 
Design option is enabled in the toolbar.

Save XSLT XSLT used to transform the XML created in the 
editor when the Smart Form is saved to the 
database.

Advanced 
Configuration

XML file that contains display information, schema 
validation, and other advanced XML data.
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Preview Tab
The Preview tab displays the XSLT applied to the editor when 
XML content is created. This is the XSLT that was created for the 
Smart Form.

Field Description

XML 
Schema

Specify the .xsd file used to validate the XML content 
that the Smart Form will be assigned to.

Target 
Namespace

Specify the default namespace used for outgoing XML.
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Display Information Tab
The display information tab lists the XSLTs that are used when 
displaying XML in the respective environment.

NOTE When a Smart Form is created using the Data Designer, a default display XSLT is 
also created which looks similar to the edit XSLT created in the editor. This default 
XSLT can be applied to the XML content.

The asterisk (*) denotes the default XSLT for the Smart Form.

The tab also displays the Smart Form’s xpaths.

Editing Smart Forms
After creating a Smart Form, you can modify it when files defined in 
the configuration have changed.

Since there are two ways to create a Smart Form, there are two 
ways to edit one.

• ”Editing Data Design Packages” on page 198

• ”Editing a Smart Form Created with External Files” on 
page 200

Editing Data Design Packages
After you create a Smart Form, you can modify it.

Field Description

XSLT1 Display XSLT 1

XSLT2 Display XSLT 2

XSLT3 Display XSLT 3

XSLT 
Package

Display XSLT Package (created 
using the Data Designer)
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Before You Edit the Data Package!

Before editing a Smart Form data package, it is important to 
understand the effects of the modifications. If an XML data 
package is edited, all content to which the configuration is applied 
is updated. Information that was originally created may be lost, 
depending on the changes you make to the package.

To ensure that information is not lost, use the Create New Smart 
Form Based on Existing Smart Form option on the view Smart 
Form screen. See ”Creating Smart Forms Based on Existing 
Configurations” on page 201 for more information.

Editing a Data Design Package

To edit a data design package, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart 
Form Configuration.

2. Click the Smart Form configuration you want to edit.
3. The View Smart Form screen appears with a more detailed 

description of the configuration.

4. Click the Data Design Mode button ( ) at the top of the 
screen.
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5. The Edit Data Design Package screen displays the current 
package.

6. Make the necessary changes to the Data Design package in 
the editor. See ”Using the Data Designer” on page 211 for 
information about creating XSLTs using the Data Designer.

7. Click the Update button ( ).

Editing a Smart Form Created with External Files

WARNING! Release 7.5.2 and up of Ektron CMS400.NET supports two editors: 
eWebEditPro+XML and eWebEdit400. If you want users to insert Smart From 
information using eWebEdit400, you cannot create or edit Smart Forms using 
external files. You must create and edit them using Ektron CMS400.NET’s Data 
Designer.

1. In the Workarea, go to Settings > Configuration > Smart 
Form Configuration.

2. Click the Smart Form configuration you want to edit.
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3. The View Smart Form screen is displayed.

4. Click the Edit button ( ).
5. The Edit Smart Form screen is displayed.
6. Edit the necessary fields to update the Smart Form. See 

”Smart Form Fields” on page 191.

7. Click the Update button ( ).
Now, all content and folders that use the Smart Form take their 
properties from the updated configuration.

See Also: ”XML File Verification” on page 192

Creating Smart Forms Based on Existing 
Configurations

Whenever major changes must be made to a Smart Form, Ektron 
recommends making a copy of it and modifying the copy. In this 
way, you do not affect the content controlled by the original 
configuration.

To create a new Smart Form based on an existing one, follow 
these steps.

1. In the Workarea, go to Settings > Configuration > Smart 
Form Configuration.

2. Click the Smart Form configuration you want to view.
3. The View Smart Form screen appears with a more detailed 

description of the configuration.

4. Click the Create New Smart Form button ( ).
5. The Add Smart Form screen is displayed.
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6. Enter a Title for the new Smart Form.

7. Click the Add Smart Form button ( ).
8. The View Smart Form screen for the new Smart Form is 

displayed. From here, you can perform the necessary actions 
on it.

Viewing Data Designer XSLTs
When a Smart Form is created using the Data Designer, an XSLT 
is produced to assist you with creating your display XSLT. This 
XSLT includes the structure for your XML documents.

If a display XSLT is not applied to a Smart Form, content is 
displayed using the default XSLT displayed in the View XSLT 
screen.

To view the XSLT for a Smart Form, follow these steps.

1. In the folder tree on the left side of the Workarea, go to 
Settings > Configuration > Smart Form Configuration.

2. Click the Smart Form configuration whose XSLT you want to 
view.

NOTE The XSLT only appears if the Smart Form was created using the Data Designer.
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3. The View Smart Form screen appears with a more detailed 
description of the configuration.

4. Click the View XSLT button ( ).

5. The View XSLT screen is displayed.

You can use this information to create your display XSLT.

Deleting Smart Form Configurations
You can delete Smart Form configurations that are no longer 
needed. To do so, follow these steps.

NOTE If any Smart Form that uses this configuration has one or more indexed fields, you 
must delete all content that uses the configuration before you can delete it. See 
Also: ”Specifying Which XML Elements are Indexed” on page 208

1. In the Workarea, go to Settings > Configuration > Smart 
Form Configuration.

2. Click the Smart Form configuration you want to delete.
3. The View Smart Form screen is displayed.

4. Click the Delete button ( ). 

5. A confirmation message is displayed.
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6. Click OK.
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XML Indexing

XML Indexing lets site visitors search XML information collected 
via Smart Forms and view the results. The results appear as a list 
of topic titles, optionally followed by the content summary.

The Data Designer lets you choose which XML fields to index. You 
can also validate those fields to be numbers, dates, Boolean, or 
string values. After you identify fields to be indexed, a search 
dialog is created. Where appropriate, the dialog automatically 
populates drop down lists from the indexed data.

NOTE As the name implies, XML indexing is only available for information collected on 
XML Smart Forms. It cannot find information in XHTML content.

See Also: 

• ”User vs. Developer Selected Search Criteria” on page 205

• ”Types of Search Criteria” on page 206

• ”Setting up a User-Defined Search” on page 207

• ”Setting up a Developer-Defined Search” on page 207

• ”Specifying Which XML Elements are Indexed” on page 208

• ”Search Dialog Setup” on page 209

• If you are upgrading from an earlier version of Ektron 
CMS400.NET to 7.5, the Knowledge Base article “INFO: 7.5 
Upgrade: Changes to 7.5 XML Index Search” lists upgrade 
considerations.

User vs. Developer Selected Search Criteria
There are two ways that XML Indexing can make XML content 
available to your site visitors.

http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
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• Present a screen of search criteria. A site visitor uses the 
screen to select the kind of information he is looking for. For 
example, your site sells outdoor clothing, and a user searches 
for wool hats under $20.00.

• Determine the search and display criteria programmatically 
using a custom function. Your Web developer inserts a control 
that specifies search and display criteria. For example, your 
site sells books. A site visitor sees a navigation link Find 
books under $5.00. When he clicks that link, the control 
searches your XML content and returns all books whose price 
is less than $5.00.

NOTE The Ektron Windows Service manages the background processing that creates 
XML indexes. See Also: ”Ektron Windows Service” on page 969.

NOTE Ektron CMS400.NET content has a Content Searchable check box, which is 
checked by default. It must be checked if you want the Index Search to find Smart 
Form content. See Also: ”The Content Searchable Field” on page 417

Types of Search Criteria
XML Indexing allows multi-dimensional searches on all types of 
XML data.

For every search field, NoSelection is a value. If this is chosen, 
the search disregards that field when compiling results. However, 

Data Type XML Index Search can 

Plain text Use an exact phrase, or any word or letter in a phrase

Numerical and date 
information

Use expressions such as greater than, less than, or between two 
values

List and choice fields Display the field values and let the user select relevant ones

Image Only Use the alt or src attribute value

Link Use the text or href attribute value
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the user must select a value (or range of values) in at least one 
field to get results.

WARNING! Do not insert a calendar field into a Smart Form that allows multiple entries (using 
the Allow more than One option on the dialog). If you do, you cannot search the 
Smart Form using that field.

WARNING! In order for Smart Form fields to searchable, they must be stored as elements not 
attributes. See Also: ”Advanced Button” on page 284 If you are upgrading to 
version 7.5, inspect your Smart Forms and change field properties as needed so 
they are stored as elements not attributes.

Setting up a User-Defined Search
To create a user-defined search, follow these steps.

Setting up a Developer-Defined Search
To set up a developer-defined search, which defines both the 
criteria and the results page, use the SearchParmXML property of 
IndexSearch Server Control. For more Information, see the Ektron 
CMS400.NET Developer’s manual section “Ektron CMS400.NET 
Server Controls” > “List of Server Controls” > “IndexSearch Server 
Control.”

Step For more information, see

1. Select a Smart Form ”Accessing Smart Forms” on page 186

2. Assign indexing to each field to be 
searched

”Specifying Which XML Elements are Indexed” on 
page 208

3. Set up the search screen ”Search Dialog Setup” on page 209

4. Have your Web developer set up a 
page that displays a search control 
and a results control

Ektron CMS400.NET  Developer’s Manual section 
“Introduction to Ektron CMS400.NET  Server Controls” 
> “IndexSearch Server Control”
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Specifying Which XML Elements are Indexed
You can index the following types of fields:

• Checkbox

• Plain Text

• Choices

• List

• Calculated

• Image Only

• Link

• Calendar

WARNING! Do not insert a calendar field into a Smart Form that allows multiple entries (using 
the Allow more than One option on the dialog). If you do, you cannot search the 
Smart Form using that field.

To enable indexing for any field on an XML Smart Form 
configuration, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Smart Form Configuration.

2. Select a Smart Form configuration that you want to index. See 
Also: ”Accessing Smart Forms” on page 186

3. Open its Data Design. See Also: ”Using the Data Designer” on 
page 211

4. Move the cursor to the first field you want to index.
5. Right mouse click the field.
6. Choose Field Properties.
7. A dialog box appears.
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8. Check Indexed.
9. Repeat these steps for every field by which you want site 

visitors to search the Smart Form.

Validation
Validation ensures that the user completing an XML form enters 
the right type of data. You can decide if the user’s input should be a 
number, boolean, date, string, zip code, etc. If you do not specify 
type attributes using validation data, the field is a string. See Also: 
”Validation” on page 248

Validation is especially important when users search XML data, 
because it helps the search find the correct information. For 
example, if a field collects a zip code but you set its type to plain 
text, a user completing the form can insert anything into the field. If 
the user inserts the letter “o” instead of the number zero (0), the 
field accepts that input but the search will not find that record. On 
the other hand, if you set validation to zip code, the user can only 
insert five or nine digits -- any other entry is rejected.

Search Dialog Setup
When you save a Data Design form, a dialog appears that lets you 
view all and modify indexed fields (illustrated below).
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The information on this screen is explained below.

Screen 
section

Description

Xpath The xpath to each indexed field.

Label The index field’s field name, as defined on its dialog.

Multiple Check this box if you want to allow the user performing the search to select more than 
one value. This checkbox only appears with List and Choice fields.

Note: To select more than one value on the search screen, the user holds down the 
<Ctrl> key while selecting additional options.
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Using the Data Designer

WARNING! The functionality described in this section is not supported when using the 
eWebEdit400 editor for editing content.

Introduction
eWebEditPro+XML’s Data Designer feature lets you design a 
screen that collects information from users and stores it as XML 
data. Creating the screen is simple and requires no knowledge of 
XML.

NOTE When using the Data Designer feature, the following browsers are supported: 
Netscape 6.2 or later; Internet Explorer 5.5 or later.

For example, you may create the following screen.

This screen can store information entered by a user as the 
following XML.

<address>
<street>123 Sesame St.</street>
<city>New York</city>
<state>NY</state>
</address>
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Note that the street and city fields accept text, while the state field 
accepts a pre-defined value (a state).

NOTE The samples installed with eWebEditPro+XML provide a good example of 
using the Data Designer. To try them out, click the Windows Start button (lower left 
corner of the screen) and follow this path: Start > Programs > Ektron > 
ewebeditpro5 > Samples > ASP > Data Design > ASP Data Design Sample. 

This section explains how to use the Data Designer feature 
through the following topics.

• ”Differences in eWebEditPro+XML” on page 212

• ”Design Mode vs. Data Entry Mode” on page 214

• ”Designing a Screen” on page 214

• ”Inserting a Field Type” on page 216

• ”Sample Screen Design” on page 220

• ”Data Designer Field Types” on page 229

Differences in eWebEditPro+XML
When you use the Data Designer, eWebEditPro+XML changes in 
the following ways.

NOTE The design toolbar and the design mode and Data Entry mode buttons appear 
only if your site administrator has defined them in the configuration data.

• two toolbars appear, illustrated below. The toolbar buttons let 
you design the data entry screen. Each button represents a 
different kind of field.
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Both toolbars provide mostly the same buttons. The major 
difference between them is how you use the button to add a 
field to the screen. If you are using the horizontal toolbar, place 
the cursor where you want field, and click the toolbar button.
When using the drag and drop toolbar, drag a button to desired 
screen location.
Note that a context-sensitive menu, available by right clicking 
the mouse, is also available to perform the commands. You 
can right click the mouse then select Insert Field to display a 
context-sensitive menu of all commands. To edit the properties 
of any field already on the screen, select the field, right click the 
mouse, and select Field Properties.

• two buttons appear on the regular (Edit) toolbar: Design mode 
and Data Entry mode. (For more information, see ”Design 
Mode vs. Data Entry Mode” on page 214.)

The Data Entry mode button lets you preview the screen being 
created.

• several toolbar buttons are grayed out -- they do not work with 
Data Designer
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Design Mode vs. Data Entry Mode
The Data Designer feature supplies two “modes,” which make it 
easier for you to design screens:

• Data Design mode - lets you insert and remove fields from the 
data entry screen

• Data Entry mode - simulates the screen’s appearance during 
data entry

Two toolbar buttons let you switch between modes. The buttons 
are located on the Edit toolbar.

When you begin to create a data entry screen, you are in design 
mode. To view the screen as the user will see it, click the Data 
Entry button ( ). To switch back to Data Entry mode and modify 
the screen, click the Data Designer button ( ).

Designing a Screen
To design a screen that captures XML data, you

1. Ask your system administrator to enable a version of 
eWebEditPro+XML that includes the Data Designer. (The 
administrator should refer to the Data Designer chapter of the 
Developer’s Reference Guide.)

2. For each field on the screen, select a field type, and place it on 
the screen. ”Inserting a Field Type” on page 216 explains the 
kind of field that each button represents.
You can also use eWebEditPro+XML’s rich formatting 
capabilities to design the screen. For example, you can format 
text, and use tables, images and hyperlinks to guide the user 
through the data entry process. Below is a sample screen 
created with the Data Designer.
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If you are familiar with XML and want to manually edit the page, 

use the View Source button ( ) to edit the page’s source code. If 
the edited source XML is not well-formed, you are notified and 
must remain in source view until you fix it.
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Inserting a Field Type
eWebEditPro+XML provides several options that let you insert or 
edit fields in the editor. Each field type is described below.

Field type Icon Description For more information, see

Group Box Groups related fields, which can be 
surrounded by a box and have a caption

”Group Box” on page 230

Tabular Same as group box, but fields can be 
presented in a table format

”Tabular Data” on page 234

Checkbox
 

User’s response is either checked or 
unchecked

”Checkbox” on page 243

Plain Text Free text field; user cannot format text ”Plain Text” on page 244

Rich Area Free text field; user can format text using 
the editor

”Rich Area” on page 249

Choices Several choices appear on screen. User 
checks appropriate boxes. All user 
choices are inserted as values within 
single XML tag.

”Choices” on page 251

List Same as Choices except options appear 
in a drop-down box

”Select List” on page 255

Calculated Performs calculations using other fields 
on the screen

”Calculated Field” on page 262

Calendar Lets user insert a date by clicking a 
calendar

”Calendar Field” on page 271

Image Only Lets user insert an image ”Image Only Field” on page 278

File Link Lets user insert a link to a file, such as a 
PDF document

”File Link Field” on page 280
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Deleting a Field from the Screen
To remove a field from the screen, follow these steps.

1. Move the cursor to the field.
2. When the cursor changes to a four-headed arrow, click the 

mouse.
3. Small boxes surround the field. 

4. Click the cut icon ( ) to remove the field.
Usually, the field label is not deleted when you delete a field. To 
delete the label, use standard eWebEditPro+XML editing buttons.

Previewing the Screen
If you want to view how the screen will appear to the person who 
will complete the screen, click the View Data Entry button ( ). 
(See Also:  ”Design Mode vs. Data Entry Mode” on page 214.)

If you want to see an internal representation of the Data Design, 
click the Preview button ( ). Next to the Preview button is a drop-
down list of internal formats in which you can view the data design.

Field 
Properties

Lets you change the properties of any 
field. Select the field then click this 
button.

Note: This option is also available on the 
right click menu, but not available on the 
drag and drop toolbar

Validate Ensure the screen contains valid XML.
This button is available in both data entry 
and data design modes. 

Field type Icon Description For more information, see
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 The formats are described below.

Format Description Example

Data as XML The XML data document <?xml version="1.0" ?> 
- <root>
- <Information>
  <LastName /> 
  <FirstName /> 
  <MiddleName /> 
  <Gender>male</Gender> 
  <Address /> 
  <city /> 
  <state>MA</state> 
  <Zip /> 
  <SSN /> 
  <BDate /> 
  <HomeTel /> 
  <WorkTel /> 
  <x-ray /> 
- <Dental_Insurance>
  <Field1 /> 
  <OtherInsurance>N/A</OtherInsurance> 
  <Account_Number>N/A</Account_Number> 
  </Dental_Insurance>
  <medication /> 
  <lastAppointment /> 
  <clincal /> 
  </Information>
  </root>
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Schema Defines the structure, content, 
and semantics of an XML 
document

<?xml version="1.0" ?> 

- <xs:schema elementFormDefault="qualified" 
attributeFormDefault="unqualified" 
xmlns:xs="http://www.w3.org/2001/XMLSchema">

- <xs:element name="root">

- <xs:complexType>

- <xs:sequence>

- <xs:element name="Information">

- <xs:complexType>

- <xs:sequence>

- <xs:element name="LastName">

- <xs:simpleType>

- <xs:restriction base="xs:string">

  <xs:minLength xmlns:xs="http://www.w3.org/
2001/XMLSchema" value="1" /> 

  </xs:restriction>

  </xs:simpleType>

  </xs:element>

- <xs:element name="FirstName">

- <xs:simpleType>

- <xs:restriction base="xs:string">. .. ..

Field List A list of all fields and information 
about them (as XML)

<fieldlist>

  <field name="LastName" datatype="string" 
basetype="text" xpath="/root/Information/
LastName" title="Last Name">Last Name</field> 

  <field name="FirstName" datatype="string" 
basetype="text" xpath="/root/Information/
FirstName" title="First Name">First Name</
field> 

  <field name="MiddleName" datatype="string" 
basetype="text" xpath="/root/Information/
MiddleName" title="Middle Name">Middle Name</
field> 

  <field name="Gender" datatype="choice" 
basetype="text" xpath="/root/Information/
Gender" title="" datalist="IDAPK3KC">Gender</
field> . .. .. ..

Index xpath information for any 
indexed field on the screen

<?xml version="1.0" ?> 

- <indexable>

  <xpath type="string">/root/Information/SSN</
xpath> 

  <xpath type="string">/root/Information/
HomeTel</xpath> 

  <xpath>/root/Information/WorkTel</xpath> 

  </indexable>

Format Description Example
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Sample Screen Design
This section provides a brief overview of designing a screen, so 
that you can learn how the pieces fit together. Let’s assume you 
want the screen to look like this.

XSLT The Data Design document’s 
presentation XSLT

<?xml version="1.0" ?> 

- <xsl:stylesheet version="1.0" 
xmlns:xsl="http://www.w3.org/1999/XSL/
Transform">

  <xsl:output method="xml" version="1.0" omit-
xml-declaration="yes" indent="yes" 
encoding="utf-8" /> 

  <xsl:strip-space elements="*" /> 

  <xsl:variable name="ektdesignns_fieldlist" 
select="/*/ektdesignpackage_list/fieldlist" /> 

- <xsl:template match="/" 
xml:space="preserve">

  

    <p> </p> 

  

- <fieldset id="Information" 
title="Demographic Information">

  

  <legend>Patient Information</legend> 

  

- <div>

  

- <p>

    

  <strong>Last Name</strong> 

  

  <xsl:text> </xsl:text> 

  

  <xsl:value-of select="/root/Information/
LastName" /> 

    

  <strong>First Name</strong> 

  

  <xsl:text> </xsl:text> 

 
  <xsl:value-of select="/root/Information/
FirstName" /> .. .. ... ..

Format Description Example
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NOTE The following example helps you understand how to create a simple data entry 
screen. It does not explain how to save a screen so that a user can enter data into 
it. When you are ready to create an screen, ask your system administrator to help 
determine a method for saving it and making it available to users for data entry.

To create such a screen, follow these steps.

1. Sign on to eWebEditPro+XML in Data Designer mode. (Ask 
your system administrator how to do this. The Developer’s 
Reference Guide (version 4.0 and higher) provides details.)

2. Since you want to surround the data entry fields with a box and 

a caption, drag the Group Box button ( ) from the drag and 
drop toolbar onto the screen. Then, complete the dialog as 
shown below.
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NOTE Later, each field on the dialog is documented. Since this section provides an 
overview, it does not delve into those details.

At this point, the screen looks like this.
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3. Select Address then apply bold and the custom color shown 
above. Now the screen looks like this.

4. The next field, street, should let the user enter text. So, drag 

the plain text field icon ( ) into the space below Address. 
Then, complete the dialog as shown below. 
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Now, the screen looks like this.
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Note that the Street field is not wide enough. To widen it, click 
the field, move the cursor until you see a two-sided arrow, and 
drag the arrow to the right.

5. The next field, City, should also let the user enter text. Assume 
that you want City to appear in the line below Street. To make 
room for City, move the cursor to the end of the Street field 
and press <Enter> to create a new line. Next, drag the plain 

text field icon ( ) into the line below Street. Then, complete 
the dialog as shown below. 
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Now, the screen looks like this.
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6. The next field, State, should let the user choose from several 
states. Assume that you want the state to appear to the right of 
City. Move the cursor to the end of the City field and drag the 

Select List Field field icon ( ) into that space. Then, 
complete the dialog as shown below.
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Now, the screen looks like this.
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The above example is very simple and does not use the Data 
Designer’s more powerful and flexible features. To learn more 
about Data Designer, read the rest of this chapter.

Data Designer Field Types
To help you use all of the Data Designer’s capabilities, this section 
explains each field type you can insert. They are very flexible and 
can accommodate all of your needs when designing a data entry 
screen.

The Data Designer supports the following field types.

• ”Group Box” on page 230

• ”Tabular Data” on page 234

• ”Checkbox” on page 243

• ”Plain Text” on page 244

• ”Rich Area” on page 249

• ”Choices” on page 251

• ”Select List” on page 255

• ”Calculated Field” on page 262

• ”Calendar Field” on page 271

• ”Image Only Field” on page 278
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• ”File Link Field” on page 280

Group Box 
A Group Box field lets you group related fields together on a 
screen by surrounding them with a box and optionally placing a 
caption above them.

After you insert a Group Box field, to insert other kinds of fields 
within the box, 

• drag the fields into the box (if you are using the drag and drop 
toolbar)

or

• place the cursor inside the box then select a field type button (if 
you are using the horizontal toolbar)

NOTE The tabular data field type might better accommodate your needs. See ”Tabular 
Data” on page 234.

Advantages of Grouping Fields

One advantage of grouping fields is that you can allow the user in 
Data Entry mode to add another instance of a group.

For example, if a screen collects several fields of information about 
each telephone call, the user could simply click the Insert Below 
button to insert a new group of fields, ready to collect information 
about the next call.
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Another advantage of grouping fields is that you can suppress a 
group of irrelevant fields. For example, if a screen includes two 
groups of fields that collect information about hardcover and 
paperback books, and you are adding information about a 
hardcover book, you can collapse the paperback book questions 
because they are not relevant to your current task.

Use the eyeglass icon to expand or collapse the display of fields 
within a group.

Expanded Group Field with glasses icon highlighted

Collapsed Group Field
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Dialog Box

Fields on the Group Box Dialog

Field Description

Descriptive 
Name

Enter the name of this field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;'”{}[]\|`~) into this field.
Internally, the name is used as the field’s caption.
The Name Field’s Default Value
By default, the Data Designer assigns a name made up 
of Field followed by the next available number. So, the 
first field’s default name is Field1, the second field’s 
default name is Field2, etc. You can change the default 
if you want.

Field Name Enter the field’s element name. This defines the field in 
the XML.
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Using a Tag Other Than <Root>

By default, Ektron CMS400.NET surrounds your Data Design with 
<root> tags. If you would like to replace the <Root> tags with 
another element name, follow these steps.

1. After creating a new Data Design screen, insert a Group Box 
as the first field.

2. In the Group Box Dialog’s Field Name field, enter the root text.
3. On the Group Box Dialog box, click the Advanced button.
4. In the Root tag section of that dialog, select Use this element 

as the Root tag and press OK.

Advanced See ”Advanced Button” on page 284

Use See ”The Use Field” on page 288

Allow See ”The Allow Field” on page 289

Appearance Click Show border and caption if you want to surround 
the fields in this group with a box. You can also create a 
caption to appear in the top line of the box.
Click No border if you do not want to surround the fields 
in this group with a box.

Caption If desired, enter text to describe this group of fields on 
the data entry screen. For example:

After you insert this field onto the screen, you can use 
eWebEditPro+XML ’s formatting capabilities to modify 
its size, font, color, and other attributes.

Note: The Caption field only appears on this dialog 
when you create the Group Box field. If you later try to 
edit the field, the Caption field is not on the dialog. 
However, you can edit Caption text within the editor.

Field Description
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5. Place all other screen elements within the Group Box field.

Tabular Data 
The Tabular data button inserts a table into which you can place 
other types of fields. It’s similar to a group box.

Tabular data’s main advantage over a group box is that it lets you 
place fields in columns (see below).
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NOTE ”Group Box” on page 230 describes many features that also apply to tabular data. 
Read that section to gain a full understanding of working with tabular data.

Creating a Table

First you insert the table. Then, you insert an appropriate type of 
field into each column. As examples, in the table above, the 
Description field type would be plain text, while the In Stock? field 
type would be choices.

If you insert a field into a table and its caption appears to the left of 
the data entry region (see below), move the caption to the column 
header (see second illustration below).
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To access table commands (such as add row and add column), 
place the cursor inside a table cell, right click the mouse, and 
select Table.

IMPORTANT! Only table cells into which you place a field are available to visitors of your Web 
page.

Editing Tabular Data

To edit tabular data, hover the cursor over a table border line until 
you see a four-headed arrow. Then, click the right mouse button 
and select Field Properties.

NOTE You cannot reduce the number of columns by editing the Tabular Data dialog’s 
Columns field. To delete a column, place the cursor in the column and select 
Delete Column from the table commands. The table commands are available in 
the table drop-down menu, the table toolbar (which is hidden by default), or the 
right-click context menu.

How Tabular Data Forms XML Structure

Tabular data creates three levels of XML tags:

• inner level: each field in the table

• middle level: each row in the table

• outer level: the entire set of table data

To explain how this works, we’ll use the following contact list as an 
example.

How XML Tags are Assigned to Field Names

Name Phone Email

John Doe 555-1212 john.doe@example.com

Mary Smith 555-8765 msmith@example.net
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When you insert a field into a table, a dialog helps you define the 
field type. For example, when inserting a plain text field, the Plain 
Text Field dialog appears. On that dialog, the value of the Phone 
field defines the tags that enclose that field’s contents.

To continue our example, every contact is represented in XML as:

<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>

and

<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>

How XML Tags are Assigned to Table Rows

Each row of the table collects information for one contact. On the 
Tabular Data Box dialog, the Row Name field defines the XML tag 
that groups information for each contact. For example, the Row 
Name field value is Contact.



Using the Data Designer

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 238

<Contact>
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>

</Contact>
<Contact>

<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>

</Contact>

How XML Tags are Assigned to the Entire Table

When you create a table, the name you give it (in the Name field of 
the Tabular Data Box dialog) defines the XML tag that groups all 
contacts on the table. In this example, the name is AddressBook.
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<AddressBook>
<Contact>

 <Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>

</Contact>
<Contact>

<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>

</Contact>
</AddressBook>
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Dialog Box
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Fields on the Tabular Data Dialog

Field Description

Descriptive 
Name

Enter the name of this table.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;'”{}[]\|`~) into this field.
The Name Field’s Default Value
By default, the Data Designer assigns a name made up 
of Field followed by the next available number. So, the 
first field’s default name is Field1, the second field’s 
default name is Field2, etc. You can change the default 
if you want.

Field Name Enter the table’s element name. This will define the table 
in the XML. See Also: ”How Tabular Data Forms XML 
Structure” on page 236

Tool Tip Text Enter the text that appears when a user hovers the 
cursor over the table’s column headers.

Advanced See ”Advanced Button” on page 284

Use See ”The Use Field” on page 288

Allow See ”The Allow Field” on page 289

Note: If you check More than one here, you are 
allowing the user to insert an entirely new table, not an 
additional table row.

Rows

Row display 
name

Enter the text that appears when a user hovers the 
cursor over the table’s cells. Use this field to describe 
the kind of information to be inserted into the table’s 
cells.
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Row name Enter the name of the XML tag used to collect data for 
each entry in the table.
See Also: ”How Tabular Data Forms XML Structure” on 
page 236

Minimum 
number

If desired, enter the minimum number of rows for this 
table.
If you enter a number and the data entry user tries to 
save the screen without inserting at least the minimum 
number of rows, he is informed that Element content is 
incomplete according to the DTD/Schema. 
By default, the user is allowed to cancel or save the 
screen anyway. However, the system administrator 
determines whether or not the user can save an invalid 
document.

Maximum 
number

If desired, enter the maximum number of rows for this 
table. If you don’t want to assign a maximum number, 
check the Unlimited check box.
Result of Assigning a Maximum
When this table appears on a data entry screen, and a 
user adds the maximum number of rows, the Insert 
Above and Insert Below options are grayed out on the 
menu (see example below).

Columns Enter the number of columns to appear in the table.
See Also: ”Editing Tabular Data” on page 236

Field Description
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Checkbox 
A Checkbox field is only one character wide and accepts one of 
two possible values: checked or unchecked. For example

Dialog Box

Caption If desired, enter text to describe this table on the data 
entry screen. The caption appears centered above the 
table.
After you insert this field onto the screen, you can use 
eWebEditPro+XML ’s formatting capabilities to modify 
the caption’s size, font, color, and other attributes.

Field Description
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Fields on the Checkbox Dialog

Plain Text 
Use a plain text field when you want the user to enter an 
unformatted, free text response.

Field Description

Descriptive 
Name

Enter text to guide the user’s response to this field. To 
continue the above example, the caption would be 
Check if you are over 65.
After you insert this field onto the screen, the Descriptive 
Name appears to the right of the checkbox. You can use 
eWebEditPro+XML ’s formatting capabilities to modify 
its size, font, color, and other attributes.

Note: The Descriptive Name field only appears on this 
dialog when you create the Check Box field. If you later 
try to edit the field, it is not on the dialog. However, you 
can edit the Descriptive Name text within the editor.

Indexed Check if you want to index this field. For more 
information, see ”XML Indexing” on page 205
The Indexed field may not appear, depending on how 
your administrator set up your system.

Field Name Enter the field’s element name. This will define the field 
in the XML.

Advanced See ”Advanced Button” on page 284

Tool Tip Text Enter text that appears when a user hovers the cursor 
over this field (circled in red below).

Default 
value

If you want this field to be checked when the screen first 
appears, click True.
Otherwise, click False.
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NOTE If a plain text field tries to perform a numerical calculation with a value that is blank 
or contains letters, NaN appears in the field. (NaN stands for “not a number.”) If a 
plain text field tries to divide by zero, Infinity appears.

Plain Text Field vs. Rich Area Field

The following capabilities are available with a plain text field but not 
a rich area field.

• You can adjust the field’s width by dragging it. See ”Resizing a 
Plain Text Field” on page 249.

• The text can be read-only or hidden

The following capability is available with a rich area field but not a 
plain text field.

• In Data Entry mode, the user can change the text’s format, 
size, style, etc. along with adding hyperlinks, using 
eWebEditPro+XML’s formatting capabilities.

• You can enter custom tags.
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Dialog Box

Fields on the Plain Text Dialog

Field Description

Descriptive 
Name

Enter the name of this field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 232
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Indexed Check if you want to index this field. For more information, 
see ”XML Indexing” on page 205.
The Indexed field may not appear, depending on how your 
administrator set up your system.

Field Name Enter the field’s element name. This defines the field in the 
XML.

Advanced See ”Advanced Button” on page 284

Tool Tip Text Enter the text that appears when a user hovers the cursor 
over this field.

Default 
Value

If you want to set a default value for this field, enter that 
value here. The default value appears in Data Entry mode, 
where the user can accept, change, or delete it.
For example, if this field collects a city, and most users 
enter New York, enter New York as the value.

Use See ”The Use Field” on page 288

Allow See ”The Allow Field” on page 289

Options Invisible - Check here to make this field hidden in Data 
Entry mode.
This option lets you store unseen information in each XML 
document. An example might be putting a version number 
for the data design so that XML documents can be 
upgraded to newer versions using an XSL transform.
Allow multiple lines - Check here to let this text box 
expand to accommodate the user’s input. 
If you do not check this box, a single line input box appears 
on the data entry screen to accept user input.

Note: A field can be either invisible or cannot be changed -- 
it cannot be both.

Cannot be changed - Check here to make this field read-
only. That is, the user cannot insert data into it in Data Entry 
mode.
You might use this option to provide instructions for 
completing the screen.

Field Description
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Validation Select the kind of validation to apply to this field. Your 
choices are:

• No validation - the user’s response is not checked

• Cannot be blank - the user must enter a response

• Non-negative whole number or blank - the user 
must enter a positive whole number or no response

• Non-negative whole number (required) - the user 
must enter a positive whole number

• Decimal number or blank - must be a decimal num-
ber (for example, 12.345 or 12) or blank . A leading 
minus sign "-" is allowed. The decimal point must be a 
period (.), even in locales that normally use a comma 
(,).

Note: Decimal numbers include whole numbers because 
the decimal point is implied. That is, 12 is 12.0000.

• Decimal number required - must be a decimal num-
ber (it cannot be blank) of none, one, or two decimal 
places.
A leading minus sign "-" is allowed. The decimal point 
must be period (.), even in locales that normally use a 
comma (,).

• Percent: (0-100) required - the user must enter a 
whole number from 0 to 100

• Zip code (US only) - the user’s response must consist 
of 5 (nnnnn) or 9 digits separated by a dash after the 
fifth (nnnnn-nnnn)

• Social Security number (US only) - the user’s 
response must consist of nine digits in this pattern: 
nnn-nn-nnnn

• Custom - You can create custom validation. 

For more information, see ”Custom Validation” on 
page 291.
If you assign to this field any value other than No 
validation, the field is initially surrounded by red dashes in 
Data Entry mode. If the user’s response does not meet the 
validation criterion, the field remains surrounded by red 
dashes. The system administrator determines whether or 
not the user can save an invalid document.

Field Description
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Resizing a Plain Text Field

If you insert a plain text field and its width is too small or too large, 
you can easily resize it. To do so, follow these steps.

1. Place the cursor over the field and click. The cursor changes to 
a four-headed arrow, and small boxes surround the field.

2. Move the cursor to the far right of the field. (See illustration 
below). The cursor turns into a two-headed arrow.

3. Drag the arrow to adjust the width.

Rich Area 
Use a rich area field to let a user enter a free text response that 
can be formatted using the editor buttons.

See Also: ”Plain Text Field vs. Rich Area Field” on page 245

Adjusting the Width of a Rich Area Field

Note that, unlike a plain text field, the width of a rich area field 
cannot be adjusted. It occupies the entire screen width. If a user 
enters more text than fits on one line, the rich area field 
automatically adds more lines. To limit the width of a rich area field, 
place it in a table cell. In this case, the field is as wide as the cell.

If you want to insert default text into a rich area field, insert it after 
you place the field in the editor.

Data Style See ”The Data Style Field” on page 290

Field Description
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Dialog Box

Fields on the Rich Area Dialog

Field Description

Descriptive 
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on 
page 232

Indexed Check if you want to index this field. For more 
information, see ”XML Indexing” on page 205
The Indexed field may or may not appear, depending on 
how your administrator set up your system.

Field Name Enter the field’s element name. This defines the field in 
the XML.

Advanced See ”Advanced Button” on page 284

Use See ”The Use Field” on page 288
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Choices 

Use the Choices field when you want to give the data entry user 
several options. For example, you create a Choices field named 
Interests that lists these options.

• music

• art

• sports

The data entry user could check the first two and leave the third 
blank.

Choices Field vs. Select List Field

The following capabilities are available with a Choices field but not 
a Select List field.

• You can limit a user’s choice to one item or allow more than 
one

• All items appear on the screen, arranged horizontally or 
vertically

• If one item is set as the default in the Smart Form 
Configuration, it is initially checked. The data entry user can 
change the selection as needed.

The following capabilities are available with a Select List field but 
not a Choices field.

• The user can only select one item.

• Only the default item appears on the screen. To the right of the 
field, a down arrow appears (circled in red below). The user 
clicks the arrow to display all items and select one.

Allow See ”The Allow Field” on page 289

Cannot be 
blank

If you want to require the user completing this field to 
enter a response, click inside this check box.

Field Description
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Dialog Box
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Fields on the Choices Dialog

Field Description

Descriptive 
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special characters 
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 232

Indexed Check if you want to index this field. For more information, see ”XML 
Indexing” on page 205
The Indexed field may or may not appear, depending on how your 
administrator set up your system.

Field Name Enter the field’s element name. This defines the field in the XML.

Advanced See ”Advanced Button” on page 284

Tool Tip Text Enter the text that appears when a user hovers the cursor over this 
choice list.

List Using a Standard List
If you want to use one of Ektron CMS400.NET’s standard lists, 
click the black down arrow next to the field to see a list of options.

If you choose a standard list, it appears in the lower half of the 
screen. You cannot change its values.
Creating a Custom List from Scratch
To create your own set of list options, accept the default value, 
Custom. Then, enter the values using the Item field.
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Allow 
selection

Click More than one to let the data entry user select more than one 
item on the data entry screen. Otherwise, click Only one.
For example, if you click More than one, and the choices are: music, 
art, sports, the user could select all three choices.
If you click Only one, the user can only select one.
A selection is required - Check this box if the user must select at 
least one list item.

Appearance Click Vertical List to arrange the choices vertically. The user selects 
items by clicking the radio button.

Click Horizontal List to arrange the choices horizontally.

Click List Box to arrange the choices vertically in a box. The user 
selects items by clicking inside the box.

Field Description
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Select List 
A Select List field is similar to a Choices field. The biggest 
differences are

• all responses appear in a drop-down box instead of appearing 
separately

• the user can only select one response. If you want to allow the 
user to select more than one response, use a choice list 
instead. See Also: ”Choices” on page 251

Item List This section of the screen displays the items that you enter in the 
Value and Text fields.
Buttons near the bottom of the screen let you remove and rearrange 
items from this list.

Place a check in the box of any item to be checked by default on the 
data entry screen. If you do, the user can accept the default or 
uncheck the item by clicking in the checkbox. Note that if Only One 
is selected under Allow selection (above), only one item can be 
selected.

Value Enter the value that is collected when the data entry user selects this 
item.
For example, if Interests appears in the Name field, and you want 
music to be collected when the data entry user selects this item and 
saves the page, enter music here.

No longer 
available

See ”No longer available” on page 259

Basic Check this box if you want this item’s XML tag to be the same as its 
name on the screen.
If you want the XML tag to be different from the screen name, 
uncheck this box. When you do, a new field appears, Value. Enter 
the XML tag into this field.

Data Style See ”The Data Style Field” on page 290

Field Description
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To see the choices, click the down arrow on the right side of the 
box (circled below).

See Also: ”Choices Field vs. Select List Field” on page 251

For example:



Using the Data Designer

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 257

Dialog Box

Fields on the Select List Field Dialog

Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special characters 
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 232
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Indexed Check if you want to index this field. For more information, see ”XML 
Indexing” on page 205.
The Indexed field may not appear, depending on how your 
administrator has set up your system.

Field Name Enter the field’s element name. This defines the field in the XML.

Advanced See ”Advanced Button” on page 284

Tool Tip Text Enter the text that appears when a user hovers the cursor over this 
list.

List Using a Standard List
If you want to use one of Ektron CMS400.NET’s standard lists, 
click the black down arrow next to this field to see your choices.

If you choose a standard list, it appears in the lower half of the 
screen. You cannot change its values.
See Also: ”Creating Your Own Predefined List” on page 260 and 
”Creating a Dynamically Populated Choice List” on page 261
Creating a Custom List from Scratch
To create your own set of list options, accept the default value, 
Custom. Then, enter the values using the Item field.

Item List This section of the screen displays the items that you enter in the 
Value and Text fields.
Buttons let you remove items from this list as well as rearrange them.
Place a check in the box of any item to be checked by default on the 
data entry screen. If you do, the user can accept the default or 
uncheck the item by clicking in the checkbox.

Field Description
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Value Enter the value that is collected when the data entry user selects this 
item.
For example, if Interests appears in the Name field, and you want 
music to be collected when the data entry user selects this item and 
saves the page, enter music here.

Text Enter text to describe this item on the data entry screen.
After you insert this field onto the screen, you can use 
eWebEditPro+XML ’s formatting capabilities to modify its size, font, 
color, and other attributes.

No longer 
available

Use this field to indicate that an item can no longer be selected by a 
user in data entry mode. For example, you have a list of team 
members. If one member leaves, check No longer available rather 
than removing the member.
If checked, the item only appears in data entry mode if a document 
contained the item when the check is applied.
This field lets you render a value obsolete without invalidating an 
existing XML document.
Exception! -- If multiple selections are allowed in a Choices Field 
and the item is selected in design mode, it appears in data entry 
mode but is disabled (grayed-out). This lets you force an item's value 
into the XML document. 

Basic Check this box if you want this item’s XML tag to be the same as its 
name on the screen.
If you want the XML tag to be different from the screen name, 
uncheck this box. When you do, a new field appears, Value. Enter 
the XML tag into this field.

First item is 
not a valid 
selection. 
For 
example, 
"(Select)" 

Check here if the first item on the list is not a valid value but instead 
text that prompts the user to respond to the field. An example of such 
text for a list of states is Select a state.
If you check this box and the user selects the first value on the list 
(most likely by default), an error message appears when he tries to 
save the screen.

Field Description
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Creating Your Own Predefined List

An administrator can create a predefined list of options to appear 
when a user is inserting a Select List field.

Advantage of Creating Custom List in Configuration File

Although a user can create a custom list of choices via the Item 
List area of the Select List Field dialog, that list is only available in 
that field of that screen. If the user wants to insert the same list in 
another section of the screen or a different screen, he must re-
enter all options.

However, if you create a list according to the steps below, your 
custom list is stored in the configuration file (along with the 
standard choice lists, such as Countries). As a result, any user 
connected to your server can insert the list into any Select List 
field on any screen.

Creating the List

To insert a custom list of choices, follow these steps.

1. Open the eWebEditPro+XML configuration file. If you are 
working with eWebEditPro+XML, this is webroot/ewebeditpro5/
config.xml.
If you are working with CMS400, this is webroot/Workarea/
ewebeditpro/cms_config.aspx.

Caption Enter text to guide the user’s selection. For example, if the user 
needs to select an area of interest, the caption could be Choose 
your interests.

Note: The Caption field only appears on this dialog when you create 
the Select List field. If you later try to edit the field, the Caption field is 
not on the dialog. However, you can edit the Caption text within the 
editor.

Data Style See ”The Data Style Field” on page 290

Field Description
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2. Insert the name of your list into the following section of the 
configuration file. In the sample below, the custom list is 
MyNewList.

<selections name="datalists">
                    <listchoice data="MyNewList">My New List</listchoice>

<listchoice data="languages" localeRef="sLanguages" />
<listchoice data="countries" localeRef="sCountries" />
<listchoice data="USPS-US" localeRef="sUSState" />
<listchoice data="USPS-CA" localeRef="sCaPrvnc" />
<listchoice data="ageRange" localeRef="sAgeRng" />
<listchoice data="numRange" localeRef="sNumRng" />
<listchoice data="years" localeRef="sYrs" />

</selections>

3. Find the <dataentry> element of the configuration file.
4. Insert the new list within that element. Below is an example of 

such a list.
            <datalist name="MyNewList">
                    <schema datatype="string" />

<item default= "true" value= "Green" />
<item value= "Red" />
<item value= "Blue" />

</datalist>

Note that

• the <datalist> element contains the list

• its name must match the listchoice data value you entered in 
Step 2

• you can specify a data type. Values are string, 
nonNegativeInteger, date, decimal.

• as shown in the third line above, you can specify a default 
value

Creating a Dynamically Populated Choice List

You specify the elements of the custom options list described 
above in the configuration data. You can also create a dynamically-
populated list from any XML source. The source can be on your 
server or on a remote Web site. Follow these steps to add a 
dynamic data list to the Select List field.

1. Follow steps 1 through 3 in ”Creating the List” on page 260.
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2. Insert a new datalist item according to this pattern.
<datalist name="MyNewList" src="{url to xml data source}" select="{xpath to data item 
element}" captionxpath="{relative xpath to data item's display text}" valuexpath="{relative 
xpath to data item's value}">

WARNING! The datalist name must match the listchoice data attribute.'

For example
<datalist name="USPS-CA" src="[eWebEditProPath]/uspsca.xsd" select="/xsd:schema/
xsd:simpleType/xsd:restriction/xsd:enumeration" captionxpath="xsd:annotation/
xsd:documentation" valuexpath="@value" namespaces="xmlns:xsd='http://www.w3.org/2001/
XMLSchema'" validation="select-req">

In this example, the data list is stored in the uspsca.xsd file, 
located within the ewebeditpro folder. However, it could be in any 
XML data source.

Calculated Field 
Use a calculated field to perform a calculation based on values in 
other fields. For example, if your screen collects mortgage 
information, you could create one field to collect the mortgage and 
interest payment and another to collect taxes and insurance. The 
calculated field could sum those two numbers and display the 
monthly payment.

You can validate a calculated field. For example, you can require a 
positive number between 100 and 1,000.

Calculated fields are display only -- users cannot edit them.

IMPORTANT! If a field will be referenced in a calculation, use the validation feature to require a 
value for that field. This forces the user to enter a number to be used in the 
calculation.
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Dialog Box

Fields on the Calculated Field Dialog

Field Description

Descriptive 
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special characters 
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 232

Indexed Check if you want to index this field. For more information, see ”XML 
Indexing” on page 205.
The Indexed field may or may not appear, depending on how your 
administrator has set up your system.
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Field Name Enter the field’s element name. This defines the field in the XML.

Advanced See ”Advanced Button” on page 284

Tool Tip Text Enter the text that appears when a user hovers the cursor over this 
field.

Formula Enter the calculation that this field will perform. See Also: ”Using the 
Formula Field” on page 265

Select Field Click this button to select a field to reference in the calculation. For 
more information, see ”Using the Formula Field” on page 265.

Examples Click the down arrow to the right of this field to see examples of 
calculations you can perform. When you select an example, it is 
copied into the Formula field.

Note: Your system administrator can customize the examples. 
Instructions are provided in “The <cmddsgcalc> Command” in the 
Data Designer chapter of the Developer Reference Guide.

See Also: ”Explanation of Examples” on page 267

Validation Select the kind of validation to apply to this field. Your choices are:

• No validation - the user’s response is not checked

• Non-negative number (required) - the result of the calculation 
must be a positive number

If you assign to this field any value other than No validation, the 
field is surrounded by red dashes in Data Entry mode. If the user’s 
response does not meet the validation criteria, the field remains 
surrounded by red dashes. Your system administrator determines if 
a user can save a screen with invalid data.

Error 
message

If you select Non-negative number above, insert text that appears 
on the screen if the user’s response does not meet this criterion.

Custom 
Validation

See ”Custom Validation” on page 291

Data Style See ”The Data Style Field” on page 290

Field Description
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Using the Formula Field

You can copy a sample calculation into the Formula field by 
clicking the Examples field and selecting an operation from the 
drop down list. For example, if you click Examples Add two 
numbers {X}+{Y}, {X}+{Y} appears in this field.

Next, replace the variables with fields on the screen. Be sure to 
select the curly brackets ({}) as well as the letter between them. 
Then, when the user enters data into those fields, the calculation is 
performed using the current field values.

If a calculated field tries to perform a numerical calculation with a 
value that is blank or contains letters, NaN appears in the field. (NaN 
stands for “not a number.”)

If a calculated field tries to divide by zero, Infinity appears.

WARNING! If the user does not replace all variables with a field or a number, when the 
content is validated, validation will fail.

To do this, follow these steps.

1. Select the first variable to replace. To continue the example, 
select {X}.

2. Click the Select Field button. A screen appears listing 
appropriate fields on the Data Design screen. 
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3. Select a field to replace {X}. When you do, the field name 
replaces {X} in the Formula field.

WARNING! If a variable appears more than once in a formula (for example, {X} * number( 
{X} &lt;= {Y} ) + {Y} * number( {X} &gt; {Y}), you only need to replace 
the first occurrence - eWebEditPro+XML replaces subsequent occurrences for 
you.

4. Continue replacing all variables in the formula.
Notes

• If an XML document contains several occurrences of a field 
that is referenced in a formula, the value is derived as follows:

-  When using the XPath functions sum() and count(), all 
values with the field name are considered. For example, a 
document includes three books whose prices are $10, $20 
and $30. In this case,  sum’s value is $60.

-  When using all other functions, the first value is used. For 
example, a document includes three books whose prices 
are $10, $20 and $30. If a calculation formula refers to 
<price>, its value is $10.

• You can replace a variable with a number instead of a field. For 
example, replace {X} * {Y} with  ../price * 1.15.

• The expression can be complex, such as (round(Field1 * 0.80) 
+ (1 div Field2)) - 2.
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• You can use a string expression that creates a text message. 
For example, to calculate a full name from its parts: concat( 
title, ' ', givenname, ' ', familyname), which could produce 
“Dr. Jonathan Smythe”.

Referencing Other Calculated Fields

A calculated field can only reference other calculated fields that 
appear before it in a document. For example, a document collects 
a series of numbers.

• One calculated field counts the number of numbers.

• Another totals their values.

• A third computes the average by dividing the total by the count.

In this example, you must place the third field below or to the right 
of the first two fields. Calculated fields that are defined later in a 
document do not appear in the Select Field or Group dialog.

Explanation of Examples

The following table explains the standard examples that appear in 
the Examples drop-down list of the Calculated Field dialog. Note 
that your system administrator can customize the list, so it may not 
match what is below.

Example Field Text Example Field Formula Description

Add two numbers {X} + {Y} Add the value in the first field (X) to 
the value in the second field (Y). 

Subtract two numbers {X} - {Y} Subtract the value in the second field 
(Y) from the value in the first field (X). 

Multiply two numbers {X} * {Y} Multiply the value in the first field (X) 
by the value in the second field (Y). 

Divide two numbers format-number( {X} div {Y} 
,'0.###')

Divide the value in the first field (X) by 
the value in the second field (Y).
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Format as a percentage format-number({X} div {Y} 
,'#0%')

Determine what percentage one 
number (X) is of another (Y).
For example, if {X}=10 and {Y}=100, 
the result of the calculation is 10%.

Absolute value of a number {X} * (number({X} &gt; 0)*2-1) The number regardless of the sign 
(negative or positive).

Minimum of two numbers {X} * number( {X} &lt;= {Y} ) + 
{Y} * number( {X} &gt; {Y})

The smaller of two field values.

Maximum of two numbers {X} * number( {X} &gt;= {Y} ) + 
{Y} * number( {X} &lt; {Y})

The larger of two field values.

Zero if subtraction is negative ({X} - {Y}) * number(({X} - {Y}) 
&gt; 0)

Subtract one number (Y) from 
another (X). If the difference is less 
than zero, insert zero.

Multiply by another number if 
checkbox is checked

{X} * ( {Y} * number( {Z} 
='true') + number( {Z} 
!='true'))

X is a numeric field.
Y is another numeric field to multiply 
by X if a checkbox is checked.
Z is the checkbox.
For example, {X}=2 and {Y}=3

• if the checkbox is checked, the 
result is 2 * 3, which is 6

• If the checkbox is not checked, 
the result is 2

Round a decimal number round({X}) Rounds the number to the nearest 
integer. For example, round(3.14). 
The result is 3.

Round up a decimal number ceiling({X}) Returns the smallest integer that is 
greater than the number. For 
example, ceiling(3.14). The result 
is 4.
For negative numbers: 
ceiling(-3.14) = -3

Example Field Text Example Field Formula Description
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Round down a decimal number floor({X}) Returns the largest integer that is not 
greater than the number argument. . 
For example, floor(3.14). The 
result is 3.
For negative numbers: 
floor(-3.14) = -4

Format decimal number 0.00 format-number( {X} ,'0.00') Rounds a value either up or down to 
the hundredth place. As examples, 
100 becomes 100.00, and 
3.14159265 becomes 3.14.

Total numeric values from 
multiple fields

sum( {X}[text()] | {Y}[text()] | 
{Z}[text()] ))

Add the values in all referenced 
fields. 
Only elements that contain a value 
are summed. Empty elements are 
excluded.

Total a list of numeric values sum( {X}[text()] ) Total all values in a single repeating 
field. Here’s an example.
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole 
number
XML Data
<root>

  <Miles>89</Miles>

  <Miles>12</Miles>

  <Miles>23</Miles>

  <Miles>19</Miles>

</root>

sum(Miles) equals 
89+12+23+19=143
Only elements that contain a value 
are summed. Empty elements are 
excluded.

Example Field Text Example Field Formula Description
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Average a list of numeric values format-number(sum( {X}[text()] ) 
div count( {X} ),'0.###')

Calculate the average of all values in 
a single repeating field.
To continue the example from the 
Total a list of numeric values field 
(above):
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole 
number
XML Data
<root>

  <Miles>89</Miles>

  <Miles>12</Miles>

  <Miles>23</Miles>

  <Miles>19</Miles>

</root>

Average=89+12+23+19=143
divided by the number of values (4)= 
35.75
Only elements that contain a value 
are summed. Empty elements are 
excluded.

Count the number of values in a 
list

count( {X} ) Calculate the number of values in a 
single repeating field.
To continue the example from the 
Total a list of numeric values field 
(above):
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole 
number
XML Data
<root>

  <Miles>89</Miles>

  <Miles>12</Miles>

  <Miles>23</Miles>

  <Miles>19</Miles>

</root>

Count = 4

Example Field Text Example Field Formula Description
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Calendar Field 
Insert a calendar field when you want the end user to enter a date. 
The user must click a date from an interactive calendar.

Lowercase text translate( {X} 
,'ABCDEFGHIJKLMNOPQRST
UVWXYZ','abcdefghijklmnopqrs
tuvwxyz')

Replace all uppercase characters 
with the lowercase version of that 
character

Uppercase text translate( {X} 
,'abcdefghijklmnopqrstuvwxyz','
ABCDEFGHIJKLMNOPQRSTU
VWXYZ')

Replace all lowercase characters with 
the uppercase version of that 
character

Remove extra spaces normalize-space( {X} ) Remove extra space characters from 
content\

Concatenate text concat( {X} , ', ' , {Y} ) Link text strings together into a single 
string. For example, concat('The',' 
','XML') yields The XML.

Size of a text string string-length( {X} ) Count the number of characters in a 
selected field’s value. For example, if 
the referenced field’s value is Hello, 
string-length = 5.

Example Field Text Example Field Formula Description
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 Because users cannot enter digits, a standard date format is 
ensured.

The date is stored as a standard XML date (in the format yyyy-mm-
dd), and localized to the computer of the user viewing it.

Dialog Box
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Fields on the Calendar Field Dialog

Field Description

Descriptive 
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special characters 
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 232

Indexed Check if you want to index this field. For more information, see ”XML 
Indexing” on page 205
The Indexed field may or may not appear, depending on how your 
administrator has set up your system.

Field Name Enter the field’s element name. This defines the field in the XML.

Advanced See ”Advanced Button” on page 284

Tool Tip Text Enter the text that appears when a user hovers the cursor over this 
field.

Default 
value

If you want this screen to have a default date when the user first 
sees it, click the calendar icon to the right and select a date. The 
user can change the date in Data Entry mode.

Note: If you enter a default date, you cannot later remove it. You can 
change it. If necessary, you can delete the field and enter a new one.

Use See ”The Use Field” on page 288

Allow See ”The Allow Field” on page 289

Warning! Do not insert a calendar field into a Smart Form that allows 
multiple entries (using the Allow more than One option on the 
dialog). If you do, you cannot search the Smart Form using that field.
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Custom Validation with a Calendar Field

The Calendar Field dialog features a Custom Validation button 
(illustrated below). 

When you click the button, the Custom Validation screen appears. 
The screen can ensure the user’s input is greater or less than the 
date you are inserting on the Data Design screen.

You can compose an error message that appears if the user’s 
response fails to meet the criteria. Your system administrator 
determines if a user can save the invalid data.

Validation If you want to require the user using the calendar to enter a 
response, click the down arrow to the right of this response field and 
select Cannot be blank. 

Error 
Message

If you select Cannot be blank above, insert text that appears on the 
screen if the user’s response does not meet this criterion.

Data Style See ”The Data Style Field” on page 290

Custom 
Validation

See ”Custom Validation with a Calendar Field” on page 274

Data Style See ”The Data Style Field” on page 290

Field Description
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When the Custom Validation button is clicked, the Custom 
Validation dialog appears. 

• The Data Type field shows Date.

• The Condition field displays the validation logic.

• The Examples drop-down list shows validation expressions 
that you can apply to the field.

• Any Error Message displays in Data Entry mode when the 
user inserts an invalid value.

When the Select Field button is clicked, the Select a Field or 
Group dialog appears. 
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This dialog displays fields that can be inserted into the Condition 
field. Not all field types are listed. You must choose calendar type 
field (note the calendar to the left of these fields.)

Example of Creating Custom Validation

As an example of custom validation, assume that a field collects 
the date when a patient’s health insurance policy expires. You want 
to make sure the date is later than today. To accomplish this, follow 
these steps.

1. Create a calendar field that prompts for today’s date.
2. Create another calendar field that prompts for a patient’s health 

insurance policy expiration date.
3. While creating the second field, in the Validation section, click 

Custom Validation. 
4. The Custom validation screen appears.
5. Click the down arrow to the right of the Examples field to see 

sample logic.
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6. Click Date After (. >={X}). This option lets you specify that the 
user’s response must be later than a specified date.

7. In the Condition field, select {X} and click the Select Field 
button.

8. The Select Field or Group screen appears. 
9. Select the field that prompts for today’s date, which you 

created in Step 1. 
10. That field replaces {X} in the Condition field.
11. Move the cursor to the Error Message field and compose an 

error message. For example: Must be after today.
12. Your screen should look like this.

13. Press OK and return to the Plain Text field dialog.
14. Press OK to save that dialog and test the validation on the date 

field. To do this, switch to Data Entry mode and enter a date 
earlier than today to verify that validation works as expected.



Using the Data Designer

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 278

Image Only Field 
Use an Image Only field to place an icon on the screen, which the 
user in Data Entry mode can click to insert an image into the Web 
content. You can insert a default image if desired.

To let the user insert any file, such as a Microsoft Word document, 
use a File Link field. See Also: ”File Link Field” on page 280

Using an Image Only Field in Data Entry Mode

In Data Entry mode, the image’s caption appears, followed by a 
default image (if you specify one) and this icon: .

NOTE The user can only insert a file whose extension is defined within the <validext> 
element of the configdataentry.xml file. Your system administrator can help you do 
this.
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Dialog Box

Fields on the Image Only Dialog

Field Description

Descriptive 
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on 
page 232

Indexed Check if you want to index this field. For more 
information, see ”XML Indexing” on page 205.
The Indexed field may or may not appear, depending on 
how your administrator has set up your system.
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File Link Field 
Use a File Link field to place an icon on the screen which the user 
in Data Entry mode can use to link to any file, such as a Microsoft 
Word document or a .gif image file. (You can also use an Image 
Only field to let the user insert an image. See Also: ”Image Only 
Field” on page 278)

Field Name Enter the field’s element name. This defines the field in 
the XML.

Advanced See ”Advanced Button” on page 284

Tool Tip Text Enter the text that appears when a user hovers the 
cursor over this field.

Use See ”The Use Field” on page 288

Allow See ”The Allow Field” on page 289

Default 
Image 
Location

If desired, you can insert a default image, which might 
be the most common image or simply a reminder that an 
image needs to be inserted.
To help find the image, click the From File button and 
navigate to image file.
You can only insert an image file whose extension 
appears between the <validext> tags in the 
configdatadesign.xml file. For example:
<validext>gif,jpg,png,jpeg,jpe,doc,txt

</validext>

Cannot be 
blank

If you want to require the user completing this field to 
enter a response, click inside this check box.

Description Enter the image’s alt text. The Alt text appears when the 
user hovers the cursor over the image on the screen

Field Description
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Using a File Link Field in Data Entry Mode

In Data Entry mode, the file link field’s caption appears, followed by 

this icon: . When the user clicks the icon, this screen prompts 
the user to specify a file, a description, and a Target Frame. 

NOTE The user can only insert a file whose extension is defined within the <validext> 
element of the configdataentry.xml file. Your system administrator can help you do 
this.
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Dialog Box

Fields on the File Link Field Dialog

Field Description

Descriptive 
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on 
page 232
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Indexed Check if you want to index this field. For more 
information, see ”XML Indexing” on page 205
The indexed field may or may not appear, depending on 
how your administrator has set up your system.

Field Name Enter the field’s element name. This defines the field in 
the XML.

Advanced See ”Advanced Button” on page 284

Tool Tip Text Enter the text that appears when a user hovers the 
cursor over this field.

Use See ”The Use Field” on page 288

Allow See ”The Allow Field” on page 289

Default 
Location

If desired, you can insert a default link, which can be the 
most common link or simply an example.
To help find the link, click the Select button and navigate 
to a file. You can only insert a file whose extension 
appears between the <validext> element of the 
configdatadesign.xml file. For example:
<validext>gif,jpg,png,jpeg,jpe,pdf,doc

</validext>

Cannot be 
blank

If you want to require the user completing this field to 
enter a response, click this check box.

Description If desired, enter text that the user can click to access the 
linked file.

Target 
Frame

• New Window(_blank) - In a new browser window, 
on top of the current browser.

• Same Window(_self) - In the same position within 
the browser window. The new window replaces the 
current one.

• Parent Window(_parent) - If your page contains 
frames, in the frame that contains the frame with 
the hyperlink.

• Browser Window(_top) - If your page contains 
frames, in the full display area, replacing the 
frames.

Field Description
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Fields that Appear on Several Dialogs

Advanced Button

The Advanced button opens a dialog that lets you control the XML 
that the field produces.

The dialog lets you generate XML microformats made up of 
standard XHTML tags and attributes that contain a specific 
structure and values. The types are described below.

WARNING! In order for Smart Form fields to searchable, they must be stored as elements not 
attributes. See Also: ”Advanced Button” on page 284 If you are upgrading to 
version 7.5, inspect your Smart Forms and change field properties as needed so 
they are stored as elements not attributes.

Data Style See ”The Data Style Field” on page 290

Field Description



Using the Data Designer

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 285

Type This field defines Example

Element A unique tag. The user’s response to the 
field becomes its value.

<Lastname>Rogers</Lastname>

Attribute An attribute of the containing field. The 
containing field is typically a Group Box.
If you insert an Attribute field type, the 
Field Name field on the dialog box is 
grayed out. The field name and type can 
only be edited on the Advanced Field 
properties screen.

<PtInformation Lastname="Rogers">

</PtInformation>

Content The content of the containing field, 
typically a Group Box.
Note that, in this case, field name is not 
used. As a result, the Field Name field is 
is grayed out.
Since most fields define their own 
content, this option is typically used to 
define a value to a Group Box that 
contains other fields defined as 
attributes.

IMPORTANT! Only one Content type 
field is valid within a containing field.

If you insert an Content field type, the 
Field Name field on the dialog box is 
grayed out. The field name and type can 
only be edited on the Advanced Field 
properties screen.

<PtInformation>Rogers</
PtInformation>

Value
(Only 
appears if 
field type is 
Image Only 
or File Link)

Whether the value is an element or plain 
text.
Value is an element renders the field as 

• <a href=”url” title=”text” 

target=”frame”>text</a> for a file 
link

• <img src=”url” alt=”text” /> for 
an image

Value is plain text renders the field as 
just the url.
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Sample Microformat

For example, the microformat of an event looks like this.

<span class="event">
<a class= "url"href="https://www.lisa.org/events/2006nyc/package_registration.html?from=fn1206 
">LISA Global Strategies Summit</a>
</span>

The Data Entry view looks like this.

The Data Design view looks like this.
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Additional Notes about Advanced Field Properties

• If the element is a group box or table, its type must be Element 
because it surrounds other elements.

• If the element is a Rich Area field, its type must be Element or 
Content.

• If the element is a link to an external file (either image or link 
filed), the Advanced Field Properties dialog has an additional 
field, Value. For more information, see ”Value” on page 285.
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The Use Field

Click May not be removed if this field must be included on the 
screen. Otherwise, click May be removed.

If you check May be removed, when this field appears on a data 
entry screen, an icon ( ) appears to the left of the field.

If the user clicks the icon, a dropdown menu provides an option to 
remove the field, as shown below.



Using the Data Designer

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 289

If the user removes the field,  add field display name replaces 
the field on the data entry screen to indicate that the field was 
removed and can be added if necessary.

For example, if the field’s display name is street address, and the 

user removes the field,  appears in place of the 
field.

NOTE The menu icon ( ) can also indicate that the user can add instances of a field 
(see the Allow field, below). So, if a field is required, the icon could appear but 
omit a Remove option.

The Allow Field

Check more than one if you want to let the user entering data add 
instances of this field. Otherwise, check only one.

WARNING! Do not insert a calendar field into a Smart Form that allows multiple entries (using 
the Allow more than One option on the dialog). If you do, you cannot search the 
Smart Form using that field.

For example, if a screen is collecting names and addresses and 
you want to let the user enter several of them, check more than 
one.

If you check more than one, when this field appears in Data Entry 

mode,  appears to the left of the field, as shown below.
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If the user entering data clicks , a menu appears (shown above), 
which lets the user add instances of the field to the screen.

NOTE The menu icon ( ) can also indicate that the user can remove a field (see the 
Use field, above). So, even if a field allows only one instance, the icon could 
appear but the menu would only display Remove.

The Data Style Field

Click the Data Style button to apply formatting to the field that 
accepts user input. When you do, the following dialog appears.

Use the dialog to assign the following formatting attributes to a 
user response field.

• Font style and size
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• Bold and italic

• Text alignment (especially helpful for formatting dollar amounts 
in a plain text field)

• Underline or strikethrough

• Font color and/or background color

NOTE The configuration data controls a command's appearance on the toolbar and on 
the Data Style dialog. For example, if <button command="cmdfontname" /> is 
removed from configdatadesign.xml, it disappears from the toolbar and the Data 
Style dialog.

Below is an example of a response field whose font, size, 
alignment, background, and foreground colors were modified via 
this dialog.

Custom Validation
The Plain Text and Calculation field dialogs feature a validation 
section (illustrated below). 

You can use the validation feature to ensure the following about 
the user’s input.

• The data type - the default types are

- text

- URL

- whole number

- decimal number
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- floating point number (Floating point includes scientific 
notation, so is appropriate for scientific numbers. Decimals 
usually suffice for business numbers.)

NOTE Your system administrator may customize the choices.

• The field value has one of the following relationships with 
another field, a number, or an expression - the default 
expressions are 

- between two values (either another field or a number that 
you specify)

- less than

- equal to

- not equal to

- maximum length (usually for text responses)

NOTE Your system administrator may customize the choices.

If the user’s response fails to meet the criteria, you can compose 
an error message that appears when that happens. Your system 
administrator determines if a user can save the invalid data.

When the Custom Validation button is clicked, the Custom 
Validation dialog appears. 
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• The Data Type field is the value’s basic type, for example, text 
number or URL.

• The Condition field displays the validation logic.

• The Examples drop-down list shows validation expressions 
that the data design creator can apply to the field.

• Any Error Message displays in Data Entry mode when the 
user inserts an invalid value.

When the Select Field button is clicked, the Select a Field or 
Group dialog appears. 
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This dialog displays fields that can be inserted into the Condition 
field. Some field types, like the RichArea field, are not listed. See 
Also: ”Referencing Other Calculated Fields” on page 267

Example of Creating Custom Validation

As an example of custom validation, assume that a field collects 
telephone numbers, and you want to make sure the user enters 10 
digits. To accomplish this, follow these steps.

1. Click the Plain Text Field dialog and complete the screen.
2. In the validation section, click Custom Validation. The Custom 

validation screen appears.
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3. In the Data Type field, select Whole Number from the drop 
down list. This ensures that the user can only enter digits.

4. Click the down arrow to the right of the Examples field to see 
sample logic.

5. Click Maximum text length... . This option lets you specify the 
length of the user’s response.

6. string-length(.) <= {X} appears in the Condition field.
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7. Since you want the user’s input to equal 10, remove the less 
than sign (<) from the calculation. Now it looks like this: string-
length(.) = {X}.

8. Replace the {X} with 10. Now, it looks like this: string-
length(.) = 10.

9. Move the cursor to the Error Message field and compose a 
relevant error message. For example: must be 10 digits.

10. Your screen should look like this.

11. Press OK and return to the Plain Text field dialog.
12. Press OK to save that dialog and test the validation on the 

phone number field. To do this, switch to Data Entry mode and 
enter more or fewer than 10 digits, as well as non-digit 
characters to verify that validation works as expected.
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Managing HTML Forms

Ektron CMS400.NET’s HTML Forms feature lets users create 
and maintain HTML forms to collect information from visitors to 
your Web site.

This section only describes the following technical topics 
relating to forms. For more information about using HTML 
forms, see the Ektron CMS400.NET User Manual.

• ”Form Permissions” on page 297

• ”Forms Must Use Template with FormBlock Server Control” 
on page 298

• ”Preparing the Server to Send email” on page 299

• ”Implementing a Form on a Web Page” on page 300

• ”Sending Data as XML” on page 301

• ”Redirecting Submitted Form Data” on page 308

Form Permissions

Folder Permissions
By default, form permissions are inherited from a form’s folder. 
To customize permissions for any folder that contains forms, 
access the corresponding folder under Content and assign 
permission as described in ”Setting Permissions for a Content 
Folder” on page 720.

Administrator Permissions
Similar to content, users in the administrator user group have 
full control over form features. You must be a member of the 
administrator group to:
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• Add a form

• Edit a form

• Delete a form

• Assign content to a form

You may also perform all actions on a form’s content.

User Permissions
Users who are not members of the administrator user group can 
add, edit, delete, and restore form content if granted these 
permissions for the content folder or item.

Forms Must Use Template with FormBlock Server 
Control

HTML forms must reside in a folder whose template uses the 
FormBlock server control or function. In the Intranet sample site 
supplied with Ektron CMS400.NET, the Contact Information folder 
uses such a template, contactinformation.aspx (illustrated below).
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You can modify this template as needed or create your own form 
template and assign it to any folder on its Folder Properties screen. 

Since, by default, folders inherit properties from their parent folder, 
any new folders created under a parent folder use the correct 
template. Of course, you can break inheritance and assign a 
custom template for any folder.

Preparing the Server to Send email
Since email generated by forms is created on and sent from the 
server that hosts Ektron CMS400.NET, the server must be enabled 
to handle those responsibilities. To configure your Web server to 
send email, refer to Configuring email Notifications in the Ektron 
CMS400.NET Setup Manual.
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Implementing a Form on a Web Page
After you create a form, the next step is to implement it on a Web 
Page. To do that, follow these steps.

NOTE The use of server controls or functions to manage templates is documented in the 
Ektron CMS400.NET Developer’s Manual.

1. Open the Web form template on which you want the Form 
content to appear. (This example uses support.aspx.)

2. Place the FormBlock server control or custom function for a 
Form content within the body of the template. Below is an 
example of what the form might look like.

IMPORTANT! Ektron recommends using the Poll server control when displaying a form that is 
being used as a form or a survey.

3. Save and close the new Web form.
4. To test your form, navigate to your Web site then to the new 

page.
5. Complete the form.
6. Click the Submit Form button.
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7. The screen is refreshed and displays the post back message 
that you created.

Sending Data as XML
While creating a form that generates email, you can specify that 
the email be sent as XML data or plain text. 

XML has the following advantages over plain text.

• Because XML data is structured, you can easily parse the 
content to store and retrieve important information. 

• If you download the form data to an Excel spreadsheet, the 
XML tags become the spreadsheet’s column headers. See 
Also: Ektron CMS400.NET User Manual Section “Working with 
HTML Forms” >”Viewing Form Reports” > “Exporting Form 
Reports”.

This section contrasts XML and plain text email using the form 
displayed below as the example. Here is an example of a form 
before it is submitted.
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The following table displays the resulting email, depending on the 
method used.

Form 
sent as

Generated email

Plain 
Text
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XML email Structure
A form’s XML structure consists of two groups of XML tags:

• Form and mail elements

• Data elements

The following image illustrates the sections of XML email structure.

XML

Form 
sent as

Generated email
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The following explains the sections of the XML email.

Root Tag

The XML email is wrapped in <cmsMail> root tags.

Form and Mail Tags

The form and mail tags display information about the form that was 
generated from the form information.

This illustration compares the information defined for the form with 
the information in the XML email.
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The following table explains each XML tag in the form and mail 
sections of the email.

XML Tag Description

<FormTitle> Title given to the form that was submitted.

<FormDescription> Description given to the form that was 
submitted.

<date> Date and time the form was submitted.

<MailTo> To email address(es) defined in the form.

<MailFrom> From email address(es) defined in the form.

<MailCc> CC address(es) defined in the form.
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Data Tags

The XML email’s data tags wrap the information entered by the 
form’s submitter. Each form element in the content becomes an 
XML tag.

The following image illustrates how a form is edited in the editor, 
displayed on a Web page, and then converted to XML for the 
email.

<MailSubject> Subject for the generated email defined in the 
form.

<MailPreamble> Preamble for the generated email defined in 
the form.

XML Tag Description
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As shown in the graphic, the content is comprised of four form 
elements that are converted to XML tags:

• Name

• Email

• PhoneNumber

• Problem
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Redirecting Submitted Form Data
This section explains how to set up the ability to redirect submitted 
form data to an action page. Because the data is redirected via 
server transfer, you can easily customize the handling of a multi-
page form.

Users can select this option when creating or editing a form 
response, as illustrated below.

Instructions for how a user chooses a hyperlink to an action page 
are in the Ektron CMS400.NET User Manual section “Working with 
HTML Forms” > “Creating a New Form” > “Redirecting to an Action 
Page and Forwarding Form Data”.

NOTE If a form’s specifications indicate that its data is saved to a database, the data is 
saved before being forwarded to an action page.

The following section explains how an administrator sets up a 
hyperlink to the action page in preparation for a user’s selection.

Setting Up the Action Page
1. Create the action page. It must
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- load and use the form variables

- have an .aspx extension

- reside in the same web application as your Web site

IMPORTANT! If your site is using URL Aliasing, the action page’s header must include the 
following: EnableEventValidation="false" EnableViewStateMac="false"

2. Place the action page in your Web site’s root folder.
3. Set up a library hyperlink to the .aspx page. Here’s how to do 

that:

- In Ektron CMS400.NET, go to the Library.

- Select Hyperlinks from the file type dropdown.

- Click the Add button ( ).

- In the URL Link field, enter the path relative to the Web root 
to the .aspx file you created in Steps 1 and 2. For example:

http://localhost/siteroot/ServerVariables.aspx

- Give the hyperlink a title and save it.

4. Inform your users of the hyperlink. They will select it when 
selecting the form response.
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Managing Assets

This section explains the administration of the Document 
Management functionality in Ektron CMS400.NET. It includes the 
following sections:

• ”Document Management Configuration” on page 310

• ”Checking Document Management Permissions” on page 314

• ”Managing Multimedia Assets” on page 317

• ”PDF Generation” on page 324

• ”Adding Assets Automatically” on page 328

• ”Merging Indexing Service Catalogs” on page 335

• ”Troubleshooting” on page 342

Document Management Configuration
This section explains configuring the Document Management 
feature. By changing these settings, you can:

• update Document Management server settings

• change which file types are allowed on the Document 
Management server

• set the View Type

There are two ways you can configure a Document Management 
server: 

• the Asset Server Setup screen in the Workarea. See Also:  
”Updating Asset Configuration Settings” on page 311

• the AssetManagement.Config file. See Also:  ”The 
AssetManagement.Config File” on page 312

In either case, you are editing the AssetManagement.Config file. 
While the Workarea screen provides a simple way to update this 
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information, some tags can only be updated in the 
AssetManagement.Config file. The table in ”The 
AssetManagement.Config File” on page 312 indicates which tags 
can be edited in the Workarea.

Updating Asset Configuration Settings
You can update some AssetManagement.Config tags from the 
Ektron CMS400.NET Workarea. To do that, follow these steps.

NOTE Only members of the Administrator User Group can view, add, or edit the Asset 
Server Setup.

1. In the Workarea, go to Settings > Configuration > Asset 
Server Setup.

2. The Asset Management Configuration screen appears.

3. Click the Edit button ( ) for the tag you want to edit.

4. The Value field for that tag changes to a text box.
5. Change the information in the text box.

6. Click the Save button ( ).
For more information on each tag, see ”The 
AssetManagement.Config File” on page 312
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The AssetManagement.Config File
The following table describes the AssetManagement.Config file’s 
tags.

Element Description Editable 
within 
Workarea?

CatalogLocation= The folder location of the Asset Catalog. This location is used 
when setting up the index service. For example: 
“C:\assetcatalog\”.

CatalogName= The name of the Asset Catalog. This name is used when 
setting up the index service.

DomainName= Can be Domain Name, IP Address or Machine Name. An 
example is: localhost. This is the address a Web client system 
uses to open managed documents through HTTP.

FileTypes= Files types that users are allowed to upload to Document 
Management. For more information, see ”FileTypes” on 
page 332. The default file types installed are 
*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.txt,*.log,*.vsd,*.dot,*.zi
p,*.swf,*.wma,*.wav,*.avi, *.mp3, *.rm, *.wmv, *.ra, *.mov, 
*.odt, *.odf, *.odp, *.odg, *.ods, *.odb

LoadBalanced= Enables Load Balancing for assets. Set to “1” to enable. See 
Also: ”Load Balancing Assets” on page 993

Password= The password for the user created during the install. This 
password is encrypted during the install. If you are changing 
the user and need to encrypt a new password, use the 
dms400encryptpassword.exe encryption tool located in 
C:\Program 
Files\Ektron\CMS400versionnumber\Utilities\DMS.

ServerName= The name of the server that hosts Ektron CMS400.NET .

StorageLocation= The folder location where published assets are stored. For 
example: “C:\assetslibrary”.

UserName= The user created during the install. 
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Allowing File Types
Administrators control which file types are allowed in the 
Document Management functionality by editing the 
AssetManagement.config file. Reasons for limiting the file types 
include:

• Security - For example, you do not want users to load .exe files 
to your Document Management server

• Ease of Management - For example, you want your Document 
Management server to store .doc files only

The <FileTypes> tag in the AssetManagement.config file contain the 
file types users can upload. The default file types are: 
*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.txt,*.log,*.vsd,*.dot,
*.zip,*.swf,*.wma,*.wav,*.avi, *.mp3, *.rm, *.wmv, *.ra, *.mov, 
*.odt, *.odf, *.odp, *.odg, *.ods, *.png,*.docx,*.xlsx,*.pptx, 

*.vsdx, *.htm, *.html *.js,*.wmf,*.css,*.xml.

Adding or Removing a File Type

To add or remove a file type from the list, follow these steps.

1. Edit the Workarea > Settings > Configuration > Asset 
Server Setup > Update Asset Configuration Settings 
screen.
Or

1. Open the AssetManagement.config file. The default location is 
(webroot)/(site root).

2. Find the FileTypes=”” element. All file types must appear 
between the quotes. For example, FileTypes=”*.doc,*.xls”.

NOTE Use a comma to separate file types. Also, file types must be formatted as 
wildcard.extension. For example, adding an .mp3 file type to the list after *.zip 
looks like this: *.zip,*.mp3

WebShareDir= The folder where temporary data files that are waiting to be 
checked in, saved, or published are stored. For example: 
”dmdata”.

Element Description Editable 
within 
Workarea?
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3. Add or remove any file type.
4. Save and close the AssetManagement.config file.

Checking Document Management Permissions
If you are having any problems with permissions, use this section 
to verify that your user and folder settings are assigned properly.

See Also: 

• ”User Permissions” on page 314

• ”Folders Used by Document Management” on page 316

User Permissions
When the Document Management functionality is installed, 
permissions are granted to several users for the following folders:

• webroot\site root\AssetManagement\dmdata

• webroot\site root\Assets

• root\assetlibrary

The assigned permissions vary depending on your server’s 
operating system.

The following table lists users and their permissions. Scan down 
the column of your server’s operating system to determine which 
users and permissions should be enabled for the folders listed 
above.

You can use this information to help troubleshoot potential 
permission problems.
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Advanced Permissions

The following are extended permissions for use with the Document 
Management functionality.

• Traverse Folder / Execute File

• List Folder / Read Data

User Needs these 
permissions

Windows 
2000 Pro 
or XP Pro

Windows 
2003 
Server

Windows 
2003 
Enterprise 
Edition

IIS_WPG User See ”Advanced 
Permissions” on 
page 315

IUSR_
(The IUSR_ account is required 
only if Impersonate is set to 
True in web.config, and its 
username and password 
attributes are not specified. If 
impersonate is set to false 
(default setting), the IUSR_ 
account may be harmlessly 
removed from the folders listed.)

See ”Advanced 
Permissions” on 
page 315

IUSR_Group See ”Advanced 
Permissions” on 
page 315

ASP.NET User See ”Advanced 
Permissions” on 
page 315

User Defined (The User Defined 
user account is required only if 
Impersonate is set to True in 
web.config, and its username 
and password attributes are 
specified.)

See ”Advanced 
Permissions” on 
page 315
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• Read Attributes

• Read Extended Attributes

• Create Files / Write Data

• Create Folders / Append Data

• Write Attributes

• Write Extended Attributes

• Delete Subfolder and Files

• Read Permissions

Folders Used by Document Management

The assetLibrary Folder
The Asset Library folder contains file assets uploaded to and 
managed by DMS. You can view and update the path to this folder 
in the Workarea under Settings > Configuration >Asset Server 
Setup > Storage Location.

Folder Set by Description

assetLibrary User Defined by user during installation. The path to this 
folder can be viewed and changed in the Workarea 
under Settings > Configuration > Asset Server Setup 
> Storage Location. See Also:  ”The assetLibrary 
Folder” on page 316

dmdata Ektron 
CMS400.NET

Defined during Ektron CMS400.NET  installation. 
Located in the AssetManagement folder. Has settings 
for both the File System and IIS.

assets Ektron 
CMS400.NET

Defined during Ektron CMS400.NET  installation. 
Located in site root folder.
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Managing Multimedia Assets
Multimedia files contain audio, video, or both. File types include 
.wav, .mpeg., .swf, .avi, and .wma.

Because of their unique characteristics, these files warrant special 
treatment within Ektron CMS400.NET. This section explains how 
multimedia files are handled through the following subtopics.

• ”Supported Multimedia Players” on page 317

• ”Multimedia File Types” on page 318

• ”Working with Multimedia Files in Ektron CMS400.NET” on 
page 319

Supported Multimedia Players
Ektron CMS400.NET supports the following media players.

• WindowsMedia®

• Quicktime®

• Realplayer®

• Flash®

This means that Ektron CMS400.NET only supports multimedia files 
that run on one of these players. If you import a multimedia file that 
cannot play on any supported player, it is treated like any other 
asset but cannot be played within Ektron CMS400.NET.

Downloading Media Players

If a Ektron CMS400.NET user within the Workarea, or a site visitor, 
tries to play a file and no supporting media player exists on the 
user’s computer, the user is prompted to download and install the 
player.

If the file uses the Quicktime or Flash media player, the web.config 
file contains information that prompts the user to immediately 
download and install the player.

If the file uses the Realplayer or WindowsMedia media player, the 
user must go to the host Web site and download them.
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Multimedia File Types
Every multimedia file type has a corresponding MIME type. For 
example, an mp3 file's MIME Type is audio/mpeg.

All supported MIME types are defined within the mediasettings 
element of the web.config file. That section of the web.config file is 
reproduced below.

<add key="application/x-shockwave-flash" value="Flash" />
<add key="audio/x-wav" value="WindowsMedia, Quicktime, Realplayer" />
<add key="audio/x-wav-default" value="WindowsMedia" />
<add key="audio/x-pn-realaudio" value="WindowsMedia, Quicktime, Realplayer" />
<add key="video/x-avi"  value="WindowsMedia, Quicktime, Realplayer" />
<add key="video/x-avi-default" value="Quicktime" />
<add key="video/x-msvideo" value="WindowsMedia, Quicktime"/>
<add key="video/x-msvideo-default" value="WindowsMedia"/>
<add key="audio/x-ms-wma" value="WindowsMedia"/>
<add key="audio/mpeg" value="WindowsMedia,Quicktime"/>
<add key="video/x-realvideo" value="Realplayer"/>
<add key="video/x-ms-wmv" value="WindowsMedia"/>
<add key="audio/x-realaudio" value="Realplayer"/>
<add key="video/quicktime" value="Quicktime"/>

NOTE A good reference of file and corresponding MIME types is http://
www.w3schools.com/media/media_mimeref.asp.

To determine if a multimedia file type is supported, go to the Web 
site listed above to find its MIME type. Then, go to the web.config 
file section show above to see if the MIME type exists and, if so, 
the supported media players.

Adding Players for a MIME Type

You can add to the list of supported media players for any MIME 
Type. To do so, open the web.config file, find the MIME type, and 
add the player name within the value element.

Here is an example: <add key="audio/mpeg" value="WindowsMedia"/>

As shown, WindowsMedia is the only supported player for mp3 files. If 
you know that other players can run mp3 files, insert additional 
media players after WindowsMedia. To get the exact name of the 
player, review the value elements in web.config file section shown 
above.

http://www.w3schools.com/media/media_mimeref.asp
http://www.w3schools.com/media/media_mimeref.asp
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Adding MIME Types

If you want Ektron CMS400.NET to support additional MIME 
Types, add them within the <mediaSettings> element using the 
following syntax:

<add key="MIME type/subtype" value="supported media player(s)"/>

For example

<add key="video/x-ms-asf" value="WindowsMedia"/>

You must also add the file type to the list of supported file types in 
the assetmanagement.config file. See Also: ”Allowing File Types” 
on page 313

Adding a MIME Type’s Default Player

To identify a player as the default for a MIME type, use the 
following syntax within web.config.

<add key="MIME Type/subtype" value="default player"/>

For example

<add key="video/x-msvideo-default" value="WindowsMedia"/>

Working with Multimedia Files in Ektron CMS400.NET

Importing Multimedia Files into Ektron CMS400.NET

You import multimedia files into Ektron CMS400.NET the same way 
you import other assets. Seethe Ektron CMS400.NET User Manual 
chapter “Using the Document Management Functionality,” sections 
“Working with Managed Files” and “Importing Files via Drag and 
Drop.“ 

Once imported into Ektron CMS400.NET, a document proceeds 
through the same workflow as any other type of content. See Also: 
”Setting Approval Chains” on page 726
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Changing Supported Media Players

After a multimedia file is imported into Ektron CMS400.NET, you 
can view supported media players’ properties on the Content tab 
of the Edit Content screen. All players defined for the file’s MIME 
type are checked. You can uncheck any media players that you do 
not want to operate a particular file.

If a default media player is defined for a MIME type in web.config, 
you cannot uncheck its checkbox. In the above graphic, 
WindowsMedia is the default player.
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Changing File Properties

After a multimedia file is imported into Ektron CMS400.NET, you 
can edit its properties on the Content tab of the Edit Content 
screen. 

If the file is supported by several players, first check the player 
whose properties you want to modify, then edit its properties.

The Width and Height fields determine the size (in pixels) of the 
media player when it appears in the Workarea and on your Web 
site. The remaining properties are determined by the media player 
(QuickTime in the example above).

Inserting a Multimedia File into Content

To insert a multimedia file into content, follow these steps.

1. Either create a new HTML content item or edit an existing one.
2. Within the content, type text or insert an image that you want 

site visitors to click to launch the multimedia file. For example: 
Click here to begin playing.

3. Select the image or text you inserted in Step 2.



Managing Assets

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 322

4. Apply a quicklink to the multimedia file to the selection. This 
procedure is described in the Ektron CMS400.NET User Manual 
section “Library Folder” > “Quicklinks and Forms.” 

Replacing Multimedia Files

If you want to replace a multimedia file but maintain all CMS 
information about that file (for example, its properties, summary, 
metadata, etc.), follow these steps.

1. Browse to the folder that contains the multimedia content item.
2. Double click the item.
3. The bottom of the Edit screen has a gray rectangle with the text 

Drag files into this window and drop to add.

4. Open Windows Explorer and navigate to the folder that 
contains the updated multimedia file.

5. Drag and drop the file into the lower section of the Edit Content 
screen.
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6. Save, Check In, or Approve the content.
Note that after you complete the replacement, you can play and 
restore older versions of the file through the content’s history. For 
more information, see the Ektron CMS400.NET User Manual 
chapter “Viewing and Restoring Previous Content.” 

Viewing and Listening to Multimedia Files

Users in the Workarea and visitors to your Web site play interact 
with multimedia files in the same way. 

When either type of user visits a page that hosts a multimedia file, 
Ektron CMS400.NET tries to match media players on the user’s 
computer with those defined in the web.config file for the file’s 
MIME type. Ektron CMS400.NET then displays a list of choices for 
every supported media player for the file. The user selects the 
preferred one.

Modifying Style Properties of the Multimedia Player

You can change the multimedia player’s style properties by 
modifying the EKTTabs.css style sheet. This file is installed to site 
folder/Workarea/csslib.

For example, you can change the color of the text that selects a 
player to red by changing the property highlighted below.

.EktTabActive

{

padding: 2px 2px 2px 2px;

top:10px;

text-decoration:none;

position: relative;

background-color:white;

border: solid thin navy;
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color:Red;

font-weight:bolder;

}

Here is the result.

PDF Generation
PDF (Portable Document Format) is a file type designed for 
distributing compact, platform-independent documents. Each 
document is self-contained, packing text, graphics, and fonts into a 
single file.

You can automatically convert Office documents stored in Ektron 
CMS400.NET to the PDF format. As a result, when a site visitor 
accesses a page containing such a document, he sees the PDF 
version. Since most computers have a PDF reader, the visitor 
needs no additional software to view the file.

IMPORTANT! Upon installing Ektron CMS400.NET, the Ektron Windows service begins 
communicating with Ektron’s external PDF-generation server. To terminate this 
communication, disable PDF generation. See ”Disabling PDF Generation” on 
page 971. Alternatively, you can generate PDFs locally. See ”Local PDF 
Generation” on page 326.

Why use PDF?
• Files easily cross multiple platforms, including Microsoft, Apple, 

Linux, and Unix.

• Documents keep their formatting and appear the same on a 
computer screen or when printing.
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• File size is typically smaller, which means less bandwidth 
usage.

• Converted Office documents can be viewed by anyone with a 
PDF viewer.

• Site visitors do not need a different viewer for each file type.

NOTE Ektron CMS400.NET also supports saving MS Office documents in .html 
format, which is also formatted for a browser.

The following sections explain creating PDFs with the Document 
Management feature:

• ”PDF Conversion Process” on page 325

• ”Local PDF Generation” on page 326

• ”Enabling or Disabling PDF Generation” on page 327

• ”Designating a Folder to Generate PDFs Automatically” on 
page 327

PDF Conversion Process
The PDF conversion of an Office document starts when it is 
published. At that point, a copy of the file is sent to an Ektron 
server for PDF generation. After the server generates the PDF, it is 
returned to your Document Management server.

The PDF file doesn’t appear in the CMS400.NET Workarea -- only 
the originally-published Office document appears. Ektron 
CMS400.NET stores the PDF file in a secure location. Subsequent 
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editing is done in the original Office document. Each time it’s 
published, a new PDF is generated.

Once the Office document is added to a Web page, the Web page 
shows the PDF version. This means site visitors only need a PDF 
viewer to view any Office document on your site.

The Ektron Windows Service runs the Office-to-PDF conversion 
process. See Also: ”Ektron Windows Service” on page 969

Local PDF Generation
If you purchase software from a PDF generation software vendor, 
you can create PDF documents on a local network instead of 
sending them an Ektron server. Reasons for generating a PDF 
locally include:

• Speed: Office documents can be converted more quickly 

• Security: Office documents never leave the local network

• Quality: You can configure the output quality
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The following sections explain setting up local PDF generation.

Modifying the PdfGenerator Information in AssetManagement.config

When setting up local PDF generation, use the PdfGenerator 
parameter in the AssetManagement.Config file to provide the 
location of the local PDF generator. To modify the file, follow these 
steps.

1. Open the AssetManagement.Config file, located in your site root 
folder.

2. Change the location of the PDF generator.
For example:

PdfGenerator=”http://aspnet20.ektron.com/PdfManager/PdfGeneratorService.asmx”

might become
PdfGenerator=”http://localhost/PdfManager/PdfGeneratorService.asmx”

3. Save and Close the file.

Enabling or Disabling PDF Generation
Administrators decide if this feature is enabled and to which folders 
it applies. After enabling this feature, administrators can change 
any folder’s properties to allow PDF generation.

Follow these steps to enable or disable this feature. 

1. In the CMS Workarea, go to Settings > Configuration > 
Setup.

2. Click the Edit button ( ).

3. Click the Enable Office Documents to be Published in other 
Format checkbox.

4. Click the Save button ( ).

Designating a Folder to Generate PDFs Automatically
By setting a folder’s properties to allow PDF generation, all Office 
documents published in that folder have a PDF created for them. 
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For an introduction to PDF generation, see ”PDF Generation” on 
page 324.

The steps below explain how to change the folder property for PDF 
generation.

NOTE Existing subfolders do not inherit PDF generation. Each subfolder needs to be set 
individually. However, a new subfolder inherits the PDF generation setting from its 
parent folder. Administrators can change the setting while creating a new 
subfolder.

1. In the Workarea, click the Content folder button.
2. Click the folder for which you want to enable PDF generation.
3. Click View > Folder Properties.

4. Click the Edit Properties button ( ).

5. Click the Publish Office Documents as PDF radio button.

6. Click Save ( ).

Adding Assets Automatically
The Auto Add Asset feature automatically transfers assets placed 
in a specified folder into Ektron CMS400.NET.

It’s a very helpful feature if, for example, several users work with 
assets, you want to manage them with Ektron CMS400.NET, but the 
users creating or updating the assets have neither Ektron 
CMS400.NET licenses nor the client software installed. These users 
simply place the assets in a folder, and the Auto Add Asset feature 
moves them to Ektron CMS400.NET.

The Auto Add Asset feature is very flexible. While setting it up, you 
can determine the following aspects of how it works.

• whether it uploads a single asset, multiple assets, a folder, or a 
folder and its subfolders

• the location of the uploaded assets

• if subfolders are included, do you want to mirror that structure 
within Ektron CMS400.NET?

• file types that can be uploaded
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• how frequently the specified assets or folders are checked for 
new content

The rest of this section explains the Auto Add Asset feature 
through the following topics.

• ”Installing the Auto Add Asset Feature” on page 329

• ”Updating the Configuration File” on page 330

• ”Start the Auto Add Asset Service” on page 334

• ”Testing the Auto Add Asset Feature” on page 335

Installing the Auto Add Asset Feature
Follow these steps to install the Auto Add Asset Feature.

1. Verify that Ektron CMS400.NET is running basic authentication 
in IIS. For information on how to do this, see http://
www.microsoft.com/technet/prodtechnol/WindowsServer2003/
Library/IIS/abbca505-6f63-4267-aac1-
1ea89d861eb4.mspx?mfr=true.

2. Create the following directories in the file system of the 
computer that will transfer the assets to Ektron CMS400.NET.

• Input - place assets in this directory before uploading them to 
Ektron CMS400.NET

• Backup - assets are moved to this directory after they are 
uploaded to Ektron CMS400.NET

• Error - assets are moved to this directory if there was a 
problem moving them to the input folder

3. To each computer that will run the Auto Add Asset Feature, 
copy the C:\Program 
Files\Ektron\CMS400versionnumber\Utilities\AssetWorkerSetup.msi 
file and run it.
This program creates a new folder, C:\Program 
Files\Ektron\AssetWorkerSetup.

4. Test that the Web Services are working. To do that, browse to 
the following page:
http://localhost/cms400min/workarea/webservices/
assetservice.asmx

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/abbca505-6f63-4267-aac1-1ea89d861eb4.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/abbca505-6f63-4267-aac1-1ea89d861eb4.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/abbca505-6f63-4267-aac1-1ea89d861eb4.mspx?mfr=true
http://localhost/cms400demo/workarea/webservices/assetservice.asmx
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NOTE Replace localhost with your server name and CMS400min with your site name.

The page displays two Web services: AddAsset and 
MakeFolderIfNoExists.

Updating the Configuration File
After installing the Auto Add Asset feature, you can modify the 
configuration file, which lets you customize the feature to fit your 
particular needs.

The file’s name and folder path is C:\Program 
Files\Ektron\AssetWorkerSetup\maindata.config. The following table 
describes its elements.

Element Description

DmsUserName The user created during the install.

DmsPassword The password for the user created during the install. This password is 
encrypted during the install. If you are changing the user and need to encrypt 
a new password, use the dms400encryptpassword.exe encryption tool 
located in C:\Program 
Files\Ektron\CMS400versionnumber\Utilities\DMS.

DmsUserDomain The domain for the user created during the install.

DmsServer The name of the server on which DMS is running.

CmsUserName By default, Ektron CMS400.NET  inserts the user name vs. This is a special 
user that lets you work in Visual Studio.net while signing into CMS as an 
administrator.

Note: "Securing Ektron CMS400.NET," on page i advises you to remove the 
VS user. If you do, you must create a new user, assign him to the 
Administrators groups, and enter his username and password in these fields.
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CmsPassword By default, Ektron CMS400.NET  inserts the password of the VS user. If you 
change the VS user’s password, or change the CMS UserName, enter the 
new password here.

Note: "Securing Ektron CMS400.NET," on page i advises you to remove the 
VS user. If you do, you must create a new user, assign him to the 
Administrators groups, and enter his username and password in these fields.

CmsUserDomain Enter the Domain Name, IP Address or Machine Name. An example is 
localhost.

A Web client system uses this address to open managed documents through 
HTTP.

Protocol Enter the protocol used to transfer the assets: http or hhtps.

CmsSite Enter the path to your Web site root. For example, one of Ektron 
CMS400.NET ’s sample site’s root is http://localhost/CMS400min.

DmsSite Enter the path to your Asset Management folder. For example, one sample 
site‘s Asset Management folder is http://localhost/CMS400min/
AssetManagement.

ConfigType Enter the type of file upload you want. Choices are:

• file

• multifile

• folder

• autofile

• autofolder

• autofoldercreate

• multifolder

• automultifolder

• automultifoldercreate

These choices are explained in ”File Upload Types” on page 332.

Element Description
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File Upload Types

There are nine methods for uploading files from the input folder 
into Ektron CMS400.NET. The following table explains the options 
and how each works.

Folder:

• Input

• Backup

• Error

Enter paths to the folders you created in Step 2 of ”Installing the Auto Add 
Asset Feature” on page 329. An example is below.
<Input>C:\Test\Input</Input>

<Backup>C:\Test\Backup</Backup>

<Error>C:\Test\Error</Error>

MultiFolder If your choice at the ConfigType element is listed below, use this element to 
specify the folders.

• multifolder

• automultifolder

• automultifoldercreate

Separate each folder with the pipe character (|). Here is an example.
C:\AutoAddAsset\InputPhotos|C:\AutoAddAsset\InputWorddocs|C:\Aut
oAddAsset\InputPDFs

CreateFolder

FileTypes Enter all file types that can be added using the Auto Add Asset feature.
To identify a file type, enter an asterisk(*), a period (.) and the file’s extension. 
Separate each file type with a comma. Here is the sample list that appears by 
default: 
*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.txt,*.log,*.vsd,*.d
ot,*.zip

Note: The FileTypes field in the Assetmanagement.config file determines 
which files can be used within Ektron CMS400.NET . You should not enter 
file types here that are not listed in AssetManagement.config. See Also: 
”Allowing File Types” on page 313

Element Description
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File Upload 
Type

What is 
uploaded

If folder, are 
subfolders also 
scanned for 
assets?

Are new files 
uploaded 
automatically?

CMS folder 
structure set up 
to match your 
file system?

File One file na no no

Multifile Multiple individual 
files separated by 
a pipe

na no no

Folder One folder no no no

Autofile One folder no yes no

Multifolder All specified 
folders

Note: Specify the 
folders at the 
Multifolder 
element. See 
”MultiFolder” on 
page 332

yes yes no

Autofolder All files in 
specified folder

yes yes no

Autofoldercreate All files in 
specified folder

yes yes yes

Automultifolder All files all 
specified folders

Note: Specify the 
folders at the 
Multifolder 
element. See 
”MultiFolder” on 
page 332

yes yes no
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Start the Auto Add Asset Service
The Auto Add Asset feature uses a Windows Service to transfer 
assets to Ektron CMS400.NET. You must begin the service 
manually every time you start Windows. Follow these steps to start 
the Auto Add Asset Service.

1. Go to Windows Control Panel > Administrative Tools > 
Computer Management.

2. Click Services and Applications > Services.
3. Click the start button (circled below) to start the Automatic 

Asset Adder service.

Automultifoldercre
ate

All files all 
specified folders

Note: Specify the 
folders at the 
Multifolder 
element. See 
”MultiFolder” on 
page 332

yes yes Yes 

Note: Changes to 
files already 
uploaded are 
considered new 
assets

File Upload 
Type

What is 
uploaded

If folder, are 
subfolders also 
scanned for 
assets?

Are new files 
uploaded 
automatically?

CMS folder 
structure set up 
to match your 
file system?
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Testing the Auto Add Asset Feature
After completing the above steps, you should verify that the Auto 
Add Asset feature is working. To do this, follow these steps.

1. Place files of the appropriate type into the specified input 
folder.

2. Open C:\Program 
Files\Ektron\AssetWorkerSetup\AssetWorker.exe.config with a text 
editor such as Notepad.

3. Change the value of the PollInterval element to 10000. Save 
and close the file.

4. The input folders will be checked for files every 10 seconds. 
They should appear within the Ektron CMS400.NET shortly.

Merging Indexing Service Catalogs
This section explains how to merge two Windows Indexing Service 
catalogs. You need to do this if your server has more than the 
maximum allowed number of 26 catalogs.

See Also: 
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• ”Windows Indexing Service Catalogs” on page 336

• ”Conditions for Merging Catalogs” on page 337

• ”Procedure for Merging Catalogs” on page 337

Windows Indexing Service Catalogs
Each Ektron CMS400.NET site has three catalogs. In addition, your 
server may have catalogs for other applications that use the 
Windows Indexing service. Below is an example of what your 
Indexing Service catalogs might look like.

Note that the first six catalogs support two Ektron CMS400.NET web 
sites: Cms.example2.com and CMS400Developer. Each site has 
three catalogs: 

• Content

• Private (assets)
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• Publish (assets)

Each catalog has a Directories folder, which lists the directories of 
the content being indexed.

Why Merge Catalogs?

When merging catalogs, you copy the directory of the “merge from” 
catalog to the Directories folder of the “merge to” catalog. Then, 
you delete the “merge from” catalog.

The merge reduces the number of catalogs, yet still indexes each 
site’s content for the search. After you merge the catalogs, each 
site’s search is still limited to content on that site -- the search does 
not find content from other sites even though several sites now 
reside in one catalog.

Conditions for Merging Catalogs
• You can only merge Ektron CMS400.NET catalogs if the Web 

sites use the same point release. For example, you can merge 
catalogs from two sites with Release 7.0.4, or a 7.5.0 site with 
a 7.5.1 site. But you cannot merge a 7.0.4 site with a 7.5 site, 
because catalog properties change between releases.

• Each Ektron CMS400.NET site has three catalogs.

- publish

- private

- content
You must merge the same catalog type between sites. So, for 
example, you cannot merge a publish with a private catalog.

Procedure for Merging Catalogs
Follow these steps for all three catalogs on each site: Content, 
Private and Publish.
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Part 1: Copy the “From” Catalog Path to a New Directory in the “To” 
Catalog

In this part, you create a new directory in the “to” catalog. Point the 
new directory to the “from” catalog folder. Then, delete the “from” 
catalog.

1. Open Computer Management > Services and Applications 
> Indexing Service.

2. Select the first catalog that you want to merge from (that is, the 
catalog you will delete after merging).

3. Click its Directories folder.
4. The directory appears in the right pane.
5. Double click it. The Add Directory dialog appears.
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6. Press <Ctrl> + <C> to copy the Path field.
7. In the left panel, select the corresponding “to” catalog, the one 

into which you will merge the “from” catalog. 

WARNING! Make sure the catalog types match: content > content, publish > publish, private > 
private.

8. Right click the mouse and select New > Directory. The Add 
Directory dialog appears.

9. In the Path field, paste the path you copied in Step 7 and press 
OK.

10. Repeat these steps for the other two catalogs on the site that 
you are merging.
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11. Click Indexing Service then stop the Indexing service.
12. Delete the three “from” catalogs.
13. Click Indexing Service then restart the Indexing Service. This 

action begins indexing the files in the new directory.

Part 2: Update .Config Files with the New Catalog Location

In this part, you open Windows Explorer and navigate to “from” 
Web site, that is, the site whose catalog you deleted above. There, 
you point its web.config and assetmanagement.config files to the 
new catalog.

1. Open Computer Management > Services and Applications 
> Indexing Service.

2. Find the catalogs that you have merged into.
3. Resize the window so that it occupies the left half of the screen.
4. Open Windows Explorer.
5. Navigate to the Web site whose catalog you deleted in ”Part 1: 

Copy the “From” Catalog Path to a New Directory in the “To” 
Catalog” on page 338.

6. In the site root folder, open the web.config file.
7. Resize the window so that it occupies the right half of the 

screen.
You should see the Computer Management screen on the left, 
and the web.config file on the right.

8. In web.config, find the element <webSearch 
defaultProvider="MSIndexDialectServer">.

NOTE Don’t confuse the MSIndexDialectServer tag with MSIndexServer. You only 
need to change MSIndexDialectServer.

9. Shortly after that are catalogName and privateCatalogName.
10. Replace the value of catalogName with the name of the publish 

catalog, visible in the Computer Management screen. For 
example:

catalogName="CMS400Developer11282007130734Publish"

11. Replace the value of privatecatalogName with the name of the 
private catalog. For example:

catalogName="CMS400Developer11282007130734Private"



Managing Assets

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 341

12. Save the web.config file.
13. In the site root folder, open the AssetManagement.config file.
14. Resize the window so that it occupies the right half of the 

screen.
You should see the Computer Management screen on the left, 
and the AssetManagement.config file on the right.

15. In AssetManagement.config, find the element CatalogName.
16. Replace the value of CatalogName with the name of the content 

catalog, visible in the Computer Management screen. For 
example:

catalogName="CMS400Developer11282007130734Content"

17. Replace the value of CatalogLoc with the path to the newly-
merged catalog. To get the path:

- open Windows Explorer.

- navigate to the folder to which the catalog is being copied. 
For example, C:\Program Files\ 
Ektron\Catalogs\CMS400Developer11282007130734\Content

- right click the folder and select Properties.

- copy the Location field.

- Select the assetmanagement.config file’s CatalogLoc tag.

- replace the path with the copied one. For example.
catalogName=”C:\Program Files\ Ektron\Catalogs\CMS400Developer11282007130734\Content”
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18. Copy the “to” catalog name and path entered in steps 16 and 
17 to the other catalogs and locations: PublishCatalogName, 
PublishCatalogLoc, PrivateCatalogName, and PrivateCatalogLoc.

19. Save the AssetManagement.config file.
20. Stop and restart the Ektron Windows Service. 

TIP! If you still have the Computer Management screen open, you can quickly navigate 
to Services and Applications > Services > Ektron Windows Services 2.0.

Troubleshooting
This section explains how to fix problems that may occur with 
Ektron CMS400.NET assets.

Symptom See this section

Error message: Install Indexing Service ”Setting Up the Indexing Service” on page 343

A search of asset files finds no assets on 
your Web site

”Turning on the Asset Indexing Service” on page 357
or
”Merging Indexing Service Catalogs” on page 335

You cannot drag and drop assets into 
Ektron CMS400.NET

”Removing Front Page Server Extensions” on page 363

When a user drags a document, the file 
opens in the browser instead of 
generating an “Uploading” notification

Ektron KB Article: http://dev.ektron.com/
kb_article.aspx?id=14204

The server running Ektron 
CMS400.NET  is running slowly; much of 
its resources are being used even though 
the computer is idle

”Disabling the System Indexing Service” on page 351

Error message after trying to upload 
documents: Failed with error -
2147217911

”Removing aspnet_isapi.dll from the List of Wildcard 
Application Maps” on page 354

http://dev.ektron.com/kb_article.aspx?id=14204
http://dev.ektron.com/kb_article.aspx?id=14204
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Setting Up the Indexing Service
If you see the following error during installation, you need to set up 
the indexing service manually.

The following steps explain how to do that.

Error message: Windows Server 2003 no 
longer ships MSDAIPP.DLL, thus 
connecting to an FPSE server through 
Webfolders, is no longer possible.

”Using Microsoft Windows Server 2003 as a Client (Web 
Folders Setup)” on page 358

While trying to drag and drop an asset, 
an error message appears: The target 
directory already exists.

Check the impersonate element of the web.config file. If 
it is set to true, make sure the anonymous access 
account has at least write access to the dmdata and 
assets directories.

When you try to publish DMS documents, 
Ektron CMS400.NET  sometimes does 
not allow them to update.

Make sure your production server is not running 
Windows XP. You cannot use XP as a production server 
for DMS.

After recently moving the ASM database 
to a new SQL server that has never 
hosted an ASM database, the following 
error appears while adding a DMS asset:

AssetManagement error: Failed to save 
asset. Internal Message: RAISERROR 
could not locate entry for error 
2000000002 in sysmessages. at 
Ektron.ASM.Documents.Asset.Create(en
AssetStatus state) at ... ....

”ERRMSG: AssetManagement error: Failed to save 
asset” on page 361

Symptom See this section
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Step Screen

1. Click Start > Control Panel 
> Administrative Tools > 
Computer Management.
The Computer 
Management screen 
appears.

2. Click the plus sign (+) next 
to Services and 
Applications.

3. Click Indexing Service.
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4. Click the stop button to halt 
the indexing service if it is 
running.

Note: If the Index service is 

running, the start button  is 
grayed out.

5. Right click Indexing 
Service, then click New > 
Catalog.

6. At the Add Catalog Screen:

• In the Name field, add the 
catalog name.

• In the Location field, iden-
tify the folder that will store 
the asset catalog.

Note: By default, during 
installation, Ektron 
CMS400.NET  names the 
catalog Asset and associates it 
with the location 
c:\assetcatalog. The installer 
can change the default location.

Step Screen
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7. Click OK.
The Computer 
Management screen shows 
your new Indexing Service.

8. Right click the Asset 
catalog, then click New > 
Directory.
This is the directory the 
service indexes.

Step Screen



Managing Assets

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 347

9. In the Path text box, add 
the folder of the secure 
storage location. Make sure 
the Include in Index radio 
button is marked Yes.

Note: By default, during 
installation, Ektron 
CMS400.NET  uses 
c:\(Domain Name, IP 
Address or Machine 
Name)\assetlibrary.

10. Click OK. Then, click the 
plus sign (+) next to Asset 
to view the Directories 
folder.
In the Directories folder, the 
new directory is displayed.

Step Screen
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11. Right click Assets, then 
click Properties.

12. On the Tracking tab, 
uncheck all boxes and 
choose None for WWW 
Server.

Step Screen
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13. On the Generation tab, 
uncheck Inherit above 
settings from Service. 
Then click OK.
The Index files with 
unknown extensions and 
Generate abstracts check 
boxes can be checked or 
empty. It is your choice.

14. Right click Indexing 
Service, then click All 
Tasks > Tune 
Performance.

Step Screen
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15. Click the Customize radio 
button.

16. Click the Customize 
button.

Step Screen
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Disabling the System Indexing Service

Symptom

The server running Ektron CMS400.NET is running slowly; much of 
its resources are being used even when the computer is idle.

17. Change Indexing to 
Instant.

18. Click OK and OK again to close both dialog boxes.

19. Click the Start button to 
start the service again.

Step Screen
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Cause

The Microsoft Windows Indexing service is turned on during 
installation. This service indexes every file on the server, and the 
resources required to carry out that task slow down other activities.

NOTE Ektron recommends turning off all indexing services other than the DMS Asset 
indexing service.

Resolution

Follow these steps to disable the Windows indexing service. This 
change does not affect DMS’s ability to find files because it uses a 
different indexing service.

Step Screen

1. Click Start > Control Panel 
> Administrative Tools > 
Computer Management.
The Computer 
Management screen 
appears.



Managing Assets

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 353

2. Click the plus sign (+) next 
to Services and 
Applications.

3. Click Indexing Service.

4. Click the Stop button to 
stop the indexing service.

Step Screen
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Removing aspnet_isapi.dll from the List of Wildcard 
Application Maps

Symptom

When you try to upload an asset, you get the error message 
“Failed to upload documents.”

Cause

Remove the aspnet_isapi.dll from the list of Wildcard Application 
Maps.

Resolution

1. Open IIS.
2. Go to your Ektron CMS400.NET Web site.
3. Underneath the Web site, click Asset Management > dmdata.
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4. Right click dmdata and choose Properties.
5. Click the Virtual Directory tab.
6. Click the Configuration button.
7. Look in the Wildcard Application Maps area. If 

aspnet_isapi.dll appears, remove it.



Managing Assets

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 356

8. Click OK.
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Turning on the Asset Indexing Service

Step Screen

1. Click Start > Control Panel 
> Administrative Tools > 
Computer Management.
The Computer 
Management screen 
appears.

2. Click the plus sign (+) next 
to Services and 
Applications.

3. Click Indexing Service.
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Using Microsoft Windows Server 2003 as a Client (Web 
Folders Setup)

Symptom

You receive the following error message:

• Windows Server 2003 no longer ships MSDAIPP.DLL, thus 
connecting to an FPSE server through Webfolders, is no longer 
possible.

Resolution

Per MS Licensing, you can obtain webfldrs.msi from any down-
level OS, or any Office product that shipped before Windows2003 
(not Office 2003) and install the WebFolders client. Doing so will 
keep you compliant with licensing. 

4. Click the Start button to 
start the indexing service.

Step Screen
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Installing WebFolders from Office 2003 is only allowed if you have 
an Office 2003 license for each Windows2003 server you plan to 
install WebFolders on.

Web Folders Setup for Microsoft Windows Server 2003

NOTE You only need to run the Web Folders Setup if there is a problem during the 
install. The Ektron CMS400.NET  install performs the setup when needed.

The MSDAIPP.DLL is no longer shipped with Microsoft Windows 
Server 2003, making communication with Web folders impossible. 
To correct this, Ektron CMS400.NET setup runs the Web folder 
setup when it detects Microsoft Windows Server 2003.

The following steps explains installing Web Folders. You will need 
to obtain a copy of the webfldrs.msi file.

Step Setup Screen

1. Double click the webfldrs.msi file.

2. The Web Folders install 
screen appears. Click Next 
to continue.
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3. The Web Folders Identity 
dialog box appears.

• Add your Name.

• Add your Organization.

• Click Next.

4. The Web Folders Product 
ID dialog box appears.
This dialog box displays the 
your product ID number.

• Click Next.

5. The Web Folders Selection 
Choice dialog box appears.

• Complete - installs all com-
ponents.

• Custom - you choose the 
components to install.

• Typical - installs the most 
frequently used compo-
nents.
After making a selection, 
click Next.

Step Setup Screen



Managing Assets

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 361

ERRMSG: AssetManagement error: Failed to save asset

Symptom

After recently moving the ASM database to a new SQL server that 
has never hosted an ASM database, the following error appears 
while adding a DMS asset.

AssetManagement error: Failed to save asset. Internal Message: RAISERROR could not locate entry 
for error 2000000002 in sysmessages. at Ektron.ASM.Documents.Asset.Create(enAssetStatus state) 
at Ektron.ASM.Documents.AbstractAssetManagement.Create(AssetMetaData assetMetaData, 
enAssetStatus state) at Ektron.ASM.PluginManager.PluginHandler.Create(AssetMetaData 
assetMetaData, enAssetStatus state) at 
AssetManagement.AssetManagementService.Create(AssetMetaData assetMetaData, enAssetStatus 
state) at Mojave.AssetManagementProxy.Create(AssetMetaData assetMetaData, enAssetStatus state) 
at Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at 
Ektron.Cms.EkException.ThrowException(Exception ex) at 
Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at 
Ektron.Cms.Content.EkContent.AddNewContentv2_0(Collection ContObj)

6. The Verify Ready All dialog 
box appears. Click Install 
Now.

7. The Action dialog box 
appears. The Setup is 
installing Web folders.

8. The We Are Done dialog box appears. Click OK.

Step Setup Screen
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Cause

During the creation of the ASM database, a total of 7 messages 
are written to the sysmessages table in SQL Server’s master 
database. Each installation of SQL Server has its own master 
database and, in a typical move from one location to another, 
changes to the master database are not brought over.

If the ASM database was moved, and these messages are not in 
the sysmessages table in the new location's master table, the 
above error appears instead of a standard error message.

Resolution

Run this set of SQL scripts against your database. They add 
appropriate messages to the sysmessages table in the master 
database.

/
*********************************************************************************************
***/
sp_addmessage 2000000001, 10, N'Error in %s: Error %d inserting into %s. %s', US_ENGLISH, 
FALSE, REPLACE
go

/
*********************************************************************************************
***/
sp_addmessage 2000000002, 10, N'Error in %s: Insert into %s returned %d rows. %s', US_ENGLISH, 
FALSE, REPLACE
go

/
*********************************************************************************************
***/
sp_addmessage 2000000003, 10, N'Error in %s: Failed creating record because primary key already 
exists. %s', US_ENGLISH, FALSE, REPLACE
go

/
*********************************************************************************************
***/
sp_addmessage 2000000004, 10, N'Error in %s: Error %d updating into %s. %s', US_ENGLISH, FALSE, 
REPLACE
go
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/
*********************************************************************************************
***/
sp_addmessage 2000000005, 10, N'Error in %s: Update into %s returned %d rows. %s', US_ENGLISH, 
FALSE, REPLACE
go

/
*********************************************************************************************
***/
sp_addmessage 2000000007, 10, N'Error in %s: Error %d deleting into %s. %s', US_ENGLISH, FALSE, 
REPLACE
go

/
*********************************************************************************************
***/
sp_addmessage 2000000008, 10, N'Error in %s: Delete into %s returned %d rows. %s', US_ENGLISH, 
FALSE, REPLACE
go

This snippet utilizes the sp_addmessage stored procedure from 
the master database, which adds the appropriate messages to the 
correct table. 

NOTE Although it is possible to recode these as an INSERT statement that can run 
directly against the sysmessages table, that procedure is not recommended.

Removing Front Page Server Extensions
Follow these steps to remove FrontPage Server Extensions from 
the Web root. When you do, the extensions are also removed from 
all folders below that.

1. Click the Windows Start button.
2. Click Control Panel > Administrative Tools > Computer 

Management.
3. Open Services and Applications > Internet Information 

Services > Web Sites > Default Web Site.
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4. Right click the mouse and select All Tasks > Remove Server 
Extensions.
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Managing Tasks

NOTE Much of the Task functionality is documented in the Ektron CMS400.NET 
Users Manual section “Managing Tasks”. As an administrator, you should 
familiarize yourself with this information.

Tasks are typically assigned to content to help you monitor and 
manage changes to your Web site. Within Ektron CMS400.NET, 
users can assign tasks to themselves and other users. Tasks may 
include updating content, publishing content, updating an image 
and reordering a collection.

There are two kinds of tasks:

• Tasks not assigned to content

• Tasks assigned to content

A standard Ektron CMS400.NET user only sees tasks that are 
either assigned to or by himself. However, an administrator can 
view all tasks regardless of who they are assigned to or by.

This chapter explains how to access, manage, and assign tasks 
via the following topics:

• ”The Tasks Folder” on page 366

• ”Task Permissions” on page 366

• ”Task Categories and Types” on page 367

• ”Automatic Creation of Tasks Associated with Content” on 
page 376

• ”Task States” on page 384

• ”Task View Options” on page 387

• ”Email Notification” on page 391

• ”Archiving a Task” on page 391 

• ”Deleting a Task” on page 392

• ”Purging a Task” on page 393
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The Tasks Folder
The tasks folder in the Smart Desktop contains all tasks in the Web 
site.

Task Permissions
Assign task-related permissions on the screens indicated below.

Permission Where assigned

Create task Manage Members for Role: Task-Create

Redirect task (that is, 
assign to another user)

Manage Members for Role: Task-Redirect

Delete task Manage Members for Role: Task-Delete
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For more information about the screens listed above, see ”Using 
the Roles Screens” on page 736.

Task Categories and Types
Tasks can be assigned a Task Category, then a Task Type. This 
gives users an additional way to filter their tasks.

Task Categories and Task Types have a hierarchical relationship: 
the Task Category is the parent, and the Task Type is the child. So, 
several types can be assigned to each category.

Some examples of Task Categories might be Engineering, Sales, 
Documentation, or Web Design. Examples of Task Types might be 
Edit Content, Update Documents, or Contact Customer.

NOTE Only members of the Administrator User Group or users assigned the following 
roles can view, add, or edit task categories and types: Task-Create, Task-delete, 
Task-Redirect. See Also: ”Defining Roles” on page 735

You can create Task Categories and Task Types from these 
locations.

• When adding a task. See Also: Ektron CMS400.NET User 
Manual section “Managing Tasks” > “Creating a Task via the 
Task Folder” When editing a task.

• When working in the View Categorization screen.

View Categorization Screen
The View Categorization screen allows administrators to work with 
Task Categories and Task Types. From this screen you can create, 
edit, and delete them.

To access the View Categorization Screen, access the Workarea 
> Settings > Configuration > Task Types.

The following screen appears.
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Viewing Task Categories

Note The View Categorization screen has a system-defined category (Form 
Submission Task) that can only be used with forms. You can change its name but 
cannot delete it. For more information, seethe Forms chapter of the Ektron 
CMS400.NET User Manual. 

While in the View Categorization screen, you can collapse and 
expand Task Categories. To collapse a Task Category, click the 
( ) button next to the Task Category name. To expand one, click 
the ( ) button next to the Task Category name.
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The following example shows the View Categorization screen with 
one Task Category minimized.

Creating Task Categories and Task Types

From the View Categorization screen, you can create Task 
Categories and Task Types by clicking the Add Task Button ( ). 
When you do, the following screen appears.
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From this screen, you can perform these tasks.

• ”Adding a New Task Category and Task Type” on page 370

• ”Adding a New Task Type to an Existing Task Category” on 
page 371

• ”Editing Task Category” on page 372

• ”Editing a Task Type” on page 373

• ”Task Type Availability” on page 374

Adding a New Task Category and Task Type

To add new Task Category and Task Type, follow these steps.

1. Click the Add Task Type button ( ).

2. The Add Task Type Screen appears.
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3. Click the Add Task Type to New Task Category radio button 
or in the text box. 

4. Enter a name in the New Task Category field.

5. Add a Task Type name in the Task Type field.
6. Enter a Task Type Description.
7. Choose a Task Type Availability. See Also:  ”Task Type 

Availability” on page 374

8. Click Save ( ).

9. Your new Task Categories and Task Types appear on the View 
Categorization screen.

Adding a New Task Type to an Existing Task Category

To add a new Task Type to an existing Task Category, follow these 
steps.

1. Click the Add Task Type button ( )
2. The Add Task Type Screen appears.
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3. Click the Add Task Type to New Task Category radio button 
or click the drop down box.

4. Choose a category from the drop down box.
5. Add a Task Type name in the Task Type field.
6. Enter a Task Type Description.
7. Choose a Task Type Availability. See Also:  ”Task Type 

Availability” on page 374

8. Click Save ( ).

9. Your new Task Categories and Task Types appear on the View 
Categorization screen.

Editing Task Category

You can edit a Task Category names. To edit a Task Category, click 
the Task Category link.

A text box screen appears next to the category name. Use the text 
box to change the name.
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You can either save ( ) the changes, or cancel ( ) the edit.

Editing a Task Type

From the View Categorization screen, you can edit a Task Type. 
This allows you to change the Task Type name, Task Type 
description, and Task Type availability.

To edit a Task Type, follow these steps.

1. On the View Categorization screen, click a Task Type.
2. The Edit Task Type screen appears.

From this screen you can edit the following:

• Task Type

• Task Type Description
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• Task Type Availability. See Also: ”Task Type Availability” on 
page 374

3. Edit the information.

4. Click Save ( ).
5. The Task Type information is changed.

Task Type Availability

Task Types can be hidden from users by clicking the Not Available 
check box in the Add Task Type and Edit Task Type screens. By 
making a Task Type not available, you can suppress without 
deleting it.

When you make a Task Type not available, you see the following 
warning.

After you make a Task Type not available, the assigned tasks’ Type 
and Category are changed to Not Specified.

Deleting Task Categories and Task Types

You can delete Task Types by Task Category or individually. 

To delete a Task Type, click the check box next to the Task Type, 
then click the Delete ( ) button. 
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When you delete a Task Type, the following appears.

To delete all Task Types, check the Delete all check box.

The following example shows which check boxes on the screen 
are associated with All Task Types, Task Categories, and individual 
Task Types.
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Automatic Creation of Tasks Associated with 
Content

In addition to the manual assignment of tasks, they can be 
automatically generated whenever content, an asset, or a form is 
created. You would enable and use the Automatic Task Creation 
feature if you want to set up a preapproval process, which requires 
one or more users to review and approve content before it enters 
the regular approval process. (The regular approval process is 
described in ”Setting Approval Chains” on page 726.)
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The most common scenario illustrated below.

In this example, an automatically-generated task assigns the 
content to a preapproval group. When any member of that group 
reviews his tasks, he inspects the corresponding content and 
assigns it to an editor. After the editor reviews and possibly edits 
the content and submits it for approval, it enters the normal 
approval process.

This section explains the automatic task creation process through 
the following subtopics:

• ”Enabling Automatic Task Creation” on page 377

• ”Assigning a Preapproval Group to a Folder” on page 378

• ”How Automatic Task Creation Works” on page 380

Enabling Automatic Task Creation
The Settings > Configuration > Application Setup screen’s Enable 
PreApproval Group field controls Ektron CMS400.NET’s Automatic 
Task feature. Check this box to turn Automatic Tasks on.
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Next, you create user groups and assign them to folders whose 
content must complete the preapproval process before it enters 
the regular approval process. See ”Managing User Groups” on 
page 670 and ”Assigning a Preapproval Group to a Folder” on 
page 378.

Assigning a Preapproval Group to a Folder
The ability to select or update a folder’s preapproval group is 
determined by the advanced permission Modify Preapproval. 
Only users with this permission can see the Modify Preapproval 
button ( ) when viewing the Folder Properties screen. See Also: 
”Standard & Advanced Permissions” on page 718
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If you have permission to modify a folder’s preapproval group, go 
to the Folder Properties screen and click the Modify Preapproval 
button ( ) to access the PreApproval Group field. (The field 
only appears if you have enabled the Preapproval Feature. See 
”Enabling Automatic Task Creation” on page 377.)

If you assign a user group, an automatic task can be assigned to 
that group whenever content in that folder is created or updated.

If you select Inherit, this folder gets its preapproval group from the 
parent folder. If you select None, you disable the preapproval 
feature for the folder.
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Preapproval Groups Report

The Preapproval Groups Report lists all preapproval groups 
assigned to folders within Ektron CMS400.NET. To access it, go to 
Smart Desktop > Reports > Preapproval Groups. See Also: 
Ektron CMS400.NET User Manual > “The Workarea and Smart 
Desktop” > “Understanding the Smart Desktop.” 

How Automatic Task Creation Works
When a user submits a content item for approval, Ektron 
CMS400.NET checks to see if an open task exists for it. (An open 
task is one whose state is Not Started, Active, Awaiting Data, on 
Hold, or Pending.) If none exists and a preapproval group is 
assigned to its folder, a task is created and associated with the 
content.

At this point, all members of the folder's preapproval group see the 
task on their Smart Desktop.
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A task has the following information.

.

Field Value

Title A string formulated by joining the

• content title

• content ID number

• underscore

• Task 

For example, Private Content2_Task

Assigned to The preapproval group

Assigned by The user who submitted the content 
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Next, the task can be reviewed by any member of the preapproval 
group. The member then has two choices.

• review the content and submit it for publishing. This action 
completes the preapproval process and submits the content 
into the regular approval chain.

• assign the task to another user, such as an editor. (The user to 
whom the task is being assigned must have permission to edit 
the content.) The editor reviews the content, updates it as 
needed, and submits it into the regular approval chain.

NOTE The user submitting the content does not need permission to create tasks. Also, 
the user assigned to the task should not change its state using the task system. 
Instead, he should review and approve content using the regular content workflow 
mechanism. That mechanism automatically changes the task’s state.

The tables below explain the sequence of changes to content and 
its associated task. All changes are logged into the task’s history. 
See Also: Ektron CMS400.NET User Manual > “Managing Tasks” > 
“Viewing a Task’s History” 

Also, email is automatically generated for automatic tasks as it is 
for manually-created tasks. See Also: ”Email Notification” on 
page 391

Content The content being submitted for approval

Priority Normal

State Not Started

Due date none

Start date none

Created by User who submitted content 

Description none

Field Value
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Sequence of Task/Content Statuses (Author Lacks Permission to 
Approve Content)

Event Content Status Task Status

Content is created and checked 
in

Checked In No auto task assigned

Content is submitted for 
approval

Note: The above action creates 
the automatic task for the 
content.

Waiting for completion of 
associated tasks

Not Started

Content is assigned by a 
member or preapproval group to 
an editor

Waiting for completion of 
associated tasks

Not Started

Editor updates content then 
checks it in

Checked In Active

Content is submitted for 
approval; it enters any approval 
chain set for the folder

Note: Since the task requires an 
approval, it appears in the task 
list of the current approver. 
When the content is approved, 
the task is moved to the next 
approver's task list. 

Submitted for Approval Pending

Approver denies request Checked In Reopened

Approver approves content Approved Complete
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Sequence of Task/Content Statuses (Author Can Approve Content)

Task States
During the life of a task assigned to content, it normally progresses 
through a series of states. The state helps track a task’s progress 
from creation to completion and even removal from the database. 
When reviewing the history of a task, the state can be used to 
review which actions changed the task’s state by whom and when.

User-Assigned versus System-Assigned States
Some states can only be assigned by users while others are only 
assigned when an event occurs to the associated content. For 
example, when content is first submitted for approval, the 
associated task’s state changes to Not Started. 

IMPORTANT! The administrator user can always change a task’s state to any other state. 

The following graphic illustrates the sequence of user and system 
actions that change a task’s state.

Event Content Status Task Status

Content is created then checked 
in

Checked In No auto task assigned

Content is edited then checked 
in

Checked In Active

Content is submitted for 
approval

Note: Although an author can 
approve content, he must click 
publish twice: once to change 
content status to Awaiting 
Completion of Associated Task, 
and a second time to change it 
to Approved.

Waiting for completion of 
associated tasks

Not Started

Content is published Approved Complete
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Progression of Task States

State Description Assigned 
by 

Not Started Assigned when task is created. User

Active The task’s content is checked out. System

Awaiting 
Data

The task is started but the assigned-to user is awaiting 
data from an external source. You can use comments 
to indicate the data being waited for.

User

On Hold Task cannot be worked on at this time. User
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Restrictions on the Task Flow Process
• Only users with archive and delete permissions can set a task’s 

status to archived or deleted. This can be done at any stage of 
the task flow process.

• Notes can be entered for the task at any time.

Pending The content is submitted for approval. 
A task remains pending while its content is in the 
approval process. When the last person in the 
approval chain approves the content, the task’s state 
changes to Completed.
If any approver declines the content, the task’s state 
changes to Reopened.
If an editor edits the content and then checks it back 
in, the task’s state changes to Reopened.

System

Reopened Content is declined by an approver in the approval 
process. Also, if someone edits content whose task 
state is pending, the tasks’s state changes to 
Reopened. 

System

Completed The last user in the approval chain approves the 
content and it is being published.

System

Archived After a task is completed, administrators can assign 
this state. It no longer appears on open task lists but is 
kept for reviews and reports. 
Only the administrator can view Archived tasks.
See Also: ”Archiving a Task” on page 391

User

Deleted When an archived task is no longer needed for 
reporting or reviewing, administrators can assign this 
state. While in this state, the task remains in the 
database. See Also: ”Deleting a Task” on page 392
When you purge the task, it and all of its transactions 
are removed from the database. See Also: ”Purging a 
Task” on page 393 

User (user 
with delete 
permission 
can delete; 
only admin 
and user with 
Task-Delete 
role can 
purge) 

State Description Assigned 
by 
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• An administrator can assign a task to any state at any time.

Task View Options
Beneath the main task module folder, 14 view screens display all 
tasks filtered by specified categories. The categories appear in 
”The Tasks Folder” on page 366. 

After viewing tasks in any category, most screens let you perform 
an action on the tasks (the actions are included in the table below). 
For example, you can redirect your tasks to another user. To select 
all tasks on a screen, click the check box in the header row 
(illustrated below).

Folder Displays these tasks Action you can perform 
from view screen

Tasks Open tasks assigned to yourself, and 
open tasks you have assigned to other 
users.

• Create a new task

• Delete a task

• View a task

• Sort tasks by column

All Open Tasks All open tasks (that is, tasks in one of 
these states) for all users

• not started
• active
• awaiting data
• on hold
• reopened
• pending

• Edit a task

• Sort tasks by column
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Assigned To Me All open tasks assigned to you • Assign tasks to a different 
user 

• View a task

• Sort tasks by column

Assigned By Me All open tasks you assigned to yourself or 
others

• Assign tasks to a different 
user 

• View a task

• Sort tasks by column

Created by Me All open tasks you created • View a task

• Sort tasks by column

Assigned to User All open tasks assigned to a user you 
select

• Select any user and view 
all tasks assigned to that 
user.
To do so, select new user 
from Assign to User drop 
down list and click Get 
Tasks.

• View a task

• Sort tasks by column

Not Started All whose state is Not Started
See Also: ”Task States” on page 384

• Change to any other state

• View a task

• Sort tasks by column

Active All whose state is Active • Change to any other state

• View a task

• Sort tasks by column

Awaiting Data All whose state is Awaiting Data • Change to any other state

• View a task

• Sort tasks by column

Folder Displays these tasks Action you can perform 
from view screen
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Determining Which Tasks a User Can View
To provide security, Ektron CMS400.NET restricts which users can 
use the task views. These restrictions are listed on the following 
table.

On Hold All whose state is On Hold • Change to any other state

• View a task

• Sort tasks by column

Pending All whose state is Pending • Change to any other state

• View a task

• Sort tasks by column

Reopened All whose state is Reopened • Change to any other state

• View a task

• Sort tasks by column

Completed All whose state is Completed • Change to any other state

• View a task

• Sort tasks by column

Archived All whose state is Archived • Change to any other state

• View a task

• Sort tasks by column

Deleted All whose state is Deleted • Change to any other state

• Purge tasks

• View a task

• Sort tasks by column

Folder Displays these tasks Action you can perform 
from view screen
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* - user can only view open tasks, that is, not started, active, awaiting data, on 
hold, pending, or reopened 

View 
option

Administrator 
group member

User or 
group to 
whom task 
assigned

User who 
assigned 
task

User who 
created 
task

All users

All Open * X

Assigned by 
Me

X X

Assigned to 
Me *

X

Created by 
Me *

X

Assigned to 
User

X X X X X

Not Started all tasks in 
specified state

only tasks 
assigned to 
user in 
specified 
state

Active | |

Awaiting 
data

| |

On hold | |

Pending | |

Reopened | |

Completed | V

Archived |

Deleted V
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Email Notification
email notification is sent on these occasions.

IMPORTANT! For email notifications to be sent, the following items must be true:
- Users have email enabled in their user profile.
- Users have a valid email address in their user profile.
- CMS400.NET is set up and configured to send emails.

• A task is assigned to a user.

• A task is redirected to a user.

• A task is submitted for content approval. Sent to the first user in 
the approval chain.

• The approval process moves on to the next approver.

• The content is declined at an approval stage. This is sent to the 
assigned user.

• The content is published. This goes to the creator, assigned 
user, and the approvers.

See Also: “Configuring E-Mail Notifications” in the Ektron 
CMS400.NET Setup Manual

Archiving a Task
After a task is completed, you may want to change its state to 
Archived. Archiving moves selected tasks from the Completed 
tasks list to the archived list. This change cleans up the completed 
tasks list and makes it and easier to use.

Archived tasks are typically kept for a predetermined time period, 
at which point an administrator deletes them (depending on your 
organization’s policies).

To archive a task, follow these steps.

1. From the Smart Desktop, open the Tasks folder.
2. Click the view option corresponding to the state of tasks you 

want to archive. Typically, you would archive completed tasks.
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3. A list of Completed tasks appears. Select tasks one at a time, 
or click the check box on the top left corner to select all.

4. Next to the Change to State field, click the down arrow to 
display the drop down list and select Archived.

5. Click the Set button.

Deleting a Task
You can easily delete tasks no longer needed on the Web site. 
Although an administrator can change a task’s state to deleted at 
any time, you typically do so after it is completed or archived, 
depending on your organization’s policies.
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Note that a deleted task remains in the system until you purge it. It 
is only visible on the View Deleted Tasks option. See Also: 
”Deleted” on page 386.

Tasks can be deleted either one at a time, or several at once. 

To delete tasks, follow these steps.

1. From the Smart Desktop, click the Tasks folder.
2. Click the view option corresponding to the state of tasks you 

want to delete. Typically, you would delete archived tasks.
3. Select tasks one at a time, or click the check box on the top left 

corner to select all.

4. Next to the Change to State field, click the down arrow to 
display the drop down list and select Deleted.

5. Click the Set button.

Purging a Task
If you want to remove deleted tasks from the system, you purge 
them. Upon purging, a task and its history are removed from the 
database.

To purge one or more tasks, follow these steps.

1. From the Smart Desktop, click the Tasks folder.
2. Click the Deleted view option. 
3. Select tasks one at a time, or click the check box on the top left 

corner to select all.
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4. Click the Purge button.
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Searching Your Web Site

NOTE This chapter describes the operation of the Web Search server control, which was 
introduced by the 7.0 Release. To learn about the operation of the Search server 
control (the search available prior to 7.0), see http://www.ektron.com/manuals/
cms400/v61/useradmin/search.62.1.html.

Ektron CMS400.NET provides two kinds of searches:

• the Web site search helps site visitors find published content 
on your Web site.
Your Web developer determines where to place the Web site 
search. The Ektron CMS400.NET sample site provides a link to 
it from every page. When a site visitor clicks the link, he sees 
the search screen.

For more information, see ”Web Site Search” on page 396.

• the Workarea search helps anyone signed into Ektron 
CMS400.NET to find content. To access the Workarea search, 
go to the folder whose content you want to search and click 
Action > Search. The following screen appears.

http://www.ektron.com/manuals/cms400/v61/useradmin/search.62.1.html
http://www.ektron.com/manuals/cms400/v61/useradmin/search.62.1.html


Searching Your Web Site

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 396

The left tab lets you access the default version of the Web site 
search, while the right tab lets you search content by properties 
(title, comments, creation date, status, etc.).

To learn more about the Workarea search, see the Ektron 
CMS400.NET User Manual section “Searching the Workarea.”

The Web site search is more fully explained through the following 
topics.

• ”Web Site Search” on page 396

• ”The Catalog and Index Files” on page 397

• ”Basic versus Advanced Web Site Search” on page 411

• ”Display of Search Results” on page 417

• ”Synonym Sets and Suggested Results” on page 421

• ”Using the Integrated Search” on page 439

• ”Setting up a Multiple Site Search Using Virtual Directories” on 
page 446

• ”Searching for Metadata” on page 450

• ”Installing the Visio IFilter” on page 451

• ”Query Language” on page 451

• ”Search Troubleshooting” on page 464

NOTE This section explains how to use the search function on a browser page. For 
information about inserting the search function into an Ektron CMS400.NET Web 
template, see the Ektron CMS400.NET Developer Manual.

Web Site Search
Ektron CMS400.NET’s Web site search provides extremely fast 
results without impacting the load on your database. To accomplish 
these goals, Ektron CMS400.NET stores a separate copy of all 
published content in local index files (also known as a catalog). 
The Microsoft Windows Indexing service constantly indexes the 
catalog so that search results are returned with lightning speed.
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NOTE Actually, two catalogs are created: one for public content, and another for private 
content.

Another advantage of the indexing service is its robust query 
language. Site visitors can use it to find Web site content by 
combining a rich collection of search criteria, including

• boolean and proximity operators

• wildcards

• free text queries

• vector space queries

• property value queries

These are explained in ”Query Language” on page 451.

A third benefit of this architecture is scalability. If the amount of 
content or number of hits begins to affect performance, you can 
move the catalog to a separate server to handle the increased 
workload.

The Catalog and Index Files
NOTE Be sure that your Web server is running Indexing Service 3.0. Earlier versions of 

the service do not work properly.

The Microsoft Windows Indexing Service uses catalogs to index 
Ektron CMS400.NET content. The catalogs read copies of content 
that are saved to the local file system whenever they are 
published.

This section explains the following topics about working with the 
Indexing Service and catalogs.

• ”Local Index Files” on page 398

• ”The Catalogs” on page 399

• ”Recreating a Catalog” on page 401

• ”Restarting the Indexing Service” on page 408
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Local Index Files
A separate copy of all published content is maintained in local 
index files (whose extension is .txt), which are stored in the 
siteroot/assets folder. Within that folder is a reproduction of the 
CMS folder structure. However, it uses the folder ID number, not 
name, to represent folders. The following graphic illustrates this 
structure.

Notice that each content item is saved as a .txt file for indexing. 
The file name is derived from the content item’s

• ID number 

• underscore (_)

• language ID

• file extension (content items have an .html extension)
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• .txt file extension

The Catalogs
Ektron CMS400.NET stores a copy of all published content in two 
catalogs that can be queried. Their default names are below.

• siteroot uniqueID Publish

• siteroot uniqueID Private

As indicated, the second catalog stores private assets. See Also: 
”Private Content” on page 692

To access these catalogs within the indexing service, go to 
Computer Management > Services and Applications > 
Indexing Service.

Within the file system, these catalogs reside in the c:\program 
Files\Ektron\Catalogs\siteroot unique identifier folder. For 
example, C:\Program Files\Ektron\Catalogs\CMS400Min312007131255.

View a catalog’s properties to see the fields you can use in 
queries. See Also: ”Property Value Queries” on page 457
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Changing a Catalog’s Name

To change a catalog’s name, open the siteroot/web.config file with 
an editor such as Notepad. Then, update the catalogName element 
for the published catalog name, and the privateCatalogName 
element for the private catalog name.

<webSearch defaultProvider="MSIndexDialectServer">
<providers>
<add name="MSIndexDialectServer" 
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexDialectProvider, Ektron.Cms.WebSearch" 
catalogName="localhostPublished" privateCatalogName="localhostPrivate" pageSize="10" 
description="MS Index Server Dialect2 Provider"/>

                  <add name="MSIndexServer" 
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexProvider, Ektron.Cms.WebSearch" 
catalogName="localhostPublished" privateCatalogName="localhostPrivate" pageSize="10" 
description="MS Index Server SQL Provider"/>
</providers>
</webSearch>
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Recreating a Catalog
If a catalog is accidentally deleted or becomes corrupted, follow 
these steps to recreate one. There are two ways to do this.

• ”Manually Recreating a Catalog” on page 401

• ”Automatically Recreating a Catalog” on page 402

Manually Recreating a Catalog

Part 1: Create a New Catalog and Copy Metaconfig.doc File to it

1. Open the C:\Program Files\Ektron\Catalogs folder.
2. Create a folder for the new catalog.
3. From the Computer Management screen, select Services and 

Applications > Indexing Service.
4. If the indexing service is running, right click Indexing Service 

and click Stop.
5. Right click the mouse and select New > Catalog.
6. Assign the catalog a name. At the Location field, browse to the 

folder you created in Step 2.
7. Navigate to the C:\Program 

Files\Ektron\CMS400releasenumber\Utilities directory and find 
the metaconfig.doc file.

8. If you are creating a public catalog, copy that file to the site 
root/Assets folder.
If you are creating a private catalog, copy metaconfig.doc to 
the site root/PrivateAssets folder.

9. From the Computer Management screen, click the new catalog 
you created in step 5. Underneath it, a Directories folder 
appears.

10. Select the Directories folder and click New > Directory.
11. The Add Directory Screen appears. If you are creating a public 

catalog, browse to the site root/Assets folder. If you are 
creating a private catalog, browse to the site root/PrivateAssets 
folder.

12. Right click Indexing Service and click Start. 
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13. From the Computer Management screen, view the new 
indexing service. Make sure a number appears in new 
catalog’s Total Docs column, and the Docs to Index number 
is zero (0) before proceeding.

Part 2: Update Metaconfig.reg

1. Navigate to the C:\Program 
Files\Ektron\CMS400releasenumber\Utilities directory 

2. Open the metaconfig.reg file with an editor like Notepad.
3. Update the first line of that file with the location of the new 

catalog relative to the C:\Program Files\Ektron\Catalogs folder. 
For example, if the new folder within the catalog folder is 
named mytest, the first line of the metaconfig.reg file looks like 
this.

[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\ContentIndex\Catalogs\mytest\Properties]

4. Save the file.
5. Double click the file. This action updates your Windows 

Registry with the new information.
6. Stop and restart Windows Indexing Service. Both commands 

are available from the menu that appears when you hover over 
the Indexing Service and right click the mouse.

7. View the new Indexing Service to verify that all properties exist 
as in the original service.

Part 3: Update web.config

Follow the directions in ”Changing a Catalog’s Name” on page 400 
to update the catalogs that are updated as content is updated.

Automatically Recreating a Catalog

If you don’t want to perform the manual steps listed above, Ektron 
CMS400.NET provides a utility that automatically creates a new 
catalog. You would typically use this if a catalog were corrupted or 
accidentally deleted.

IMPORTANT! Before running the Search Data Configuration utility, if your server has Visio 
documents, install the Visio IFilter. See ”Installing the Visio IFilter” on page 451. 
Also, if your server has Office 2007 documents, install the Microsoft Office 
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SharePoint Server 2007 IFilters. See http://technet2.microsoft.com/Office/en-us/
library/c6c029bd-64ea-4617-b2da-c269f13599e21033.mspx?mfr=true.

To launch the utility, follow this path from the Windows Start button:

Start > Programs > Ektron > CMS400 version > Utilities > 
SearchConfigUI

Alternatively, click the following file: C:\Program 
Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig\s
earchconfigUI.exe

When you do, the following screen appears.

To create a new published asset catalog, follow these steps.

http://technet2.microsoft.com/Office/en-us/library/c6c029bd-64ea-4617-b2da-c269f13599e21033.mspx?mfr=true
http://technet2.microsoft.com/Office/en-us/library/c6c029bd-64ea-4617-b2da-c269f13599e21033.mspx?mfr=true
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1. In the Published Catalog field, enter the name of a new 
catalog. Or, leave the current catalog name, and the utility will 
overwrite the catalog.

2. Do the same to create a new or replace the Private Catalog.
3. Check the Create New Catalogs box.
4. If you want to automatically generate a summary for all content 

in the new catalog, click the Automatically generate 
summary for content checkbox. See Also: ”Auto Generating 
Summaries” on page 74

5. Click the Advanced tab.
6. Check each type of content that you want to index for the 

search.

7. By default, new catalogs are created in the web site root/ 
catalogs folder. If you want to create these in another folder, 
use the Specify directory for catalogs field to enter or browse 
to that folder.

8. Press Start.
9. Ektron CMS400.NET creates a new catalog and index files for 

your content.
After you run this utility, the old catalog remains but no new content 
is written to it. All subsequent changes are written to the new 
catalog.

See Also: ”SearchConfigUI.exe crashes while building search 
indexes and catalogs” on page 466

The SearchConfig Log

All activity generated by the Search Data Configuration screen is 
tracked by a log. You can view the log top obtain a history of these 
changes. 

The log is located in the C:\Program 
Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig 
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folder. Its name is date time.LOG. The log is also available on the 
Search Data Configuration Screen’s Log output tab.

Search Data Configuration Screens
Use these screens to perform the following actions.

• make all Ektron CMS400.NET content searchable (do this if you 
recently switched to a new database)

• make any of the following kinds of content searchable (do this if 
the search cannot find this content)

- HTML

- assets

- XML Smart Forms

- users and groups

- forums

• reindex the catalogs

• create a new catalog and index it (do this if a catalog was 
corrupted or accidentally deleted)

The following table explains the fields on the screens.

See Also: ”The SearchConfig Log” on page 404

The Configuration Tab

Field Description

Web Site Select the Ektron CMS400.NET  site that you want to work with

Connection String Review the connection string to your Ektron CMS400.NET  database. 
Update if needed.

Assets Path Review the path to your site’s Assets folder. Update if needed.

Private Assets Path Review the path to your site’s Private Assets folder. Update if needed.

Re-index existing catalogs Check this box if you want to reindex the existing catalogs.
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The Advanced Tab

Create New Catalogs Check this box if you want to create a new catalog.

Published Catalog Review the name of your published catalog. Update if needed. See Also: 
”The Catalogs” on page 399

Private Catalog Review the name of your private catalog. Update if needed. See Also: 
”The Catalogs” on page 399

Automatically Generate 
Summary for Content

If you want to automatically generate a summary for all content in the new 
catalog, click this checkbox. See Also: ”Auto Generating Summaries” on 
page 74

Status After you click the Start button, this area indicates the status of the new 
catalog creation.

Field Description
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The Log Output Tab

All activity generated by the Search Data Configuration screen is 
tracked by a log. The Log Output Tab displays a history of these 
changes.

Field Description

Index the following for 
Search

• Html Content

• Users and Groups

• Documents

• Forums

• XML Content

Check each type of content that the search can find.

Specify directory for 
catalogs

Use this field to change the location of the published and private 
catalogs, if desired. By default, they reside in the your web site/catalogs 
directory.
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A permanent copy of the log is saved in the C:\Program 
Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig 

folder. Its name is date time.LOG.

Restarting the Indexing Service
Use the Indexing Service screen to restart Windows’ Indexing 
Service. You can also use the screen to rescan the catalogs.

To access the Indexing Service screen, go to Workarea > 
Settings > Configuration > Indexing Service.

From this screen, you can

• ”Restart the Indexing Service” on page 408

• ”Run a Full Scan of a Catalog” on page 410

• ”Run an Incremental Scan of a Catalog” on page 410

Restart the Indexing Service

Sometimes, when resolving issues with your search, you must stop 
and restart the indexing service. To restart it via the Indexing 
Service screen, click the Restart Service button. 
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To restart the indexing service for a particular catalog only, click 
Restart to the right of the catalog name.

Alternatively, you can stop and restart the Indexing service from 
the Computer Management screen, as shown below.
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Run a Full Scan of a Catalog

Sometimes, when resolving issues with your search, you need to 
run a full scan of a catalog. To do this, access the Settings > 
Configuration > Indexing Service screen. Then, click Rebuild 
next to the affected catalog.

The following text explains the full scan. (Copied from Microsoft 
Management Console help)

A full scan takes a complete inventory of all documents in the 
cataloged folders and adds them to the list of documents to be 
indexed. The Indexing Service does a full scan of disk drives 
attached to your computer (except for removable devices) in the 
following situations:

• When it is run for the first time after installation 

• When a folder is added to the catalog 

• As part of recovery if a serious error occurs 

Run an Incremental Scan of a Catalog

Sometimes, when resolving issues with your search, you need to 
run an incremental scan of a catalog. To do this, access the 
Settings > Configuration > Indexing Service screen. Then, click 
Update next to the affected catalog.
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The following text explains the incremental scan. (Copied from 
Microsoft Management Console help)

Microsoft Windows Indexing Service cannot track changes to 
documents when it is shut down. When Indexing Service restarts, it 
does an incremental scan to detect all documents that were 
modified while it was inactive so it can update its index.

An incremental scan may also be performed if Indexing Service 
loses change notifications. This can happen if the update rate of 
documents is very high and the buffer used to get change 
notifications from Windows XP overflows.

Basic versus Advanced Web Site Search
When your developer places a Web Search server control on any 
page, and a site visitor browses to it, he sees the following.

This section now divides into two sections:

• Basic Search (shown above)
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• Advanced Search (access this by clicking Advanced Search 
from the Basic Search screen)

This section also explains the following search-related topics.

• ”The Content Searchable Field” on page 417

• ”Display of Search Results” on page 417

• ”Synonym Sets and Suggested Results” on page 421

• ”Using the Integrated Search” on page 439

• ”Setting up a Multiple Site Search Using Virtual Directories” on 
page 446

• ”Searching for Metadata” on page 450

• ”Installing the Visio IFilter” on page 451

See Also: ”The Advanced Search” on page 414

The Basic Search

NOTE You can also create a folder with content outside of Ektron CMS400.NET that is 
searched. For more information, see ”Using the Integrated Search” on page 439.

The Basic Search finds content that satisfies these criteria.

• published

• active (archived content is ignored)

• its Searchable check box is checked (see ”The Content 
Searchable Field” on page 417)

• public. However, private content is available to those with 
permission to view it, such as membership users after logging 
in. See Also: ”Private Content” on page 692.

• resides in the CMS folder specified in the Web search server 
control, or in one of that folder’s subfolders if the control’s 
recursive property is set to true

• is not a non-image file added to the library. Images are 
searchable, while other files added to the library are not. So, to 
make files searchable, add them as assets, not library files.

• matches selected language, if site is multi-lingual
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• satisfies text and/or query entered in the search box (no value 
returns nothing) See Also: ”Query Language” on page 451 

- The text inserted in the search field can appear in the 
content or metadata (See Also: ”Searching for Metadata” 
on page 450)

• satisfies content type criterion selected on screen, if chosen 
(see below)

NOTE The search does not find documents inside compressed files, such as *.zip, *.cab, 
etc.

Search Results by Content Type

Search Screen 
Option

Finds submitted text in these content types

Site Content from all options below plus Forums

HTML • HTML

• Smart Form (XML)

Note: Finds XML field values but not field labels. This has 
not changed since prior releases.

• HTML Form

• Blog entries (not comments)
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NOTE The search cannot find calendar events.

Searching Multiple Terms

If a site visitor enters several terms, the search only returns pages 
that include all terms. This is known as an ‘and’ relationship. For 
example, if the user enters cancer and cure in the Search box, 
only content that includes both terms (and satisfies the other 
criteria) appears.

The advanced search screen, on the other hand, lets the site 
visitor determine if he wants an and, or, not, or exact phrase 
relationship. See Also: ”The Advanced Search” on page 414

The Advanced Search
The Advanced Search uses nearly all the same search criteria as 
the Basic Search. (See ”The Basic Search” on page 412). The 
differences are additional options and filters (explained below) and 
the fact that you cannot use queries.

Documents • MS Office document (includes Powerpoint, Excel)

Note: The search finds text within Visio documents if the 
Visio IFilter has been installed. See ”Installing the Visio 
IFilter” on page 451.

• PDF file

• .txt file

Images added as 
assets and through the 
library

.gif, .jpeg, etc.

Multi Media Flash, .mp3, etc.

Search Screen 
Option

Finds submitted text in these content types
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Advanced Search Options

Search Option Finds these pages

with all of the words Web page must include all submitted terms; their 
position on the page does not matter. 
You cannot enter queries into this field.

with the exact phrase Web page must include the exact phrase. For example, 
if you enter Ektron healthcare, a page with the term 
Ektron provides healthcare is not found because it is 
not an exact match.

at least one of the words Web page can include any one of the submitted terms
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Advanced Result Filters

Below the Advanced Search Options is a list of additional fields 
you can use to refine the search. These are titled Advanced 
Result Filters.

To add a filter, click Add Filter. To remove a filter, click Remove to 
the right of the filter.

without the words Web page contains none of the submitted terms.
Only use this option if you also reply to one of the three 
fields above. 

Search Option Finds these pages

Result 
Filter

Prompts site visitor to enter

Author Enter firstname<space>last name.
Can abbreviate by entering part of either name surrounded by 
asterisks (*). For example, *Jo* finds any author whose first or last 
name contains those letters.

Created 
Before

All content created before date entered by user. 
Date format is YYYY/MM/DD.

Created 
After

All content created after date entered by user. 
Date format is YYYY/MM/DD.

Modified 
Before

All content updated before date entered by user. 
Date format is YYYY/MM/DD.

Modified 
After

All content updated after date entered by user. 
Date format is YYYY/MM/DD.

File Size Enter file size in kilobytes. You can use greater and less than 
operators (>, <) to find content greater or less than a value. For 
example, > 10000.
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The Content Searchable Field
Each content item includes a Content Searchable field. The 
search only considers content whose field is checked. See 
illustration below.

By default, this field is checked when content is created.

IMPORTANT! Despite the value of this checkbox, if an Ektron CMS400.NET user places this 
content item in a Suggested Results list, it will appear in the Suggested Results 
area of the Search Results screen. See Also: ”Suggested Results” on page 425. 
Also, this content can still be found by the Advanced Workarea search. 

Display of Search Results
Below is an example of the Web Site Search and Search 
Published results screen. Your developer can customize it using 
the Web Search server control.
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Below the search box is an optional Filter by Category link. If your 
developer enables the link in the WebSearch server control, a site 
visitor can click it to see a folder structure of taxonomy categories. 
He can then select categories of interest. When he does, only 
content that includes the search term and which is assigned to the 
selected categories appears. For more information, see the Ektron 
CMS400.NET Developer Manual section “Web Search Server 
Control” > “Filtering Search Results by Category.”

The actual results begin with the title and last edited date. 
Following them is either 

• an abstract of the content, which is automatically generated by 
the Windows Indexing Service, or

• the content summary ( The Ektron CMS400.NET User Manual 
section “Adding a Content Summary)

Your developer makes this decision in the WebSearch server 
control.



Searching Your Web Site

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 419

Following the abstract or summary is additional information, such 
as content ID number, size, last author, number of occurrences of 
the search term, and rank. Your developer determines which 
criterion is used to order the results.

TECHNICAL NOTE The Adobe IFilter, which is used to generate the abstract, is only supported in Tier 
1 languages (English, French, German, and Japanese). If your Web site uses 
other languages, the abstract may not be legible. In such a case, your developer 
should suppress the abstract from the search results. This procedure is 
documented in the Ektron CMS400.NET Developer Manual section “Web 
Search Server Control” > “Determining the Display of Search Results.”

When you click the title of any content item, it appears with the 
search term highlighted (see example below).

See Also: 

• ”Adjusting the Length of the Search Result Abstract” on 
page 420

• ”Search Result Ranking” on page 420
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Adjusting the Length of the Search Result Abstract
To adjust the length of the abstract, update the Indexing Service’s 
Properties window > Generation tab > Maximum Size field (see 
below).

The abstract’s text is taken from the content. (It ignores text in 
tables.) If the content text has fewer characters than the Maximum 
Size, Ektron CMS400.NET tries to complete the abstract by 
retrieving the title, summary, metadata, comments, and additional 
information stored in the content item’s tabs.

Search Result Ranking
Each content item found by a catalog search is given a numerical 
rank between 0 and 1000. Search results can be sorted by rank.

Criteria used to calculate rank include the 

• number of occurrences of the search term
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• proximity of search term to beginning of file

• proximity of search term to other occurrences of the term

• whether the term is in the title

Customizing the Postback Message
By default, if a search term yields no results, the following 
message appears on the screen.

If you want to customize this message, follow these steps.

1. In your site root folder, find the workarea/resources folder.
2. Open the resource file that corresponds to your site’s 

language. For example, if your site is in American English, 
open EkResource.en-US.resources.

NOTE If your site supports multiple languages, follow these steps for each 
corresponding resource file. See Also: ”Procedure for Translating Workarea 
Strings” on page 848

3. Within the resource file, find the key lbl search no results.
4. The default text (shown above) follows this key. Modify the text 

as needed.
5. Save the file.

Synonym Sets and Suggested Results
This section describes two search enhancements that can be used 
independently but are more powerful when used together.

• ”Synonym Sets” on page 422
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• ”Suggested Results” on page 425

Synonym Sets
You can create sets of synonyms to work with the search. If a site 
visitor enters any term in a synonym set into the Search box, 
Ektron CMS400.NET’s search looks for that term plus all other 
terms in the set.

For example

Synonym Set: Tuition

Terms: tuition, bill, payment, pay, fee, charge, price, amount, cost, 
money, balance

If a site visitor inserts bill into the search field, Ektron CMS400.NET 
uses bill or tuition or payment or pay or fee or charge, etc. to 
gather search results.

The Synonym Set feature will typically produce more “hits.” So, 
while the user does no more work, his chances of finding the right 
information on your Web site are greatly increased.

If a term exists in more than one Synonym Set, the search 
encompasses all terms in all sets.

The following sections explain how to work with Synonym Sets in 
more detail.

• ”Synonym Set Best Practices” on page 423

• ”Creating a Synonym Set” on page 423

• ”Editing a Synonym Set” on page 424

• ”Deleting a Synonym Set” on page 425

TECHNICAL NOTE The Web Search server control has a SearchSynonyms property. This must be set 
to true for a Synonym Set’s terms to be included in the search logic.
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Synonym Set Best Practices
• Synonyms are searched across all HTML content and 

documents indexed by Ektron CMS400.NET (for example, Word 
documents). 

• Ektron CMS400.NET’s search does not include plurals or verb 
forms. So, if you think a site visitor might enter either ticket or 
tickets, enter both into the Synonym Set. Same with bill, 
billing, etc.

• A search term can consist of several words as long as the term 
is entered the same way in the Synonym Set. For example, 
love seat is part of a Synonym Set that includes sofa.
As long as both love and seat are in a content item, the search 
finds it even if the words are separated. But, entering a single 
term, like love, will not find that Synonym Set.
So, if you think people may search using loveseat or love 
seat, enter both terms into the Synonym Set.

• The metadata search does not use or support Synonyms Sets.

Creating a Synonym Set
Follow these steps to create a Synonym Set.

1. From the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Search > Synonyms.

2. From the language dropdown, select a language for the 
Synonym Set. (The search is language-specific. When a site 
visitor begins using your site, he selects a language. Only 
synonyms sets in that language are considered.)

3. Click the Add button ( ).
4. The following screen appears.
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5. Enter a name for the set. Ektron CMS400.NET users will use 
this name to identify the Synonym Set.

6. Enter all terms that make up the set. Separate each with a 
semicolon (;). You cannot enter a comma (,) or a parenthesis 
character (() into the Terms field.

7. After entering all terms, click the Check for Duplicates button. 
Ektron CMS400.NET compares terms in this set against the 
other Synonym Sets in this language. If the same term is found 
in another set, you are notified.
It is not necessarily a problem for a term to exist in more than 
one Synonym Set. So, review each Synonym Set that contains 
the duplicate and decide what to do.

8. Click Save ( ).

Editing a Synonym Set
Follow these steps to edit a Synonym Set.

1. From the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Search > Synonyms.

2. From the language dropdown, select the Synonym Set’s 
language. 

3. Click the Synonym Set that you want to edit.

4. Click the Edit button ( ).
5. The Edit Synonym Set screen appears.
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6. Add or remove terms. Be sure to separate each term with a 
semicolon (;).

7. Click the Check for Duplicates button. Ektron CMS400.NET 
compares terms in this set against the other Synonym Sets in 
this language. If the same term is found in another set, you are 
notified.

8. Click Save ( ).

Deleting a Synonym Set

NOTE Deleting a Synonym Set also deletes any Suggested Results associated with the 
Synonym Set. The user is warned about this when deleting.

Follow these steps to delete a Synonym Set.

1. From the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Search > Synonyms.

2. From the language dropdown, select the Synonym Set’s 
language.

3. Click the Synonym Set that you want to delete.

4. Click the Delete button ( ).
5. You are asked to confirm your action.
6. The Synonym Set is deleted.
7. Perform an IIS reset on your server. This utility clears the 

cache, so that the synonym set is no longer available to Ektron 
CMS400.NET. 

See Also: http://support.microsoft.com/kb/202013

Suggested Results
For any term or Synonym Set, you can create a list of Suggested 
Result links. That is, links that appear in a special area of the 
Search Results page whenever someone searches for a selected 
term. These links can jump to your Web site or an external Web 
site.

http://support.microsoft.com/kb/202013
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The Suggested Results feature is explained through the following 
topics.

• ”Using Suggested Results to Direct Site Visitors” on page 427

• ”Determining the Display of Suggested Results” on page 430

• ”Creating a Set of Suggested Results” on page 431

• ”Editing a Suggested Result Set” on page 435

• ”Deleting a Suggested Results Set” on page 439

TECHNICAL NOTE The Web Search server control has a ShowSuggestedResults property. This must 
be set to true for suggested results to appear on the page that hosts that control.
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Using Suggested Results to Direct Site Visitors
Use this feature to direct site visitors to pages that do not appear at 
the top of natural search results. For example, you manage a 
university’s Web site. When a site visitor wants to know where to 
mail a tuition payment, he enters bill into the search field and gets 
these results.

Faculty member Bill McDermott
The Student Bill of Rights
How a Bill Becomes Law

Frustrated, many people call the business office to get information 
that exists on the Web site but is difficult to find.

Using Ektron CMS400.NET, you can combine a Synonym Set with 
Suggested Results to direct site visitors to the correct Web pages. 
To continue this example, you could create

• a Synonym Set (named tuition) that includes all terms people 
might enter when searching for the tuition page on your Web 
site. See Also: ”Synonym Sets” on page 422

• a Suggested Results list in which you assign the “Tuition & 
Fees” Web page to the Tuition Synonym Set

These sets are illustrated below.
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After you set up the Synonym Set and Suggested Results, here is 
a typical sequence of events.

1. A site visitor enters a phrase on your site's Search page.

2. The phrase matches a term in a Synonym Set that has 
Suggested Results.
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3. Suggested Result hyperlinks assigned to the set appear in a 
special area of the results page. They appear in the order you 
defined when setting up links.

4. The search term’s normal results can also appear. Your 
developer determines their location on the results page.

Using Suggested Results to Enhance Business Opportunities 

You can also use Suggested Results to direct site visitors to 
business partners' Web sites. One example is a stop smoking 
clinic near your hospital that has been successful with your 
patients. When someone visits your Web site and searches for 
smoking, you can set the clinic to be the top Suggested Result.

As another example, your organization creates widgets but does 
not implement or customize them. Over time, several agencies 
develop experience at deploying and customizing your widgets. 
Therefore, you want to promote these supporting businesses on 
your site. To do so, create a Synonym Set (for example: deploy, 
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install, implement, customize, modify, adapt) and assign the Web 
sites of approved agencies to the Suggested Results list. Then, 
when a site visitor searches for the word implement or customize, 
he gets links to those agencies’ Web sites.

Suggested Results can also be used to advertise products, as 
used in the sponsored results section of popular search engines 
like Google® search and Yahoo!® .

Determining the Display of Suggested Results 
Suggested Results can appear on any page that contains a 
Websearch server control. They can appear wherever you want: at 
the top of the search results page, in the right column, etc. You can 
also choose if and where to display the search term's regular 
results.

In the Web Search server control, your Web developer determines 
where search results appear, using either a style sheet or an XSLT. 
For more information, see the Ektron CMS400.NET Developer 
Manual section “Web Search Server Control.”

NOTE The WebSearch server control has a ResultsPageSize property. If your 
developer sets it to less than the number of suggested results applied to a term or 
synonym set, the ResultsPageSize property’s number of results appears. For 
example, if you assign five links to a Suggested Result set but a developer sets 
ResultsPageSize to three, only the first three results appear.

What Happens when a Term Appears in More than One Synonym Set

If more than one Synonym Set contains the same word, and each 
set has suggested search results, the results appear in 
chronological order by Synonym Set creation date. Here is an 
example.

Synonym Set Terms Creation Date

Milk production Cow; Milk; Dairy January 1, 2007

Animals Horse; Sheep; Cow April 16, 2007
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When a site visitor searches for Cow, the Milk production set’s 
links appear above Animals links because it was created first.

Creating a Set of Suggested Results
Follow these steps to create a set of Suggested Results. You 
cannot enter more than 10 links into any Suggested Results set.

1. From the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the 
Suggested Results. (The search is language-specific. When a 
site visitor begins using your site, he selects a language. Only 
Suggested Results in that language are considered.)

3. Click the Add button ( ).
4. The following screen appears.

5. Use the following table to complete the fields.

Field Description

Type To apply this Suggested Results set to a single term, proceed to the next field, 
Term.
To apply this set to a Synonym Set, change this value to Synonym Set. (If 
you do, the next field’s name changes to Synonym Set.)
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6. Click Add.
7. The following screen appears. Here, you add the URL, text, 

and summary for each Suggested Result. 

Term/ 
Synonym 
Set

If the above value is Single Term, enter a search phrase that will trigger the 
Suggested Results you will create below. 

Note: You cannot enter a comma(,) or a parenthesis character (() into the 
Terms field.

If the above value is Synonym Set, select from the dropdown the Synonym 
Set that will trigger the Suggested Results you will create below. That is, if a 
user enter a search phrase that matches any term in the Synonym Set, the 
Suggested Results appear.

Suggested 
Results

Place the cursor in this field. When you click, a menu appears (see illustration 
below).

Field Description
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8. Use the following table to complete the fields.

Field Description

Link To create a link to

• content on your Web site, click the Browse to CMS content button. 
Then, navigate to the folder that contains the content you want to link 
to. Select the content and click Save.

• an external Web site, enter its full address, starting with http://. 
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Title If you created a link to

• content on your Web site, its title is retrieved and displayed here. You 
may edit it as needed.

• an external Web site, enter the text of the link that will appear on the 
Suggested Results display.

Site visitors use this text to select the linked Web page. The title is circled 
in the example below.

Summary If you created a link to

• content on your Web site, its summary appears here. You may edit it 
as needed. The summary cannot exceed 320 characters (including 
HTML tags).

• an external Web Site, nothing appears. Enter up to 320 characters 
(including HTML tags) to further describe this link on the search 
results page.

The summary is circled in the example below.

Field Description
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9. Click Save ( ).
10. The Add Suggested Results screen reappears. You can add 

more links, edit existing ones, etc. When done, click Save ( ).

Editing a Suggested Result Set
The following sections explain how to perform the following edits 
on a Suggested Result Set.

• ”Adding a Link to a Suggested Result Set” on page 435

• ”Editing a Link in a Suggested Result Set” on page 436

• ”Removing a Link from a Suggested Result Set” on page 437

• ”Rearranging the Sequence of Links in a Suggested Results 
Set” on page 438

• ”Deleting a Suggested Results Set” on page 439

Adding a Link to a Suggested Result Set

1. From the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the 
Suggested Results. (The search is language-specific. When a 
site visitor begins using your site, he selects a language. Only 
Suggested Results in that language are considered.)

3. Select the Suggested Results set to which you want to add a 
link.

4. Click the Edit button ( ).
5. Place the cursor over the first result in the Suggested Results 

area of the screen.
6. Click once and a menu appears.
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7. Click Add.
8. The Add New Suggested Results screen appears.
9. See ”Use the following table to complete the fields.” on 

page 433.

10. Click Save ( ).

11. Click Save ( ) again.

Editing a Link in a Suggested Result Set

1. From the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the 
Suggested Results. (The search is language-specific. When a 
site visitor begins using your site, he selects a language. Only 
Suggested Results in that language are considered.)

3. Select the Suggested Results set that you want to edit.

4. Click the Edit button ( ).
5. Place the cursor in the Suggested Results area of the screen.
6. Place the cursor on the result that you want to edit.
7. Click once and a menu appears.
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8. Click Edit.
9. See ”Use the following table to complete the fields.” on 

page 433.

10. Click Save ( ).

11. Click Save ( ) again.

Removing a Link from a Suggested Result Set

1. From the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the 
Suggested Results.

3. Select the Suggested Results set from which you want to 
remove a link.

4. Click the Edit button ( ).
5. Place the cursor in the Suggested Results area of the screen.
6. Place the cursor over the result that you want to delete.
7. Click once and a menu appears.
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8. Click Delete.
9. A confirmation message appears. Click OK.

10. Click Save ( ).

Rearranging the Sequence of Links in a Suggested Results Set

Use this procedure to move Suggested Results up or down within 
a list.

1. From the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the 
Suggested Results.

3. Select the Suggested Results set from which you want to 
remove a link.

4. Click the Edit button ( ).
5. Place the cursor in the Suggested Results area of the screen.
6. Place the cursor over the result that you want to move up or 

down.
7. Click once and a menu appears.
8. Click Move Up or Move Down.
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9. Click Save ( ).

Deleting a Suggested Results Set
1. From the Ektron CMS400.NET Workarea, go to Settings > 

Configuration > Search > Suggested Results.
2. From the language dropdown, select a language for the 

Suggested Results.
3. Select the Suggested Results set from which you want to 

remove a link.

4. Click the Delete button ( ).
5. Click OK to the confirmation message.

Using the Integrated Search
You can expand the Web search to any Web-accessible files on 
your server, even if they are not part of Ektron CMS400.NET. This 
feature is called Integrated Web Search.

NOTE The Integrated Search only works with a Web Search server control that is placed 
on a Web page. It does not work with the Workarea search or any other search 
server control.

Use an Integrated Search if your site’s search should include non-
Ektron CMS400.NET files which, nevertheless, need to be 
searchable by site visitors. For example, a folder of personnel 
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policy documents should be searchable on your intranet but you do 
not want to add them to Ektron CMS400.NET.

As another example, you have a Web site of static HTML pages, 
and are now deploying Ektron CMS400.NET for certain parts of the 
site, such as job listings or a discussion forum. You can create a 
page with an Integrated Search that encompasses your entire site.

The following topics explain the Integrated Search in more detail.

• ”Integrated Search Overview” on page 440

• ”Setting up a Virtual Directory” on page 440

• ”Setting up an Integrated Search” on page 441

• ”Searching for non-Ektron CMS400.NET Content” on page 445

• ”Integrated Search Content in Search Results” on page 446

Integrated Search Overview
To set up an Integrated Search, create one or more Windows 
folders underneath the site root folder. Place files to be searched 
within them or their subfolders.

Alternatively, Integrated Search can find content in any Web- 
accessible folder on the server’s file system. In this case, create 
one or more virtual directories that point to the site root folder. 
Then, identify the Integrated Search folder and, if desired, file 
types to include or exclude when searching. The procedure for 
doing this is explained in ”Setting up a Virtual Directory” on 
page 440.

Setting up a Virtual Directory
The Integrated Search’s starting folders can reside anywhere on 
your server’s file system. If you want a folder to reside somewhere 
other than under the site root folder, follow these steps to set up a 
virtual directory. A virtual directory resides in the site root folder, but 
contains no content -- instead, it points to a Web-accessible folder 
anywhere in the file system.

IMPORTANT! Although a virtual directory is not on the same server as your site, it must be on 
the same domain as your site’s server.
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Since creating a virtual folder is a Windows procedure, the 
procedure is explained in http://support.microsoft.com/kb/301392/
en-us?FR=1&PA=1&SD=HSCH.

On the Access Permissions screen that appears during the setup, 
only check Read (see below).

Setting up an Integrated Search
There are three parts to setting up an Integrated Search.

• ”Creating an Integrated Search Folder Structure” on page 442

• ”Assign the Integrated Search folder to the WebSearch Server 
Control” on page 442

• ”Identifying Integrated Search Folder Information in the 
Workarea” on page 442

After setting up an Integrated Search, you might want to do these 
things:

http://support.microsoft.com/kb/301392/en-us?FR=1&PA=1&SD=HSCH
http://support.microsoft.com/kb/301392/en-us?FR=1&PA=1&SD=HSCH
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• ”Viewing All Integrated Search Folders” on page 444

• ”Viewing an Integrated Search Folder” on page 445

• ”Editing an Integrated Search Folder” on page 445

Creating an Integrated Search Folder Structure

1. In the site root folder, create one or more folders for non-Ektron 
CMS400.NET files to be searched. You can create child folders 
in as many levels as needed underneath these folders.
Alternatively, create a virtual folder that points to any folder in 
your file system. See Also: ”Setting up a Virtual Directory” on 
page 440

2. Place all files to be searched in the parent or child folders.

Assign the Integrated Search folder to the WebSearch Server Control 

To find Integrated Search content, users must access a Web page 
that contains a WebSearch server control. Further, you must 
assign to that control’s CustomSearch property the names of all 
top-level Integrated Search folders (see illustration below). Any 
child folders under the top-level folders are included in the search.

Identifying Integrated Search Folder Information in the Workarea

Follow this procedure for every folder that contains Integrated 
Search content.
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1. In the CMS Workarea, go to Settings > Configuration > 
Integrated Search Folders.

2. Click the Add button ( ).
3. The Add Integrated Search Folder screen appears.

4. Complete the fields as described in the table below.
To include all files in the folder (except those that would 
typically not be searched, such as .exe and .dll files), do not 
modify the Include Extensions and Exclude Extensions 
fields.

Field Description

Site Directory Enter the name of the parent folder (or virtual folder) that contains the 
searchable, non-Ektron CMS400.NET  content. This folder must reside in the 
site root folder. If you are using a virtual folder, enter its name, not the folder 
that contains the content.
See Also: ”Creating an Integrated Search Folder Structure” on page 442

Recursive Check this box if you want the search to include all child folders under the 
folder in the Site Directory field.
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IMPORTANT! Ektron’s Windows service runs hourly to index these files. So, you will not see 
search results for at least an hour after you set up this feature.

Viewing All Integrated Search Folders

To view all integrated search folders, go to Settings > 
Configuration > Integrated Search Folders. The screen displays 
every folder that will be included in the Integrated Search. See 
Also: ”Using the Integrated Search” on page 439

Click any folder to edit its properties or delete it.

Exclude Directories If you want to exclude files in any directory underneath the directory listed in 
the Site Directory field, enter the names of the directories to exclude. You do 
not need to enter the path to the directory -- only the name.
If you enter more than one directory, use a comma to separate them.
By default, Ektron CMS400.NET  places several directories that a search 
would typically ignore. Edit as needed.

Exclude Extensions If you want the search to ignore certain file types, enter those extensions in 
this format: *.filetype. For example *.xml. If you enter more than one, 
separate them with a comma (,).
By default, Ektron CMS400.NET  inserts several file types that a search 
would typically ignore. Edit as needed.

Important! - If you enter any value into the Include Extensions field, this field 
is ignored.

Include Extensions If you want the search to include only certain file types, enter those extensions 
in this format: *.filetype. For example *.xml. If you enter more than one, 
separate them with a comma (,).

Important! - If you enter any value into this field, the Exclude Extensions 
field is ignored.

Domain/User Name, 
Password and Confirm 
Password

If the parent folder is a virtual folder that points to another server, enter the 
domain\user name and password needed to access that server.
The parent folder is identified at the Site Directory field.

Field Description
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If you want to create a new Integrated Search folder, click the Add 
button ( ). See Also: ”Creating an Integrated Search Folder 
Structure” on page 442

Viewing an Integrated Search Folder

This screen displays all information about one Integrated Search 
folder. See Also: ”Using the Integrated Search” on page 439

To see documentation for any field on the screen, go to ”Complete 
the fields as described in the table below.” on page 443.

To edit information assigned to this Integrated Search folder, click 
the Edit button ( ). 

To delete this Integrated Search, click the Delete button ( ).

Editing an Integrated Search Folder

To edit an integrated search folder, select if from the View 
Integrated Search Folders screen. Then, click the Edit button ( ).

Edit the fields as needed. To see documentation for any field, go to 
”Complete the fields as described in the table below.” on page 443.

Searching for non-Ektron CMS400.NET Content
You can search for all non-Ektron CMS400.NET content by file title. 
For example, you can find the file Ektron.gif by inserting Ektron 
into the search field.

You can search text files (.doc, .pdf, .txt, etc.) by either file name or 
text within them.

Finally, you can use the following syntax to find files by extension: 
#filename *.extension. For example, to find all .gif files, use 
#filename *.gif. Be sure to click the Images button.
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NOTE Because Ektron CMS400.NET stores all content in .txt files, you cannot use this 
syntax to find files with a .txt extension.

Integrated Search Content in Search Results
To distinguish Integrated Search content from regular content, the 
ID number of IS content begins with 1,000,000,000. Also, the last 
author name is Non_Cms_User. See illustration below.

Setting up a Multiple Site Search Using Virtual 
Directories

Use the following procedure if you want to set up two sites but use 
a single database. The steps below allow you to search from either 
site to find the same content.

In this example, the first site contains the database, while the 
second site uses virtual directories to point to content in the first 
site.

1. Set up the first site and create a database for it in the normal 
manner.

2. Set up the second site, but when you are prompted to set up 
the database, click No.
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3. The following message appears. Press OK.

4. In the first site, open the web.config file.
5. Copy the database connection information for your database, 

as indicated below.
<connectionStrings>
    <!--FOR SQLSERVER-->
<add name="Ektron.DbConnection" providerName="System.Data.SqlClient" 
connectionString="server=(local);database=CMS400Min;Integrated Security=TRUE;user=;pwd=;" /> 

NOTE Your information may be different from the sample above.

In the second site, open the web.config file. Then, overwrite the 
database information with the text you copied in Step 5.

6. Copy the catalog information from the first site to the second. 
To do this, open the first site’s web.config file, and copy the 
contents of the <providers> element (illustrated below).

<providers>

<add name="MSIndexServer" 
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexProvider, 
Ektron.Cms.WebSearch" catalogName="CMS400Min3152007121250Publish" 
privateCatalogName="CMS400Min3152007121250Private" pageSize="10" 
description="MS Index Server Provider"/>
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<add name="MSIndexDialectServer" 
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexDialectProvider, 
Ektron.Cms.WebSearch" catalogName="CMS400Min3152007121250Publish" 
privateCatalogName="CMS400Min3152007121250Private" pageSize="10" 
description="MS Index Server Dialect2 Provider"/>

    </providers>

NOTE The catalog names are examples. You catalog names may be different.

7. In the second site, open the web.config file. Then, overwrite the 
<providers> information with the text you copied in Step 7.

8. Open the folder that contains the first site. Copy the 
AssetManagement.config file.

9. Open the folder that contains the second site. Overwrite the 
AssetManagement.config file in that folder with the file you 
copied in Step 9.

10. Set up the virtual directories. To do that, follow these steps.

- In IIS, open the second Web site you created in Steps 2 and 
3

- Delete the Assets folder

- Create a new virtual directory named Assets
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- When prompted to specify a path to the new Assets folder, 
navigate to the first site’s Assets folder
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- When you finish setting up the virtual folder to Assets 
directory, set up virtual directories in the same manner for 
the following directories: PrivateAssets, uploaded files, and 
uploaded images. Remember to delete the folder in the 
second site before creating the virtual directory.

- Make sure that none of the folders is set up as an 
application. To do that, open IIS, right click each folder and 
select properties. On the Directory tab, the Application 
name field should be grayed out, as shown below.

:

Searching for Metadata
• Searchable type metadata values are returned like regular 

content. See Also: ”Types of Metadata” on page 116

• It can take up to 30 minutes for newly-added metadata to be 
available to the search.

• Searchable metadata field names must not include a space. If 
they do, the search cannot find the metadata.

• To find content with searchable metadata whose style is yes or 
no, enter true or false.
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Installing the Visio IFilter
The search finds text within Visio documents if the Visio IFilter has 
been installed to the Ektron CMS400.NET server. Use the following 
links to download the Visio IFilter.

Query Language
NOTE Following text collected from Microsoft Web site. © 2006 by Microsoft Corporation. All rights 

reserved.

To search for any word or phrase on a Web site, enter the word or 
phrase into the Search field and click the button to begin the 
search.

This section covers the following topics.

• ”Rules for Formulating Queries” on page 452

• ”Boolean and Proximity Operators” on page 453 - increase 
accuracy of searches by inserting Boolean and proximity 
operators

• ”Localized Symbols and Keywords” on page 455 - explains 
which keywords are supported in foreign languages

• ”Wildcards” on page 455 - find pages with words similar to your 
search term

Visio 
Version

Link

2003 http://www.microsoft.com/downloads/details.aspx?FamilyID=dcee9e09-448b-
4386-b901-efea29cac808&DisplayLang=en

2002 http://www.microsoft.com/technet/prodtechnol/Visio/visio2002/deploy/
ifilter.mspx

http://www.microsoft.com/downloads/details.aspx?FamilyID=dcee9e09-448b-4386-b901-efea29cac808&DisplayLang=en
http://www.microsoft.com/technet/prodtechnol/Visio/visio2002/deploy/ifilter.mspx
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• ”Free-Text Queries” on page 456 - create a query based on a 
phrase’s meaning as opposed to exact wording

• ”Vector Space Queries” on page 456 - find pages that match a 
list of words and phrases

• ”Property Value Queries” on page 457 - query a file’s properties

• ”Query Examples” on page 462 - examples of various queries

Rules for Formulating Queries
When a search is executed, it returns a list of Web pages that 
contain the word or phrase that a user entered, regardless of 
where it appears in text.

Follow these rules when formulating queries.

• Multiple words are treated as individual search terms. So, the 
term calendar server returns pages that have both words.
To find pages that have calendar and server in that exact order, 
use quotes. “calendar server” returns pages that include both 
terms in that exact order with no intervening words.

• Queries are case-insensitive. You can type a query in upper or 
lower case.

• The search ignores words in the noise files. Ektron 
CMS400.NET’s noise files screen from the search every single 
letter of the alphabet as well as many common words, such as 
about, after, all, and also. Avoid entering such words into the 
Search Text field, because the search ignores them.
The list of noise words (noise.enu) is installed to your siteroot/
Workarea and Windows/System 32 folders. You can open a noise 
file with a simple word processor program, such as Notepad, to 
view the noise words. You can also edit the files. For example, 
you can remove words that users should be able to search on.
To make a word in the noise files searchable, remove it from 
both files then restart both catalogs. See Also: ”Run a Full Scan 
of a Catalog” on page 410
Exceptions:

- In the Ektron CMS400.NET Workarea, the Advanced Search 
disregards the noise file. 
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- You cannot make the indexing service operators (and, or, 
but) searchable.

• Words in the noise file are treated as placeholders in phrase 
and proximity queries. For example, if you search for “Word for 
Windows”, the results could return “Word for Windows” and 
“Word and Windows”, because “for” is in the exception list.

• Punctuation marks, such as period (.) and comma (,), are 
ignored by a search.

• To use special characters, such as &, |, ^, #, @, $, (, ), in a 
query, enclose the query in quotation marks (“). 

• To search for a word or phrase containing quotation marks, 
surround the entire phrase with quotation marks and double 
the quotation marks around the word to be surrounded with 
quotes. For example, “World-Wide Web or ““Web””” searches 
for World-Wide Web or “Web”. 

• Use Boolean operators (AND, OR) and the proximity operator 
(NEAR) to specify additional search criteria. See Also: 
”Boolean and Proximity Operators” on page 453

• Use the wildcard character (*) to find words with a given prefix. 
For example, the query esc* finds Web pages with “ESC,” 
“escape,” and so on. See Also: ”Wildcards” on page 455

• You can specify free-text queries without regard to query 
syntax. See Also: ”Free-Text Queries” on page 456

• Vector space queries can be specified. See Also: ”Vector 
Space Queries” on page 456

• You can search on ActiveX™ (OLE) and file attribute property 
values. See Also: ”Property Value Queries” on page 457

Boolean and Proximity Operators
Use boolean and proximity operators to create a more precise 
query.

To Search for Example Results

Both terms on a 
page

healthcare insurance Pages with words “healthcare” and 
“insurance” 
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Tips

• To nest expressions within a query, add parentheses. 
Expressions within parentheses are evaluated before the rest 
of the query.

• Use double quotes (“) to ignore a Boolean or NEAR operator 
keyword. For example, “Abbott and Costello” finds pages with 
the entire phrase, not pages that match the Boolean 
expression. In addition to being an operator, the word “and” is a 
noise word in English.

• The NEAR operator is like the AND operator because it finds 
pages that include both search words.
However, the rank assigned by NEAR depends on the 
proximity of the search words. A page with the searched-for 
words closer together has a higher rank than a page where 
they are farther apart. If the search words are more than 50 
words apart, the page is assigned a rank of zero.

NOTE The NEAR operator can be applied only to words or phrases.

• The AND operator has a higher precedence than OR. For 
example, the first three queries are equal, but the fourth is not:

- a AND b OR c

- c OR a AND b

- c OR (a AND b)

Either term on a 
page 

kidney or renal
—Or—
kidney | renal#

Pages with “kidney ” or “renal” 

All pages that 
match a property 
value 

@CMSsize > 1000 Pages greater than 1000 kilobytes 

Both terms on a 
page, close 
together 

treatment near immunoglobulin
—Or—
treatment ~ immunoglobulin

Pages with the word “treatment” near the 
word “immunoglobulin” See Also: ”The 
NEAR operator is like the AND operator 
because it finds pages that include both 
search words.” on page 454

To Search for Example Results
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- (c OR a) AND b

Localized Symbols and Keywords
The symbols (&, |, !, ~) and the English keywords AND, OR, and 
NEAR work the same in all languages supported by Ektron 
CMS400.NET. Localized keywords are also available when the 
browser locale is set to one of the following languages.

Wildcards
Wildcard operators find pages that contain words similar to a given 
word.

Language Keywords

German UND, ODER, NICHT, NAH

French ET, OU, SANS, PRES

Spanish Y, O, NO, CERCA

Dutch EN, OF, NIET, NABIJ

Swedish OCH, ELLER, INTE, NÄRA

Italian E, O, NO, VICINO

To Search For Example Results

Words with the 
same beginning 
letters

pharm* Pages with words that have the prefix pharm, such as 
pharmaceutical, pharmacist, and pharmacology. 

Words based on 
any form of a verb

fly** Pages with any form of a verb. For example, if you enter fly, 
the search returns pages that contain flying, flown, flies, 
and flew.
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Free-Text Queries
A free-text query finds pages that match the meaning, not the 
exact wording, of submitted words and phrases. Begin free-text 
queries with $contents.

You cannot use boolean, proximity, or wildcard operators in a free-
text query.

Vector Space Queries
The search supports vector space queries, which return pages that 
include a list of words and phrases. Each page is ranked according 
to how well it matches the query.

Tips

• Separate terms in a vector query with commas (,)

• You can weight terms in vector queries by using the [weight] 
syntax (see example above)

• Pages found by vector queries do not necessarily match all 
words submitted in the query

To Search For Example Results

Files that match 
free-text

$contents how do I 
print in Microsoft 
Excel?

Pages that mention printing and Microsoft Excel

To Search for Example Results

Pages that contain 
specific words

light, bulb Files with words that best match the search words

Pages that contain 
weighted prefixes, 
words, and 
phrases

invent*, light[50], 
bulb[10], “light 
bulb”[400]

Files that contain words prefixed by “invent,” the words 
“light,” “bulb,” and the phrase “light bulb” (the terms are 
weighted)
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• Vector queries work best when results are sorted by rank

Property Value Queries
Use a property value query to find files whose property values 
match a given criteria. Properties you can query include file 
information (like file name and size), and ActiveX properties, 
including the document summary stored in files created by 
ActiveX-aware applications.

There are two types of property queries.

• Relational property queries - consist of an “at” character (@), 
a property name, a relational operator, and a property value. 
For example, to find all files larger than one million kilobytes, 
use @CMSsize > 1000000. See Also: ”Relational Operators” on 
page 458

• Regular expression property queries - consist of a number 
sign (#), a property name, and a regular expression for the 
property value. For example, to find all .avi files, use #filename 
*.avi. See Also: ”Regular Expressions” on page 461
Regular expressions do not match the contents (#contents) and 
all (#all) properties. 
In regular expression property queries, you can only use 
properties that are retrievable at query time. Properties that are 
not retrievable include HTML META properties not stored in the 
property cache.

Property Names

Property names are preceded by the “at” sign (@) for relational 
queries, and the pound sign (#) for regular expression queries.

If no property name is specified, @contents is assumed.

Properties available for all files are listed below.

Property Name Description

All Matches words, phrases, and any property
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You can also use ActiveX property values in queries. You can 
search for files created by most ActiveX-aware applications by 
querying for the following properties.

Relational Operators

Use relational operators to create relational property queries.

Contents Words and phrases in the file

Note: The contents property does not support relational 
operators. If a relational operator is specified, no results 
are found. For example, @contents Ektron finds 
documents containing Ektron, but @contents=Ektron 
finds none. 

Filename Name of the file

CMSsize File size

Write Date file was created or last modified (whichever is 
later)

Property Name Description

Property Name Description

DocTitle Title of the document

DocSubject Subject of the document 

DocAuthor The document’s author 

DocKeywords Keywords for the document 

DocComments Comments about the document
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Property Values

To Search for Example Results

Property values in 
relation to a fixed 
value

@CMSsize < 100

@CMSsize <= 100

@CMSsize = 100

@CMSsize != 100

@CMSsize >= 100

@CMSsize > 100

Files whose size matches the query

Property values 
with all of a set of 
bits on 

@attrib ^a 0x820 Compressed files with the archive bit on 

Property values 
with some of a set 
of bits on 

@attrib ^s 0x20 Files with the archive bit on

To Search for Example Results

A specific value @DocAuthor = “Bill 
Bailey”

Files authored by Bill Bailey

Values beginning 
with a prefix

#DocAuthor George* Files whose author property begins with George

Files of any 
extension

#filename *.gif Files with a .gif extension

Note: Because Ektron CMS400.NET  stores all content in 
.txt files, you cannot use this syntax to find files with a .txt 
extension.

Files modified 
after a certain date

@write > 2006/02/14

Note: You cannot use 
the equal operator (=) 
with @ write. Only 
greater than (>) and 
less than (<) operators 
work.

Files modified after February 14, 2006
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Tips for Using Property Queries

• Use the pound (#) character before the property name when 
using a regular expression in a property value.
Use the “at” (@) character otherwise. The equal (=) relational 
operator is assumed for regular-expression queries.

• File name (#filename) is the only property that efficiently 
supports regular expressions with wildcards to the left of text.

• Dates use the format yyyy/mm/dd. 
You can omit the first two characters of the year. If you do, 29 
or less is interpreted as the year 2000, and 30 or greater is 
interpreted as the year 1900. All dates are in Greenwich Mean 
Time (GMT). 

• Currency values use the format x.y, where x is the whole value 
amount and y is the fractional amount. There is no assumption 
about units.

• Boolean values are (t) or (true) for TRUE and (f) or (false) for 
FALSE. 

• Vectors (VT_VECTOR) are expressed as an opening brace ({), 
a comma-separated list of values, and a closing brace (}). 

• Single-value expressions that are compared against vectors 
are expressed as a relational operator, then a (^a) for all of or a 
(^s) for some of. See Also: ”Relational Operators” on page 458

• Numeric values can be expressed in decimal or hexadecimal 
(preceded by 0x).

Vectors matching 
a vector

@vectorprop = { 10, 
15, 20 }

ActiveX documents with a vectorprop value of { 10, 15, 20 }

Vectors where 
each value 
matches a 
criterion

@vectorprop >^a 15 ActiveX documents with a vectorprop value in which all 
values in the vector are greater than 15

Vectors where at 
least one value 
matches a 
criterion

@vectorprop =^s 15 ActiveX documents with a vectorprop value in which at least 
one value is 15

To Search for Example Results
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Regular Expressions

Regular expressions in property queries are defined as follows.

• Any character except asterisk (*), period (.), question mark (?), 
and vertical bar (|) defaults to matching itself.

• A regular expression can be enclosed in matching quotes (“). It 
must be enclosed in quotes if it contains a space ( ) or closing 
parenthesis ()). 

• The characters *, ., and ? behave as in Windows. They match 
any number of characters, match (.) or end of string, and match 
any one character, respectively. 

• The character | is an escape character. After |, the following 
characters have special meaning: 

- ( opens a group. Must be followed by a matching ).

- ) closes a group. Must be preceded by a matching (. 

- [ opens a character class. Must be followed by a matching 
(un-escaped) ]. 

- { opens a counted match. Must be followed by a matching }. 

- } closes a counted match. Must be preceded by a matching 
{. 

- , separates OR clauses. 

- * matches zero or more occurrences of the preceding 
expression.

- ? matches zero or one occurrences of the preceding 
expression.

- + matches one or more occurrences of the preceding 
expression. 

Anything else, including |, matches itself.

• Between square brackets ([]), the following characters have 
special meaning.

- ^ matches everything but following classes. Must be the first 
character. 

- ] matches ]. May only be preceded by ^. Otherwise, it closes 
the class.
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- - range operator. Preceded and followed by normal 
characters.

Anything else matches itself (or begins or ends a range at 
itself).

• Between curly braces ({}), the following syntax applies.

- |{m|} matches exactly m occurrences of the preceding 
expression. (0 < m < 256). 

- |{m,|} matches at least m occurrences of the preceding 
expression. (1 < m < 256). 

- |{m,n|} matches between m and n occurrences of the 
preceding expression, inclusive. (0 < m < 256, 0 < n < 256).

• To match *, ., and ?, enclose them in brackets (for example, 
|[*]sample matches “*sample”). 

Query Examples

Example Results

@CMSsize > 10000 Pages larger than 10 MB

@write > 2003/05/12

Note: You cannot use the equal 
operator (=) with @ write. Only 
greater than (>) and less than (<) 
operators work.

Pages modified after the date

pear tree Pages with the phrase “pear tree”

“pear tree” Same as above

@contents pear tree Same as above

Ektron and @CMSsize > 10000 Pages with the word “Ektron” that are larger than 10 
thousand kilobytes

“Ektron and @CMSsize > 10000" Pages with the phrase specified (not the same as 
above)
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#filename *.avi Video files (the # prefix is used because the query 
contains a regular expression)

@attrib ^s 32 Pages with the archive attribute bit on 

@docauthor = “John Stanton” Pages with the given author

$contents why is the sky blue? Pages that match the query 

Example Results
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Search Troubleshooting

Problem Solutions

You publish content 
but cannot find it using 
the search

1. Wait 5 or 10 minutes (depends on the load on the server).

2. Make sure the Microsoft indexing service is running (Computer 
Management > Services and Applications > Indexing Service). Verify 
that the Run button is grayed out. If the service is not running, start it.

3. Query the catalog using the new content’s ID. See ”Querying the Catalog 
for the Content” on page 467. 

4. Make sure the Ektron Windows service is running (Computer 
Management > Services and Applications > Services > Ektron 
Windows Services 2.0). Verify that the Run button is grayed out.

If the service is not running, start it. If you do, it may take a while for the 
service to prepare the content for indexing. 
(Continued below)
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You publish content 
but cannot find it using 
the search (continued)

1. Make sure the siteroot/Assets folder’s Advanced Attributes screen’s 
For fast searching, allow Indexing Service to index this folder check-
box is checked. To access this screen, click the Advanced button on the 
siteroot/Assets folder properties screen.

2. Check the priority of the database table. See ”Checking the Priority of the 
Database Table” on page 469

Indexing service uses 
too much memory or 
resources.
Or, too many instances 
of cidaemon.exe are 
running.

Check the number of catalogs being serviced. To do so, follow these steps.

1. Go to Computer Management > Services and Applications > Index-
ing Service. 

2. You should see three Ektron CMS400.NET  catalogs (Public, Private, 
and Content), plus System and Web. Ektron CMS400.NET  does not 
use the system and Web catalogs, so unless your server uses them for 
another purpose, delete them.

3. Delete any other unused catalogs.

4. Restart the Microsoft Indexing Service.

The catalog size is 
growing too quickly, or 
is really huge

The indexing service generates an abstract for each content item. See ”Query 
Language” on page 451. By default, the abstract length is 320 characters.
To reduce the catalog size, reduce the abstract length. See ”Adjusting the 
Length of the Search Result Abstract” on page 420

Catalog is mistakenly 
deleted or corrupted

Recreate it. See ”Recreating a Catalog” on page 401

Problem Solutions
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The Inheritable 
Settings checkboxes 
are not checked

Make sure the Inheritable Settings checkboxes on the Generation tab of the 
Properties dialog are checked.

1. Go to Computer Management > Services and Applications > Index-
ing Service. 

2. Select the first of the three Ektron CMS400.NET  catalogs (Public, 
Private, and Content). 

3. Right click the mouse and select Properties.

4. Click the Generation tab.

5. Make sure the two checkboxes are checked (illustrated below).

6. Repeat for the other two catalogs.

Verify that Windows 
can find files on your 
server

1. Open Windows Explorer.

2. Right click your C drive and select Search.

3. In the All or part of the file name field, enter *.*.
4. The search should find all files on your computer. 
If it does not, ask your system or network administrator to help you determine 
why your Windows search is not working. For example, he should verify that 
you have permission to search for files.

SearchConfigUI.exe 
crashes while building 
search indexes and 
catalogs

1. Make sure the metaconfig.doc file exists in the siteroot/
uploadedfiles directory.

If it does not, ask Ektron Technical Support to send you a new file.

2. If anyone uploaded Visio documents to your server, make sure the iFilter 
is installed. See ”Installing the Visio IFilter” on page 451.

Problem Solutions

http://dev.ektron.com/support.aspx
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Querying the Catalog for the Content
To query the catalog for a content item, follow these steps

MS Indexing Service 
cannot find files in the 
siteroot/assets 
folder.

1. Open Windows Explorer.

2. Navigate to the siteroot/assets folder.

3. Select the folder and right click the mouse.

4. Select Properties.

5. Click the Advanced button.

6. Check the box next to For faster searching, allow Indexing Service to 
index this folder.

7. Press OK.

Get error message.
An unhandled 
exception has 
occurred: The type 
initializer for 
Ektron.CMS. 
WebSearch.Manager 
threw an exception.0

During installation, the user might have canceled the database setup. Check 
the following.

1. Check the site root folder for the following folders. If they do not exist, cre-
ate them.

•PrivateAssets

•Assets

•UploadedFiles

•UploadedImages

2. Make sure MetaConfig.doc exists in the [sitepath]\UploadedFiles 
folder. If it does not, ask Ektron Technical Support for a copy of that file 
from the same Ektron CMS400.NET  version.

3. Make sure noise.enu file exists in the [sitepath] folder. If it does not, 
look in the [sitepath]\workarea folder. If noise.enu is there, copy it to 
the [sitepath] folder. If you cannot find noise.enu, ask Ektron Technical 
Support for a copy of that file from the same Ektron CMS400.NET  
version. 

4. Check the following registry key: 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\ContentI
ndexCommon. For that key, make sure DefaultColumnFile has the value 
C:\WINDOWS\system32\FriendlyNamesDefinitionFile.txt.

If the entry does not exist, create it and set the value as listed above.

Problem Solutions
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1. Go to Computer Management > Services and Applications 
> Indexing Service > sitenamePublishedAsset > Query the 
Catalog.

2. Choose Advanced Query. 
3. Use the syntax @contentID = IDnumber. For example, if the 

content ID is 30, enter @contentID = 30.
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4. The content should appear as shown above.

Checking the Priority of the Database Table
To check how your database is processing the documents, follow 
these steps.

1. Launch a database management tool, such as SQL Server 
Management Studio.

2. Find the Ektron CMS400.NET database. 
3. Open Tables > dbo.perform.action.
4. A list of content blocks being processed appears. 
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5. Make sure the action_priority for each item is less than -8. If 
that is the case, the database will process the record.
If the priority is -8 and the action status is inAction, there is a 
problem with the service that processes the document. To 
resolve the problem, you can 

- go to Computer Management > System Tools > Error 
Log to find any errors and fix them

- reset the action_priority value to zero (0) and the action 
status to PerformAction

- contact Ektron Support
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Discussion Boards

The Discussion Board feature provides an opportunity for topic 
discussions on your Web site. A site or membership user with Add 
Topic permission creates a topic and posts a starter question. Site 
visitors can then reply. See Also: ”Discussion Board Permissions” 
on page 521.

An example of a Discussion Board is below. As you can see, the 
first screen has general topics, the second screen’s topics are 
more specific, and a third screen displays posts to the forum.

As an administrator, you can determine the following Discussion 
Board features.
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• The subjects being discussed

• A starter post, which initiates a discussion

• If users must sign in before posting to the forum

• If a post appears as soon as someone submits it, or must be 
approved first

- If a post requires approval, you can edit or delete it before it 
appears

Whether or not posts must be approved, anyone with permission to 
the board can perform the following tasks on a post from the 
Workarea

• edit

• delete

• reply

This section explains Discussion Boards through the following 
topics.

• ”Hierarchy of Discussion Board Elements” on page 472

• ”Implementing Discussion Boards” on page 476

• ”Assigning Permissions to a Discussion Board” on page 518

• ”Sending Notifications When a New Forum Topic or Post is 
Created” on page 526

• ”Inserting Discussion Board Server Controls” on page 529

• ”Using Discussion Boards on Your Web Site” on page 530

Hierarchy of Discussion Board Elements
A Discussion Board consists of a five-level hierarchy, illustrated 
below. Before creating a Discussion Board, it is important to 
understand the elements of the hierarchy.
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Ektron CMS400.NET supports an unlimited number of Discussion 
Boards. Each board must follow the hierarchy. Below is the 
hierarchy with sample data, to explain how each element is used.
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Within the Workarea, Discussion Boards appear as top-level 
folders in the folder structure. Forums appears under them. Both 
folders use the people icon ( ) to distinguish them from content 
and blog folders.
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If you click a Discussion Board, you see its Subjects and Forums 
on the right side of the Workarea, as shown below.

If you click a Discussion Forum, you see its topics. If you click a 
topic, you see its posts, as shown below.
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Implementing Discussion Boards
To implement a Discussion Board into your Web site, place a 
Forum server control on a Web page. Then, select a Discussion 
Board.

All Subjects and Forums within that board appear on the Web 
page. You cannot selectively suppress Subjects or Forums. Keep 
this in mind when determining the contents of a Discussion Board.

This is more fully explained through the following topics.

• ”Working with Discussion Boards and Subjects” on page 477

• ”Ranking Forum Users” on page 491

• ”Working with Forums” on page 488

• ”Working with Topics” on page 496

• ”Working with Posts” on page 503

• ”Changing Page Size for Discussion Boards” on page 484

• ”Replacing Words in a Post” on page 510



Discussion Boards

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 477

• ”Restricting an IP Address” on page 516

• ”Setting Up Post Reporting” on page 517

Working with Discussion Boards and Subjects
This section contains the following topics.

• ”Creating a Discussion Board” on page 477

• ”Viewing a Discussion Board” on page 483

• ”Editing a Discussion Board” on page 483

• ”Deleting a Discussion Board” on page 483

• ”Changing Page Size for Discussion Boards” on page 484

• ”Editing Subject Name and Sort Order” on page 484

• ”Creating a New Subject” on page 485

• ”Terms & Conditions” on page 485

Creating a Discussion Board
To create a Discussion Board, follow these steps.

1. From the Workarea’s Content tab, navigate to the folder in 
which you want to place the Discussion Board.

2. Click New > Discussion Board.
3. The Add a Discussion Board to folder screen appears.
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.

Complete the screen using the following table.

NOTE Some items in this table only appear when editing an existing Discussion Board’s 
properties.

Discussion Board Properties

Field Description When 
Available

Board Name Enter the name of the Discussion Board. This text describes the 
board within the Workarea and on your Web site. 

Enter or edit

Board Title Enter the title of the board. Enter or edit
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Accepted 
HTML

A comma-delimited list of HTML tags allowed in the editor. When left 
blank, all tags are available.
The default list is:
br,hr,b,i,u,a,div,ol,ul,li,blockquote,img,span,p,em,
strong,font,pre,h1,h2,h3,h4,h5,h6,address

Site visitors posting to the forum can apply these HTML tags to 
content when 

• their Forum editor is JavaScript Editor, as set in the user profile

• for the server control this displays the Forum, its 
JavascriptEditorHTMLMode property is set to true

Enter or edit

Accepted 
Extensions

A comma delimited list of file extensions that can be uploaded. You 
can enter the extension with or without the period (.). Use a comma 
to separate each extension.
The default list is: bmp,conf,doc,gif,jpe,jpeg,jpeg,png
The list appears at the bottom of the editor screen to notify the 
person entering a post which file types he can attach.

Edit only

Max File Size The maximum size of the file, in bytes, that a user can upload. The 
default is 200000 bytes (200 megabytes).

Edit only

Field Description When 
Available
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Topics: Require 
Authentication

Effect of this Field on the Web Site
Check this box if a site visitor must sign in before he can post to the 
Discussion Board. If the user cannot access a login screen, he 
cannot post.
If this box is unchecked, site visitors can post without signing in.
Effect of this Field within the Workarea
If this field is checked, only users with Add Topic or Edit Topic 
permissions for the Discussion Board can create or reply to posts.
See Also: ”Assigning Permissions to a Discussion Board” on 
page 518

Enter or edit

Lock Check this box if you want to prevent all posting to this Discussion 
Board. You can do this temporarily or permanently.
If a Board is locked, only Administrator user group members can 
post to it, or edit or delete posts. Those users can post from the Web 
site or the Workarea.
You can alternatively lock any Forum underneath this Board via the 
Forum properties screen.

Edit only

CSS Theme Choose a style sheet to determine the appearance of the Discussion 
Board on your Web site. Select any theme available in the CSS 
Theme dropdown. The default is site root/Workarea/
threadeddisc/themes/standard.css.
Alternatively, enter a path below the site root folder to your custom 
CSS file in the path box.

Note: If you edit a CSS file, Ektron recommends saving it under a 
new name. This prevents your changes from being overwritten 
during an upgrade.

For additional information on creating custom themes, see the 
Developer Manual section “Discussion Board Server Controls” > 
“Forum Server Control” > “Using a Custom Theme.”

Enter or edit

Page Template Lets you specify a template for the Forum. If you do not specify a 
template, the search results do not link properly to the Forum. See 
Also: ”Creating/Updating Templates” on page 64
To preview what the Forum looks like within the selected template, 

click the preview icon to the right ( ).

Enter or edit

Field Description When 
Available
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Taxonomy: 
Required 
category 
selection

If you want all topics in this Discussion Board to be assigned a 
taxonomy category, check Required category selection. If you do, 
a signed-in user is prompted to select a taxonomy category when 
creating a topic.
This checkbox has no effect when creating new topics within the 
Ektron CMS400.NET Workarea.
See Also:  ”Taxonomy” on page 626 

Edit only

Taxonomy: All 
taxonomies 
appear

Select a taxonomy whose categories will be assigned to Forum 
topics. The Taxonomies are created in the Taxonomy Module. The 
Discussion Board’s taxonomy display represents another way to 
organize the Forum’s posts.
See Also:  ”Taxonomy” on page 626 
Effect of Assigning Taxonomy Categories to a Topic
When a Discussion Board server control is placed on a Web page, 
its display includes a small taxonomy icon (circled below).

When a site visitor clicks this icon, he sees all taxonomy categories. 
When he selects a category, he sees its subcategories followed by 
all Forum posts assigned to that category.
Below is an example of how a Discussion Board’s posts might be 
organized by taxonomy category.

See Also: ”Using the Taxonomy Search” on page 628

Field Description When 
Available
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Subjects Tab Enter as many Subjects as you wish. Each Subject contains one or 
more Discussion Forums.
You must create at least one Subject for each Discussion Board.
To learn how Subjects fit into the Discussion Board hierarchy, see 
”Hierarchy of Discussion Board Elements” on page 472.

Note: You can also add a Subject by selecting a Discussion Board 
then selecting New > Subjects.

Subject Sort Order
Subjects are the highest level of the hierarchy that appears on your 
Web site. In the sample Forum below, Latest Discoveries and 
Patient Care are Subjects.

Subjects appear in alphabetical order unless you use the Sort Order 
field. The Sort Order field accepts a number and uses it to arrange 
the Subjects of a Discussion Board on the Web site. The lowest 
numbers appear near the top of the page.
To access the Sort Order field, follow these steps.

1. Save the Discussion Board.

2. Click the Discussion Board in the Workarea.

3. Click View > Properties.

4. Click the Subjects tab.

5. Modify the number in the Sort Order field as needed.

Enter or edit

Terms & 
Conditions Tab

Add the Terms & Conditions for using the Discussion Board. By 
entering text in this text box and saving, you activate the Terms and 
Conditions feature. See Also: ”Terms & Conditions” on page 485

Edit only

Field Description When 
Available
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Viewing a Discussion Board
To view a Discussion Board, select it from the Folders display. 
When viewing the Board, you see all of its Forums. You can click 
any Forum to see details about it.

See Also: ”Implementing Discussion Boards” on page 476; 
”Discussion Boards” on page 471

Editing a Discussion Board
When editing a Discussion Board, you can change information 
entered when it was created plus additional fields only available 
when editing. See the When Available column of the ”Discussion 
Board Properties” on page 478. 

To edit a Discussion Board, follow these steps.

1. Click the Workarea’s Content tab.
2. Form the folder structure in the left frame, click the Discussion 

Board.
3. Click View > Properties.

4. Click the Edit button ( ).
5. Update the screen as needed. Fields are described in 

”Discussion Board Properties” on page 478.

6. Click Save ( ).

Deleting a Discussion Board
You can delete any Discussion Board. When you do, its Subjects, 
Forums, and posts are also deleted. Once deleted, they cannot be 
retrieved.

1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion 

Board.
3. Click Delete > This folder.
4. A message appears asking you to confirm.
5. Press OK If you are sure.
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Changing Page Size for Discussion Boards
You can change the number of Topics or Posts shown on a page 
by changing the ek_PageSize value in the Web.config file.

See Also: The ek_PageSize property description in the Ektron 
CMS400.NET Setup Manual section “Managing the web.config 
File” > “Settings in the web.config File” > “Miscellaneous Settings.”

Editing Subject Name and Sort Order
You can change any Subject’s name or sort order. To do so, follow 
these steps.

1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion 

Board that contains the Subjects.
3. Click View > Properties.
4. Click the Subjects tab.
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5. Click the Subject that you want to edit.
6. The current Subject name and sort order appear on a new 

screen. Edit as needed. See Also: ”Subject Sort Order” on 
page 482.

7. Click Save ( ).

Creating a New Subject
Use this procedure when you want to add a new Subject to a 
Discussion Board.

NOTE For more information about how Subjects fit into the Discussion Board hierarchy, 
see ”Hierarchy of Discussion Board Elements” on page 472.

1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion 

Board to which you want to add a Subject.
3. Click New > Subject.
4. Enter a Subject name and sort order. See Also: ”Subject Sort 

Order” on page 482

5. Click Save ( ).

Terms & Conditions
Adding Terms & Conditions to a discussion board allows you to 
convey to a user the expectations when using the discussion 
board. Once Terms & Conditions are added, users can only post to 
the Forum after agreeing to the Terms.

Once any text is entered into the Terms & Conditions editor and 
saved, anyone posting to the site sees the following screen the first 
time he tries to post or reply to a Forum. The circled text is an 
example of your entry in the Terms & Conditions editor. The rest of 
the text, checkbox, and button are provided by Ektron 
CMS400.NET.
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When new Membership users are added, you can have them 
accept the Terms & Conditions during registration. This is 
explained in the “Membership Server Control” section of Developer 
manual.
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.

Adding Terms and Conditions to a Discussion Board

1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion 

Board to which you want to add terms and conditions.
3. Click View > Properties.

4. Click the Edit button ( ).

5. Click the Terms & Conditions tab.
6. Add the terms and conditions text to editor.

7. Click the Save ( ) button.
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Working with Forums
A Forum is a particular thread within a Discussion Board. To learn 
about how Forums fit into the Discussion Board hierarchy, see 
”Hierarchy of Discussion Board Elements” on page 472.

For each Forum, you define the following:

• name and Description

• whether posts to it must be approved before appearing on your 
Web site

• if it’s accepting new postings

• its sort order, which determines its sequence on the Web page 
within its Subject

• its Subject

This section contains the following topics.

• ”Creating a Forum” on page 488

• ”Editing a Forum” on page 490

• ”Deleting a Forum” on page 491

• ”Ranking Forum Users” on page 491

Creating a Forum
You can only create a Forum after a Discussion Board and at least 
one Subject have been created.

1. In the Workarea, click the Content tab.
2. Select a Discussion Board.
3. Click New > Discussion Forum.
4. The Add a Discussion Forum to Board screen appears.
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Complete the screen using the following table.

Field Description

Name Enter the name of the discussion Forum.
The name identifies the Forum in the left side of the Workarea. The 

Forum’s name appears next to a people icon ( ). This icon 
distinguishes it from content and blog folders. 
It also appears on the Web site (see example below).

Description Enter a more detailed description of the Forum.
The description appears on the Web site, as illustrated above.
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5. Click Save ( ).

Editing a Forum
Follow these steps if you want to change any information about a 
Forum.

1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion 

Board that contains the Forum.
3. Click the Forum.

Moderate Comments Checking this box causes

• comments to require approval before appearing on the Web site 
See Also: ”Approving a Topic” on page 502

• a post to be reported to all moderators of the Forum. See Also: 
”Reporting a Post” on page 536 and ”Setting Up Post Reporting” 
on page 517

Only users who are granted Moderate permission can approve 
comments, thereby allowing them to be published on the site. See 
Also: ”Discussion Board Permissions” on page 521
The Smart Desktop has a Forum Topics and Posts category. This 
tells you how many posts currently require your approval before they 
appear on the site.

Lock Forum Check this box if you want to prevent all posting to this Forum. You 
can do this temporarily or permanently.
If a Forum is locked, only members of the Administrators user group 
can post to it, or edit or delete posts. Those users can post from the 
Web site or the Workarea.
A Discussion Board can also be locked. If a board is locked, a 
message on this screen indicates that. In that case, no posting is 
allowed to this Forum regardless of this setting.

Sort Order Enter a number if you want to arrange the sequence of Forums 
within the Subject.
If you do not, Forums appear in alphabetical order within a Subject.

Subject Enter the Subject within which this Forum will appear on the Web 
site. To learn more about the relationship of Subjects to Forums, see 
”Hierarchy of Discussion Board Elements” on page 472.

Field Description
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4. Click the View Properties button ( ).

5. Click the Edit button ( ).
6. Update the screen as needed. The fields are described in 

”Complete the screen using the following table.” on page 489.

7. Click Save ( ).

Deleting a Forum
You can delete any Forum. When you do, its topics and posts are 
also deleted. Once deleted, they cannot be retrieved.

To delete a Forum, follow these steps.

1. In the Workarea, click the Content tab.
2. Select the Discussion Board that contains the Forum.
3. Click the Forum.

4. Click the Delete Forum button ( ).
5. A message appears asking you to confirm.
6. Press OK if you are sure.

Ranking Forum Users
The User Ranking feature lets you recognize users for their Forum 
contributions. You can create a ranking system that determines the 
number of posts a user must submit to move up to the next level. 
Here’s an example.

This is known as a ladder system, because users move to the next 
level after a designated number of posts.

Rank Number of posts

Newbie 0 - 9

Intermediate 10 - 19

Expert 20 and up
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This system lets Forum users build credibility. You can assign each 
rank an image, which appears below the user’s name on any post 
(see illustration below).

The rank also appears on a user’s forum profile. See Also: 
”Suppressing User Information from the Forum Profile Display” on 
page 536

Ranks Independent of the Ladder System

You can also create ranks that are independent of the ladder 
system. Such a rank bears no relationship to the number of posts a 
user has made. For example, after a Forum user acquires Ektron 
Developer Certification, he is assigned the Ektron Developer rank. 

Users can be moved from a non-ladder rank to the ladder system 
and vice versa. Whether or not a user is in a ladder system, Ektron 
CMS400.NET keeps a tally of posts. So, if the user is moved into a 
ladder system at any time, he is placed into the correct rank.

Adding a User Rank

To add a user rank, follow these steps.

NOTE You can also access the User Ranks screen from Workarea > Settings > 
Configuration > Discussion Board > User Ranks. If you have more than one 
Forum, this screen lets you pick the Discussion Board to which a rank is assigned.

1. In the Workarea, click the Content tab.
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2. Select a Discussion Board.
3. Click New > User Ranks.
4. The User Ranks screen appears.

5. Complete the screen using the following table.

Field Description

Name The name of the rank. For example, Newbie, Expert, Developer, or 
Associate.

Rank Image Click the upload link to browse and select an image to upload. Once 
uploaded the path where the image is stored appears in the text box. 
Images are optional.
If you assign an image, it appears below the user’s name on any 
post.

Ladder System Check this box if this rank is part of a ladder system. That is, a rank 
based on the number of posts a user has submitted to this 
Discussion Forum. If you uncheck Ladder System, both Starting 
Rank and Number of Posts become inactive, since those fields set 
up and manage the ladder system.
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6. Click the Save button ( ).

Deleting a User Rank

1. In the Workarea, click the Content tab.
2. Select a Discussion Board.
3. Click View > User Ranks.
4. Select the rank you want to delete.

5. Click the delete ( ) button.
6. Press OK to the confirmation message.

Changing a User’s Rank

In order to change a user’s current rank, you must know it. As 
mentioned above, a user’s rank appears below the user name on 
any post he has made.

Starting Rank If you are using a ladder system, use this check box to designate this 
rank the Starting Rank. A user is assigned to this rank when he 
submits the first post.
A Discussion Forum can only have one Starting Rank. Also, If this is 
the Starting Rank, you cannot enter a number of posts.

Number of Posts Enter the number of posts it takes to reach this rank. If the Starting 
Rank check box is checked, the number is 1 and cannot be 
changed.

Applies To If you accessed this screen from Workarea > Settings > 
Configuration > Discussion Board > User Ranks, use this field to 
select the Discussion Forum to which this rank applies.

Field Description
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You can only move a user into and out of a ladder system. You 
cannot change his rank within a ladder system -- that is determined 
by the number of posts.

To change a user’s rank, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Content and 
navigate to the forum to which the user has posted.

2. Click View > User Ranks.
3. Select the rank that you want to move the user out of. 
4. The User Ranks screen appears. The lower half shows all 

users assigned that rank.

5. Click the user that you want to move out of the rank.
6. The screen display all ranks. The current one is selected.
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7. Click next to the desired rank.

8. Click the Save ( ) button.

Working with Topics
Topics are specific issues to be discussed in a Forum. For 
example, in a medical research Forum, a topic might be New 
Cancer Treatments. Topics can only be started within the 
Workarea.

Before creating a topic, you must create a Forum into which to 
place it. To learn more about how Topics fit into the Discussion 
Board hierarchy, see ”Hierarchy of Discussion Board Elements” on 
page 472.

This section contains the following topics:

• ”Adding a Topic to a Forum” on page 497

• ”Setting and Changing the Topic Priority” on page 499

• ”Viewing a Topic” on page 500

• ”Editing a Topic’s Title” on page 502

• ”Approving a Topic” on page 502

• ”Deleting a Topic” on page 503
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Adding a Topic to a Forum
When a new Topic is created, the first post is created from the 
message of the Topic.

To create a Topic, follow these steps.

NOTE If the user adding the Topic is not a Forum moderator, that user does not see the 
Topic in the workarea until it is approved. See Also: ”Approving a Topic” on 
page 502.

1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder 

structure.

3. Click the New Topic button ( ).
4. The Post New Topic screen appears.

5. Complete the screen using the following table.
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6. Click Save ( ).

Field Description

Subject Enter a short description of the topic. The Topic Subject appears on the Forum 
page, as shown below.

Priority Set the priority level for the topic. This determines where the topic appears in 
the topic list on the site. The default setting is Normal. See Also: ”Setting and 
Changing the Topic Priority” on page 499

Message Enter the topic text. This text appears on a new Web page after a Web site 
visitor clicks a Topic’s Subject line.
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Setting and Changing the Topic Priority
You can set a topic’s priority when creating it. Within a Forum, 
topics are sorted by priority.

Anyone with Moderate permission can change a topic’s priority. To 
do so, edit a Forum’s properties and click the View Properties 
button ( ).

Priority Levels

There are three priority levels:

• Announcement

• Sticky

• Normal

• Announcement - topic always appears at the top of the list. If a 
list has more than one announcement, they are sorted by date 
with most recent on the top.

The Announcement icon ( ) indicates its priority to the left of 
the title.

• Sticky - topic appears near the top of the list, just below the 
announcements. If a list has more than one sticky topic, they 
are sorted by date with most recent on the top.

The Sticky icon ( ) indicates its priority to the left of the title.
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.

• Normal - Topics with this priority follow Announcements and 
Sticky topics. The Normal icon ( ) next to the topic indicates 
its priority.

Viewing a Topic

NOTE To learn about viewing a topic from your Web site, see ”Using Discussion Boards 
on Your Web Site” on page 530.

To view a topic from the Workarea, follow these steps.

1. In the Workarea, click the Content tab. 
2. Select a Discussion Board, then select a Forum from the folder 

structure.
3. The Forum’s topics appear in the right frame. Click the one that 

you want to view.



Discussion Boards

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 501

The View Topic screen displays each post within the topic. If a post 
is surrounded by a yellow border (illustrated below), it must be 
approved before it can appear on the Web site. Only users with 
Moderate permission can approve a post. See Also: ”Assigning 
Permissions to a Discussion Board” on page 518

NOTE A red flag (circled below) to the left of a post on the Content of Forum screen also 
indicates that posts require a moderator’s approval.

The following options may appear across the top of the screen, 
depending on your permissions.

Button Description For more information, see

Delete topic and all of its posts ”Deleting a Topic” on page 503

View and edit the topic’s title and priority ”Editing a Topic’s Title” on page 502

Return to previous screen
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Under each post is a set of options that you may be able to perform 
on any post, depending on your permissions and the status of the 
post. 

If an option is underlined, you have authority to perform it. If not, 
you cannot. For example, if a post’s status is approved, the 
approve option is not underlined because it is already approved.

See Also: 

• ”Approving a Post in the Workarea” on page 504

• ”Adding a Reply to a Post” on page 504

• ”Editing a Post” on page 506

• ”Deleting a Post” on page 506

Editing a Topic’s Title
The only part of topic you can edit is its title.

1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then select a Forum from the folder 

structure.
3. The Forum’s topics appear in the right frame. Click the one that 

you want to edit.

4. Click the View Properties button ( ).
5. The Edit Topic screen appears. Modify the title as needed.

6. Click Save ( ).

Approving a Topic
A Topic needs approval when a user without moderate permissions 
for the Forum adds a Topic. To approve a Topic, follow these steps.

1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then select a Forum from the folder 

structure.
3. The Forum’s topics appear in the right frame. Click the one that 

you want to approve.
4. The View Topic screen appears.
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5. Click the Approve Topic button ( ).
6. The Topic is approved.

Deleting a Topic
You can delete any Topic. When you do, its posts are also deleted. 
Once deleted, they cannot be retrieved.

1. In the Workarea, click the Content tab,
2. Select a Discussion Board, then select a Forum from the folder 

structure.
3. The Forum’s topics appear in the right frame. Click the one that 

you want to delete.
4. The View Topic screen appears.

5. Click the Delete Topic button ( ).
6. A confirmation message appears.
7. Click OK if you are sure you want to delete it.

Working with Posts
When a new Topic is created, the first post is created from the 
message of the Topic. Essentially, all posts to the Topic are replies 
to the first.

This section contains the following topics, which explain working 
with posts.

• ”Adding a Reply to a Post” on page 504

• ”Approving a Post in the Workarea” on page 504

• ”Editing a Post” on page 506

• ”Deleting a Post” on page 506

• ”Attaching Images and Files to a Post” on page 506

• ”Searching a Forum’s Posts” on page 508

• ”Moving All Posts to Another Topic” on page 509

• ”Replacing Words in a Post” on page 510

• ”Creating and Editing Emoticons” on page 513
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Adding a Reply to a Post

NOTE You can also reply to a post from the Web site. See ”Posting a Reply” on 
page 532.

1. In the Workarea, click the Content tab 
2. Select a Discussion Board, then select a Forum from the folder 

structure.
3. The Forum’s topics appear in the right frame. Click the one that 

has the post that you want to reply to.
4. The next screen, View Topic, displays all posts to the selected 

topic.
5. Find the post that you want to reply to by reading its text 

(illustrated below).

6. Click reply.
7. Enter a Title for the post.
8. In the Description field, enter the text of your post.

Approving a Post in the Workarea
When defining a Forum, you can check the Moderate Comments 
field. If you do, posts to the Forum must be approved before they 
appear on the Web site. Only users who are assigned the 
Moderate permission are allowed to approve a post. See Also: 
”Discussion Board Permissions” on page 521

You can approve a post from the Workarea or the Forum on the 
site. See also ”Approving a Post” on page 534.
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To approve a post in the Workarea, follow these steps.

1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder 

structure.
3. The Forum’s topics appear in the right frame. Click the one that 

has the post that you want to reply to. (Unapproved posts have 
a red flag in the left column, as illustrated below.)

4. The next screen, View Topic, displays all posts to the selected 
topic.

5. Find the post you want to reply to. Unapproved posts have a 
yellow border (Illustrated below).

6. Click approve under the post icon.
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Editing a Post
You can edit the text of a post but you cannot edit its title.

NOTE You can also edit a post from the Web site. See ”Using Discussion Boards on 
Your Web Site” on page 530.

1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder 

structure.
3. The Forum’s topics appear in the right frame. Click the one that 

has the post that you want to edit.
4. The next screen, View Topic, displays all posts to the selected 

topic.
5. Find the post that you want to edit.
6. Click edit under the post icon.
7. The Edit Reply screen appears. Within the editor, update the 

text as needed.

8. Click Save ( ).

Deleting a Post
1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder 

structure.
3. The Forum’s topics appear in the right frame. Click the one that 

has the post you want to delete.
4. The next screen, View Topic, displays all posts to the selected 

topic.
5. Find the post that you want to delete.
6. Click delete under the post icon.

Attaching Images and Files to a Post
When creating a topic or post, you can add an attachment. In the 
Attached Files field, A list of the files of files that will be attached 
appears, In addition, a list of valid file extensions appear. The list of 
valid file extensions and maximum size of the file upload are 
defined at the Discussion Board level. See ”Accepted Extensions” 
on page 479 and ”Max File Size” on page 479. 
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Attaching a File

To add an attachment to a topic or post, follow these steps.

1. Click the Attachments button below the editor.

2. The Attachments window appears.

3. Click the Browse... button to find the file.



Discussion Boards

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 508

4. Browse to the location of the file and select it.
5. Click Open.
6. Click the Attach button to attach the file to the post.
7. The file appears in the list of Current File Attachments.
8. Click the Close button.

Viewing an Attached File

To view an attached file, click its name in the post.

Removing an Attached File

To remove a file from the list of attachments, follow these steps.

1. Click the Attachments button below the editor.
2. Highlight the attached item.
3. Click the Remove button.
4. Click the Close button.

Searching a Forum’s Posts
The Forum server control includes a search feature that lets site 
visitors search through all posts on your site. Any user can access 
the search from the Forum screen (see below).
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When a site visitor clicks Search, he can search the current Forum 
(the default value), select a different Forum, or search all Forums.

Moving All Posts to Another Topic
If you want to move all posts in one topic to another, follow these 
steps.

Prerequisite: The topic to which you want to move the posts must 
exist. See ”Adding a Topic to a Forum” on page 497

1. Access a page on your Web site that has a login button.
2. Sign in as a member of the Administrators group or as a 

Moderator of the board.
3. Navigate to a page with Discussion Board.
4. Navigate to a topic page.
5. Click the Move to... dropdown list. (It appears in the right 

corner above the posts.)

6. Select the topic to which you want to move all posts.
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7. Confirm that you want to move all posts.

Replacing Words in a Post
You can configure Ektron CMS400.NET to replace unwanted 
words in a post. This feature is useful for changing words that are 
obscene, indecent, or should not appear on your site. In addition, 
Replace Words can fix commonly misspelled words. For example, 
the can replace teh. See Also: ”Adding a Replacement Word” on 
page 511

The Replace Words feature works with exact matches but does not 
append words. For example, if you replace car with auto, the 
sentence I bought the car from the cartel becomes I bought the 
auto from the cartel. Note that cartel did not change to autotel even 
though the word car appears in cartel.

This feature is more fully explained through the following topics.

• ”Using Regular Expressions” on page 510

• ”Adding a Replacement Word” on page 511

• ”Viewing Existing Replacement Words” on page 512

• ”Editing a Replacement Word” on page 512

• ”Deleting a Replacement Word” on page 513

Using Regular Expressions

If you would like the Replace Words feature to modify words that 
contain a word you do not want used, you can use Regular 
Expressions. A Regular Expression, often referred to as regex, is a 
pattern of metacharaters placed around a word that describes a 
string. Used for string manipulation, regex allows you to detail a 
succinct description of a group of words without having to detail 
each word in the group.

Regular Expression Description

. Matches any character, similar to a wildcard. For example, .ar matches any 
three letter word ending in ar, such as car, bar, tar or far.
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Adding a Replacement Word

To add a replacement word to a Forum, follow these steps.

| Acts as an or operator. For example, steak|stake would find steak or stake.

[ ] Matches one character that is between the brackets. For example, [rst] 
matches r, s or t. [d-g] matches d, e, f, or g. Another example, [bc]ar matches 
bar and car. If you need to match a dash (-), use it a the beginning or end of 
the group. For example, [xyz-] or [-xyz].

[^ ] Matches one character that is not in the group. For example, [^rst] matches 
any character other than r, s or t. Another example, [^bc]ar does not match bar 
or car, but does match words, such as tar or far.

^ Matches the beginning of any line. For example, ^[bc]ar matches bar or car, 
but only at the beginning of a line.

$ Matches the end of any line. For example, ^[bc]ar matches bar or car, but only 
when it appears at the end of a line.

( ) Marks a sub expression. For example, alt(a|e)r finds altar or alter.

* When an expression is followed by *, it matches zero or more versions of the 
expression. For example, [rst]* finds (blank), r, s, t, rs, sr, rt, tr, st, ts, rst, rts, 
srt, str, trs and tsr.

+ When an expression is followed by +, it matches one or more versions of the 
expression. This differs from * because it does not match (blank). It must 
match at least one character. For example, r+ matches r, rr, rrr and so on.

{x,y} Must match at least x times and not more than y times. For example, s{2,4} 
matches ss, sss and sss. You can also use {x} to specify an exact match. For 
example, s{3} matches sss. You can use {x,} to specify that the match is at 
least x amount of times. For example, s{4} matches ssss, sssss, ssssss and 
so on.

? Must match the preceding character zero or one times. For example, 
Boa?rder matches boarder and border.

Regular Expression Description
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NOTE In addition to using Replace Words for a specific Forum, you can access the 
Replace Word feature from the Workarea > Settings > Configuration > Discussion 
Board > Replace Words. If you have more than one Forum, this allows you select 
to which Discussion Boards the Replace Words feature is applied.

1. In the Workarea, click the Content tab. 
2. Select a Forum from the folder structure.
3. Click New > Replace Word.
4. The Replace Word screen appears.
5. Add the word to be replaced in the Old Word textbox.
6. Add the replace word in the New Word textbox.
7. Select the language for the Replace Word.

8. Click the Save button ( ).

Viewing Existing Replacement Words

To view a list of existing words that are replaced, follow these 
steps.

1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click View > Replace Words.
4. A list of word to be replaced appears.

Editing a Replacement Word

1. In the Workarea, click the Content tab
2. Select a Forum from the folder structure.
3. Click View > Replace Words.
4. Click either the Old Word or the New Word to edit.

5. Click the Edit button ( ).

6. Change the Old Word, New Word or Language.

7. Click the Save button ( ).
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Deleting a Replacement Word

1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click View > Replace Words.
4. Click either the Old Word or the New Word to delete.

5. Click the Delete button ( ).

6. A dialog box asks if you are sure you want to delete.
7. Click OK.

Creating and Editing Emoticons
An emoticon is an icon used to express emotion in a Forum post. 
For example, .

There are two ways to insert an emoticon.

• A Forum participant clicks the emoticon toolbar button . 
Next, a small window appears with available emoticons (shown 
below). The user clicks one to insert it.

• A Forum participant enters a few characters that resemble the 
image. For example, to insert , the user enters O:\).
While working in a post, the user only sees the text. But when 
the post is saved, Ektron CMS400.NET converts the text to the 
corresponding emoticon. In all subsequent work with the post, 
users see only the emoticon.

”Viewing Emoticons” on page 514 explains how to find the list of 
available emoticons and the characters used to insert each one.

You can view and modify or delete a standard set of emoticons. 
You can also create your own.
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Inserting Emoticon Images 

Place emoticon images in the following folder: 
webroot\Workarea\threadeddisc\emoticons. Administrators reference 
these files when editing or creating new emoticons.

Viewing Emoticons

A standard set of emoticons is supplied with Ektron CMS400.NET. 
After viewing them, you can add new ones as well as delete or 
modify standard ones.

To see Ektron CMS400.NET’s emoticons, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Discussion Boards > Emoticons.

2. A list of emoticon images and text appears.

Editing Emoticons

To edit an emoticon, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Discussion Boards > Emoticons.

2. Click the emoticon text or image that you want to edit.

3. Click the Edit button ( ).
4. Use the following table to guide you through the screen’s fields.



Discussion Boards

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 515

Fields on the Emoticons Properties Screen

Deleting Emoticons

To delete an emoticon, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Discussion Boards > Emoticons.

2. Click the emoticon that you want to delete. 

3. Click the Delete button ( ).
4. Reply to the confirmation message.

Creating Emoticons

To create an emoticon, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings > 
Configuration > Discussion Boards > Emoticons.

2. Click the Add button ( ).
3. Respond to the fields on the screen. See ”Editing Emoticons” 

on page 514.

4. Click Save ( ).

Field Description

Emoticon 
Text

Enter or update the characters a Forum participant would enter to insert this 
emoticon.

Emoticon 
Image

Enter the name of the image file that will appear after a user enters the above 
Emoticon text and saves the post. Administrators place emoticon images in 
the webroot\Workarea\threadeddisc\emoticons folder. 

Regex See ”Using Regular Expressions” on page 510

Language Select the emoticon’s language from the dropdown list. If a Forum is 
language-specific, only emoticons assigned to that language or all languages 
are available.
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Restricting an IP Address
If you are not using authentication for the Forums and want to 
block a site visitor from posting to the Forum, you can use the 
Restricted IP feature to block site visitors from posting to the 
Forum.

Adding an IP Address the Restricted List

NOTE In addition to using Restricted IPs for a specific Forum, you can access the 
Restricted IP feature from the Workarea > Settings > Configuration > Discussion 
Board > Restricted IPs. If you have more than one Forum, this allows you select 
to which Discussion Boards the Restricted IPs are applied.

To add an IP address to the restricted list, follow these steps.

1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click New > Restricted IP.
4. Enter the IP Address to be blocked.

5. Click the Save button ( ).
6. A list of restricted IP addresses appear.

Editing a Restricted IP Address
1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click View > Restricted IPs.
4. A list of restricted IP addresses appears.
5. Click the IP address to be edited.
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6. Click the Edit button ( ).

7. Edit the IP address in the Block IP text box.

8. Click the Save button ( ).

Deleting a Restricted IP Address
1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click View > Restricted IPs.
4. A list of Restricted IP addresses appears.
5. Click the IP address to be deleted.

6. Click the Delete button ( ).

7. A dialog asks if you are sure you want to delete the restricted 
IP address.

8. Click OK to continue.
9. A list of the remaining restricted IP addresses appear.
See Also: ”Discussion Boards” on page 471

Setting Up Post Reporting
When you set up the Forum Post Reporting feature, it adds a 
Report button to the bottom of each post. The button lets site 
visitors report posts to Forum moderators. For example, users can 
report posts that are offensive or spam posts.
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When a user clicks the Report button, an email notification is sent 
to moderators. A moderator can then view the post and decide 
whether to edit, delete or leave the post. See Also: ”Reporting a 
Post” on page 536

To set up a Forum for Post Reporting, follow these steps.

IMPORTANT! Your Ektron CMS400.NET Web server must be set up to send emails. See the 
Setup Manual section “Configuring E-Mail Notifications for Tasks and Content 
Workflow.”

1. In the Workarea, click the Content tab.
2. Select a Discussion Board from the folder structure.
3. Click View > Permissions.
4. Make sure Forum moderators have Moderate permission. See 

Also:  ”Assigning Permissions to a Discussion Board” on 
page 518

5. Click the Back button ( ).

6. Select a Forum.

7. Click the Properties button ( ).

8. Make sure the Moderate Comments box is checked. If it is 
not, click the Edit button ( ) and check the Moderate 
Comments box.

9. Click the Save button ( ).

Assigning Permissions to a Discussion Board
Like regular content folders, Discussion Boards have a permission 
table that lets you determine which users can perform which 
functions. (To learn more about folder permissions, see ”Setting 
Permissions” on page 716.) Because Discussion Boards have 
different functions than folders, their permission table is slightly 
different.

In addition, each Forum has permission settings. By default, a 
Forum inherits permissions from its parent Discussion Board. But, 
you can break this inheritance and customize permissions for a 
Forum. If you break a Forum’s inheritance, only the Forum’s 
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permission table is checked -- the parent Discussion Board’s 
permissions are ignored.

Modifying a Discussion Board’s Permission Table
To access a Discussion Board’s permission table, navigate to and 
click the board so it appears in the Workarea. Then, click View > 
Permissions.

NOTE Only Administrators group members can access the Discussion Board 
Permission Table.

Below is an example of a Discussion Board permission table for 
regular users. Membership users have fewer permissions. See 
Also: ”Discussion Board Permissions” on page 521
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Discussion Board permissions are more fully explained through the 
following topics.

• ”Initialization of Discussion Board Permission Values” on 
page 521

• ”Discussion Board Permissions” on page 521

• ”Discussion Forum Permissions for Membership Users” on 
page 522

• ”Granting Discussion Board Permissions to CMS Users and 
User Groups” on page 523

• ”Removing Discussion Board Permissions from CMS Users 
and User Groups” on page 524

• ”Editing Discussion Board Permissions for CMS Users and 
User Groups” on page 524

• ”Assigning User Permissions to Forums” on page 525
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Initialization of Discussion Board Permission Values
When you create a Discussion Board, Ektron CMS400.NET seeds 
its permission table with values from the parent folder, as 
described in the following table.

NOTE Because there are no corresponding permissions for the Discussion Board’s 
Moderate and Post/reply permissions, their initial value is blank.

So for example, if the user JSmith has permission to perform all 
functions for a folder, and a Discussion Board is created in that 
folder, JSmith initially receives all permissions listed above for the 
Discussion Board. However, you can edit the permissions as 
needed.

As soon as you create a Discussion Board, it is disconnected from 
the parent folder’s permission table. Subsequent changes to the 
parent’s permissions have no effect on Discussion Board 
permissions.

Discussion Board Permissions
The following table lists all permissions that may be granted to 
regular users. Only some permissions can be granted to 
membership users (that is, site visitors who register to participate 
in the Forum).

Parent Folder Permission Discussion Board Permission

Read only Read only

Edit Edit Topic

Add Add Topic

Delete Delete Topic

Add Folders Add Forum

Edit Folders Edit Forum

Delete Folders Delete Forum
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Discussion Forum Permissions for Membership Users

Permission Give the user ability to Can be assigned to 
membership users

For more 
information, see

Read only View Forums and posts; cannot 
submit a post

Yes

Edit Topic Edit a topic’s title No ”Editing a Topic’s Title” 
on page 502

Add Topic Add new topics Yes ”Adding a Topic to a 
Forum” on page 497

Delete Topic Delete a topic No ”Deleting a Topic” on 
page 503

Post/Reply Post a new topic or reply to an 
existing one, either from the 
Workarea or the site

Yes ”Adding a Topic to a 
Forum” on page 497;
”Adding a Reply to a 
Post” on page 504

Moderate

Important: 
Everyone who 
has Moderate 
permission will 
receive 
notifications 
when a post is 
reported. See 
Also: 
”Reporting a 
Post” on 
page 536

Approve posts and receive 
notifications when a post is 
reported using the report post 
feature; only applicable if the 
Forum’s Properties field 
Moderate Comments is 
checked.

No ”Moderate Comments” 
on page 490

Add Forum Create a new Forum No ”Creating a Forum” on 
page 488

Edit Forum Edit a Forum No ”Editing a Forum” on 
page 490

Delete Forum Delete a Forum No ”Deleting a Forum” on 
page 491
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By default, membership users are assigned the following 
permissions:

• Read only

• Add Topic

• Post Reply

They cannot be granted Edit or Delete topic nor advanced 
permissions (Add, Edit or Delete Forum).

To change the default permissions, follow these steps.

1. Navigate to and click the Discussion Board so it appears in the 
Workarea.

2. Click View > Permissions.
3. Click View Membership Users.

4. The View Permissions for Board screen appears. 
5. Add new member users and groups, remove them, or change 

their permissions.

Granting Discussion Board Permissions to CMS Users and 
User Groups

To give a CMS user or user group permissions to work with a 
Discussion Board, follow these steps.

1. Navigate to and click the Discussion Board so it appears in the 
Workarea.

2. Click View > Permissions.
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3. Click the Add button ( ).
4. All users and groups who are not currently assigned 

permissions appear. Click any user or group.
5. The Add Permission for Folder screen appears with the 

selected user or group.
6. Assign appropriate standard and advanced permissions then 

click the Save button ( ). See Also: ”Assigning Permissions to 
a Discussion Board” on page 518

Removing Discussion Board Permissions from CMS Users 
and User Groups

To remove a user or user group from the Discussion Board 
permission table, follow these steps. After you remove the user, 
Discussion Boards do not appear within his Workarea.

1. Navigate to and click the Discussion Board so it appears in the 
Workarea.

2. Click View > Permissions.

3. Click the Delete icon ( ).
4. Select the user or group that you want to remove from the 

Permission table.
5. A confirmation message. Click OK.
6. The user is removed.

Editing Discussion Board Permissions for CMS Users and 
User Groups

To edit a user or user group’s Discussion Board permissions, 
follow these steps.

1. Navigate to and click the Discussion Board so it appears in the 
Workarea.

2. Click View > Permissions.
3. Click the user or group whose permissions you want to edit.
4. The Edit Permissions screen appears.
5. Change the settings as appropriate. See Also: ”Discussion 

Board Permissions” on page 521
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6. Click the Save button ( ).

Assigning User Permissions to Forums
You can use all of the permission features available to Discussion 
Boards with any Forum. To access a Forum’s Permission Table, 
follow these steps.

1. Open CMS Workarea > Content.
2. Click the Forum.
3. Click the View Permissions button on the Contents of Forum 

screen (circled below).

4. A Permission Table appears. See Also: ”Discussion Board 
Permissions” on page 521

Setting a Forum’s Permission Table Values

A Forum initially inherits (that is, copies all permissions from) its 
parent Discussion Board’s permission settings.

When you first view a Forum’s permission table, you see these 
settings plus a check box that allows you to maintain the 
inheritance or break it (circled above).
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If you break inheritance by unchecking the Allow this object to 
inherit permissions box, the Forum permission screens change 
from view-only to edit. At this point, you can modify the Forum’s 
permissions as needed.

To later restore inheritance, check the box. When you do, the 
parent Discussion Board’s permissions overwrite any Forum-
specific changes. The Forum then reverts to a read-only state. Any 
permission changes must be made at the Discussion Board level 
while inheritance is enabled.

Sending Notifications When a New Forum Topic or 
Post is Created

The Discussion Board’s Email Notification feature enables Ektron 
CMS400.NET to generate email for a list of registered users 
whenever a new forum topic or post is created.

For example, anyone may register to be notified whenever a new 
forum topic or post is created. As soon as the new forum topic or 
post is created on the discussion board, registered users receive 
an email announcement with a link to the new topic or post. The 
recipient clicks the link and immediately accesses the page.

As a result, a self-selected group of users can be instantly notified 
when user’s post information to your discussion board relating to 
their interests. Once the messages are set up, you don’t need to 
do anything -- everything happens in the background.
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Sample Discussion Board Email Notification

See Also: ”Creating the Email Message” on page 527

Creating the Email Message
You can create an email message to be sent when a new post is 
added to the discussion board or when a new topic is added. A 
simple editor lets you apply some XHTML formatting the message.

Including Variables in the Default Message

The messages can include variables that retrieve information 
about the new post or topic and display it in the message text. The 
variables are surrounded by at signs (@). For example:

@appPosterDisplayName@ has created a thread you have subscribed to.

In the email, this text might read:
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Alan Administrator has created a thread you have subscribed to.

You can use the following variables in the body of an email 
notifications.

To create a message, follow these steps.

1. In the Workarea, go to Settings > Configuration > 
Discussion Boards > Messages.

2. Click the Add button ( ).

3. Enter a title that describes the message.

Variable Displays this information in the email

@appTopicTitle@ The title of the topic.

@appTopicId@ The integer ID of the topic.

@appRecipientDisplayName@ The display name of the person receiving the email.

@appRecipientId@ The recipient’s integer ID.

@appRecipientFirstName@ The first name of the person receiving the email.

@appRecipientLastName@ The last name of the person receiving the email.

@appRecipientEmail@ The email address of the person receiving the email.

@appHostUrl@ The host site’s URL.

@appForumUrl@ The forum’s URL.

@appPostMessage@ The text of the message that was posted to the 
discussion board.

@appPosterId@ The integer ID of the person who created the post.

@appPosterDisplayName@ The display name of the person who created the post.

@appPosterProfileUrl@ The profile URL for the person who created the post.

@appPostUrl@ The URL of the post on the Web site.
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4. At the Type field, select either NewForumTopic or 
ForumPost.

5. Select whether to make the email message a Default message.
6. In the editor, enter the message text. Use the variables listed in 

the table above to retrieve information about the about the new 
post or topic and display it in the message.

7. Click the Save button ( ).

Inserting Discussion Board Server Controls
Ektron CMS400.NET provides two server controls for use with the 
Discussion Boards. The Forum server control displays the 
discussion board. The Active Topics server control displays a list of 
active or recent topics.

Inserting the Forum Server Control
After creating at least one hierarchy of Discussion Board elements, 
place a Forum server control on a Web page. That procedure is 
described in the Ektron CMS400.NET Developer’s Manual section 
“Introduction to Ektron CMS400.NET Server Controls” > 
“Discussion Board Server Controls” > “Forum Server Control.”

If you want require authentication by site visitors, the web page 
that hosts the Forum should also contain

• a Membership server control (or a link to page that has one). 
This lets site visitors/membership users register for Discussion 
Boards.

• a Login server control that lets the site visitor/membership user 
log in

NOTE Ektron recommends adding text below the Login server control to remind the site 
visitor to enter his email address at the User field. For example, “At the User field, 
enter your email address.”

Inserting the ActiveTopics Server Control
Displays the most active or recent topics. You can place this server 
control anywhere on your site. For example, on your home page, 
display the last ten topics added to the board.
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To learn about the ActiveTopics Server Control, see the Ektron 
CMS400.NET Developer’s Manual section “Introduction to Ektron 
CMS400.NET Server Controls” > “Discussion Board Server 
Controls” > “ActiveTopics Server Control.”

Using Discussion Boards on Your Web Site
This section explains what can be done when using a Discussion 
Board on your site.

• ”Approving a Topic” on page 530

• ”Sorting Topics” on page 531

• ”Posting a Reply” on page 532

• ”Editing a Post” on page 534

• ”Quoting a Post” on page 532

• ”Approving a Post” on page 534

• ”Deleting a Post” on page 535

• ”Reporting a Post” on page 536

• ”Moving All Posts to Another Topic” on page 509

• ”Suppressing User Information from the Forum Profile Display” 
on page 536

• ”Outputting a Forum as an RSS Feed” on page 539

• ”Subscribing to a Discussion Board” on page 540

• ”Sending a Private Message” on page 541

• ”Using the Control Panel” on page 542

Approving a Topic
A Topic needs to be approved when a user who does not have 
moderate permission for the Forum adds a Topic. When you view 
topics on the site, any that need approval are highlighted with a 
different color background.
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From this screen, you can click the Approve link next to the topic’s 
title. You could also click the Topic’s title to view it and click the 
Approve button ( ) on that screen.

Sorting Topics
Topics can be sorted by the columns of a Forum. To sort a Forum:

1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Click any of the column titles to sort by alpha or numerical 

order.
On the first click, items are sorted first by any numeric (1-10) 
values, then by alpha values (A to Z). Clicking a column title a 
second time sorts the items in reverse.
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When the page is first viewed, the list is sorted by Last Post.

Posting a Reply
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Click Add Reply.

NOTE If a topic is moderated, a message appears stating that your reply is pending 
moderator approval.

There are two editors that site visitors can use when replying:

• eWebEditPro (scaled-down version)

• Javascript Editor

For users who sign in before posting, this decision is made for the 
user at the Forum Editor field on the Edit User screen.

If users does not sign in, the Javascript Editor is the editor.

Quoting a Post
Quoting a post’s comments means that your reply begins with the 
original post’s comments. You can then add your comments and 
even edit the quoted post, so that you can include only the portion 
on which you are commenting.
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To quote a post, follow these steps.

1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Click a Topic.
4. Find the post you want to quote.
5. Click the Quote button.

6. The editor appears with the quoted information at the top of the 
text area.
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.

7. Add your comments below the quote.
8. Click Post.

Editing a Post
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Find the topic you want to edit.
4. Click Edit.

Approving a Post
When defining a Forum, you can check the Moderate Comments 
field. If you do, posts to the Forum must be approved before they 
appear on the Web site. Only users who are assigned the 
Moderate permission are allowed to approve a post. See Also: 
”Discussion Board Permissions” on page 521

You can approve a post from the Workarea or the Forum on the 
site. See also ”Approving a Post in the Workarea” on page 504.

To approve a post from the Forum, follow these steps.

1. Log into the site.
2. Navigate to the Forum.

3. Click the Moderate button ( ).

4. The Forum’s Control Panel appears.
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5. Click the topic.
6. The topic appears. Posts requiring approval have an Approve 

button ( ).

7. Click the Approve button ( ).

8. A screen appears stating that the post has been approved.
9. The post now appears on your Web site.

Deleting a Post
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.



Discussion Boards

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 536

3. Find the topic you want to delete.
4. Click Delete.

Reporting a Post
You can allow site visitors to inappropriate report posts, such as 
spam or offensive posts. 

When a site visitor clicks the Report Post button (located at the 
bottom of the post), an email notification is sent to all Forum 
moderators. Any moderator can review the post and decide to edit, 
delete, or leave it alone. See Also: ”Setting Up Post Reporting” on 
page 517

.

Suppressing User Information from the Forum Profile Display
Anyone browsing to a Discussion Forum can view information 
about its contributors by clicking the user name, as shown below.
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.

However, if the Forum server control’s HideUserProfile property is 
true, non-administrator users cannot see the profile, even if the 
Private Profile setting is set to Public. For more information, see 
”How Users Suppress Profile Information” on page 538 and ”How 
Administrators Suppress Profile Information” on page 539.

Administrators can see the profile, regardless of how the 
HideUserProfile property is set.

What Information is Contained in the Profile?

The profile contains the following information about a user:
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• First Name - the first name of the user

• Last Name - the last name of the user

• Email - the email address of the user

• Joined - the date the user joined

• Last Visit - the date the user last visited the site

• Number of Posts - the amount of posts a user has contributed

• Post History - a list of posts the user has contributed

How Users Suppress Profile Information

Users can determine if their profile is viewable via the Private 
Profile drop down box on the Membership Registration screen 
(shown below) and the Edit Profile screen. If Private Profile is set 
to Private, profile information is suppressed. If it is set to 
Colleagues, only a user’s colleagues can see his profile. When set 
to public, everyone can see a user’s profile information.

NOTE If the Forum server control’s HideUserProfile property is set to true, non-
administrator Forum visitors cannot see a user profile, even if the Private Profile 
drop down box is set to Public.
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NOTE The Membership Registration screen appears wherever your developer inserts 
the Membership Server Control. For more information, see the Ektron 
CMS400.NET Developers Manual section “Membership Server Control.”

How Administrators Suppress Profile Information

If you want to suppress the display of user names as an 
administrator, follow these steps.

NOTE If the Forum server control’s HideUserProfile property is set to true, non-
administrator Forum visitors cannot see the profile, even if the Private Profile 
check box is unchecked.

1. If the user is a regular user, go to Settings > Users and select 
the user whose information you want to suppress.
If the user is a membership user, go to Modules > Community 
Management > Memberships > Users and select the user 
whose information you want to suppress.

2. In the User Properties area of the screen, check the Private 
Profile checkbox.

Outputting a Forum as an RSS Feed
You can output a Forum as an RSS feed by clicking the RSS feed 
button ( ). Each level of the Forum has an RSS feed button. This 
allows you to output a specific topic as an RSS feed. 

This following is an example of the output.

<?xml version="1.0" encoding="UTF-8" ?> 
- <rss version="2.0">

<!--  Generated by Ektron CMS400.NET --> 
- <channel>

<title>Ektron Medical Center Forum</title>
<link>http://test/webform.aspx</link>
<description>Ektron Medical</description>

- <item>
<title>Research</title>
<link>http://test/webform.aspx?g=topics&f=108</link>

- <description>
<![CDATA[ Latest medical research ]]>

 </description>
 <pubDate>Wed, 11 Oct 2006 17:50:04 GMT</pubDate>

</item>
</channel>

</rss>
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Subscribing to a Discussion Board
After logging in, discussion board users can subscribe to Forum 
posts and replies by clicking the Subscribe button ( ) 
(highlighted below). 

The button appears at each Discussion Board level, so that a user 
can subscribe to Forums and topics of interest. After clicking the 
button, the following screen appears.

The user selects a notification type, listed below.

• All Posts - notifies you when any post or reply is added

• Replies to Me - notifies you when someone replies to your 
post
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Next, he clicks the Add Subscription button. A page notifies him 
that his subscription was added.

Reviewing Subscriptions

To review your Forum subscriptions, go to the Control Panel and 
click Notifications in the lower left corner. A screen indicates each 
Discussion Board level to which you have subscribed, as 
illustrated below.

Deleting a Subscription

To delete any subscription, check the corresponding check box 
and click the Delete button (highlighted above).

Sending a Private Message
Logged in users can send a private message to the person who 
created a post or reply. Only the sender and receiver can view 
private messages. This requires both users to be either a 
CMS400.NET user or a Membership user.

To send a private message, follow these steps.

1. Navigate to a post.
2. Click the User’s name.
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3. When the User Profile appears, click the Message button.

4. The Message screen appears.

NOTE The To: field is filled automatically. Users cannot add additional members.

5. Enter a Subject.
6. Enter a Message.
7. Click the Post button.
8. Users are notified that a message was sent.

Using the Control Panel
The Control Panel allows logged in users to view your profile, read, 
reply to and delete private messages. It also allows users with 
moderate permissions to moderate the Forum. The Control Panel 
button is located at the Forum level.
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.

Clicking the Control Panel button opens control panel.

The Inbox view appears by default. From this view, users can read 
a message by clicking on it. Once a message is read, its icon 
changes from unread ( ) to read ( ).

In addition, users can view information about the person who sent 
the message by clicking their name. Users can also delete the 
message by clicking the corresponding check box then the delete 
button. To switch to a different view, click its link.

The user can also check his subscriptions. See ”Reviewing 
Subscriptions” on page 541.
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Viewing and Replying to Messages

From the Inbox or Sent Items in the Control Panel, users can view 
a message by clicking on it. On the View Message screen, users 
can see who sent the message, to whom the message was 
directed, when it was sent, the subject and the contents of the 
message.

Users can reply to a message by clicking the reply button ( ). 
Once clicked, the editor opens in the control panel, and a user can 
reply.

IMPORTANT! When replying to a private message, users add their response to the existing 
message. Only one message is created.
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Once a user adds a reply to the private message, he clicks the 
Post button. He is then informed that the message was sent.

Deleting a Private Message

To delete a private message, follow these steps.

1. Click the Control Panel button on the front page of the 
Discussion Board.

.

2. Click the check box next to the message.



Discussion Boards

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 546

3. Click the Delete Selected button.
4. A confirmation box asks if you want to delete all selected 

messages. Click OK.
5. The message is deleted.

Viewing a User Profile From the Control Panel

To view a profile from the Control Panel, click the Profile link in the 
Control Panel. ”What Information is Contained in the Profile?” on 
page 537
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Once the Profile link is clicked, the user’s profile page appears.
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Moderating From the Control Panel

Users who have permission to moderate a Forum can do so from 
from the Control Panel by clicking the Moderate link.

Once Moderate is clicked, the user sees a list of items that need 
approval.
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Clicking an item opens the post. From this screen, you can edit, 
approve, or delete the post. See Also: ”Approving a Post” on 
page 534.
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Calendars

The Calendars feature allows you to create event calendars for 
your Web site. Once created, users may add calendar events 
that are posted to the calendar for visitors to see.

NOTE The User Manual section “Working with Calendars“ explains calendar 
concepts and procedures that end users need to know. This section does not 
repeat that information. So, you should be familiar with that information 
before reading this.
Also, the Ektron CMS400.NET Developer’s Manual provides instructions on 
using the Calendar server control/custom function.

This chapter explains Ektron CMS400.NET calendars through 
the following topics.

• ”Calendar Toolbar Buttons” on page 551

• ”Accessing the Workarea Using Calendars” on page 552

• ”Calendar Permissions” on page 552

• ”Adding a New Calendar” on page 553

• ”Editing a Calendar” on page 558

• ”Deleting a Calendar” on page 559

• ”Calendar Event Types” on page 559

• ”Displaying Calendars on Web Pages” on page 562

• ”Creating a Foreign Language Calendar” on page 562
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Calendar Toolbar Buttons
Within the Calendars feature, several buttons (described below) 
help you perform actions.

Button Name Lets you More Information

Add 
Calendar

Access Add Calendar screen ”Adding a New Calendar” 
on page 553

Save Save calendar or calendar event

Show 
Calendar

Display calendar in Workarea “Viewing a Calendar” in 
the Ektron 
CMS400.NET  User 
Manual chapter “Working 
with Calendars

Manage 
Event 
Types

Add, edit, and delete Event Types to and 
from a calendar

”Calendar Event Types” 
on page 559

Add 
Calendar 
Event

Access Add Calendar Event screen in 
the Workarea

“Adding a Calendar 
Event” in the Ektron 
CMS400.NET  User 
Manual chapter “Working 
with Calendars” 

Edit Edit calendar or event name ”Editing a Calendar” on 
page 558; ”Editing the 
Event Type Name” on 
page 561

Delete Delete calendar or calendar event ”Deleting a Calendar” on 
page 559

Delete all 
recurring 
events

Delete all events in a recurring series “Deleting All Events in a 
Recurring Series” in the 
Ektron CMS400.NET  
User Manual chapter 
“Working with Calendars” 
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Accessing the Workarea Using Calendars
To access the Workarea after viewing a calendar, you cannot right 
click the mouse then choose Workarea from the context-sensitive 
menu as you can with content. Instead, after logging in, click either 
the Add Events or View Events icon (circled below) to access the 
Workarea.

Calendar Permissions
Calendar permissions are derived from the content folder assigned 
to the calendar. This section explains the permissions you can set 
for a calendar.

Add 
Calendar 
Event

Access the Add Calendar Event screen 
from calendar on Web page

“Adding a Calendar 
Event” in the Ektron 
CMS400.NET  User 
Manual chapter “Working 
with Calendars” 

View Date View calendar events for selected day “Viewing a Calendar 
Event” in the Ektron 
CMS400.NET  User 
Manual chapter “Working 
with Calendars” 

Add Library Select a library Quicklink for an event. Hyperlink field 
description in the Ektron 
CMS400.NET  User 
Manual chapter “Working 
with Calendars”

Button Name Lets you More Information
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Administrator Permissions
Members of the following groups have full control over all calendar 
features (as they do for content). Only these users can add, edit, or 
delete a calendar.

• administrator user group

• users and user groups defined on the Manage Members for 
Role: Calendar-Admin screen. (For more information, see 
”Defining Roles” on page 735.)

Administrators may also add, edit, and delete calendar events.

User Permissions
Users who are not in one of the groups listed in ”Administrator 
Permissions” on page 553 cannot add, edit, or delete calendars.

Non-administrator users can add, edit, or delete calendar events if 
they have add, edit, and delete permissions for the calendar’s 
content folder. See Also: ”Setting Permissions for a Content 
Folder” on page 720

Adding a New Calendar
To add a new calendar, follow these steps.

See Also: ”Calendar Permissions” on page 552

1. From the Ektron CMS400.NET Workarea, click Modules > 
Calendar.

2. Click the Add Calendar button ( ).
3. The Add or Edit Calendars screen appears. The following table 

explains each field on the screen.
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Section Description

Title Enter a calendar title, which identifies the calendar in the 
Workarea.

Description Enter a calendar description, which appears on the 
Calendar Modules screen to help identify the calendar.

Location Label Specify the label text for the location field. The location 
appears with the detail of a calendar event.

Start Time Label Specify a label for the start time. A calendar event can 
display the start time.

End Time Label Specify a label for the end time. A calendar event can 
display the end time.

Display Weekends Place a check in this box if you want the calendar to display 
Saturdays and Sundays along with weekdays.
To display weekdays only, remove the check. See Also: 
”Display Weekends” on page 557

Forward Only To have the calendar display only events from the date 
when someone views the calendar forward (but no past 
events), place a check in the box next to
Show only events that fall after the viewing day
However, a logged-in user can view past calendar events.
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Event Type Label One section of the Add Calendar Events screen displays 
available event types and lets the user assign them to the 
event.

By default, this text is Event Type:. To change the default 
text, edit this field.

Event Types Available If you want to allow users to assign event types to events 
on this calendar, check this box.

Event Types Required If you want to require users to assign event types when 
adding events, check this box.
This checkbox can only be checked if Event Types 
Available is checked.

Instructions If you allow users to filter a calendar view by event type, 
text appears at the bottom of the screen that explains how 
to use the selection box. By default, this text is Select 
Event Type To View.

If you want to change this text, edit this field.

Show All label If you allow users to filter a calendar view by event type, the 
list of event types appears at the bottom of the screen. On 
top of the list is text indicating that all event types will 
appear on the calendar. By default, this text is Show All.

If you want to change this text, edit this field.

Section Description
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4. Click the Save button ( ).

Long Description This field can allow the user to enter additional information 
about a calendar event.

Your choices are:

• No Long Description - no additional description is 
allowed

• Text Only - while adding an event, a user can enter 
text into a Long Description box. No formatting is 
allowed within this text.
This text appears in the Event View screen and in the 
XML Packet. Because the text is not formatted, the 
XSL creator is responsible for its display.

• Rich Text Description - works the same as the Text 
Only option (see above) except the user can format 
text using Ektron’s eWebEditPro editor.

Content Folder Specify the calendar’s content folder. 
To understand how folder assignment affects calendar use, 
see ”Calendar Permissions” on page 552.
By default, the root (0) folder is selected. To assign a 
different folder, click change. If you do, a new screen 
appears. Navigate to and select the folder of your choice. 

Section Description
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Display Weekends
To display seven day weeks (for example, Sunday to Saturday), as 
opposed to five day weeks (Monday to Friday), check this box.
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Do Not Display Weekends

Editing a Calendar
All calendar information, with the exception of the ID, can be edited 
at any time. To edit a calendar, follow these steps.

1. From the Ektron CMS400.NET Workarea, click Modules > 
Calendar.

2. Click the calendar you want to edit. 

3. Click the Edit button ( ).

4. The Add or Edit Calendar screen is displayed.
5. Make the necessary changes to the calendar, using the table in 

”Adding a New Calendar” on page 553 as a reference.

6. Click the Save button ( ).
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Deleting a Calendar
You can delete calendars that are no longer needed.

NOTE Deleting a calendar deletes all events assigned to it.

To delete a calendar, follow these steps.

1. From the Ektron CMS400.NET Workarea, click Modules > 
Calendar.

2. Click the calendar you want to delete. 

3. Click the Delete button ( ).

4. A confirmation message is displayed.
5. Click OK.

Calendar Event Types
Any calendar event can have one or more Event Types assigned 
to it. An event type might be a meeting, product demonstration, or 
deadline. When a user views a calendar, he can change the 
display to view only events that are relevant to him.

This section explains how to manage calendar Event Types 
through the following subtopics.

• ”Enabling Event Types” on page 559

• ”Viewing Event Types” on page 560

• ”Adding Event Types” on page 560

• ”Editing the Event Type Name” on page 561

• ”Deleting Event Types” on page 561

• ”Assigning an Event Type to an Event” on page 562

Enabling Event Types
To enable event types, edit the calendar and check off the Event 
Types Available box. If desired, you can also check the Event 
Types Required box. This forces the user to specify an event type 
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when adding a calendar event. See Also: ”Adding a New Calendar” 
on page 553

Once event types are enabled, the Manage Event Types button 

( ) appears on the toolbar.

Viewing Event Types
To view available Event Types, follow these steps.

1. From the Ektron CMS400.NET Workarea, click Modules > 
Calendar.

2. Access the View Calendar screen for the calendar whose 
event types you want to view.

3. Click Event Types button ( ).

NOTE If the Event Types button does not appear in the toolbar, you must make Event 
Types available. See ”Enabling Event Types” on page 559 for more information.

4. The View Event Types for [Calendar Name] screen is displayed 
with a list of Event Types.

From this screen, you can add, edit, and delete Event Types.

Adding Event Types
1. Access the Event Types screen, as described in ”Viewing 

Event Types” on page 560.

2. Click the Add button ( ).
3. The Add or Edit an Event Type screen is displayed.
4. Type an Event Type name in the displayed field.

5. Click the Save button ( ).
After you add an Event Type to a calendar, it can be assigned to a 
calendar event by users. See ”Assigning an Event Type to an 
Event” on page 562 for more information.
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Editing the Event Type Name
To edit the name of an event type, follow these steps.

1. Access the View Event Types for [Calendar Name] for the 
calendar with the Event Type you want to edit, as described in 
”Viewing Event Types” on page 560.

2. Click the Event Types button ( ). 

3. The View Event Types for [Calendar Name] window opens, 
listing all Event Types.

4. Click the Edit button ( ).

5. The Edit an Event Type screen appears.
6. Click the radio button next to the Event Type you want to edit.

7. Click the Edit button ( ).

8. The Add or Edit an Event Type screen is displayed. Update the 
Event Type name.

9. Click the Save button ( ).

Deleting Event Types
To delete an event type from a calendar, follow these steps.

1. Access the View Event Types for [Calendar Name] for the 
calendar with the Event Type you want to delete, as described 
in ”Viewing Event Types” on page 560.

2. Click the Event Types button ( ).

3. The View Event Types for [Calendar Name] window opens, 
listing all Event Types.

4. Click the Remove button ( ).
5. The Delete Event Types screen displays available Event 

Types.
6. Check the box next to each Event Type you want to delete.
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NOTE Click either Select All or Clear All to check off all or none of the Event Types.

7. Click the Delete button ( ) to delete the Event Type.
8. A confirmation message is displayed.
9. Click OK.

Assigning an Event Type to an Event
After Event Types are available, users can assign them to calendar 
events. This is described in the Ektron CMS400.NET User Manual 
chapter “Working with Calendars.” 

After users assign Event Types to a calendar event, visitors can 
filter the calendar view by them.

Displaying Calendars on Web Pages
After a calendar is created, it can easily be inserted onto a Web 
page. For information about inserting calendars into your Web site, 
refer to the Ektron CMS400.NET Developers Reference Manual.

Creating a Foreign Language Calendar
As part of the comprehensive multi-language features of Ektron 
CMS400.NET, calendars can be created in any supported 
language.

Exception Microsoft’s .NET platform supports most languages. If a language is not 
supported by .NET (for example, Welsh), an English calendar appears instead.

Once you enter the calendar and event information in the foreign 
language, the calendar display (that is, day and month names) 
automatically appears in that language. Also, regional conventions 
for first-last days of the week, and date and time formats are 
maintained. As an example, see the French calendar below.
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Notice that the days and months are translated, and that the week 
begins on Monday instead of Sunday (as in American English). 

And in the daily detail (below), note that date and time format 
follows French conventions.

WARNING! In order to see foreign characters and accents, the client PC must have support 
enabled for that language in Windows. For more information, see http://
www.microsoft.com/globaldev/handson/user/2kintlsupp.mspx.

http://www.microsoft.com/globaldev/handson/user/2kintlsupp.mspx
http://www.microsoft.com/globaldev/handson/user/2kintlsupp.mspx
http://www.microsoft.com/globaldev/handson/user/2kintlsupp.mspx
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See Also: ”Using an Existing Calendar ID or Creating a New One” 
on page 564

Using an Existing Calendar ID or Creating a New One
When you create a calendar in a foreign language, you can either 
use an existing calendar ID or create a new one.

Type Use when... For more information, see

Foreign language 
version of existing 
calendar ID

You want one Web page that 
displays a calendar in the language 
selected by the site visitor

”Creating a Multilingual Calendar 
Using the Same ID” on page 566

New calendar ID The foreign calendar will be placed 
on its own Web page; there is no 
equivalent calendar in the default 
language

”Creating a Multilingual Calendar 
Using a New ID” on page 567
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For example, the following is the English-language version of the 
sample calendar provided with the intranet. The URL of the 
following calendar is

http://localhost/CMS400EXAMPLE/intranet/
calendar.aspx?menu_id=15&calendar_id=3&TitleLabel=Company%20Calendar&LangType=1033

If you create a French version of that calendar, and a user 
navigates to the same page but views it in French, he sees the 
French version of the calendar (below). Note that they are 
separate calendars with separate event listings -- they only share 
the ID number.
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The URL of the following calendar is

http://localhost/CMS400EXAMPLE/intranet/
calendar.aspx?menu_id=15&calendar_id=3&TitleLabel=Company%20Calendar&LangType=1036

Creating a Multilingual Calendar Using the Same ID

To create a multi-lingual calendar using the same ID number but a 
different language, follow these steps.

1. Within the Workarea, select Modules > Calendars.
2. Select the calendar for which you want to create a version in 

another language.
3. When the View Calendar Screen appears, pull down the Add 

In box and select the new language.
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4. Complete the calendar information, as explained in ”Adding a 
New Calendar” on page 553.

Creating a Multilingual Calendar Using a New ID

To create a multi-lingual calendar using a unique ID number, follow 
these steps.

1. Within the Workarea, select Modules > Calendars.
2. From the Calendar Modules screen, click to open the View In 

dropdown box.

3. Select the language for the calendar.
4. The Calendar Modules screen reappears, showing only 

calendars in the selected language (if any exist).
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Complete the calendar information, as explained in ”Adding a New 
Calendar” on page 553.
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URL Aliasing

Aliasing is an Ektron CMS400.NET feature that lets you change the 
name of your Web site’s pages. By default, Ektron CMS400.NET 
Web pages have the following format:

See Also: ”Forming URLs For Ektron CMS400.NET Documents” 
on page 76

Sometimes, you want to change a page’s name. The Aliasing 
feature offers two ways to do this:

• Ektron CMS400.NET can automatically change each page’s 
name to a format that search engines more easily recognize. 
This is called Automatic Aliasing.

• You can manually change the name of any page to whatever 
you wish. For example, you can change the name of your 
technical support page to http://www.example.com/help.htm from 
http://www.example.com/help.aspx?id=27. This is called Manual 
Aliasing.

NOTE When using Manual Aliasing, you cannot alias the root of your Web site (for 
example, www.example.com). You can, however, alias everything after that.

This chapter explains how to alias pages on your Web site through 
the following topics.

• ”Automatic vs. Manual URL Aliasing” on page 570

• ”Automatic URL Aliasing” on page 570

• ”Manual Aliasing” on page 573
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Automatic vs. Manual URL Aliasing
Automatic URL Aliasing allows you to create a URL that does not 
have a URL parameter. This URL aliases the URL that contains 
parameters found in a regular Ektron CMS400.NET URL, such as 
?id=43. With Automatic URL Aliasing, you can alias all content at 
once. For more information on Automatic URL Aliasing, see 
”Automatic URL Aliasing” on page 570.

Manual URL Aliasing lets you choose the URL and extension that 
you would like to use. With Manual URL Aliasing, you must assign 
an alias to each content item individually. You can also assign 
several aliases to any content item then pick one to be the primary 
alias. For more information on Manual URL Aliasing, see ”Manual 
Aliasing” on page 573.

Automatic URL Aliasing
People looking for information on your Web site typically use 
search engines (such as Google.com) to find pages with the 
desired content. On rare occasions, some older search engines 
work better without the URL parameters that make up an Ektron 
CMS400.NET Web page name.

If this becomes a problem, use the Automatic URL Aliasing 
feature, which creates a page name that search engines easily 
recognize. The new name includes the template and the page's ID 
values.

When you use the Automatic URL Aliasing feature, Ektron 
CMS400.NET makes the following changes.

• A delimiter of ekt indicates the start of each parameter

• URL parameters follow each delimiter

Here is an example of aliasing content.

Original URL

/400Intranet/mycalendars.aspx?id=2
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Aliased version

/400Intranet/mycalendars_ektid2.aspx

Enabling Automatic URL Aliasing
If you do not see a URL Aliasing option under Settings > 
Configuration, follow these steps to enable it.

NOTE Before editing your web.config file, you should close all open browsers. In some 
instances, you may need to do an IIS reset.

1. Open the web.config file, located in your Web site’s root folder.
2. Change the value of ek_RedirectorInstalled to True.
3. Enable the URL aliasing section of the httpHandlers element. 

To do so, uncomment the following tags by removing the 
dashes and the exclamation point (!) in red below.

<httpHandlers>
.
<!--add verb="*" path="*.asmx"
.
.
<add verb="*" path="*" type="URLRewrite.URLRewriter,Ektron.Cms.URLRewriter" /-->

The tags are separated by several lines that look like this:
<add verb="*" path="*.gif" type="URLRewrite.StaticFileHandler,Ektron.Cms.URLRewriter" />

4. Save web.config.

Activating/Deactivating the Aliasing Feature
To activate the automatic aliasing feature, follow this path to the 
URL Aliasing Configuration screen: Settings > Configuration > 
URL Aliasing.

NOTE If you do not see a URL Aliasing option under Configuration, see ”Enabling 
Automatic URL Aliasing” on page 571.

The screen indicates if automatic aliasing is currently on or off. To 
change its state, click the Edit button ( ), check or uncheck the 
box, and click the Save button ( ).
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If Automatic Aliasing is turned on and you uncheck it, your page 
URLs return to their original format (see ”Sample Quicklinks Folder 
with URL Aliasing Turned Off” on page 572).

Effect of Activating Automatic URL Aliasing
When you enable automatic URL aliasing, the feature updates 
every Quicklink in your Ektron CMS400.NET library to the new 
format. This may take a few moments.

Sample Quicklinks Folder with URL Aliasing Turned Off
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Sample Quicklinks Folder with URL Aliasing Turned On

The aliasing feature does not review Quicklinks embedded in your 
content -- these maintain their original format. When a user or site 
visitor is navigating through Ektron CMS400.NET, either format 
works.

Manual Aliasing
When using manual aliasing, you choose content then assign a 
different URL to it. From then on, the content can be identified 
either by its original URL (assigned automatically by Ektron 
CMS400.NET) or its alias.

When assigning an alias, choose the name you want users to see 
as your URL. In the example below, the page name changed from 
/cms400Sample/index.aspx to /cms400Sample/Launch.htm. Launch.htm is 
the alias.
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Before Manual URL Aliasing

After Manual URL Aliasing

This section explains manual aliasing through the following 
subtopics.

• ”Benefits of Manual URL Aliasing” on page 575

• ”Enabling Manual Aliasing” on page 575

• ”Activating/Deactivating Manual Aliasing” on page 584

• ”Permissions for Manual Aliasing” on page 585

• ”Adding a Base Reference to a Template” on page 586

• ”Assigning a Manual URL Alias” on page 586

• ”Editing a Manual URL Alias” on page 589
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• ”Removing a Manual URL Alias” on page 590

Benefits of Manual URL Aliasing
Manual URL Aliasing lets you completely alias a static or dynamic 
site. Benefits include:

• You can make your site more user-friendly by creating “human 
readable” URLs (for example, /ourcompany.html is readable, 
while company.aspx?id=1 is not).

• If you have a PHP site, you can alias all php pages and use the 
same Query String names to pass the needed info to the new 
ASPX pages.

NOTE Any query strings appended to an aliased page pass to the ASPX page and may 
be used if necessary.

• If you have a static Web site (for example, all HTML pages) 
that is indexed in a search engine, you can alias your whole 
site and gain complete content management without affecting 
your search engine ranking.

• You can increase your search engine rankings by naming 
pages according to the context of a specific search term.

Enabling Manual Aliasing
If you do not see a URL Aliasing option under Settings > 
Configuration, follow these steps to enable it. First, update the 
web.config file. Next, update IIS Application Mappings.

Updating the Web.config File

1. Close all open browsers. In some instances, you may need to 
do an IIS reset.

2. Open the web.config file, located in your Web site’s root folder.
3. Change the value of ek_RedirectorInstalled to True.

NOTE You only need to perform step 4 if you want add content with an extension other 
than those already registered, such as .aspx. The App Mappings tab on the 
Application Configuration screen (illustrated below) indicates which extensions 
are registered on your server. 
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4. After ek_RedirectorManualExt, enter a comma-delimited list of 
Web page extensions for which you will want to create aliased 
pages. For example, .aspx,.htm,.html,. By default, .aspx is in 
the list.
You can enter one or more extensions. Each extension must 
begin with a period, and separated from other extensions by a 
comma. 

IMPORTANT! Make sure you do not put spaces in between the extensions.

5. Enable the httpHandlers section of Web.config. To do so, 
uncomment the following tags by removing dashes and the 
exclamation point (!):
To uncomment the opening tag, remove the characters in red 
below:

<!--add verb="*" path="*.asmx" 
type="System.Web.Services.Protocols.WebServiceHandlerFactory,System.Web.Services, 
Version=1.0.5000.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a" validate="false"/>

To uncomment the closing tag, remove the characters in red 
below:

<add verb="*" path="*" type="URLRewrite.URLRewriter,Ektron.Cms.URLRewriter" /-->
</httpHandlers>

6. If you want to use .htm as a file extension with your Web site, 
comment out the following line by adding the red characters 
below.

<!--add verb="*" path="*/*.htm" type="URLRewrite.StaticFileHandler,Ektron.Cms.URLRewriter"/-->

7. Add the following line below the one shown above.
<add verb="*" path="*.htm" type="URLRewrite.URLRewriter,Ektron.Cms.URLRewriter" />

8. Add a similar line for each file type you want to enable. For 
example:

<add verb="*" path="*.html" type="URLRewrite.URLRewriter,Ektron.Cms.URLRewriter" />
<add verb="*" path="*.aspx" type="URLRewrite.URLRewriter,Ektron.Cms.URLRewriter" />

9. For each folder path containing non-HTML content, add the 
pathway to it relative to the site root:

<add verb="*" path="*/FOLDERPATH/
.*" type="URLRewrite.StaticFileHandler,Ektron.Cms.URLRewriter"/>

For example, for the CMS400Min site, add this:

<add verb="*" path="*/privateassets/
.*" type="URLRewrite.StaticFileHandler,Ektron.Cms.URLRewriter" />

10. Save web.config.



URL Aliasing

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 577

NOTE If you are using .aspx pages, you do not need to install the ISAPI filter. The 
following steps do not need to be performed.

Updating IIS Application Mappings for Windows 2000 and XP

See Also: ”Updating IIS Application Mappings for Windows 2003 
Server” on page 581

1. Open IIS, go to the Web site, and right-click Properties.

IMPORTANT! You must click the actual site, not Default Web Site.

2. Click the Directory tab.
3. Click the Configuration button.
4. On the Mappings tab, click Add.
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5. The Add/Edit Application Extension Mapping dialog appears.
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NOTE The dialog should look like the sample above when you finish.

6. In the Executable field, browse to the .NET Framework 
aspnet_isapi.dll file (illustrated below).

NOTE Use the latest version of the asp.net_isapi.dll. The default location is 
c:\windows\Microsoft.NET\Framework\latestversion\aspnet_isapi.dll.
In the path, latestversion refers to the folder containing the latest version of the 
.NET framework.

WARNING! IIS sometimes abbreviates the path in the Executable field, causing the OK 
button to be grayed out. If the text box does not contain the full path, IIS cannot 
validate it. To remedy this, click in the Executable field. The full path appears, and 
the OK button is active.
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.

NOTE When browsing to the aspnet_isapi.dll folder, you may need to change the Files 
of Type dropdown to .dll or all files. It is set to .exe by default.

7. In the Extension field, enter characters to allow all extensions.

8. Under Verbs, check Limit to. Then, enter GET, HEAD, POST, 
DEBUG.

9. Uncheck Check (or Verify) that file exists.

Server Platform Your entry in the Extension field

Windows 2000 *.*

Windows XP .*
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Important! Don’t skip step 9!

10. Click OK.

Updating IIS Application Mappings for Windows 2003 Server

See Also: ”Updating IIS Application Mappings for Windows 2000 
and XP” on page 577

1. Open IIS, go to the Web site, and right click Properties.
2. Click the Home Directory tab.
3. Click the Configuration button.
4. On the Mappings tab, click Insert.

5. The Application Extension Mapping dialog appears (see 
above).
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6. In the Executable field, click Browse to navigate to the .NET 
Framework aspnet_isapi.dll file (illustrated below).

NOTE Use the latest version of the asp.net_isapi.dll. The default location is 
c:\windows\Microsoft.NET\Framework\latestversion\aspnet_isapi.dll.
In the path, latestversion refers to the v2.0.50727 folder or the folder that 
contains the latest version.

WARNING! IIS sometimes abbreviates the path in the Executable field, causing the OK 
button to be grayed out. If the text box does not contain the full path, IIS cannot 
validate it. To remedy this, click in the Executable field. The full path appears, and 
the OK button is active.

.

NOTE When browsing to the aspnet_isapi.dll folder, you may need to change the Files 
of Type dropdown to .dll or all files.

7. Make sure Verify that file exists is not checked.
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8. Click OK.
9. In IIS, underneath your Web site, click Asset Management > 

dmdata.
10. Right click dmdata and choose Properties.
11. Click the Virtual Directory tab.
12. Click the Configuration button.
13. In the Wildcard Application Maps area, if aspnet_isapi.dll if 

appears, remove it.
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14. Click OK.

Activating/Deactivating Manual Aliasing
To activate the aliasing feature, follow this path to the URL Aliasing 
Configuration screen: Settings > Configuration > URL Aliasing.

NOTE If you do not see a URL Aliasing option under Configuration, see ”Enabling 
Manual Aliasing” on page 575.

The screen indicates if Manual Aliasing is currently on or off. To 
change its state, click the Edit button ( ), check or uncheck the 
box, and click the Save button.
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If Aliasing is turned on and you uncheck it, your page URLs return 
to their original format (see ”Sample Quicklinks Folder with URL 
Aliasing Turned Off” on page 572).

Permissions for Manual Aliasing
To give users or groups permission to assign a manual alias to 
content, follow these steps.

1. In the Ektron CMS400.NET Workarea, select Settings > 
Roles.

2. Select Built-In > System-Wide > Alias-Edit.
3. The Manage Members for Role: Alias-Edit screen appears.

4. Click the Add button ( ).

5. Click the check box next to all users and user groups that have 
permission to manually alias content.

6. Click the Save button ( ).
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See Also: ”Defining Roles” on page 735

Adding a Base Reference to a Template
When aliasing a Web page, you must add a reference to the base 
URL into the <Head> section of the template. Otherwise, any relative 
links on the page use the alias as the base URL.

For example, you have the file winners.gif on a Web page. The 
page’s URL is http://www.example.com/baseball/team.aspx?id=37. The 
alias for this page is http://www.example.com/2004/worldchamps.aspx. 
When the page tries to find winners.gif, it looks in the /2004/ 
directory. The page should look in the /baseball/ directory, 
because that is where the file is located.

Here is the syntax used in the <Head>.

<BASE HREF=”baseURL”
TARGET=”WindowName”>

Here is an example:

<HEAD>

<BASE HREF=”http://www.example.com/baseball/”>

<HEAD>

Assigning a Manual URL Alias
There are two ways to manually assign an alias.

• Use the Page Name Maintenance screen. This method is for 
administrators only.

• Use the Alias tab in View Content area of the content. This 
method can be used by content editors or administrators.
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Each method is explained below.

Adding a Manual Alias via the Page Name Maintenance Screen

NOTE Make sure you have enabled URL Aliasing and given the administrator’s group 
permissions for aliasing. See ”Enabling Manual Aliasing” on page 575 and 
”Viewing the Users in a User Group” on page 672.

1. Go to Workarea > Settings > Configuration > URL Aliasing.

2. Click the Page Name Maintenance button ( ).

3. The Page Name Maintenance screen appears.

The following explains the columns on the screen.

Field Description

Alias The URL as it appears aliased.

Actual The actual URL before aliasing.

Content Title The title of the content.

Status The status of the content.

ID The content’s ID number.

Lang ID The language code for the content. See Also:  
”Appendix C: List of Supported Languages” on 
page 1015

Primary The alias a content editor sees when editing an alias via 
the Alias tab. See Also: ”Adding a Manual URL Alias via 
the Alias Tab” on page 589

 = Primary Alias for that URL
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4. Click the Add Alias button ( ). The Add a New Alias screen 
appears.

5. In the Alias Name field, choose the name you want to use for 
an alias.

6. Click Select a Content Block to choose content.
7. The QuickLink Select window appears.
8. Choose content.
9. Check the Primary box if you want to make this the primary 

alias, that is, the alias a content editor sees when editing an 
alias via the Alias tab.

10. Choose a Quicklink option.

• Overwrite Existing Quicklink overwrites the existing 
Quicklink for the content.

WARNING! When you choose to overwrite an existing Quicklink, you permanently delete it. 
There is no way to revert back to the old Quicklink. If you want to use the old 
Quicklink again, you need to add a new one. For more information on creating 
Quicklinks, see Ektron CMS400.NET User Manual > “Library Folder” 
>”Quicklinks”.

• Do not add Quicklink does not create a Quicklink for this 
alias.

11. Click the Save button ( ).
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Adding a Manual URL Alias via the Alias Tab

NOTE Make sure you have enabled URL Aliasing and given the administrator’s group 
permissions for aliasing. For information on Enabling URL Aliasing, see ”Enabling 
Manual Aliasing” on page 575. For information on User Group Permissions, see 
”Viewing the Users in a User Group” on page 672.

On the Alias tab, Alias Name has the message, [Not Defined]. 
There are two reasons this message appears:

• No alias is defined

• An alias is defined in Page Name Maintenance, but it is not set 
to be a primary alias

1. In the Workarea, select Content.
2. Navigate to and click the content you want to work with.

3. Click the Edit button ( ).The Edit Content screen appears.
.

4. Click the Alias tab.
5. In the Alias Name field, enter the name you want to use for an 

alias.
6. Save and publish the content.

NOTE An alias goes live only after content is published.

Editing a Manual URL Alias
You can edit an alias by going to the Page Name Maintenance 
screen. This lets you change the alias name and Quicklink 
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properties. You can also change the primary alias if you have more 
than one for a content item.

To edit a Manual URL Alias, follow these steps.

1. Go to Workarea > Settings > Configuration > URL Aliasing.

2. Click the Page Name Maintenance button ( ).

3. On Page Name Maintenance screen, click the link you want to 
edit.

4. The Edit Alias screen appears.

NOTE When editing an Alias, you can only change the Alias Name and Primary fields.

5. Make any changes. To learn about the fields, see ”Adding a 
Manual Alias via the Page Name Maintenance Screen” on 
page 587.

6. Click the Save button ( ).

Removing a Manual URL Alias
To remove a Manual URL Alias, follow these steps.

1. Go to Workarea > Settings > Configuration > URL Aliasing.

2. Click the Page Name Maintenance button ( ).

3. On Page Name Maintenance screen, click the Remove button 
( ). 
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4. Check the boxes of the aliases you would like to remove.

5. Click the Delete button ( ).
6. Click OK to confirm.
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Business Rules

Business Rules allow you to define conditions for Web pages on 
your site. You choose an action based on whether the conditions 
are true or false when a site visitor browses your site. For example:

• Condition - a site visitor visits your site for the first time

• Action - add a cookie to the site visitor’s system and pop up a 
welcome message

With Business Rules, you do not write code to set conditions and 
initiate actions. You simply complete the information requested in 
the Business Rules wizard, have your developer add a Business 
Rules server control to your Web form, and assign the server 
control the Business Rules Ruleset.

NOTE For Information on the Business Rules server control, see the Developer Manual 
Section “Introduction to Server Controls” > “Business Rules Server Control”.

Business Rules start out with a Ruleset that is assigned an ID. 
Each Ruleset is made up of one or more rules. Rules are made up 
of conditions and actions. There are several predefined conditions 
and actions for rules in CMS400.NET. 

Conditions include:

• Cookie Parameter = value

• Form Parameter = value

• QueryString Parameter = value

• Server Variable = value

• Custom Parameter = value

Actions include:

• Displaying a calendar

• Displaying a message

• Opening a URL in a new window
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• Popping up a message

• Redirecting to a new URL

• Setting a cookie value

• Displaying a content block.

Once a rule is defined, you can add it to multiple Rulesets. This is 
useful if you have several groups of rules that use a common rule.

Business Rules are more fully explained through the following 
topics.

• ”Selecting a Rule” on page 593

• ”Creating a New Business Rule Ruleset” on page 594

• ”Working with Rulesets” on page 595

Selecting a Rule
There are two ways to select a rule. The first, check boxes, allows 
you to select a rule by clicking the check box. This method is used 
when turning a rule on or off in the Ruleset. Checked, the rule is 
active. Unchecked the rule is inactive.

The second, highlighting a rule, is used to when you want to work 
with the rule. For example, you want to add or remove a rule from a 
Ruleset. To highlight a rule, click its title. Once a rule is highlighted, 
it is ready for an action, such as Remove or Edit.
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Creating a New Business Rule Ruleset
NOTE Only members of the Administrators group or those defined in Manage Members 

for Role: Rule Editor screen can create or edit Business Rules and Rulesets. See 
Also: ”Defining Roles” on page 735

You create Business Rules Rulesets from the Business Ruleset 
screen in the Workarea.

The Business Ruleset screen contains these columns:

• ID - the numerical ID assigned to the Ruleset.

• Name - a unique name you give to the Ruleset to help you 
understand what the Ruleset does.

To add a new Ruleset, follow these steps:

1. In the Workarea, click Modules > Business Rules.

2. Click the Add New Ruleset button ( ).

3. The Add New Ruleset screen appears.

4. In the Name: text box, add a name for the rule.

5. Click the Save button ( ).
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6. The View Ruleset screen appears.
At this point, you can continue on to ”Add a New Rule to a Ruleset” 
on page 598 or ”Add an Existing Rule to a Ruleset” on page 602 to 

add a rule or click the Back button ( ) and return to add a rule 
later.

Working with Rulesets
After creating a Ruleset, you typically add rules to it via the View 
Ruleset screen. 

The View Ruleset screen is the launch pad for working with 
existing Rulesets. From this screen you can:

• ”Edit a Ruleset” on page 596

• ”Remove a Rule From a Ruleset” on page 596

• ”Change the Order of Rules in the Ruleset” on page 597

• ”Delete a Ruleset” on page 598

• ”Add a New Rule to a Ruleset” on page 598

• ”Add an Existing Rule to a Ruleset” on page 602

• ”Edit a Rule in a Ruleset” on page 604

• ”Viewing a Rule in a Ruleset” on page 604
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Edit a Ruleset
You can initiate editing a Ruleset from two different locations, the 
Web page or the Workarea. To edit a Ruleset from the Web page, 
navigate to a Business Rule on a Web page while logged in. Then, 
right click the Business Rule icon and click Edit. 

If editing from the Workarea, click Modules > Business Rules and 
then click the Ruleset to edit. Next, click Action > Edit Ruleset.

The Edit Ruleset screen appears.

Remove a Rule From a Ruleset

Follow these steps to remove a rule from the Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in ”Edit a 
Ruleset” on page 596.
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2. Highlight the rule you want to remove.

WARNING! The check box associated with the rule must be empty for you to remove the rule. 
If the check box is not empty, the rule will look as though it has been removed 

3. Click the Remove Rule button ( ).
4. A pop up appears letting you know that the rule will be removed 

from this Ruleset only.

5. Click OK.
6. The rule is removed from the Edit Ruleset screen.

7. Click the Save button ( ).

Change the Order of Rules in the Ruleset

The order of rules in a Ruleset affects how rules are applied when 
a site visitor views a page. For example, you want to display a 
welcome message before a content item. To accomplish this, move 
the rule for the welcome message above the rule for a content 
item.

Follow these steps to change the order of the rules in a Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in ”Edit a 
Ruleset” on page 596.

2. Highlight the rule you want to reorder.

3. Click the Move Up or Move Down buttons ( ) ( ) to move 
the rule up or down the list.

4. Click the Save button ( ).
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Delete a Ruleset

When you delete a Ruleset, it is removed from the system 
permanently. However, rules included in a Ruleset are not deleted. 
This is because a rule can be used in multiple Rulesets.

Follow these steps to delete a Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in ”Edit a 
Ruleset” on page 596.

2. Click the Delete Ruleset button ( ).
3. A dialog asks you to confirm the deletion.

4. Click OK.

Add a New Rule to a Ruleset
Adding a new rule is easy with Ektron CMS400.NET. Just click the 
Add button on the View Ruleset screen. The Rules Wizard 
launches and helps you define a rule.

Follow these steps to add a new rule to your Ruleset.

1. If you arrived here from the ”Creating a New Business Rule 
Ruleset” on page 594 section, continue to the next step.
Otherwise, navigate to the Business Rules screen in the 
Workarea by clicking Modules > Business Rules. Next, click 
the Business Rule for which you want to create a new rule.

2. Click New > Add New.
3. The Rules Wizard launches.
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4. Step 1 prompts you to create conditions for the rule and decide 
whether a site visitor needs to match Any or All conditions. 
Clicking the param and value links opens a dialog to enter 
information.

Place a check next to any condition you want to use. Use the 
table below to help you fill out the param and value fields.
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Conditions Table

Condition Description Example

The Cookie param 
equals value

Use a cookie for this condition.
param - enter Name in this field.
value - enter the name of the cookie in 
this field.

Does the site visitor's system have an 
Ektron cookie?
Usage:
The Cookie param “Name” equals 
value “Ektron”

The Form param 
equals value

Use a form elements field name and 
match the value entered into the element.
param - enter a form’s element Field 
Name from a form.
value - enter the value you want the form 
element to match.

A form has a Choices Field element 
with the Field Name “Favorite_Food” 
and choices of Pizza, Steak and 
Chicken. When a site visitor chooses 
Pizza and clicks submit, your rule 
launches a Pizza company’s Web 
site.
Usage:
The Form param “Favorite_Food” 
equals value “Pizza”

The QueryString 
param equals value

Use the QueryString for this condition
param - the name of the QueryString. For 
example, ID.
value - the value associated with the 
parameter. For example, 18.

Is content with the ID of 18 being 
displayed?
Usage:
The QueryString param “ID” equals 
value “18”

The Server Variable 
param equals value

Use server variables from the site visitor.
param - enter the name of a server 
variable. For example, HTTPS.
value - the value associated with the 
parameter. For example, On.

Is the site visitor’s browser using 
SSL? 
Usage:
The Server Variable param “HTTPS” 
equals value “On”

A list of server variables and their descriptions can be found at http://msdn.microsoft.com/library/
default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp.

The Custom param 
equals value

Use custom parameters from the user. 
User parameters are defined in the 
codebehind of a web page.
param - enter the name of a custom 
parameter. For example, AcctBlnc
value - the value associated with the 
parameter. For example, 1000

Is the user's account balance $1000?
Usage:
The Custom param “AcctBlnc” equals 
value “1000”

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp
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5. Click Next.
Step 2 of the Wizard prompts you select an action to take if 
conditions are true. Check the boxes for the actions to take. Click 
the blue links to add the appropriate information.

Conditions Table

Action Description

Display Calendar ID Enter a CMS400.NET Calendar ID. 

Display a Message Enter a message to be displayed.

Open URL Enter a URL. This opens a new window with the URL.

Popup A Message Enter a message that appears in a popup dialog box.

Redirect to a URL Enter a URL to redirect a the site visitor’s browser.

Set Cookie to Value Creates a cookie on the site visitor’s system. Enter 
Name for Cookie and the name of the cookie for Value.
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6. Click Next.
7. Step 3 of the Wizard lets you select actions to take when 

conditions are false. This works the same as Step 2 of the 
Rules Wizard. For descriptions of the actions, see ”Conditions 
Table” on page 600.

8. Click Next.
9. Step 4 of the Wizard asks you to enter a name for the rule in 

the text box.
10. Click Done.
11. The View Ruleset screen appears. Your rule appears in the 

Ruleset box.

Add an Existing Rule to a Ruleset
Because rules are not tied to a Ruleset once they are created, you 
can add a rule to more than one Ruleset. To add an existing rule to 
a Ruleset, follow these steps:

1. If you arrived here from the ”Creating a New Business Rule 
Ruleset” on page 594 section, continue to the next step.
Otherwise:

Display Content Block ID Enter a CMS400.NET content block’s ID.

Action Description
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Navigate to the Business Rules screen in the Workarea by 
clicking Modules > Business Rules. Next, click the name of 
the Business Rule for which you want to add an existing rule.

2. Click New > Add Existing.
3. The Add an Existing Rule screen appears.

4. Check the rules to add to the Ruleset.
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5. Click the Save button ( ).

Edit a Rule in a Ruleset
Following these steps to edit a rule in a Ruleset.

1. In the Workarea, navigate to Modules > Business Rules.
2. Select the Ruleset that contains the rule to be changed.
3. Highlight the rule to be changed.

4. Click Action > Edit Rule.
5. The Rules Wizard appears with the rule loaded. Edit as 

necessary. The Rules Wizard is explained in ”Add a New Rule 
to a Ruleset” on page 598.

Viewing a Rule in a Ruleset
To help you understand the contents of a rule, a (View) link 
appears next to each rule in a Ruleset. Click this link to launch a 
view window for the rule. This window displays settings for each 
Rules Wizard step applied to a rule.

NOTE The steps are not editable from this window. To edit rules in a Ruleset, see ”Edit a 
Rule in a Ruleset” on page 604.
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To navigate through the steps, use the Previous and Next Step 
buttons ( ). To close the window, click the Close button ( ).

Permission to Work with Business Rules
Only members of the Administrators user group and those defined 
in the Manage Members for Role: Add Role Member Business 
Rule Editor screen can work with Business Rules. See Also: 
”Defining Roles” on page 735
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Web Site Navigation Aids

Collections

Ektron CMS400.NET’s Collection feature lets users create a list 
of content that can be placed on a Web page to offer readers 
links to them. In the following illustration, the circled content is 
an example of a collection on a Web page.

Collections can also be used to display listings such as job 
postings, press releases, and Knowledge Base articles. The 
following graphic illustrates the use of a collection on the 
landing page of Ektron’s Knowledge Base.
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This section only describes managing permissions to use the 
Collections feature. For more information about the Collections 
feature, see the Ektron CMS400.NET User Manual section “Working 
with Collections.” See Also: 

• ”Collection Permissions” on page 607

• ”Setting up Approval for Collections” on page 610

Collection Permissions
Any of the following users have permission to create or edit a 
collection.

• a member of the Administrators group

• a user who has been assigned the Collection and Menu Admin 
role. See Also: ”Defining Roles” on page 735

• a user who has been granted collection permission for the 
collection’s folder. Permission is granted on the folder 
Permission screen (see graphic below). See Also: ”Setting 
Permissions” on page 716
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How a Folder is Assigned to a Collection
If you create a collection by going to the Workarea’s Modules tab, 
it is assigned to the root folder.

If you create a collection by going to a folder then selecting New > 
Collection, it is assigned to that folder.
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A collection’s folder appears on the Modules > Collections > 
Collection Report screen, in the Path column. No value there 
indicates root folder.
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Setting up Approval for Collections
If desired, you can set up an approval system for any collection. As 
with a content approval chain, you specify users who must approve 
changes to a collection before it can be published.

Any collection approver can either approve or decline the modified 
collection. And, if a user who is not an approver tries to delete a 
collection, that action also requires approval.

See Also: 

• ”Differences Between Content and Collection Approval 
Systems” on page 610

• ”Creating a Collection that Requires Approval” on page 610

• ”Which Users Can Approve Collections” on page 611

• ”What Happens When an non-Approver Submits Changes to a 
Collection” on page 611

• ”How Approvals Affect Deleting a Collection” on page 612

Differences Between Content and Collection Approval 
Systems

• While content can have a chain of approvers, a collection has a 
list of approvers. Any collection approver can publish or decline 
changes. There is no concept of a “chain” of approvers.

• While content approval is folder-specific, collection approval is 
not. Once set up, collection approval affects the collection to 
which it was assigned, regardless of its folder.

Creating a Collection that Requires Approval
Only administrators or users to whom the folder-admin role has 
been assigned see the Approval is Required checkbox on the 
Add and Edit Collection screens. See Also: ”Defining Roles” on 
page 735
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When the collection is created, its status is set to checked out. This 
allows you to add items to it. When ready, you can publish it.

Which Users Can Approve Collections
If you require a collection to be approved, only the following users 
have permission to create or edit a collection and can approve a 
change to a collection.

• a member of the Administrators group

• users to whom the Collection Approver role has been assigned 
and who have permission to work with the collection

• users to whom the Folder User Admin role has been assigned 
and who have permission to work with the collection

See Also: ”Defining Roles” on page 735

What Happens When an non-Approver Submits Changes to a 
Collection

A user who has permission to edit collections but not approve 
changes sees the following buttons.
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After making the change, the user clicks the submit button ( ). 
This action triggers an email notification to all approval users for 
the collection. It also changes the collection’s status to checked 
out. No other users can edit it in this status.

Next, one of the approval users must open the Edit Collection 
screen and click the Publish or Decline button. If he clicks Publish 
( ), the new version of the collection is published to your Web 
site. If Decline ( ), the user who submitted the changes is 
notified by email but no changes are made to your Web site.

If the user who made the changes realizes he made a mistake, he 
can go to the screen and click the Undo Checkout button at any 
time before the approval. In this case, his submitted changes are 
deleted, and the collection reverts to its original state.

In fact, any user with permission to edit a collection can perform 
the undo function until the content is approved.

How Approvals Affect Deleting a Collection
To delete a collection, a user who has permission to work with 
collections but not approve changes clicks the Delete button ( ) 
from the View Collection screen. This action changes the 
collection’s status to Marked for Deletion (M) and triggers an email 
notification to all approval users for the collection. One of the 
approval users must open the Edit Collection screen and click the 
Delete or Decline button.
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If the approval user clicks Delete ( ), the collection is removed 
from your Web site. If the approval user clicks Decline ( ), the 
user who submitted the deletion is notified by email but no 
changes are made to your Web site.
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Personalization Feature

Ektron CMS400.NET’s Personalization feature can be used in a 
couple of different ways. It allows

• a signed-in (typically membership) user to determine a page’s 
layout and content. This user can personalize the page, 
displaying whatever interests him in an arrangement of his own 
design.

• an Ektron CMS400.NET administrator to build a page’s content 
without Visual Studio.Net

IMPORTANT! The Personalization feature requires Internet Explorer 5 or higher. You cannot use 
other browsers.

Most personalization features are described in the Ektron 
CMS400.NET User Manual section “Personalizing Your Web Page.” 
Also, the Ektron CMS400.NET Developer Manual describes how to 
create a template that supports personalization. This section only 
describes permissions that affect someone’s ability to personalize 
a page. So, Ektron recommends familiarizing yourself with those 
sections before reading this section.

Sample Pages
When using the sample site provided by Ektron, the Web page 
http://localhost/your site root/mypage.aspx gives users basic 
access to the Personalization feature. For example, they can edit, 
move, and add new content by selecting from a few folders.

Ektron also provides a more advanced page, http://localhost/your 
site root/mypageadvance.aspx, that lets users add content by 
selecting a content type then navigating through the CMS to find 
items of that type. The advanced page also provides an example of 
how to use the page catalog.
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Permissions that Affect Personalization
A CMS user who is a member of the Administrators groups has full 
privileges to do everything. Other users, both CMS and 
membership, can be selectively granted permissions via 
Personalization roles screens. One screen grants all permissions, 
while the others grant a single permission.

To assign a role to a user, go to Workarea > Settings > Roles > 
Built-In > System Wide > Personalization. Choose any screen 
under that folder, click the Add button ( ) and select user(s) to 
whom assign the role. See Also: ”Defining Roles” on page 735

The following table explains the permissions granted by each role.

The right column indicates the ability to customize a page for all 
unauthenticated site visitors. However, if a membership or CMS 
user signs in and views a page that he has personalized, his 
version of the page appears.

Personalization 
Role

Description Add 
content

Edit 
content

Move 
content

Change 
page for 
unauthenti-
cated users

Admin Can do everything 
(Administrators group 
members also have 
these permissions)

Add Web parts Add new content to 
page; new selections 
controlled by 
developer who creates 
template

Edit Web parts Replace current 
content with other 
content of same type; 
cannot change type

Move Web parts Move content among 
Web part zones
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NOTE If you assign the Edit Web part role to a user or group, those users have access to 
all content in your Ektron CMS400.NET  Web site (except private content). 
Folder permissions are ignored.

Web Configuration Tags that Affect Personalization
The following tags in the web.config file (located in your site root 
folder) affect some aspects of how Personalization works.

IMPORTANT! When using the Personalization feature, the web config file’s authentication 
mode tag must be set to Forms.

<webParts>
<personalization defaultProvider="EktronPersonalizationProvider">

<providers>
<add connectionStringName="Ektron.DbConnection" name="EktronPersonalizationProvider"                                            

type="Ektron.Cms.EktronPersonalizationProvider" />
</providers>
<authorization>

<allow users="*" verbs="enterSharedScope"/>
<allow users="*" verbs="modifyState"/>

</authorization>
</personalization>

</webParts>

Tag or Attribute Description

webparts Overall tag that surrounds other personalization tags.

personalization Tags that surround personalization section of web.config.

defaultprovider If EktronPersonalizationProvider appears, Ektron’s personalization 
controls are used instead of Microsoft’s.

providers Tag that surrounds provider information.

add 
connectionStringName

Tells the .NET control to use the database being used by Ektron 
CMS400.NET .

name Tells the .NET control to use Ektron CMS400.NET  personalization feature 
instead of the .NET personalization controls.

type Tells the .NET control to use Ektron CMS400.NET  personalization feature 
instead of the .NET personalization controls.
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authorization Tag that surrounds the <allow users> tags.

allow users, enter 
SharedScope and 
modifyState

Tells Microsoft .NET to let users authorized by the Ektron CMS400.NET  
control the personalization features.

Tag or Attribute Description
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Menu Feature

Ektron CMS400.NET’s Menu feature lets users create and maintain 
a dropdown menu navigation system for your Web site. Like 
Collections, the Menu feature gives you the flexibility to display 
links to content, library assets, external hyperlink and submenus.

This section only describes managing permissions to use the 
Menus Feature, suggestions for implementing it, and how folder 
associations work.For more information about using the Menus 
feature, see the Ektron CMS400.NET User Manual section “Working 
with Menus.”

See Also: 

• ”Permission to Use the Menus Feature” on page 618

• ”Implementation of the Menus Feature” on page 620

• ”Working with Menus” on page 446.

Permission to Use the Menus Feature
There are two ways to create a menu. Each has its own permission 
model.
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Menu Creation 
Method

Illustration How to set permissions

Via the Workarea’s 
Modules tab

The user must be one of the following.

• a member of the Administrators user 
group

• assigned the Collection and Menu 
Admin role. See Also: ”Defining 
Roles” on page 735

• granted permissions to Collections 
for the root folder. This is advanced 
permission. See Also: ”Setting Per-
missions through the Permissions 
Table” on page 716

Via the View Contents 
of Folder screen’s New 
> Menu option

See ”Permissions for Menus Created 
from the View Contents of Folder Screen” 
on page 620
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Permissions for Menus Created from the View Contents of 
Folder Screen

Only users with permission to use the Collections feature 
(illustrated below) for a folder can work with menus. If user does 
not have permission to Collections, the Menu option does not 
appear on the New menu.

Also, if a user has permission to Collections but Read Only 
permission for content and the library, he cannot add content from 
a navigation link.

Implementation of the Menus Feature
In order for a menu to appear on your Web site, your Web 
developer must modify a page template to display it. This 
procedure is described in the Ektron CMS400.NET Developer 
Manual sections “Ektron CMS400.NET Server Controls” > “List of 
Server Controls” > “Menu Server Control”, “Smart Menu Server 
Control”, and “DhtmlMenu Server Control.”

See Also: 

• ”Assigning Folders or Templates to a Menu” on page 621

• ”Effect of Assigning a Folder to a Menu” on page 622

• ”Effect of Assigning a Template to a Menu” on page 624
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Assigning Folders or Templates to a Menu
The Advanced Settings on the Edit Menu screen has Folder 
Associations and Template Associations sections (see image 
below). Any folders or templates currently assigned to the menu 
appear. You can use this section of the screen to add new 
templates/ folders or remove existing ones.

For more information, see

• ”Effect of Assigning a Folder to a Menu” on page 622
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• ”Effect of Assigning a Template to a Menu” on page 624

Effect of Assigning a Folder to a Menu
If

• you assign a folder to a menu
and 

• a user navigates to any content item that resides in the folder
and

• a Smart Menu whose EnableSmartOpen property is true appears 
on the screen

the Smart Menu automatically displays the items on the associated 
submenu.

NOTE Navigation to the content item can consist of clicking a quicklink, a menu option, a 
list summary item, the result of a search, etc.

In effect, you are instructing Ektron CMS400.NET to expose a menu 
whenever a content item that resides in one or more selected 
folders appears on the screen. As a result, a user who begins 
looking for a specific content item sees similar items on the screen.

As an example, assume your Web site sells books, and your 
folders are organized by genre. One of your folders is “Teen 
Fiction.” You create a submenu that contains the top five sellers in 
“Teen Fiction.” You then associate the Teen Fiction folder with that 
submenu.

If a site visitor uses the site search to find any book in that 
category, and proceeds to a page describing the book, the Smart 
Menu in the page’s left column displays the five top Teen Fiction 
titles.

Using the Select Folder Screen
The Select Folder screen lets you assign new folders to the menu, 
reorder the folders, and delete folders from the menu association. 
These tasks are described below.
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When you click Change below Folder Associations on the Edit 
menu screen, the Select Folder screen appears (see image 
below). 

The following table describes tasks you can perform on this 
screen.

Task Instructions

Add folder to list 1. In the top of the screen, navigate to the folder you want to 
add.

2. Click the Add button ( ).

Remove folder from list 1. Click check box to the left of the folder.

2. Click the Delete button ( ).

Remove all folders from list 1. Click check box to the left of Folder.

2. Click the Delete button ( ).
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Effect of Assigning a Template to a Menu
If

• you assign a template to a menu
and 

• a user navigates to any content item that uses the template
and

• a Smart Menu whose EnableSmartOpen property is true appears 
on the screen

the Smart Menu automatically displays the items on the associated 
submenu.

NOTE Navigation to the content item can consist of clicking a quicklink, a menu option, a 
list summary item, the result of a search, etc.

In effect, you are instructing Ektron CMS400.NET to expose a menu 
whenever a content item that uses one or more selected templates 
appears on the screen. As a result, a user who begins looking for a 
specific content item sees similar items on the screen.

As an example, assume your Web site sells books, and your 
templates are organized by genre. One of your templates is “Teen 
Fiction.” You create a submenu that contains the top five sellers in 
“Teen Fiction.” You then associate the Teen Fiction template with 
that submenu.

Move a folder up or down on the list

Note: The sequence in which folders 
appear has no impact on how they are 
used. It merely affects the appearance of 
the folders on the Select Folders screen.

1. Click check box to the left of the folder.

2. Click the up or down arrow buttons ( ).

Save changes and return to Edit Menu 
screen Click the Save button ( ).

Exit screen; do not save changes Click the Exit button ( ).

Task Instructions
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If a site visitor uses the Web site search to find any book in that 
category, and proceeds to a page describing the book, the Smart 
Menu in the page’s left column displays the five top Teen Fiction 
titles.

Assigning a Template to a Menu

To add a new template, follow these steps.

1. Move to the Template Associations area of the Edit menu 
screen.

2. In the box on the right, enter the template that you are 
assigning to this menu. It can be a CMS template, or any file 
that you wish.

3. Click Add.
To later change or remove the template, select it then click 
Change or Remove.
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Taxonomy

Ektron CMS400.NET’s Taxonomy Feature lets you assign custom-
made information categories to folders, individual content items, 
community groups and users. When you create a taxonomy, you 
select which types of objects to associate with it. You can 
associate more than one object type with a taxonomy. For 
example, you might create a taxonomy for content items and users 
that belong to Technical Support.

When working with content, you can place a listing of those 
categories (a taxonomy) on a Web page. When that page displays, 
all published items in that taxonomy appear. So, a taxonomy is an 
easy way to organize and display Web site content according to 
your categories.

You can use taxonomy categories to help site visitors find content 
on your Web site. To help site visitors find content via a taxonomy, 
your developer places a Directory server control on a Web page. It 
looks something like this.
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There is no limit to the number of category levels you can assign to 
a taxonomy. For example, if you want a Web page to display a link 
to all content in a folder, you can easily do that using a taxonomy. 
Alternatively, you can assign any number of content items from any 
folders to a taxonomy. In the first example, the taxonomy displays 
content organized by folder structure. In the second case, the 
taxonomy connects content unrelated by folder structure.

To illustrate the benefits of a taxonomy that pulls together content 
from different folders, assume your Web site is for a college. 
Several items that relate to the graduate school are organized 
under major departments: Admissions, Academics, Faculty, Library 
& Information Services, etc. Using a taxonomy, you could 
assemble a group of content items relevant to graduate students 
(regardless of their folder location), and display them on a 
graduate students page.

When you have a community or social networking Web site, you 
can assign users and community groups to a taxonomy. This 
allows site visitors to search for users and groups based on the 
category to which they are assigned.

To allow site visitors to search for users and community groups 
based on a taxonomy, a developer can add a 
CommunityGroupBrowser or CommunitySearch server control to 
the site. The CommunityGroupBrowser control allows a site visitor 
to browse a selected taxonomy category for community group. The 
CommunitySearch control allows a site visitor to search for users 
and community groups based on selected criteria. See Also: The 
Developer Manual section “Introduction to Server Controls” > 
“Community Platform Server Controls” > 
“CommunityGroupBrowser Server Control” and 
“CommunitySearch Server Control.”

NOTE To see a comparison of taxonomy with other list options available with Ektron 
CMS400.NET, seethe User Manual section “Web Site Navigation Aids” > 
“Working with Collections” > “Comparison of Collections, Menus, Taxonomy, and 
the List Summary Features.” 

The following sections are included 

• ”Displaying a Content Item Taxonomy Search on your Web 
Site” on page 628

• ”Creating a Taxonomy” on page 630
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• ”Additional Taxonomy/Category Tasks” on page 648

Displaying a Content Item Taxonomy Search on 
your Web Site

When your Web developer places a Directory server control on a 
Web page, he can enable the Enable Search property to include a 
Search box with the taxonomy display (circled in the illustration 
below). The box helps site visitors find content by returning only 
items that include a search phrase and are assigned to a selected 
category.

When placing a Directory server control, your Web developer 
defines a Taxonomy ID number. The ID determines the top level of 
the taxonomy that appears below the Search box, to the right of 
Breadcrumb. Below that are categories that exist directly below 
the Taxonomy ID.

Using the Taxonomy Search
To use the search, a site visitor enters a search term and clicks the 
Directory radio button (above the Search box). The screen may 
return links in two areas below Breadcrumb.
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• Category - all categories below the selected level with content 
that includes the search term. Click a category to see a list of 
content that includes the search term in that taxonomy/
category level or one of its subcategories.

• Articles - content within the currently selected taxonomy/
category level that includes the search term

As illustrated below, within the Editor category, one category 
(eWebEditPro) includes content with the word library. And, one 
content block (The best Microsoft Word content processing) 
includes library.

The Directory and Catalog Radio Buttons

Use the Directory radio button to begin the search at the top level 
of the taxonomy.



Taxonomy

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 630

Use the Category button to limit the search to the currently 
selected category and its subcategories.

Creating a Taxonomy
Follow these steps to create and deploy a taxonomy. 

1. ”Planning the Taxonomy” on page 630
2. ”Creating a Taxonomy in the Workarea” on page 631
3. ”Making a Taxonomy Available to a Folder” on page 638
4. ”Assigning Items to a Taxonomy/Category” on page 641
5. ”Assigning a Folder to a Taxonomy/Category” on page 646
6. ”Insert the Directory Server Control on a Web Page” on 

page 648

Planning the Taxonomy 
It helps to design a taxonomy on paper before creating it in Ektron 
CMS400.NET. This can help you configure relationships among the 
kinds of information before you try to implement them.

As an example, here is a hierarchy of some content in the Ektron 
CMS400.NET sample site. The top level item is the taxonomy. All 
levels below it are categories.
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Next, review the site content and decide which content items and 
folders to assign to which taxonomy categories. Some categories 
may map directly to a folders. Other categories may use content 
from several folders.

Once you determine which content and folders will be assigned to 
which taxonomy categories, sign on to Ektron CMS400.NET and set 
up those relationships.

Creating a Taxonomy in the Workarea

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.

2. Click the Add Category button ( ).
3. The Add Taxonomy or Category screen appears. Enter a title 

and description.
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4. If desired, select a template to apply to the taxonomy or 
category. For more information, see ”Applying a Template to a 
Taxonomy or Category” on page 636.

5. Select the Configuration with which to associate the taxonomy.

NOTE If you do not make a selection, the taxonomy is associated with content.

Configuration Check this box to get this Effect

Content Associate this taxonomy with content. When this configuration is selected, 
the taxonomy category appears as option when creating new folders and 
content.
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User Associate this taxonomy with CMS or membership users. You assign CMS 
and membership users to a taxonomy on the Assign Items to Taxonomy 
screen. 

Once users are assigned to a taxonomy, an option to find them in a 
community search appears on the Advanced tab of the CommunitySearch 
server control. Select the Category tab and a User Categories dialog 
appears.

Configuration Check this box to get this Effect
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6. Click the Save button ( ).
7. The View All Taxonomy screen reappears, and you can see the 

new taxonomy.
8. Next, assign items and/or folders to the taxonomy. To do that, 

click it from the View All Taxonomy screen.
9. Hover the cursor over the taxonomy. A context-sensitive menu 

appears.

Group This taxonomy‘s categories can be assigned to community groups from the 
Category tab of the Edit Community Group screen. See example below.

If you do not check this box, users can only view taxonomy/category 
assignments on the Category tab.
Whether or not this box is checked, you can assign taxonomy categories to 
community groups via the View All Categories of Taxonomy screen. See 
Also: ”Viewing a Taxonomy” on page 649; ”Assigning a Taxonomy or 
Category to Community Group via the Edit Community Group Screen” on 
page 644

Configuration Check this box to get this Effect
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10. Click Assign Item(s) or Assign Folder(s). These procedures 
are more fully explained in ”Assigning Items to a Taxonomy/
Category” on page 641 and ”Remove Content from a 
Taxonomy/Category” on page 655.

NOTE You can also assign a Taxonomy to any content item using the Edit Content in 
Folder screen’s Category tab (illustrated below).
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Applying a Template to a Taxonomy or Category

Taxonomy categories are applied to Ektron CMS400.NET content in 
order to help site visitors find that content. To facilitate a taxonomy 
search, your developer places a Directory server control on a Web 
page. 

By default, when a user clicks a hyperlink on such a Web page, it 
uses the template assigned to the linked content. See Also: 
”Creating/Updating Templates” on page 64

If you want to display the linked content using a different template, 
follow these steps.

1. When creating or editing a taxonomy or category, select the 
appropriate template at the Template pull-down field.
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NOTE Alternatively, any category below the root level can inherit its parent’s taxonomy 
template. Use the Inherit checkbox to do this.

You may need a developer’s help with the rest of these steps.

2. In Visual Studio.Net, open the .aspx page that contains the 
directory server control. 

3. Look at the server control’s MarkupLanguage property.
4. If the property is blank, open the following file: site root/

workarea/template/taxonomy/taxonomy.ekml.
If the property displays an .ekml file, open that file. Its path may 
be listed in the property. If the .ekml file’s path is blank, it is 
workarea/template/taxonomy/.

5. Find the following line:
[$HyperLink]<br/>[$Teaser]

6. Replace it with the following:
<a href="[$TemplateQuickLink]">[$Title]</a><br/>[$Teaser]

7. Save the .ekml file.
The content selected from this Directory server control will now use 
the template assigned to the taxonomy/category. 
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If no template is assigned to a taxonomy/category, the template 
assigned to the content is used.

Numbers on the View Categories Screen

On the View All Categories of Taxonomy screen, the number to the 
right of any taxonomy/category is a cumulative total of all content 
items assigned to it and its subcategories. In the example below, 
the three subcategories have a total of 13 content items (2 + 1 + 
10).

Since the number to the right of the parent category is equal to 
number assigned to all subcategories, you know that no content is 
assigned to the parent category.

Also, the number of items is a combination of individual items plus 
all items in any assigned folders. So, for example, if one content 
item and one folder are assigned to a category, and the folder has 
five items, the number assigned to a category is six.

Making a Taxonomy Available to a Folder
Ektron CMS400.NET lets you control which taxonomies are 
available to a folder’s content. For example, a folder’s content 
consists of restaurants, and you want to restrict users to the 
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Restaurants taxonomy -- users cannot assign other taxonomies to 
that folder’s content.

The taxonomy folder property only affects users’ ability to assign 
taxonomy categories via the Edit Content in Folder screen’s 
Category tab (shown below). 

It has no effect on the assignment of taxonomy categories via the 
Modules > Taxonomy > View all Categories of Taxonomy 
screen.

To make a taxonomy available to any folder, follow these steps.

1. Navigate to the folder.
2. Choose View > Folder Properties.
3. In the Taxonomy section of the properties screen (shown 

below), uncheck the Inherit Parent Taxonomy Configuration 
checkbox. 

NOTE To inherit taxonomy settings from any folder’s parent folder, check this box.

4. Check one or more taxonomies to make available to this folder.
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Inheriting Taxonomies from a Parent Folder
Unlike some folder properties, a set of Taxonomies is not inherited 
from a parent folder by default.

If the set of Taxonomies you want to apply to a folder is already 
applied to its parent folder, go to the folder’s properties screen and 
check the Inherit Parent Taxonomy Configuration checkbox.

Requiring Content to Have at Least One Category Assigned
At the folder level, you can require all content to be assigned at 
least one taxonomy category. If you do, as content in that folder is 
submitted for publishing, Ektron CMS400.NET checks the content 
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for at least one taxonomy category. If none is found, an error 
message appears, and the user must assign a taxonomy category 
before the content can be published.

To set a folder-level requirement for all content to be assigned a 
taxonomy category, follow these steps.

1. Navigate to the folder.
2. Choose View > Folder Properties.
3. In the Taxonomy section of the properties screen (shown 

below), check the Require at Least One Category Selection 
checkbox.

Assigning Items to a Taxonomy/Category
There are three ways to assign a taxonomy or category to an item.

• from the Modules > Taxonomy screen

• from the content item

• from the community group
Each method is explained below.

Assigning a Taxonomy or Category to Content via Modules > Taxonomy

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomy Screen.
3. Select the taxonomy or category under which you want to 

assign one or more content items. 
4. Click Assign Item(s).



Taxonomy

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 642

5. Choose the object type of the item to associate.

6. Navigate to the folder that contains the content you want to 
assign to the taxonomy or category. 
Or
Search for the user or community group to assign to the 
taxonomy or category.

NOTE Folder content appears below the folder list (see below). 
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7. Check the box to the left of content, user or community group 
you want to assign. You can assign all types of content, even 
blogs.
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Assigning a Taxonomy or Category to Content via the Edit Content 
Screen

1. Navigate to the content item.

2. Hover the cursor over the adjacent triangle ( ) and click. 

3. Click View from the dropdown menu.

4. From the View Content screen, click the Edit button ( ).
5. Click the Category tab.

6. Check the taxonomies or categories to apply.

NOTE Your system administrator can restrict which taxonomies can be assigned to 
content at the folder level. So, a taxonomy available in one folder may not be 
available in another.

7. Save the content.

Taxonomy Categories and Assets

If you drag and drop assets into Ektron CMS400.NET, any 
taxonomy categories applied to the folder are available to that 
asset. If a category is required for the folder, you must assign one 
of the categories before you can publish the asset.

Assigning a Taxonomy or Category to Community Group via the Edit 
Community Group Screen

Prerequisite

You can perform this procedure only if a taxonomy’s 
Configuration > Group check box is checked. 
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If it is not checked, you can view the taxonomy categories 
assigned to a Community Group on the Edit Community Group 
Screen. And, you can assign Community Groups to a Taxonomy 
via the View all Categories of Taxonomy screen.

1. In the Workarea, navigate to Modules > Community 
Management > Community Groups > Groups.

2. Select a community group.
3. Select the Category tab.
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4. Check the taxonomies or categories to apply.
5. Click the Save button.

Assigning a Folder to a Taxonomy/Category
If you assign a folder to a taxonomy, it displays published content 
in the folder when the page is viewed. As content is assigned to or 
removed from the folder, the taxonomy on the Web page changes 
dynamically.

For example, if you have a “Top News Stories” folder, in which old 
news items are frequently removed and new ones assigned, the 
page displaying the taxonomy only shows the latest news items. 
The updating of content on the Web page is automatically handled 
by the taxonomy.

When assigning a folder, an option to assign its subfolders is 
available.

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

To assign a folder to a taxonomy category, follow these steps.

1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomy Screen.
3. Select the taxonomy or category under which you want to 

assign a folder. 
4. Click Assign Folder(s).
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5. Navigate to the folder you want to assign to the taxonomy or 
category.

6. Check the box to the left of any folder you want to assign.

IMPORTANT! Only folders you check are assigned to the taxonomy/category. Checking a parent 
folder has no effect on its child folders.
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Insert the Directory Server Control on a Web Page
See the Ektron CMS400.NET Developer Manual chapter 
“Introduction to Ektron CMS400.NET Server Controls” > “Directory 
Server Control.”

Additional Taxonomy/Category Tasks
The following sections explain additional tasks you can perform 
when working with a Taxonomy or its categories.

• ”Viewing All Taxonomies” on page 648

• ”Viewing a Taxonomy” on page 649

• ”Edit Taxonomy/Category Title, Description, and Template” on 
page 652

• ”Delete a Taxonomy/Category” on page 653

• ”Add a Category to a Taxonomy/Category” on page 654

• ”Remove Content from a Taxonomy/Category” on page 655

• ”Remove Folder from a Taxonomy/Category” on page 656

• ”Change Order of Categories Assigned to a Taxonomy/
Category” on page 657

• ”Change Order of Content Assigned to a Taxonomy/Category” 
on page 658

• ”Importing and Exporting a Taxonomy” on page 658

Viewing All Taxonomies
The View All Taxonomies screen displays all taxonomies currently in 
Ektron CMS400.NET. The language pull down lets you sort the list by a 
language. 
To work with any taxonomy, select it. When you do, it appears within the 
View All Categories of Taxonomy screen.
You can also use the View All Taxonomies screen to perform these tasks.

Button Task For more information, see

Add new taxonomy ”Creating a Taxonomy in the Workarea” on 
page 631
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See Also: ”Taxonomy” on page 626

Viewing a Taxonomy
The View All Categories of Taxonomy screen exposes all 
categories in a selected taxonomy. 

Use this screen to perform tasks on a taxonomy or one of its 
categories, such as adding new categories, assigning content to a 
category, and changing the order of items in a category.

TIP! On the View All Categories of Taxonomy screen, a dashed box indicates the 
selected Taxonomy/category (see below).

Tasks you can perform from this screen are listed below.

Delete one or more taxonomies ”Deleting a Taxonomy/Category from the View All 
Taxonomy Screen” on page 653

Import a taxonomy ”Importing and Exporting a Taxonomy” on 
page 658

Button Task For more information, see
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Task How to initiate For more information, see

Edit the taxonomy title, 
description, and template. Click Edit toolbar button ( )

or

1. Place cursor over the tax-
onomy/category.

2. Click Edit from the popup 
menu.

”Edit Taxonomy/Category Title, 
Description, and Template” on 
page 652

Delete the taxonomy Click Delete toolbar button ( ) ”Deleting a Taxonomy/Category from 
the View All Taxonomy Screen” on 
page 653

Export a taxonomy Click Export Taxonomy toolbar 

button ( )

”Exporting a Taxonomy” on 
page 659

Add a taxonomy category 1. Select the taxonomy/cate-
gory under which the new 
category should appear.

2. Click Add from the popup 
menu.

”Assigning a Taxonomy or Category 
to Content via Modules > Taxonomy” 
on page 641

View a taxonomy category 1. Place the cursor over the 
taxonomy/category.

2. Click View from the popup 
menu.

Change the order of items in a 
taxonomy/category

1. Place the cursor over the 
taxonomy/category.

2. Click Reorder from the 
popup menu.

”Change Order of Categories 
Assigned to a Taxonomy/Category” 
on page 657

Delete a category 1. Place the cursor over the 
taxonomy/category.

2. Click Delete from the 
popup menu.

”Deleting a Taxonomy/Category from 
the View All Taxonomy Screen” on 
page 653

Assign content items to a 
category

1. Place the cursor over the 
taxonomy/category.

2. Click Assign Item(s) from 
the popup menu.

”Assigning Items to a Taxonomy/
Category” on page 641
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Viewing a Taxonomy or Category
To view any taxonomy or category, move the cursor over it then 
select View from the popup menu.

The View screen displays the taxonomy/category’s title and 
description. You also see assigned content items or folders, 
depending on how the View dropdown is set.

From here you can perform these tasks.

Assign folders to a category 1. Place the cursor over the 
taxonomy/category.

2. Click Assign Folder(s) 
from the popup menu.

”Assigning a Folder to a Taxonomy/
Category” on page 646

Task How to initiate For more information, see
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Edit Taxonomy/Category Title, Description, and Template
To edit a Taxonomy’s title, description or template, follow these 
steps.

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomy Screen.

3. Click the Edit button ( ) or hover the cursor over the 
taxonomy and select Edit from the popup menu.

Task Press 
toolbar 
button

Directions

Edit taxonomy/category title and 
description

1. Click button and update the fields.

2. Click the Save button ( ).

Delete the selected taxonomy/
category

1. Click the toolbar button.

2. A confirmation window appears

3. Click OK.

Remove items (content or folders) 
from the selected taxonomy/
category

1. From the View dropdown list, select Folders or 
Items, whichever you want to delete.

2. Check the box next to each item you want to 
delete. To delete all items, check the box in the 
title bar.

3. Click the button.



Taxonomy

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 653

See Also: “Applying a Template to a Taxonomy or Category” on 
page 636

Delete a Taxonomy/Category
There are two ways to delete a taxonomy or category.

Deleting a Taxonomy/Category from the View All Taxonomy Screen

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.
2. From the View All Taxonomy Screen, check the box to the left 

taxonomy you want to delete.

3. Click the delete button ( ).

Deleting a Taxonomy/Category from the View All Categories of 
Taxonomy Screen

1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomy Screen.
3. Hover the cursor over the taxonomy and select Delete from the 

popup menu.
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Add a Category to a Taxonomy/Category
Follow these steps to add a category to a taxonomy, or to add a 
subcategory to a category.

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomy Screen.
3. Select the taxonomy or category under which you want to 

create a new category. 
4. Click Add from the popup menu.
5. The Add Taxonomy or Category screen appears.
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6. Enter the name and description of the new category.

7. Click the Save button ( ).

Remove Content from a Taxonomy/Category

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.
2. Select a taxonomy from the View All Taxonomy Screen.
3. Select the taxonomy or category that has content that you want 

to edit. 
4. Click View from the popup menu.
5. The View Taxonomy screen appears.
6. From the View dropdown, select Item(s).

7. Check the box to the left of content you want to remove.

TIP! To remove all content, check the box in the title bar.



Taxonomy

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 656

8. Click the delete button ( ).

Remove Folder from a Taxonomy/Category

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.
2. Select a taxonomy from the View All Taxonomy Screen.
3. Select the taxonomy or category that has folder that you want 

to delete. 
4. Click View from the popup menu.
5. The View Taxonomy screen appears.
6. From the View dropdown, select Folder(s).
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7. Check the box to the left of folders you want to remove.

TIP! To remove all content, check the box in the title bar.

8. Click the delete button ( ).

Change Order of Categories Assigned to a Taxonomy/
Category

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomy Screen.
3. Select the taxonomy or category that has content that you want 

to reorder. 
4. Click Reorder from the popup menu.
5. Set the reorder pull-down list to Category.

6. Select an item that you want to move up or down.
7. Click the up or down arrow to move the item in that direction. 
8. Continue steps 5 and 6 until all content is in the desired order.

9. Click the save button ( ).
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Change Order of Content Assigned to a Taxonomy/Category

NOTE Only administrators or users to whom the Taxonomy-Administrator role has been 
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on 
page 735

1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomy Screen.
3. Select the taxonomy or category that has content that you want 

to reorder. 
4. Click Reorder from the popup menu.
5. Set the reorder pull-down list to items.

6. Select an item that you want to move up or down.
7. Click the up or down arrow to move the item in that direction. 
8. Continue steps 5 and 6 until all content is in the desired order.

9. Click the save button ( ).

Importing and Exporting a Taxonomy
You can export any taxonomy as an xml file. Then, you can reuse it 
or send it to someone else, who would import it in order to bring a 
copy of it onto their computer.

You can use the Export/Import feature like a “save as” feature. For 
example, you want to create a taxonomy that is similar to an 
existing one but has some differences. The easiest way to do this 
is to export an existing one, then import it under a new name and 
edit it.

Below is an example of part of a taxonomy saved as an XML 
document.

<?xml version="1.0" ?> 
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- <TaxonomyData xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://
www.w3.org/2001/XMLSchema">
  <TaxonomyName>MapCategory</TaxonomyName> 
  <TaxonomyDescription>map</TaxonomyDescription> 
- <Taxonomy>
- <TaxonomyData>
  <TaxonomyName>Sports</TaxonomyName> 
  <TaxonomyDescription>sports</TaxonomyDescription> 
  </TaxonomyData>
- <TaxonomyData>
  <TaxonomyName>Banks</TaxonomyName> 
  <TaxonomyDescription>Banks</TaxonomyDescription> 
  </TaxonomyData>
- <TaxonomyData>
  <TaxonomyName>Pharmacies</TaxonomyName> 
  <TaxonomyDescription>Pharmacies</TaxonomyDescription> 
  </TaxonomyData>
- <TaxonomyData>
  <TaxonomyName>Travel</TaxonomyName> 
  <TaxonomyDescription>Travel</TaxonomyDescription> 
  </TaxonomyData>
- <TaxonomyData>
  <TaxonomyName>Restaurant</TaxonomyName> 
  <TaxonomyDescription>Restaurant</TaxonomyDescription> 
- <Taxonomy>
- <TaxonomyData>
  <TaxonomyName>American</TaxonomyName> 
  <TaxonomyDescription>American</TaxonomyDescription> 
  </TaxonomyData>
- <TaxonomyData>
  <TaxonomyName>Indian</TaxonomyName> 
  <TaxonomyDescription>Indian</TaxonomyDescription> 
  </TaxonomyData>

Exporting a Taxonomy

Exporting a taxonomy means saving it as an .xml file on your 
computer or network drive. To export a taxonomy, follow these 
steps.

1. From the Workarea, go to Modules > Taxonomy.
2. All taxonomies appear.
3. Click a taxonomy that you want to export.

4. Click the Export Taxonomy button ( ).
5. You are prompted to select a folder into which to save it.
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Importing a Taxonomy

1. From the Workarea, go to Modules > Taxonomy.
2. All taxonomies appear.

3. Click the Import Taxonomy button ( ).
4. The Import Taxonomy screen appears.

5. Use the language dropdown box to select the language of your 
taxonomy.

6. In the Title field, enter a name for your new taxonomy.
7. Click the Browse button.
8. Navigate to the taxonomy file you want to import.
9. The path appears in the File field.
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NOTE Alternatively, you can enter or paste the xml into the XML box.

10. Determine the taxonomy’s configuration. See ”Configuration” 
on page 632

11. Click the Save button ( ).

NOTE If you assign a name that is already given to a taxonomy, Ektron CMS400.NET 
appends a number to the title, beginning with 1.
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Managing Users and 
Permissions

Managing Users & User Groups

Users are people who administer the Web site, create content, or 
publish content. Without users, the Web site would be blank. In 
Ektron CMS400.NET, you can add, edit, and delete users to and 
from the application through the Settings folder in the Workarea.

Every Ektron CMS400.NET user belongs to a User Group. User 
groups are used when creating permissions and an approval chain 
for content folders. User groups can be departments in your 
company (Human Resources, Sales, Engineering) or indicate a 
user’s role (Publishers, Administrators, Editors, etc.).

IMPORTANT! If your system uses the Active Directory Integration Feature, proceed to ”Active 
Directory Feature” on page 741 to learn about user management functions. This 
chapter only applies to systems that do not use Active Directory Integration.

IMPORTANT! If your system uses LDAP Authentication, proceed to ”LDAP Authentication” on 
page 791. Some functionality in this chapter does apply to LDAP. The LDAP 
chapter explains which information is applied.

This section explains the most common actions that you will 
perform on users and user groups. These actions include:

• ”Accessing the Users and User Groups Folders” on page 663

• ”Creating a New User” on page 664

• ”Viewing a User” on page 667

• ”Editing a User” on page 667
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• ”Deleting a User” on page 669

• ”Assigning Users To User Groups” on page 671

NOTE Only members of the Administrators User Group and those defined in the Manage 
Members for Role: User Admin screen can view, add, or edit users and user 
groups.

Accessing the Users and User Groups Folders
All user and user group information is accessible from the 
Workarea.

Accessing the User Folder
To access the user folder in Ektron CMS400.NET, follow these 
steps.

1. Access the Workarea > Settings > Users.
2. All Ektron CMS400.NET users appear.
From this screen, you can add, edit, and delete users. These 
procedures are explained in the next sections.

Accessing the User Group Folder
To access the user group folder in Ektron CMS400.NET, follow 
these steps.

1. Access the Workarea > Settings > User Groups.
2. All user groups appear.
From this screen, you can add, edit, and delete user groups. These 
procedures are explained in the next sections.

Managing Users
IMPORTANT! If you are using Active Directory to Manage users, see ”Associating User 

Information in AD with Ektron CMS400.NET” on page 755.

The following topics explain how to manage users. 



Managing Users & User Groups

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 664

• ”Creating a New User” on page 664

• ”Viewing a User” on page 667

• ”Editing a User” on page 667

• ”Deleting a User” on page 669

• ”Removing Users from User Groups” on page 669

Creating a New User

IMPORTANT! If you are using Active Directory to add a new user, see ”Manually Adding AD 
User Information to Ektron CMS400.NET” on page 757. If you are using LDAP, 
see ”Adding User Information from an LDAP Server to Ektron CMS400.NET” on 
page 797.

Before you can assign a user to a user group, you must add the 
user to the system. To create a new user, follow these steps.

1. Access the User folder, as described in ”Accessing the User 
Folder” on page 663.

2. Click the Add User button ( ).

3. The Add a New User to the System screen appears.
4. Enter the following information about the user.

Field Description

Username Insert a username for the user you want to create.

Organization
Organizational Unit
Domain

These fields are only available when using LDAP Authentication. See Also: 
”Adding User Information from an LDAP Server to Ektron CMS400.NET” on 
page 797.

First Name Enter the first name of the user.

Last Name Enter the last name of the user.
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Display Name The name that is used to identify a user on the Web site. This can be 
different from their Username, which is the name you use to log into the 
Ektron CMS400.NET Web site.

Important: This name needs to be unique inside CMS400.NET and it 
cannot be blank.

Password Enter a password for the user.

Note: Passwords can be either case-sensitive or case-insensitive. For more 
information, see ”Making Passwords Case Sensitive” on page 6.

Confirm Password Confirm the password by typing it again.

User Language Select the language in which the user will view Ektron CMS400.NET 
screens and messages. The language also determines the default value 
whenever a drop-down list of languages appears within Ektron 
CMS400.NET .
The dropdown list of choices at this field is derived from the Language 
Settings screen, available from the Settings> Configuration folder.
Do not confuse the system language with the user’s ability to create and edit 
foreign editions of content. This field does not prevent a user from working 
with multiple language content.
See Also: ”Multi-Language Support” on page 809

Note: If the selected language is not English, French or German, it is only 
supported after you download the Ektron CMS400.NET  Language Support 
Program from Ektron and translate the Web site.

Email Address Enter the email address of the user. 

Forum Editor Determines which editor will be used when this user replies to a Discussion 
Board. 
See Also: ”Using Discussion Boards on Your Web Site” on page 530

Field Description
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Avatar An image or icon to represent you in the Forum.
Type in a web path to image. For example: http://www.example.com/
smileyface.gif

By default, the maximum file size of an avatar is limited to 200 kilobytes and 
the height and width of the avatar will be reduced 125 pixels preserving the 
aspect ratio.
To change the file size limit, edit this file:
C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to allow. For 
example, to allow 500kb files, change 200 to 500.
If (numFileSize > 200) Then

Remember, this number is in kilobytes.
To change the default height and width of the avatar, edit this file:
C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow. For 
example, to make avatars have a height and width of 166 pixels, change 
125 to 166 in both these lines.
Dim Width As Integer = 125
Dim Height As Integer = 125

Disable Receiving of 
System Notification 
Email

Select to disable the email notifications for the user. If you do, the user will 
not receive the automatic email notification described in ”Automatic eMail 
Notification” on page 996. However, this field has no effect on the user’s 
ability to receive instant email.

Any custom user 
properties

See ”Custom User Properties” on page 696

Field Description
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NOTE If email notification is turned off in the setup page, you are notified when editing, 
adding, or viewing a user.

5. Click the Save button ( ).
6. The View Users in Group Everyone screen appears with the 

new user included in the table.

NOTE When you add a new user, he is automatically placed in the Everyone user group. 
To assign users to other groups, see ”Assigning Users To User Groups” on 
page 671.

7. Continue this process until you add all users of your Web site, 
or are allowed to depending on your license.

NOTE Contact Ektron Sales for pricing of adding more users to your license.

Viewing a User
After adding a user, you can view that information. While viewing a 
user, you can edit or delete the user.

To view a user, follow these steps.

1. Access the user folder as described in ”Accessing the User 
Folder” on page 663.

2. Click the Username of the user you want to view.
3. The View User Information screen is displayed.

To learn about the fields, see ”Enter the following information 
about the user.” on page 664 and ”The following fields are only 
available when editing a user.” on page 668

From the View User screen, you can edit or delete users. These 
actions are described in the next sections.

Editing a User

IMPORTANT! If you are using Active Directory to edit a user, see ”Editing User Information in 
Ektron CMS400.NET” on page 758.

When editing a user, you can change the username, first name, 
last name, password, user language, and email address. Also, 
while editing, you can change three fields that were not available 
when the user was created. 
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• Account Locked

• Work Page Size

• Landing Page after login

To edit a user, follow these steps.

1. Access the view user screen of the user you want to edit as 
described in ”Viewing a User” on page 667.

2. Click the Username of the user you want to edit. 
3. The View User Information screen is displayed.

4. Click the Edit button ( ).

5. The Edit User screen is displayed. To learn about most fields, 
see ”Enter the following information about the user.” on 
page 664.
The following fields are only available when editing a user.

.

Field Description

Account Locked See ”Restricting Login Attempts” on page 7

Forum Editor Determines which editor will be used when this user replies to a 
Discussion Board. See Also: ”Using Discussion Boards on Your Web Site” 
on page 530

Forum Signature Adds a signature to your posts in the forum. You do not see the signature 
in the editor. It is added after you click the Post button.
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6. Make the necessary changes to the user information.

7. Click the Update button ( ).

Deleting a User

IMPORTANT! If you are using Active Directory to delete a user, see ”Deleting Users” on 
page 758.

When you need to remove a user from the application, you can 
easily do it from the User’s Folder in the Workarea.

WARNING! Once a user is deleted from the database, he is deleted permanently. The process 
cannot be undone.

To delete a user, follow these steps.

1. Access the view user screen for the user you want to delete, as 
described in ”Viewing a User” on page 667.

2. Click the Username of the user you want to delete. 
3. The View User Information screen is displayed.

4. Click the Delete button ( ).

5. A confirmation message is displayed.
6. Click OK.

Removing Users from User Groups

IMPORTANT! If you are using Active Directory to remove a user from a group, see ”Removing 
Users from a Group” on page 753.

Work Page Size See ”Work Page Size” on page 21

Landing Page after 
login

See ”Landing Page after login” on page 22

Field Description
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NOTE Removing a user from a user group does not delete the user from Ektron 
CMS400.NET. Also, you cannot remove users from the Everyone or Admin user 
groups.

To remove a user from a user group, follow these steps.

1. Access the User Groups folder, as described in ”Accessing the 
User Group Folder” on page 663.

2. Click the User Group that includes the user you want to 
remove.

3. Members of the selected group appear.
4. Click the user to remove.
5. The View User Information screen is displayed.

6. Click the Delete button ( ) to delete the user from the group.

7. A confirmation message is displayed.
8. Click OK.

Managing User Groups
The following topics explain how to manage User Groups. 

• ”Creating a New User Group” on page 670

• ”Assigning Users To User Groups” on page 671

• ”Viewing the Users in a User Group” on page 672

• ”Editing a User Group” on page 673

• ”Deleting a User Group” on page 673

• ”Removing Users from User Groups” on page 669

Creating a New User Group
To create a new User Group in Ektron CMS400.NET, follow these 
steps.

1. Access the User Groups folder in the administrator Workarea, 
as described in ”Accessing the User Group Folder” on 
page 663.

2. Click the Add User Group button ( ).
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3. The Add a New User Group to the System screen is displayed.
4. Enter a name and brief description of the user group you want 

to create.

5. Click the Save button ( ).

Assigning Users To User Groups
To add a user to a user group, follow these steps.

1. Access the Workarea > Settings > User Groups.
2. Click the user group to which you want to add a user.
3. The View Users in Group screen appears with all current group 

members.

NOTE When you create a new user group, no user assigned to it initially.

Note that you can select any number of users by checking the 
box to the left of their name. To select all users, check the box 
in the column header row.
You can also sort the display by Username, Lastname or 
Firstname.
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And, you can enter characters into the Search field and find 
only users that match them. For example, you could enter bill, 
click the Search button, and see only users with those 
characters in their name. 

4. Click the Add User button ( ).

5. Users who do not belong to the group appear.
6. Click the user you want to add.
7. A confirmation message is displayed.
8. Click OK.
9. The selected user is now a member of the selected group.
10. Continue this process until you add all users into User Groups.

Viewing the Users in a User Group
To view a list of users who are members of a user group, follow 
these steps.

1. Access the User Group folder in the administrator Workarea, 
as described in ”Accessing the User Group Folder” on 
page 663.

2. Click the user group whose members you want to view.
3. The View Users in Group screen appears with a list of users 

who are members of the group.

From this screen, you can edit or delete user groups, as well as 
add and remove users to and from the user group. 

You can also send an email to any group member by clicking the 
checkbox next to the email icon on the same line as the user’s 
name.
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After selecting all users to receive email, click the email toolbar 
button ( ). A new screen appears that lets you compose the 
email.

Editing a User Group
When editing a User Group, you can only change its name.

NOTE You cannot edit the default Administrators and Everyone user groups.

To edit a user group, follow these steps.

1. Access the View Users in Group screen for the user group you 
want to edit, as described in ”Viewing the Users in a User 
Group” on page 672.

2. Click the User Group you want to edit.
3. The View Users In Group screen is displayed.

4. Click the Edit button ( ).

5. The Edit User Group screen is displayed.
6. Make the necessary changes.

7. Click the Update button ( ).

Deleting a User Group
When you do not need a User Group anymore, you can delete it 
from the system.

NOTE You cannot delete the Administrator and Everyone groups.

To delete a user group, follow these steps.

1. Access the View Users in Group screen for the user group you 
want to delete, as described in ”Viewing the Users in a User 
Group” on page 672.

2. Click the User Group you want to delete.
3. The View Users In Group screen is displayed.

4. Click the Delete button ( ).

5. A confirmation message is displayed.
6. Click OK.
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7. The User Group is deleted from the Ektron CMS400.NET Web 
site.

Removing Users from User Groups
See ”Removing Users from User Groups” on page 669.
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Membership Users and Groups

Membership users are a category of users who have limited 
privileges to Ektron CMS400.NET. Unlike regular CMS users, they 
cannot use the Workarea. When a membership user logs in, he 
can view, add and edit content from the Web site (as permitted) -- 
all other functionality is disabled.

Membership users can also be granted permission to view private 
content. This is helpful if your organization has partners who need 
access to Web pages that should not be visible to the general 
public.

When you have a Social Network or Community Web site, 
membership users can create an online area for themselves.

You can use Membership groups to group similar membership 
users. 

Privileges of Membership Users
• They can create, edit, and view content after log in. See Also: 

”Community Folders” on page 43

• They can be granted permission to view private content. See 
Also: ”Membership User/User Group Example” on page 676 
and ”Private Content” on page 692

• They can self-subscribe to receive Web Alerts. See Also: ”Web 
Alert Feature” on page 931

• If your site is a Community Web site, they become members of 
the community and can use the following features provided by 
Ektron’s Community Platform. See Also: ”Community 
Management” on page 868, The user manual section “My 
Workspace” and the Developer Manual section “Community 
Platform Server Controls.”

- Share their Document Workspace and Photo Gallery with 
other site visitors
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- Join a Community Group

- Mark content the member likes and allow site visitors to see 
the list of these Favorites

- Mark other members or site users as Colleagues.

- Keep a Journal about themselves.

- Add and read comments left on a Message Board

- Send and receive Messages with other registered users.

• If a Discussion Board requires sign in, they can view and post 
to them. See Also: ”Discussion Boards” on page 471

• If a blog requires authentication, they can post blog comments. 
See Also:  “Working with Folders and Content” > “Blogs” in the 
Ektron CMS400.NET User Manual

• If a poll or survey is set up to track participating users, 
membership users’ names appear on the Form reports.

Membership User/User Group Example
A typical membership scenario is a Partners section of your Web 
site that contains private content for partners only. Set up a 
membership user group to include users from your partner’s 
organization. The group is given add and edit permissions to the 
Partners section. As a result, any partner can log into Ektron 
CMS400.NET and view, add, or edit the private content.

This topic is more fully explained through the following subtopics.

• ”Accessing the Membership Module Folder” on page 677

• ”Working with Membership Users” on page 677

• ”Membership User Groups” on page 686

• ”Assigning Permissions for Memberships” on page 690

• ”Troubleshooting Problems with Membership Users and 
Groups” on page 691

.
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Accessing the Membership Module Folder
Use the Membership Module folder to enter and edit membership 
users and user groups. To access the folder, follow these steps.

1. Navigate to Workarea > Modules > Community 
Management.

2. Click the Memberships folder to view its subfolders.

Working with Membership Users
The following sections explain all actions that may be performed 
on membership users via the following topics.

• ”Adding Membership Users” on page 678

• ”Adding Membership Users to a Membership User Group” on 
page 681

• ”Setting Permissions on Private Content for Membership 
Users” on page 681

• ”Viewing Membership User Information” on page 681

• ”Editing Membership Users” on page 683

• ”Deleting Membership Users” on page 686

Folder Name More Information

Users ”Working with Membership Users” on page 677

Users not 
Verified

”What Happens if Verification email is Used” on 
page 965

User Groups ”Membership User Groups” on page 686

Messages ”What Happens if Verification email is Used” on 
page 965
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Adding Membership Users

NOTE If you are using the Web Alert feature, any site visitor can sign up to be a 
membership user. That represents another way to add membership users. For 
more information, see ”How Users Sign up for Subscriptions” on page 963.

To add a new membership user, follow these steps.

1. Form the Workarea, click Modules > Community 
Management > Memberships > Users.

2. Click the Add Membership User button ( ).

3. The Add Membership User screen is displayed.
4. Complete the form using the following table as a reference.

Field Description

Username Enter a unique username for the membership user.

First Name Enter the first name of the user.

Last Name Enter the last name of the user.

Display Name The name that is used to identify a Membership user on the Web site. 
This can be different from their Username, which is the name you use to 
log into the Ektron CMS400.NET Web site.

Important: This name needs to be unique inside CMS400.NET and it 
cannot be blank.

Password Enter a password for the user.

Confirm Pwd Re-type the password to confirm it is correct.
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User Language Select the language in which the user will view Ektron CMS400.NET 
screens and messages. The language also determines the default value 
whenever a drop-down list of languages appears within Ektron 
CMS400.NET .
The dropdown list of choices at this field is derived from the Language 
Settings screen, available from the Settings> Configuration folder.
Do not confuse the system language with the user’s ability to create and 
edit foreign editions of content. This field does not prevent a user from 
working with multiple language content.
See Also: ”Multi-Language Support” on page 809

Note: If the selected language is not English, French or German, it is only 
supported after you download the Ektron CMS400.NET  Language 
Support Program from Ektron and translate the Web site.

Email Address Enter an email address for the user.

Forum Editor Determines which editor will be used when this user replies to a 
Discussion Board. 
See Also: ”Using Discussion Boards on Your Web Site” on page 530

Field Description
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Avatar An image or icon to represent the user in the Forum.
Type in a web path to image. For example: http://www.example.com/
smileyface.gif

By default, the maximum file size of an avatar is limited to 200 kilobytes 
and the height and width of the avatar will be reduced 125 pixels 
preserving the aspect ratio.
To change the file size limit, edit this file:
C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to allow. 
For example, to allow 500kb files, change 200 to 500.
If (numFileSize > 200) Then

Remember, this number is in kilobytes.
To change the default height and width of the avatar, edit this file:
C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow. For 
example, to make avatars have a height and width of 166 pixels, change 
125 to 166 in both these lines.
Dim Width As Integer = 125
Dim Height As Integer = 125

Address The address used to find your location when a user is performing a 
search based on location.

Latitude The latitude used to find your location when a user is performing a search 
based on location. 
Google maps provides a service that takes the address of user and 
returns its latitude and longitude.

Note: You don’t need to use Google’s automatic retrieval of latitude and 
longitude. Instead, you can enter the values manually.

Field Description
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5. Click the Save button ( ).

Adding Membership Users to a Membership User Group
See ”Adding Membership Users to a Membership User Group” on 
page 688.

Setting Permissions on Private Content for Membership Users
See ”Assigning Permissions for Memberships” on page 690.

Viewing Membership User Information
To view membership user information, follow these steps.

Longitude The longitude used to find your location when a user is performing a 
search based on location. 
Google maps provides a service that takes the address of content and 
returns its latitude and longitude.

Note: You don’t need to use Google’s automatic retrieval of latitude and 
longitude. Instead, you can enter the values manually.

Forum 
Signature

Adds a signature to your posts in the forum. You do not see the signature 
in the editor. It is added after you click the Post button.

Tags Select from a predefined list of Tags that describe yourself. Or, create a 
new tag by clicking the Click To Add A New Tag link. Placing a check 
mark in the check box next to a tag activates it for your profile. See Also: 
”Tags” on page 909

Field Description
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1. Access the membership users folder, as described in 
”Accessing the Membership Module Folder” on page 677.

NOTE The ek_PageSize setting in the web.config file determines the maximum number 
of users that can appear on a page before it “breaks.” When a page breaks, 
additional entries appear on another screen, and the following text appears near 
the bottom of the list: 
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

The View Users in Group All_Members screen lets you add 
new users, as well as sort and search for existing users. See 
”Sorting Membership Users” on page 682 and ”Searching for 
Membership Users” on page 682.

2. Click the user you want to view.
3. The View Membership User Information screen is displayed.
From this screen, you can edit or delete membership users.

Sorting Membership Users

You can arrange users on the View Users in Group All_Members 
screen by clicking the following column headers:

• Username

• Last Name

• First Name

By default, users are arranged alphabetically by Username, 
starting with the beginning of the alphabet. To switch that 
arrangement so that users whose username is last when sorted 
alphabetically, click the column header. To revert to the original 
arrangement, click the header again.

You can also sort the list by last name or first name. Like 
username, clicking the column header reverses the arrangement.

Searching for Membership Users

You can use the Search field (circled below) to display only users 
who meet your criteria. This would be especially helpful to filter out 
a large number of membership users.
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Use the Search field to enter unique characters to find members 
you seek. For example, to find all members whose username 
includes @example.com, enter that into the Search field and click 
the Search button. Only users with those characters in that exact 
sequence in their username, first name, or last name appear on 
the screen.

You can also search by First and Last name fields. Click the down 
arrow to the left of the Search button to select a field to search.

The sequence of search characters must match your entry in the 
Search field. For example, if you are searching by last name and 
enter MI, anyone whose name is Smith appears. But, if you enter 
IM, users with the last name of Smith do not appear.

Also, the search is case-insensitive, so MI produces the same 
results as mi.

Editing Membership Users
To edit a membership user, follow these steps.
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1. Access the View Membership User screen of the membership 
user you want to edit, as described in ”Viewing Membership 
User Information” on page 681.

2. Click the Edit button ( ).

3. The Edit Membership User Information screen is displayed.
4. Use the following table to assist with editing the membership 

user’s information.

Field Description

Username Enter a unique username for the membership user.

First Name Enter the first name of the user.

Last Name Enter the last name of the user.

Display Name The name that is used to identify a Membership user on the Web site. 
This can be different from their Username, which is the name you use to 
log into the Ektron CMS400.NET Web site.

Important: This name needs to be unique inside CMS400.NET and it 
cannot be blank.

Password Enter a password for the user.

Confirm Pwd Re-type the password to confirm it is correct.

User Language Select the language in which the user will view Ektron CMS400.NET 
screens and messages. The language also determines the default 
value whenever a drop-down list of languages appears within Ektron 
CMS400.NET .
The dropdown list of choices at this field is derived from the Language 
Settings screen, available from the Settings> Configuration folder.
Do not confuse the system language with the user’s ability to create and 
edit foreign editions of content. This field does not prevent a user from 
working with multiple language content.
See Also: ”Multi-Language Support” on page 809

Note: If the selected language is not English, French or German, it is 
only supported after you download the Ektron CMS400.NET  
Language Support Program from Ektron and translate the Web site.

Email Address Enter an email address for the user.
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Forum Editor Determines which editor will be used when this user replies to a 
Discussion Board. 
See Also: ”Using Discussion Boards on Your Web Site” on page 530

Avatar An image or icon to represent the user in the Forum.
Type in a web path to image. For example: http://www.example.com/
smileyface.gif

By default, the maximum file size of an avatar is limited to 200 kilobytes 
and the height and width of the avatar will be reduced 125 pixels 
preserving the aspect ratio.
To change the file size limit, edit this file:
C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to 
allow. For example, to allow 500kb files, change 200 to 500.
If (numFileSize > 200) Then

Remember, this number is in kilobytes.
To change the default height and width of the avatar, edit this file:
C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow. For 
example, to make avatars have a height and width of 166 pixels, 
change 125 to 166 in both these lines.
Dim Width As Integer = 125

Field Description
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5. Click the Update button ( ).

Deleting Membership Users
To delete a membership user, follow these steps.

1. Access the View Membership User screen of the membership 
user you want to edit, as described in ”Viewing Membership 
User Information” on page 681.

2. Click the Delete button ( ).

3. A confirmation message is displayed.
4. Click OK.

Membership User Groups
IMPORTANT! Membership User Groups and Community Groups are two different concepts. 

Community Groups allow users with similar interest to join together in a social 
networking environment. See ”Community Groups” on page 870. Membership 
User Groups are explained below.

Membership user groups organize similar membership users, 
reducing the effort required to assign identical permissions to many 
users. You can assign them permission to any folder by going to 

Forum 
Signature

Adds a signature to the membership user’s posts in the forum. You do 
not see the signature in the editor. It only appears after you click the 
Post button.

Field Description
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Folder Properties > View Permissions for Folder > View 
MemberShip users.

The following sections explain membership user group 
management.

• ”Adding Membership User Groups” on page 687

• ”Viewing Users in a Membership User Group” on page 688

• ”Adding Membership Users to a Membership User Group” on 
page 688

• ”Setting Permissions on Private Content for Membership User 
Groups” on page 688

• ”Editing Membership User Group Name” on page 689

• ”Deleting User from Membership User Group” on page 689

• ”Deleting Membership User Groups” on page 689

Adding Membership User Groups
To create a new membership user group, follow these steps.

1. Access the membership user group folder, as described in 
”Accessing the Membership Module Folder” on page 677.

2. Click the Add Membership User Group button ( ).

3. The Add a New User Group screen is displayed.
4. Enter a unique name for the group.
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5. Click the Save button ( ).

See Also:  ”Membership User Groups” on page 686

Viewing Users in a Membership User Group
To view the information about a membership user group, follow 
these steps.

1. Access the membership user group folder, as described in 
”Accessing the Membership Module Folder” on page 677.

2. Click the membership user group you want to view.
3. The View Users In Group screen is displayed.
See Also: ”Membership User Groups” on page 686

Adding Membership Users to a Membership User Group
To add a membership user to a membership user group, follow 
these steps.

NOTE Only membership users can be added to membership user groups.

1. Access the View Membership User Group screen for the 
membership user group to which you want to add a 
membership user, as described in ”Viewing Users in a 
Membership User Group” on page 688.

2. Click the Add Membership User button ( ).

3. The Add User to Group screen is displayed.

NOTE Only membership users who do not belong to the group appear.

4. Click the user you want to add.
5. A confirmation message is displayed.
6. Click OK.
See Also: ”Membership User Groups” on page 686

Setting Permissions on Private Content for Membership User 
Groups

See ”Assigning Permissions for Memberships” on page 690 
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Editing Membership User Group Name
To edit a membership user group name, follow these steps.

NOTE The membership user group, All_members, cannot be edited.

1. Access the View Membership User Group screen for the 
membership group you want to edit, as described in ”Viewing 
Users in a Membership User Group” on page 688.

2. Click the Edit button ( ).

3. The Edit User Group screen is displayed.
4. Change the membership group name.

5. Click the Update button ( ).

See Also: ”Membership User Groups” on page 686

Deleting User from Membership User Group
To remove a user from a membership user group, follow these 
steps.

1. Access the View Membership User Group screen for the 
membership user group that contains the membership user 
you want to delete, as described in ”Viewing Users in a 
Membership User Group” on page 688.

2. Click the name of the membership user you want to remove.
3. The View User Information screen is displayed.

4. Click the Delete button ( ).

5. A confirmation message is displayed.
6. Click OK.

Deleting Membership User Groups
To delete a membership user group, follow these steps.

1. Access the View Membership User Group screen for the 
membership user group you want to delete, as described in 
”Viewing Users in a Membership User Group” on page 688.

2. Click the Delete button ( ).

3. A confirmation message is displayed.
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4. Click OK.

Assigning Permissions for Memberships
After you create membership users and groups, you can assign 
them permissions to content folders. To do so, follow these steps.

1. Access the permissions table for the content or folder to which 
you want to assign membership permissions.

2. If necessary, break the inheritance for the content or folder. 
See Also:  ”Inheritance” on page 718

3. If desired, set the folder or item to Private. See Also: ”Private 
Content” on page 692

4. Click View MemberShip Users on the right side of the 
permissions table.

5. The membership users/user groups added to the permissions 
table are displayed.

6. Click the Add button ( ).

For See

Content folders ”Setting Permissions for a Content Folder” on 
page 720

Content ”Setting Permissions for Content” on page 724
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7. The Add Permissions screen is displayed.
8. Click a username or user group name to add to the 

permissions table.
9. The Add Permissions Options screen is displayed.
10. Check appropriate permissions for the membership user or 

group. 

11. Click the Save button ( ).

Troubleshooting Problems with Membership Users 
and Groups

Symptom Problem Solution

Error 
message:
Response 
object 
error 'ASP 
0251 : 
80004005'

Response 
Buffer 
Limit 
Exceeded

Response Buffer exceeded its 
limit

Increase limit. To do so, follow these steps.

1. Stop IIS.

2. Locate the file 
%WinDir%\System32\Inetsrv\Metabase.xml

3. Modify the AspBufferingLimit value.

4. Restart IIS.
The default value is 4194304, which is about 4 MB. 
Suggest changing it to 20MB (20971520) and see if 
that helps.
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Private Content

Private content is only available to CMS users or membership 
users with at least Read-Only permissions for its folder. Those 
users must log in to work with the private content. Unauthorized 
site visitors cannot see it.

You can designate a folder to be private. In that case, all content in 
it and its subfolders is private (if they inherit permissions). 
Alternatively, you can designate specific content items as private.

To demonstrate private content, the following table shows how a 
user’s status affects the display of content in three scenarios.

Scenario Private Content Web Page

Site visitor

Logged in user 
with read-only 
permissions
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Making a Folder Private

NOTE You can only set content to private when inheritance is broken. See Also: 
”Inheritance” on page 718.

To make a folder private, follow these steps.

1. In the Workarea, navigate to the folder that you want to make 
private.

2. Click View > Folder Properties.

3. Click the View Permissions button ( ).
4. If necessary, uncheck the box that says Allow this object to 

inherit permissions. (Inheritance must be disabled before you 
can make the content private.)

5. Check the box that says The content in this folder is private 
and can only be viewed by authorized users and members.

6. A confirmation message is displayed.
7. Click OK.
All content in the folder is now private. As new content is added, it 
is automatically set to private.

Logged-in user 
with edit 
permissions

Note: You can determine the appearance of the menu shown above. See ”The Server 
Control Web Site Menu” on page 15.

Scenario Private Content Web Page
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Making Content Private
To make any content private, follow these steps. See Also: ”Making 
Assets Private” on page 694

1. In the Workarea, navigate to the folder that contains the 
content you want to make private.

2. Click the content item you want to make private.

3. Click the View Permissions button ( ).
4. If necessary, uncheck the box that says Allow this object to 

inherit permissions. (Inheritance must be disabled before you 
can make the content private.)

5. Check the box that says This content is private and is NOT 
viewable on the public Web site.

6. A confirmation message is displayed.
7. Click OK.
The content is now private.

Making Assets Private
If assets are set to private, they are handled like other private 
content with one important exception: Unless you follow the 
procedure described below, anyone can access an asset by typing 
the URL of the asset into the browser’s address field.

If a user attempts to access the asset in any other way (such as, 
linking to it from a Web page), the regular methods of making 
content private work. See ”Making a Folder Private” on page 693 
and ”Making Content Private” on page 694.

To make assets private even if someone types their URL into the 
browser’s address field, follow these steps.

NOTE If site users receive a 404 Page Not Found Error when trying to view private 
assets, make sure you have completed all step below.

1. Open your Web site’s web.config file, located in the site root 
folder.

2. Make sure the following line is uncommented.
<remove verb="GET,HEAD,POST" path="*"/>
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3. Comment out the eight lines indicated below. 
<httpHandlers>
<remove verb="GET,HEAD,POST" path="*"/>
<add 
verb="HEAD,OPTIONS,PROPFIND,PUT,LOCK,UNLOCK,MOVE,COPY,GETLIB,PROPPATCH,MKCOL,DELETE,(GETSOURCE),(HEA
DSOURCE),(POSTSOURCE)" path="*" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<!--<add verb="GET,POST" path="*.doc" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.docx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.xls" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.xlsx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.ppt" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.pptx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.vsd" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.vsdx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>-->

Eight add verb statements in the middle are commented out.
4. Make sure the following line is uncommented.

<add verb="GET,HEAD,POST" path="*" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

5. Save web.config.
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Custom User Properties

Custom User Properties allow you to create custom fields. These 
custom fields appear on the User Properties and Membership User 
Properties screens, and on the Membership server control. They 
are used to define information about a user beyond the standard 
Ektron CMS400.NET user properties, such as Username, First 
Name, Password and email Address.

Examples of Custom User Properties might be:

• employee ID

• phone number

• phone extension

• instant message screen name

• position

• start date

• department

• birthday

• the IP address of the user’s machine

Your ability to create and manage custom user properties is 
explained through the following topics.

• ”The View Custom Properties Screen” on page 697

• ”Adding a Custom User Property” on page 698

• ”Editing a Custom User Property” on page 707

• ”Deleting a Custom User Property” on page 708

• ”Setting the Custom User Properties Order” on page 709

• ”Using Custom User Properties for Non-English Languages” on 
page 711
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NOTE Only members of the Administrator User Group can work with Custom User 
Properties.

The View Custom Properties Screen
Use the View Custom Properties screen to create custom 
properties for users and membership users. From the View 
Custom Properties screen, you can:

• add a new custom property. See ”Adding a Custom User 
Property” on page 698

• edit a custom property. See ”Editing a Custom User Property” 
on page 707

• reorder the way custom properties appear on the users and 
membership users screen. See ”Setting the Custom User 
Properties Order” on page 709

• work with custom properties in different languages. See ”Using 
Custom User Properties for Non-English Languages” on 
page 711

Below is an example of the View Custom Properties screen.

The table below describes the View Custom Properties screen.

Buttons, Dropdown 
Boxes or Fields

Description For More Information

Add button ( ) Add custom user properties. ”Adding a Custom User 
Property” on page 698
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Adding a Custom User Property
After you add a custom user property, it appears on all User and 
Membership User Information screens, under the User Properties 
header. When new users and membership users are added, 
custom user properties appear during the creation process.

Reorder button ( ) Change the order in which the custom 
properties appear on the Users or 
Membership User Properties screen.

”Setting the Custom User 
Properties Order” on 
page 709

Language Selection 
Dropdown List 

( )

Allows you to view custom user properties by 
language.

”Viewing Custom User 
Properties By Language” 
on page 714

Title Field Displays the title of a custom user property. 
When viewing by language, the title changes 
to the title used in a specific language if it has 
been defined. Click a Title to edit the 
property.

Note: The title and label are the same field. 
On some screens, Title is used; on others 
Label is used.

”Editing a Custom User 
Property” on page 707

Type Field Shows the Type that was chosen for a 
custom user property.

”Type” on page 700

Buttons, Dropdown 
Boxes or Fields

Description For More Information
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Follow these steps to add a custom user property.

1. In the Workarea, click Settings > Configuration > User 
Properties > User Properties.

2. Choose the standard language used in your Ektron 
CMS400.NET Workarea.

3. Click the Add Property button ( ).

4. The Add Custom Property screen appears.
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5. Complete the screen according to the table below.

The Custom User Properties Fields
The following table describes the custom user properties fields

Field Description More Information

Label Title of the property you are adding. For example, Employee ID.

Note: The Title and Label are the same field. On some screens the 
word Title is used, on others the word Label is used.

Type The property’s data type. Once a type is selected and saved, you 
cannot change it. You must delete the custom property and re-
enter it.

”The Type Field” on 
page 701

Input Type Choose how a user is able to enter a response to the property. ”The Input Type Field” 
on page 702

Validation Ensures the right type of data is entered in a text box or text area. ”Validation” on 
page 703

Min Value If desired, enter the minimum value you want to allow. The Min 
Value only appears when the following Validations are used: 
Numeric Only, Date Only and U.S. Zip Code. 
The following is an example of a Date Only Min Value: 01/01/1900. 
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6. Click the Save button ( ).

7. The new property appears on the View Custom Properties 
screen.

The Type Field

The following table describes the types available in the Type field.

Max Value If desired, enter the maximum value you want to allow. The Max 
Value only appears when the following Validations are used: 
Numeric Only, Date Only and U.S. Zip Code. 
The following is an example of a Date Only Max Value: 01/01/
1987. 

Message A message that appears when information entered in a user 
property violates the validation criteria.
For example, if the validation is U.S. Zip Code, you might use the 
following message: Please enter a valid zip code

Field Description More Information

Types Description Input Types 
Available

Validations 
Available

String Accepts all alpha, numeric, and symbol 
characters

• Text Box

• Text Area

• Hidden

All validations
See Also: 
”Validation” on 
page 703

Boolean Accepts a true or false response • Check Box None

Numeric Accepts numbers only • Text Box • No Validation

• Cannot be blank

• Numeric Only

• U.S. Zip Code

• Dollar Amount



Custom User Properties

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 702

The Input Type Field

The following table describes possible responses to the Input 
Type field.

Date Only a date can be entered. • Text Box • No Validation

• Cannot be blank

• Date Only

SelectList Select a response from a list of choices.
See Also: ”SelectList Field” on page 705

NA NA

Multi 
SelectList

Select any number of responses from a list 
of choices. See Also:  ”MultiSelectList 
Field” on page 706

NA NA

Category A system-defined type that appears when 
the first subscription is created. One entry 
covers all subscriptions.
See Also: ”Defining Subscriptions” on 
page 953.

NA NA

Types Description Input Types 
Available

Validations 
Available

Input Type Description An Option When 
Used With

Text Box Creates a standard text box. Below is an example of a text 
box.

• String

• Numeric

• Date

Text Area Creates a multi-lined area for entering text. Typically used 
when more than one line of text needs to be added. Below is 
an example.

• String
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Validation

The following table describes the validations available in the 
Validation field.

Hidden Hides the input field. This can be used by an administrator to 
add additional values at postback time. This requires a 
developer to add client-side JavaScript.

• String

Check Box Creates a checkbox. Used when the field requires a boolean 
(true / false) response. Below is an example of a check box.

 = True   = False

• Boolean

Input Type Description An Option When 
Used With

Validation Description An Option When 
Used With

No Validation The entry is not checked. • String

• Numeric

• Date

Cannot be blank A response must be entered. • String

• Numeric

• Date

Numeric Only The response must be a number. • String

• Numeric

Text Only The response must be characters. • String

Date Only  The response must be entered in the following format: mm/
dd/yyyy.

• String

• Date

Email Only The response must be entered as an Email address. For 
example, username@domain.domainextention.

• String
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Credit Card Only  The response must be entered as a credit card number. For 
example, nnnn nnnn nnnn nnnn

• String

Social Security 
Only

 The response must consist of nine digits in this pattern: nnn-
nn-nnnn.

• String

U.S. State Code A two letter state code. For example: NH = New Hampshire. • String.

U.S. Zip Code The response must consist of 5 (nnnnn) or 9 digits separated 
by a dash after the fifth (nnnnn-nnnn).

Note: If you use the Numeric Type, you cannot have a dash 
or space when using a nine digit Zip Code

• String

• Numeric

Valid US Phone 
Number

The response must consist of a 10 digits in this pattern: nnn-
nnn-nnnn.

• String

Canadian Postal 
Code

 The response must consist of 6 (xnx nxn) alpha or numeric 
characters with a space after the first three characters.

• String

Time HH:MM or 
HH:MM:SS or 
HH:MM:SS.mm

Time is entered in one of the following three formats.
HH:MM - Hours and Minutes 09:30
HH:MM:SS - Hours, Minutes and Seconds 09:30:45
HH:MM:SS.mm - Hours, Minutes, Seconds and milliseconds 
09:30:45.002

• String

IP Address The response must be in the form of an IP address. • String

Dollar Amount This validation works differently depending on the Type used. 
If used with the String Type, you can have a dollar sign ($) 
along with the money amount in the text field. 
When used with the Numeric Type, you are not allowed to 
have a dollar sign ($) in the text field. The following are 
examples of each type with validation:
String - $3.00
Numeric - 3.00

• String

• Numeric

Canadian Social 
Insurance Number

 The response must consist of nine digits in this pattern (nnn 
nnn nnn).

• String

Validation Description An Option When 
Used With
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SelectList Field

Use a SelectList field to present the user completing the User 
Information or Membership User Properties screen with a list of 
choices. See example below.

When you create a custom user property and specify its type to be 
Select List, the screen changes as shown below.

Completing a SelectList Field Entry

To add an item to the list, enter its text in the Text field, then click 
the Add button. Added items then appear in the larger box on the 
left.

You can then

• remove any item from the list by clicking it. It appears in the 
Text field. Click Remove.
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• change the text of any list item by clicking it. It appears in the 
Text field. Make changes then click Change.

• change the sequence of list items by selecting an item then 
clicking the up or down arrow to move the item

Using the First List Item to Prompt a Response

You can use the first list item to prompt the user to make a 
selection instead of being a valid response. For example, the first 
list item may say Select from a list of choices. To do this, check 
the First item is not a valid selection for example, “[Select]” 
check box.

If you do, the field has an asterisk (*) next to it (indicating it is 
required) on the User Information and Membership User 
Properties screens. The user completing the screen must choose 
any selection other than the first item. If he tries to file the screen 
without choosing a different item, the following error message 
appears:

Please fill in all required fields (*)

MultiSelectList Field

Use a MultiSelectList field to present the user completing the 
User Information or Membership User Properties screen with a list 
of choices. The user can choose as many responses as 
appropriate. See example below.

Selected items are indicated by a blue background.

When you create a custom user property and specify its type to be 
MultiSelect List, the screen changes as shown below.
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For information about completing the screen, see ”Completing a 
SelectList Field Entry” on page 705.

Editing a Custom User Property
When you click a custom user property’s title, you are brought to 
the Edit Custom Property Screen. From this screen, you can edit 
and delete a custom property or create a version of the custom 
property in a non-English language.

When you edit a custom user property, the changes are applied to 
all users and membership users. These changes are also applied 
to any other language versions of the custom properties that exist. 

To learn how to:

• edit a custom user property. See ”Editing a Custom User 
Property” on page 708.

• delete a custom property. See ”Deleting a Custom User 
Property” on page 708.

• create a custom property for a non-English language. See 
”Create a Custom User Property for a Non-English Language” 
on page 711.
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Editing a Custom User Property
When editing a custom user property, the changes are available to 
users and membership users when the save button is clicked.

Follow these steps to edit a custom user property.

1. In the Workarea, click Settings > Configuration > User 
Properties > User Properties.

2. Click the Title of the Custom User Property you want to edit.
3. Choose the field you want to change. You can edit the following 

fields:

• Label

• Input Type

• Validation

• Min Value

• Max Value

• Message
For descriptions of these fields, see ”The Custom User 
Properties Fields” on page 700.

NOTE You cannot edit the Type field. If you need to change the type, you must delete 
the custom user property and create a new one.

WARNING! If you delete a custom user property, it is removed from all users and membership 
users. Any information that has been collected about users and membership 
users for that property will be lost. In addition, any language versions of the 
custom user property are deleted.

4. Click the Save button ( ).

5. When you click a user or membership user, you see your 
changes.

Deleting a Custom User Property
If you delete a custom user property, it is removed from all users 
and membership users. Any information that has been collected 
about users and membership users for that property will be lost. In 
addition, any language versions of the custom user property are 
deleted.
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Follow these steps to delete a custom user property.

1. In the Workarea, click Settings > Configuration > User 
Properties > User Properties.

2. Click the Title of the custom user property you want to delete.

3. Click the Delete button ( ).
A dialog box appears asking if you are sure you would like to 
delete the item. 

4. Click OK.
5. The View Custom Properties screen appears, and the property 

is no longer available.

Setting the Custom User Properties Order
From the View Custom Properties screen, you can set the order in 
which the properties appear on the User and Membership Users 
Properties screen. To set the custom user properties order, 
complete these steps.

1. In the Workarea, click Settings > Configuration > User 
Properties > User Properties.

2. Click the Reorder button ( ).

3. The Reorder Custom Properties screen appears. 
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4. Click a property.

5. Click the Up or Down arrows ( ) to move the property up or 
down the list.

6. Click the Save button ( ).

7. On the View Custom Properties screen, you now see the 
properties in the new order. If you go to the User or 
Membership User Properties screen, the order of the 
properties there now reflects the changes.
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Using Custom User Properties for Non-English 
Languages

Like content, custom user properties have a language attribute. 
This is useful if you have users or membership users that only use 
a specific language. It can also be used if you want a custom user 
property to appear in the language in which the user is signed in.

Unless a language other than English is defined for a custom user 
property, the property defaults to the English version. For example, 
if you have two properties called Birthday and Phone Number in 
English and you can translate the French version of Birthday to 
Anniversaire, when you view the properties in French, you see the 
English version of Phone Number and the French version of 
Birthday.

Create a Custom User Property for a Non-English Language
When creating a custom user property, it must be created in 
English then translated to the desired language. This is done by 
editing the property, changing languages, filling out the Translate 
Custom Property Label screen and saving the property.
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IMPORTANT! All custom user properties in languages other than English are tied to the English 
version of the property. If you delete the English version of the property, all other 
language versions of the properties are deleted also. However, you can remove a 
non-English language version of the custom properties without deleting the 
English version. See ”Removing a Non-English Custom User Property Title” on 
page 712

The following steps illustrate how to translate the Title/Label of a 
property into French.

1. In the Workarea, click Settings > Configuration > User 
Properties > User Properties.

2. Choose a custom property to be defined in another language.
3. Choose a language from the language select dropdown box.

4. The Translate Custom Property Label screen appears.
5. Enter a Label for the property in the language you have 

chosen. For example, if you are creating a French version of a 
Birthday custom user property, you would enter Anniversaire in 
the label text field. For information on the Label property, see 
”Label” on page 700

6. Click the Save button ( ).

Removing a Non-English Custom User Property Title
Removing a non-English version of a custom user property title 
does not remove the english version of the property. When you 
remove the non-English version of a property, you are basically 
removing the label for that specific language in the custom 
property.

1. In the Workarea, click Settings > Configuration > User 
Properties > User Properties.
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2. Choose the language in which the custom user property 
appears from the Language Dropdown Box.

3. Click the Title you want to delete.

4. The Translate Custom Property Label screen appears.

5. Click the Delete button ( ).

6. A dialog box appears asking if you would like to remove the 
translated custom property title.

7. Click OK.
8. The English version of the Edit Custom Property screen 

appears.

9. Click the Back button ( ).
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WARNING! Do not click the delete button on the Edit Custom Property screen. This action 
deletes the English version of the custom user property. If you click the delete 
button, you lose all information collected by the property and all language 
versions of the property.

Viewing Custom User Properties By Language
From the View Custom Properties screen, you can view the 
custom users properties by languages. When viewing by 
languages, it is important to remember that if there is only an 
English version of the property, the English version appears in all 
the languages.

All custom user properties, in languages other than English, are 
tied to the English version of the property. If you delete the English 
version of the property, all other language versions of the 
properties are deleted. 

To view the custom user properties by language, follow these 
steps.

1. In the Workarea, click Settings > Configuration > User 
Properties > User Properties.

2. Choose the language in which to view the properties from the 
language dropdown box.

3. The View Custom Languages screen for that language 
appears.
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NOTE In the example below, some properties have not been translated, so the English 
versions appear instead.
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Setting Permissions

Permissions determine which actions users and members of user 
groups can perform on content, library items, and content folders. 
For example, you allow your Webmaster to perform the most 
advanced actions, such as adding folders, editing folder properties, 
and deleting folders. At the same time, you restrict content 
contributors to viewing, editing, and adding new content.

You can set permissions for a content folder or content item. When 
you assign permissions to a content folder, it affects all of its 
subfolders unless you break inheritance for a subfolder.

Permissions are explained through the following topics:

• ”Who Is Authorized to Set Permissions” on page 716

• ”Setting Permissions through the Permissions Table” on 
page 716

• ”Inheritance” on page 718

• ”Standard & Advanced Permissions” on page 718

• ”Setting Permissions for a Content Folder” on page 720

• ”Setting Permissions for Content” on page 724

Who Is Authorized to Set Permissions
Only Ektron CMS400.NET administrators and users identified on 
the Manage Members for Role: Folder User Admin screen can set 
permissions. See Also: ”Using the Roles Screens” on page 736

Setting Permissions through the Permissions Table
IMPORTANT! All members of the Administrators group are automatically granted all permissions 

to all Ektron CMS400.NET folders. Although these users do not appear when you 
view a folder’s permission settings, they have full permissions.
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You manage the following permissions through the Permission 
Table (illustrated below).

• Content management: view, add, edit, delete, restore

• Library File Management: view, add images, add other types of 
files, add hyperlinks, overwrite files

• Folder management: add, edit, delete, traverse

• Work with Collections and Menus

NOTE You can use the Roles screens to assign additional permissions that are not 
defined in the Permission Table, such as the ability to create tasks. See Also: 
”Defining Roles” on page 735

The Permission Table appears when you click the Permission 
button ( ) from a folder’s or content item’s Properties window.

Best Practice
If you need to assign multiple users the same permission, Ektron 
recommends placing them in a user group and assigning the group to the 
Permission Table. If you assign too many users in the Permission Table, 
your system's response time may degrade.
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Inheritance
By default, all content folders and items inherit permissions from 
their parent folder. You have two options for modifying 
permissions.

• Modify the permissions of the parent folder - see ”Setting 
Permissions for a Content Folder” on page 720

• Break inheritance and add permissions to a folder

Breaking Inheritance
To break inheritance from a parent folder, follow these steps.

1. Access the Permissions Table for a content folder or content in 
your Workarea, as described in ”Accessing the Permissions 
Table” on page 720.

2. Remove the check mark from the box that says Allow this 
object to inherit permissions.

3. A confirmation message appears.
4. Click OK.

Restoring Inheritance
To restore inheritance for a content folder or content, follow these 
steps.

1. Access the Permissions Table as described in ”Accessing the 
Permissions Table” on page 720.

2. Place a check in the box that says Allow this object to inherit 
permissions.

3. A confirmation message appears.
4. Click OK.

Standard & Advanced Permissions
There are two categories of permissions. You assign permissions 
in each category from a different screen.

• Standard Permissions - basic functions
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• Advanced Permissions - administrator level functions

The following table explains the permissions in Ektron 
CMS400.NET.

Category Permission Allows user/user group to perform this action on 
content in selected folder

Standard Read Only View content 

Edit Edit content

Add Add content

Delete Delete content 

Restore Restore old versions of content 

Library Read Only View items in the corresponding library folder 
See Also: ”Managing Library Items” on page 175

Add Images Upload images to the corresponding library folder

Add Files Upload files to the corresponding library folder 

Add Hyperlinks Add hyperlinks to the corresponding library folder

Overwrite Library Overwrite images and files to the corresponding library folder
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Setting Permissions for a Content Folder
You can set permissions for any content folder and language from 
the Folder Properties screen. Here is the Permissions button on 
the Folder Properties screen.

Accessing the Permissions Table
To access the Permissions Table, follow these steps.

1. Select a content folder from the left frame of the Workarea.
2. Click View.
3. From the language dropdown, select the language whose 

folder properties you want to update.

Advanced Collections Manage collections See Also: ”Collections” on page 606 

Add Folders Add sub folders See Also: ”Search Content Folder” on page 62

Edit Folders Edit folder properties See Also: ”Folder Properties” on page 36 

Delete Folders Delete the current folder or its subfolders

Traverse Folders Access folders under the root folder. By default, the Everyone 
user group has permission to view all subfolders.
If you disable or modify the Everyone user group, and you want 
to grant users/groups permission to a folder other than the root 
folder, you must also assign Traverse permission. If you do not, 
the user cannot access the folder. In that case, the user cannot 
perform any other granted permissions.

Modify Preapproval Set or update a folder’s preapproval group. See Also: 
”Automatic Creation of Tasks Associated with Content” on 
page 376

Category Permission Allows user/user group to perform this action on 
content in selected folder
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4. Click View > Folder Properties. The Folder Properties screen 
appears.

5. Click the Permissions button ( ).

6. The Permissions Table appears.
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The Permissions Table displays each user’s abilities to perform 
actions on content within the selected folder. Since all permissions 
cannot fit on one screen, you can click View Advanced 
Permissions to see the other group.

After viewing the permissions, you can change them. Below is a list 
of actions you can perform from this screen.

Actions You Can Perform from the Permissions Table

The following table summarizes actions you can perform from the 
Permission Table screen.

Action How to perform it For more information, see

View advanced 
permissions

Click View Advanced 
Permissions

”Standard & Advanced Permissions” on 
page 718

Add user or group to 
permission table Click 

”Adding a User or User Group to the 
Permissions Table” on page 723

Remove user or group 
from permission table Click 

”Deleting Users or User Groups from the 
Permissions Table” on page 724

View membership 
users

Click View MemberShip users ”Community Folders” on page 43

Have this folder inherit 
permissions from 
parent folder

Check box next to Allow this 
object to inherit permissions

”Inheritance” on page 718

Make content in this 
folder private

Check box next to The content 
in this folder is private and 
can only be viewed by 
authorized users and 
members

Note: If Allow this object to 
inherit permissions is 
checked, you cannot check this 
box. In that case, this folder is 
inheriting this setting from its 
parent folder.

”Private Content” on page 692
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Adding a User or User Group to the Permissions Table
To add a user or user group to the Permissions Table, follow these 
steps.

NOTE Before adding users or groups, you must break inheritance. See ”Inheritance” on 
page 718.

NOTE If a user and the user group to which that user belongs are both given permission 
to a folder, the user has all permissions to which he/she is assigned as well as 
permissions assigned to the user group.

NOTE You can only assign Read Only permission to a Membership user or user group. 
See Also: ”Membership Users and Groups” on page 675

1. Access the Permissions Table for the content folder or content, 
as described in ”Accessing the Permissions Table” on 
page 720.

2. Click the Add button ( ).

3. The Add Permissions screen appears. Only users and groups 
not assigned to the Permissions Table appear.

4. Click a user or group to add to the Permissions Table.
5. The Add Permissions screen appears.
6. Check the standard and advanced permissions for the user or 

group. Refer to ”Standard & Advanced Permissions” on 
page 718 for a description of permission options.

NOTE Check Enable All to assign all standard permissions. If you do, you still must 
assign advanced permissions by hand.

7. Click the Save button ( ).

Editing User or User Group Permissions
To add or remove permissions for a user or group, editing the user 
or group in the Permissions Table. To do so, follow these steps.

1. Access the Permissions Table for the content folder or content, 
as described in ”Accessing the Permissions Table” on 
page 720.
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2. Click the user or group for which you want to edit permissions.
3. The Edit Permissions screen appears.
4. To assign any permission, check the box. To remove any 

permission, uncheck the box.

NOTE Remember to toggle between standard and advanced permissions.

5. Click the Update button ( ).

Deleting Users or User Groups from the Permissions Table
To remove permissions from a user or user group, use the Delete 
button on the View Permissions window. To do so, follow these 
steps.

1. Access the Permissions Table for the content folder or content, 
as described in ”Accessing the Permissions Table” on 
page 720.

2. Click the Delete button ( ).
3. The Remove Permissions screen appears.
4. Click the user or group to remove from the Permissions Table.
5. A confirmation message appears.
6. Click the OK button.

NOTE When you delete the permissions of a user or user group, that change is 
propagated to all subfolders and content. Also, if the user or group was part of an 
approval chain, they are removed from it.

See Also: ”Setting Permissions” on page 716

Setting Permissions for Content
You can assign permissions to a single content item, overriding the 
default permissions inherited from the folder. To do so, follow these 
steps.

1. Access the content by navigating to its folder, selecting a 
language, and clicking on it.
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2. Click the View Permissions button ( ).

3. Uncheck the box next to Allow this object to inherit 
permissions.

4. A confirmation message appears. Press OK.
5. You can perform any action on the content that you can 

perform on a folder. These options are described in ”Actions 
You Can Perform from the Permissions Table” on page 722.
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Setting Approval Chains

What is an Approval Chain?
An approval chain is a series of users or user groups who must 
approve content before it can be published on your Web site. 
When the last person in the chain approves content, it goes live.

Also, if a user deletes content, before it can be removed from 
Ektron CMS400.NET, it must pass through the approval chain 
before it is deleted.

An approval chain can include any number of users or user groups. 
However, to be eligible, a user or user group must have 
permissions to the content folder or content item. See Also:  
”Setting Permissions” on page 716

NOTE If you assign a user group to an approval chain, only one member of the group 
needs to approve the content, not all members.
Also, if a user appears in an approval chain twice (both as a user and part of a 
user group), the approval chain skips the second approval because the user has 
already approved the content.

You can set up an approval chain for a content folder or a content 
item as well as a language. See Also: ”Multi-Language Approval 
Chains” on page 836

Finally, the Approval Method determines if content must be 
approved by all users in the chain, or only users higher up the 
chain than the one making the edits.

This chapter explains how to manage approval chains through the 
following subtopics.

• ”Examples of Approval Chains” on page 727

• ”Inheritance and the Approval Chain” on page 727

• ”Creating an Approval Chain for a Content Folder” on page 728

• ”Editing an Approval Chain For Content” on page 732

• ”The Approval Method” on page 732
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NOTE Only Ektron CMS400.NET administrators and users identified on the Manage 
Members for Role: Folder User Admin screen can modify the approval chain.

Examples of Approval Chains
An approval chain lets you control how and when your Web site is 
updated. For example, if your Webmaster needs to approve every 
new content item or update of an existing item, he would be last 
user in every approval chain and exert total control over the site.

Alternatively, you could set up a less centralized organization, 
where each department head controls his section. To 
accommodate this, set up an approval chain for each department, 
and assign the department head as the last person in the chain.

On the opposite extreme, you can delete the approval chain for a 
content item or folder. In this case, every item in that folder is 
published as soon as a user submits it for publication.

Inheritance and the Approval Chain
An approval chain’s inheritance is determined by the 
corresponding permission table. So, if a folder’s permission table 
inherits settings from its parent folder, that folder’s approval chain 
also inherits. To learn about enabling and disabling permission 
table inheritance, see ”Inheritance” on page 718.

The Approval Chain screen only displays its inheritance status; it 
does not let you set it.
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Creating an Approval Chain for a Content Folder
Before you can create or edit an approval chain, you must access 
the View screen.

Viewing a Folder’s Approval Chain
To view a folder’s approval chain, follow these steps.

1. Select a folder from the left frame of the Workarea.
2. Click View > Language.
3. Select the language of the approval chain you want to view.
4. Click View > Folder Properties.

5. Click the Approvals button ( ).

6. The approval chain appears in the lower section of the screen.

This screen shows the following information about the approval 
chain.

• its language

• every user and user group in the approval chain

• the approval order

• the approval method (See also: ”Changing the Approval 
Method” on page 733)

• toolbar buttons for modifying the approval chain and method
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Actions You can Perform from the Approvals Screen

From this screen, you can perform these actions.

Adding Approvers
To add a user or user group to the approval chain, follow these 
steps.

1. Access the approval table, as described in ”Viewing a Folder’s 
Approval Chain” on page 728.

2. Select the language of the approval chain. The chain only 
applies to content in this language.

3. Click the Add button ( ).

4. The Add Approvals screen appears.

NOTE Only users and user groups with permissions to the folder appear. See ”Adding a 
User or User Group to the Permissions Table” on page 723 for more information.

Action Button See this section for details

Add approvers ”Adding Approvers” on page 729

Remove approvers ”Deleting Approvers” on page 731

Change the order of users in the 
approval chain

”Editing the Approval Order” on page 730

Change the approval method ”Changing the Approval Method” on page 733

Change the language of the 
approval chain

Content 
Language

”Multi-Language Approval Chains” on page 836

Best Practice
Ektron suggests assigning user groups to the approval chain, as opposed 
to individual users. In this way, if someone is out of the office for a day, 
another group member can approve the content.
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5. Click the user or user group to add to the approval chain.
6. A confirmation message appears.
7. Click OK.

NOTE If you assign a user group to an approval chain, any member of the group can 
approve the content, not all members.

Editing the Approval Order
After you assign approvers to a folder, you may want to adjust the 
approval order. Place the user or group with final review at the end 
of the approval chain (that is, the highest number).

For example, if you have a content contributor whose edits must be 
approved by a department head, and the Webmaster has final 
review of all content, the approval order would look like this.

To edit the approval order, follow these steps.

1. Access the approval table as described in ”Viewing a Folder’s 
Approval Chain” on page 728.

2. Select the language.

3. Click the Reorder button ( ).

4. The Edit Approval Order screen appears.

User or Group Name Approval Order

Content contributor 1

Department Head 2

Webmaster 3



Setting Approval Chains

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 731

5. Click the user or group whose approval order you want to 
change.

6. Click the Up ( ) or Down ( ) arrow to move the user or 
group to the desired order.

7. Click the Save button ( ).

Deleting Approvers

NOTE If a user in an approval chain is deleted from the permissions table, he or she is 
automatically deleted from the approval chain.

To delete a user or user group from an approval chain, follow these 
steps.

1. Access the approval table as described in ”Viewing a Folder’s 
Approval Chain” on page 728.

2. Select the language.

3. Click the Remove button ( ).
4. The Remove Approval screen appears.
5. Click the user or group that you want to remove from the 

approval chain.
6. A confirmation message appears.
7. Click OK.
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Editing an Approval Chain For Content
At times, you may need to change the approval chain for a specific 
content item. Use the Approvals button ( ) on the View Content 
screen to change a content item’s approval chain.

Viewing an Approval Chain for Content
To view the approval chain for content, follow these steps.

1. Navigate to the folder that contains the content.
2. Click the content.

3. Click the View Permissions button ( ).

4. Uncheck the checkbox next to Allow this object to inherit 
permissions. 

5. Return to the View Content screen.

6. Click the Approvals button ( ).

7. The content’s approvals table appears.

After viewing the content’s approval chain, you can perform the 
same actions on it as you can perform on a folder. This list of 
actions is available from ”Actions You can Perform from the 
Approvals Screen” on page 729.

The Approval Method
The Approval Method determines if content must be approved by 
all users in the chain, or only users higher up in the chain than the 
user making the edits. The approval method only affects the 
approval process if the person submitting content for publishing is 
a member of the approval chain.
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Two approval methods are available.

For example, assume the approval chain is set as below.

If the Approval Method is Force All Approvers, and the 
Department Head submits content, the content must be approved 
by the content contributor, then the department head, and the 
Webmaster before it is published.

If the Approval Method is Do Not Force All Approvers, and the 
Department Head submits content, the content must only be 
approved the Webmaster before it is published.

Changing the Approval Method
By default, the approval method is set to Do Not Force All 
Approvers. To change the approval method for a content folder or 
item, follow these steps.

1. Access the approval table, as described in ”Viewing a Folder’s 
Approval Chain” on page 728.

2. Click the Edit button ( ).

3. The Edit Approval Method screen appears. 
4. Select an approval method by clicking the radio button.

Approval Method Description

Force All Approvers All users in approval chain must approve the content, 
beginning with the first

Do Not Force All Approvers Approvers after the user submitting content in the 
approval chain must approve the content

User or Group Name Approval Order

Content contributor 1

Department Head 2

Webmaster 3
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5. Click the Save button ( ).
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Defining Roles

Ektron CMS400.NET contains an Administrators User Group. Any 
user who is a member of that group automatically has full 
administrator privileges. See Also: ”Guidelines for Using The 
Folder-User Admin Role” on page 738

The Roles feature lets you assign limited or specific administrator 
privileges to users who should not have full administrator 
privileges. For example, you can let certain users create, redirect, 
or remove tasks but deny them other privileges normally granted to 
administrators.

NOTE The Permissions Table lets you control which users can manage a folder’s 
properties, its content, library items, and create or edit collections. (See Also: 
”Setting Permissions” on page 716) So, together, the Roles feature and the 
Permission Table give you the ability to assign administrative privileges to users 
who are not members of the Administrators group.

This section explains the use of Roles through the following topics.

• ”Using the Roles Screens” on page 736

• ”Guidelines for Using The Folder-User Admin Role” on 
page 738

• ”List of Administrator Privileges” on page 739

Best Practice
When creating new user groups to use with roles, assign names as a 
mnemonic aid for the role, especially for folder-specific rules. For 
example, the Marketing Folder Admins user group could be used for all 
role members who can administer the marketing folder. 
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Using the Roles Screens
Use the Roles screens to assign limited administrator privileges. 
To access the Roles screens, go to the Ektron CMS400.NET 
Workarea and select Settings > Roles.

NOTE In the screens listed below, you can select users or groups. However, you can 
never select the Administrators group, because that group already has all 
permissions.

The following table describes the Roles screens.

Screen Lets you give a user or user 
group the ability to

For more information, see

Alias-Edit Assign a manual alias to content ”Permissions for Manual Aliasing” on page 585

Calendar- Admin Create, edit and delete calendars ”Calendar Permissions” on page 552

Collection and 
Menu Admin

Create, edit and delete Collections 
and Menus via the Modules tab.

Note: To manage permissions for 
creating collections and menus via 
the folder’s New > Collection or 
New> Menu option, use folder 
permissions. See Also: ”Setting 
Permissions” on page 716

”Collection Permissions” on page 607; ”Menu 
Feature” on page 618

Collection 
Approver

If approval is required for a 
collection, approve changes to it, 
including the deletion of a collection.

”Setting up Approval for Collections” on page 610

Community 
Group Admin

Create, edit and delete and manage 
all Community Groups.

”Community Groups” on page 870 and the 
Developer Manual section > “Introduction to 
Server Controls” > “Community Platform Server 
Controls”

Community 
Group Create

Create and manage Community 
Groups. A user with this role can 
only manage community groups he 
has created.

”Community Groups” on page 870 and the 
Developer Manual section > “Introduction to 
Server Controls” > “Community Platform Server 
Controls”

Metadata-Admin View, create and edit metadata 
definitions

”Metadata” on page 116
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Business Rule 
Editor

Create or edit Business Rules and 
Rulesets

”Business Rules” on page 592

Smart Forms 
Admin

Create or edit Smart Forms ”Working with Smart Forms” on page 183

Task Create Create tasks ”Task Permissions” on page 366

Task Delete Delete tasks ”Task Permissions” on page 366

Task Redirect Redirect tasks ”Task Permissions” on page 366

Taxonomy 
Administrator

Create and manage taxonomies ”Taxonomy” on page 626

Template 
Configuration

View, create, update, and delete 
system templates

”Creating/Updating Templates” on page 64

User-Admin Create, view, edit, and delete users 
and user groups

”Managing Users & User Groups” on page 662

XLIFF-Admin Use the Language Xport feature, 
which copies content into XLIFF files 
that can be submitted to a translation 
agency.

”Using the Language Export Feature” on page 824

Taxonomy 
Administrator

View, create, update, and delete 
taxonomies and their categories

”Taxonomy” on page 626

Message Board 
Admin

A user with this role can approve 
pending comments or delete existing 
comments on a message board.
Message board comments for users 
and community groups are 
administered on the Web site. 
Message Board comments for 
content can be administered on the 
Web site or from the Content Report 
screen in the Workarea.

”Content Rating” on page 85 and the Developer 
Manual section “Introduction to Server Controls” > 
“Community Platform Server Controls” > 
“MessageBoard Server Control”

Personalization Personalize a web page on your site ”Permissions that Affect Personalization” on 
page 615

Screen Lets you give a user or user 
group the ability to

For more information, see
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Guidelines for Using The Folder-User Admin Role
When setting up users and groups for administrative access over 
folders, keep these in mind.

• After being identified on the Manage Members for Role: Folder 
User Admin screen, users or groups must also be given at 
least Read-Only permission for individual folders on the Folder 
Properties > View Permissions for Folder screen. See Also: 
”Setting Permissions” on page 716

• You must use the same identity on the Manage Members for 
Role: Folder User Admin and Folder properties screens. So, if 
a user group is listed for the role, use the same group when 
assigning folder permissions, not simply a group member. 
Conversely, if individual users are listed on the role screen, 
they must be specified in the folder permission.

• Ektron strongly recommends adding only user groups to the 
Folder User Admin role, not individual users.

If you set up an individual user as a role member, he could 
accidentally receive administrative rights to other folders.

Folder-User 
Admin

View and edit folder properties. 
These users can update properties, 
permissions, the approval chain, 
metadata, Web alerts, purge history, 
etc.
For example, create a user group 
and give it permission to manage the 
top-level marketing folder. Members 
of the group can do everything to 
that folder and its subfolders, but 
lack authority over other folders.
See Also: ”Guidelines for Using The 
Folder-User Admin Role” on 
page 738

”Folder Properties” on page 36

Custom 
Permissions

Would be used by a developer when 
extending Ektron CMS400.NET ’s 
standard features.

Screen Lets you give a user or user 
group the ability to

For more information, see
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List of Administrator Privileges
Administrator privileges include access to most screens that 
appear when you select Settings > Configuration from the lower 
left panel of the Workarea (illustrated below).

Administrators can also 

• edit folder properties (including Web alerts, metadata, 
permissions, and the approval chain)

• manually alias content

• add, edit, or delete a calendar

• add, edit, or delete a business rule

• create, view, edit, and delete metadata definitions
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• create, view, edit, and delete taxonomies

• create, redirect, and delete tasks

• require a collection to go through an approval process

• export content for translation to another language using XLIFF

• perform all personalization functions
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Active Directory Feature

The Active Directory feature allows you to retrieve user and user 
group information from the Microsoft Windows Active Directory 
(AD) into Ektron CMS400.NET. As a result, you can administer 
user information from one place only, and users need to remember 
only one password/username combination to sign on to the 
network and Ektron CMS400.NET.

To learn more about Active Directory, see http://
www.microsoft.com/windowsserver2003/technologies/directory/
activedirectory/default.mspx.

This feature is described through the following top-level topics.

• ”Setup Guidelines” on page 742

• ”Implementing Active Directory Integration” on page 745

• ”Active Directory Integration” on page 745

• ”User Authentication Only Mode” on page 778

• ”Logging into a System that Uses AD Integration” on page 782

http://www.microsoft.com/windowsserver2003/technologies/directory/activedirectory/default.mspx
http://www.microsoft.com/windowsserver2003/technologies/directory/activedirectory/default.mspx
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Setup Guidelines

WARNING! Ektron strongly recommends configuring a secure socket layer (SSL), especially if 
you are using Active Directory Integration. SSL encrypts passwords that are 
otherwise sent as clear text to the Ektron CMS400.NET server. See SSL Support 
in the Ektron CMS400.NET Setup Manual for more information.

The two ways to set up Active Directory are contrasted in the table 
below. Below the table are instructions for each setup option.

Setting Up Active Directory via the Advanced 
Domains Method

1. Make sure each AD user to be used in Ektron CMS400.NET is 
defined correctly in the Active Directory. Remember that, when 
you enable AD integration, logon name and domain are copied 
from AD to Ektron CMS400.NET.

Method When to Use How setup is done

Advanced 
Domains

• You are using a firewall

• The Ektron CMS400.NET  server 
need not be part of an Active Direc-
tory domain

• You are connecting to multiple Active 
Directory domains, even ones that 
do not see each other

Ektron CMS400.NET  Workarea. For setup 
instructions, see ”Setting Up Active Directory 
via the Advanced Domains Method” on 
page 742.

Legacy You are using auto discovery and Active 
Directory single signon.

The domain connects to the AD domain within 
the web.config.
For setup instructions, see ”Setting Up Active 
Directory via the Legacy Method” on 
page 743
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2. If you have multiple domains in your Active Directory Forest, 
decide if you want Ektron CMS400.NET to reference all 
domains or if you want to choose a specific one. (You will use 
this when completing the Domain field of the Active Directory 
Setup Screen.)

3. Set the following elements in the Web.config.

- Set the ek_ADEnabled element to true. It should look like this:
<add key="ek_ADEnabled" value="true"/>

- Set the ekADAdvanced element to true. It should look like this:
<add key="ekADAdvanced" value="true"/>

- Set the ek_AUTH_Protocol element to LDAP. It should look like 
this:

<add key="ek_AUTH_Protocol" value="LDAP"/>

4. Set up your domains on the Edit Domains screen. See ”The 
Edit Domains Screen” on page 760

5. Configure the AD setup page. See ”The Active Directory Setup 
Screen” on page 763.

6. Assign AD groups to Ektron CMS400.NET user groups. See 
”Copying User Groups from AD to Ektron CMS400.NET” on 
page 749

Setting Up Active Directory via the Legacy Method
1. Make sure each AD user to be used in Ektron CMS400.NET is 

defined correctly in the Active Directory. Remember that, when 
you enable AD integration, logon name and domain are copied 
from AD to Ektron CMS400.NET.

2. If you have multiple domains in your Active Directory Forest, 
decide if you want Ektron CMS400.NET to reference all 
domains or if you want to choose a specific one. (You will use 
this when completing the Domain field of the Active Directory 
Setup Screen.)

3. Set the following elements in the Web.config.

- For the authentication element, change the value of the 
impersonate attribute to false. It should look like this:

<identity impersonate="false" userName="" password=""/>

- Set the ek_ADEnabled element to true. It should look like this:
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<add key="ek_ADEnabled" value="true"/>

- Make sure the ekADAdvanced element is set to false. (This is 
the default value.)

- Set the ek_AUTH_Protocol element to GC. It should look like 
this:

<add key="ek_AUTH_Protocol" value="GC"/>

- declare a domain account through ek_adusername and 
ek_adpassword. It should look like this:

<add key="ek_ADUsername" value="[username]@domain" />
<add key="ek_ADPassword" value="YourPasswordHere" />

NOTE Before entering the password, encrypt it using Ektron’s password encryption 
utility. To access that utility, go to the Windows Start menu > All Programs > 
Ektron > current release > Utilities > Encrypt Email Password.

4. Configure the AD setup page. See ”The Active Directory Setup 
Screen” on page 763.

5. Assign AD groups to Ektron CMS400.NET user groups. See 
”Copying User Groups from AD to Ektron CMS400.NET” on 
page 749
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Implementing Active Directory 
Integration

The Active Directory feature has two implementation modes, 
described in the following table. Choose the mode that best meets 
your needs.

.

Active Directory Integration
This section covers the following topics:

• ”How Information is Transferred from AD to Ektron 
CMS400.NET” on page 746

Mode Information Shared 
between AD and 
CMS

How to Implement For more 
information, see

user 
authentication 
only

• user logon name

• domain

• password 

On the Active Directory Setup 
screen, check Enable Active 
Directory authentication.

”User Authentication 
Only Mode” on 
page 778

active 
directory 
integration

• user logon name

• domain

• password

• user’s first and 
last name

• email address

• user groups

• user’s group 
memberships

On the Active Directory Setup 
screen, check Enable Active 
Directory authentication and 
Enable Active Directory 
integration.
You may also want to check 
Enable automatic addition of 
user from AD and Enable 
automatic addition of user to 
groups.

”Active Directory 
Integration” on 
page 745
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• ”Which Information is Transferred from AD to Ektron 
CMS400.NET” on page 746

• ”Copying User Group Information from AD to Ektron 
CMS400.NET” on page 749

• ”Associating User Information in AD with Ektron CMS400.NET” 
on page 755

• ”The Screens of the Active Directory Feature in Active 
Directory Integration Mode” on page 759

• ”Disabling AD Integration” on page 777

How Information is Transferred from AD to Ektron 
CMS400.NET

Ektron CMS400.NET does not write to the AD – it only reads from 
it. This results in the following changes to how user information is 
handled within Ektron CMS400.NET.

• Once you enable AD integration, all changes to user and user 
group information must be made in the AD -- the Ektron 
CMS400.NET Edit User and User Group screens change to 
primarily view screens.

• When adding a new user or user group toEktron CMS400.NET, 
you can only select users and groups in the AD. If the user or 
user group does not exist in the AD, create them there first, and 
then import the user or group into Ektron CMS400.NET.

Which Information is Transferred from AD to Ektron 
CMS400.NET

Ektron CMS400.NET accesses the following AD user information.

• Authentication (password, user logon name, and domain) for 
signing in to Ektron CMS400.NET.
The password is not stored in Ektron CMS400.NET – the 
application only refers to the password during sign in.

• User information, listed in the following table
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• user group information, listed in the following table.

The following diagram illustrates the components of the Active 
Directory feature.

Field in AD AD attribute Corresponding field in Ektron 
CMS400.NET

User logon name (pre-
Windows 2000) 

sAMAccountName Domain and Username

Note: Users can share a name in different 
domains. For example, juser/example.com 
and juser/example.net. Otherwise, user 
names must be unique. 

Last Name sn Lastname

First Name givenName Firstname

Email mail email Address

Field in AD AD attribute Corresponding field in Ektron 
CMS400.NET

Group Name (pre-Windows 
2000)

cn Domain and User group name

Note: User groups can share a name in 
different domains. For example, editors/
example.com and editors/example.net. 
Otherwise, user group names must be 
unique. 
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Copying User Group Information from AD to Ektron 
CMS400.NET

This section explains how a user’s group membership is copied 
from the AD to the Ektron CMS400.NET system when integration 
is first enabled, and then on an ongoing basis. Once assigned to a 
group, the user automatically receives all Ektron CMS400.NET 
privileges and workflow responsibilities associated with it.

NOTE The Active Directory has two kinds of user groups: security and distribution. 
Ektron CMS400.NET does not distinguish between them – as long as a user is a 
member of either kind of group, group information is imported to Ektron 
CMS400.NET.

This section explains the following topics.

• ”Copying User Groups from AD to Ektron CMS400.NET” on 
page 749

• ”Associating a User’s AD Group Information with Ektron 
CMS400.NET” on page 750

• ”Mapping the Administrator Group” on page 752

• ”User Belongs to AD Group that Does Not Exist in Ektron 
CMS400.NET” on page 753

• ”User Belongs to Ektron CMS400.NET Group that Does Not 
Exist in AD” on page 753

• ”Removing Users from a Group” on page 753

• ”Adding User Groups” on page 754

• ”Adding a User to a Group” on page 754

• ”Replacing a User Group” on page 754

• ”Deleting a User Group” on page 754

Copying User Groups from AD to Ektron CMS400.NET

Before using the AD integration feature, copy all AD groups you 
will use in your Web site into Ektron CMS400.NET. To do that, 
follow these steps.

1. From the left side of the Workarea, click Settings > User 
Groups.
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2. Click the Add Groups button ( ).

3. The Search Active Directory for Groups screen appears.

4. From the Domain drop-down list, select the domain from which 
you want to add a user group.

NOTE The Active Directory Setup screen can restrict AD integration to one domain. If it 
does, you can only search within that domain.

5. Enter as much information as you know into the Active 
Directory Group field.

6. Click the Search button.
7. A new screen displays all groups that satisfy the search 

criteria.
8. Click the check box under the Add column to add the user 

group to Ektron CMS400.NET.

9. Click the Save button ( ).

Associating a User’s AD Group Information with Ektron CMS400.NET

When Integration is First Enabled

Ektron CMS400.NET User Database Already Exists
If Auto Add User To Group is checked (on the Active Directory Setup 
screen), a user’s group membership is first copied from the AD to 
Ektron CMS400.NET when a user logs in or is added. At this time, 
any AD group memberships overwrite Ektron CMS400.NET group 
memberships except the Everyone group, to which all users 
belong.

NOTE The Everyone group, unlike other Ektron CMS400.NET groups, is not associated 
with an AD group. It is an all-encompassing group with no special permissions.
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If a user belongs to an AD user group that does not exist in Ektron 
CMS400.NET, nothing happens because the feature assumes that 
all AD groups are not meaningful in Ektron CMS400.NET.

If a user belongs to an Ektron CMS400.NET user group that does 
not exist in AD, the discrepancy is flagged on the Active Directory 
Setup and Active Directory Status screens. From these screens, 
you can copy the AD group information into Ektron CMS400.NET.

See Also: ”Associating User Group Membership with Active 
Directory User Group Membership” on page 770 and ”Associating 
Groups with Active Directory Groups” on page 770

To learn how membership is updated from then on, see ”After 
Integration is Enabled” on page 751.

Ektron CMS400.NET is Being Installed, so No User Groups Exist
Follow the procedure described in ”Copying User Groups from AD 
to Ektron CMS400.NET” on page 749 to copy AD user groups to 
Ektron CMS400.NET. As users in those groups are added to 
Ektron CMS400.NET, their group membership is copied from AD 
to Ektron CMS400.NET.

After Integration is Enabled

A user’s group membership is updated in Ektron CMS400.NET 
when all of the following are true:

• The Enable automatic addition of user to groups field is 
checked on the Active Directory Setup screen

• A user is added to Ektron CMS400.NET or his group 
membership changes in the Active Directory

• The user logs in or someone clicks on the Refresh button ( ) 
on the user’s View User Information screen

On the other hand, if Enable automatic addition of user to 
groups field is unchecked, you can add the user to groups and 
remove him from groups independently of his AD group 
memberships.
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Mapping the Administrator Group

On the Ektron CMS400.NET Active Directory Setup screen, you 
can identify an AD user group that maps to the Ektron 
CMS400.NET Administrator group.

Administrators have access to all functions documented in this 
documentation. (Unlike other Ektron CMS400.NET user groups, 
whose names are copied from the AD, the Administrator and 
Everyone group names cannot be changed.)
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For example, if the AD has a user group named CMSAdmin whose 
members should have the privileges of Ektron CMS400.NET 
administrators, assign that group to Administrators on the Active 
Directory Setup screen. If such a group does not exist in AD yet, 
you should create it and then assign it on the Active Directory 
Setup screen.

Note that only one AD group can be mapped to the Ektron 
CMS400.NET Administrator group -- you cannot have an AD 
administrator group within each AD domain.

See Also: ”The Active Directory Setup Screen” on page 763

User Belongs to AD Group that Does Not Exist in Ektron CMS400.NET

If user is assigned to an AD user group that does not exist in 
Ektron CMS400.NET, nothing happens. The AD integration feature 
assumes that an Ektron CMS400.NET administrator only 
maintains user groups that are meaningful to Ektron CMS400.NET, 
and not all AD groups may be meaningful to Ektron CMS400.NET.

NOTE If a user belongs to a user group that is given Membership permissions, but also 
to a group that has CMS permissions, the user will only receive Membership 
permissions if logged into Ektron CMS400.NET.

User Belongs to Ektron CMS400.NET Group that Does Not Exist in AD

If a user was a member of a user group in Ektron CMS400.NET 
before integration was enabled, but does not belong to that group 
in the AD, this discrepancy is flagged on the Active Directory Setup 
and Active Directory Status screens.

If the user should belong to the AD group, add the group 
membership within the AD. Then, refresh the user on these 
screens to copy AD group information into Ektron CMS400.NET.

See Also: ”Associating Groups with Active Directory Groups” on 
page 770

Removing Users from a Group

If you delete a user from an AD group, the user is automatically 
removed from the associated Ektron CMS400.NET group the next 
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time the user’s information is updated (as explained in ”Copying 
User Group Information from AD to Ektron CMS400.NET” on 
page 749).

Adding User Groups

Once AD integration is enabled, you can only add new user groups 
in the AD. In Ektron CMS400.NET, use the Search Active Directory 
for Groups screen to copy an AD user group to Ektron 
CMS400.NET. You can only add groups that do not already exist in 
Ektron CMS400.NET. This procedure is described in ”Copying 
User Groups from AD to Ektron CMS400.NET” on page 749.

Adding a User to a Group

You cannot add a user to a user group within Ektron CMS400.NET 
-- you must do so in the Active Directory.

Replacing a User Group

If you realize that you have associated the wrong AD user group 
with an Ektron CMS400.NET user group, you can replace the user 
group. Follow these steps to do so.

1. From the left side of the Workarea, click User Groups.
2. Click the user group that you want to replace.
3. Click the Associate Ektron CMS400.NET Group with Different 

AD Group button ( ).

4. Select a group to replace the group you selected in Step 2.

5. Click the Save button ( ) to finalize the change.

Deleting a User Group

Deleting a User Group in AD

If you delete a user group in AD and users are assigned to the 
group within Ektron CMS400.NET, the group is not automatically 
deleted in Ektron CMS400.NET. However, any Ektron 
CMS400.NET users who were members of the group are no longer 
members the next time their Ektron CMS400.NET information is 
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updated. The discrepancy is flagged on the Active Directory Setup 
and Active Directory Status screens.

Deleting a User Group in Ektron CMS400.NET

If you delete a user group in Ektron CMS400.NET and users are 
assigned to that group within AD, nothing happens. This is 
because the AD Integration Feature assumes that, in Ektron 
CMS400.NET, the administrator only sets up user groups that are 
meaningful to Ektron CMS400.NET, and some AD groups are not 
meaningful to Ektron CMS400.NET.

Associating User Information in AD with Ektron CMS400.NET
A key component of the Active Directory Integration feature is to 
maintain consistent information between the AD and Ektron 
CMS400.NET. This section explains the transfer of user 
information between AD and Ektron CMS400.NET when 
integration is first enabled and on an ongoing basis.

This section covers the following topics.

• ”Automatically Copying AD User Information When Integration 
is First Enabled” on page 755

• ”Automatically Copying AD User Information after Integration is 
Enabled” on page 756

• ”Manually Adding AD User Information to Ektron 
CMS400.NET” on page 757

• ”Editing User Information in Ektron CMS400.NET” on page 758

• ”Deleting Users” on page 758

• ”Replacing a User” on page 759

Automatically Copying AD User Information When Integration is First 
Enabled

Ektron CMS400.NET Database Already Implemented

If Enable automatic addition of user from AD is checked on the Active 
Directory Setup screen, user information is copied from the AD to 
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Ektron CMS400.NET when that user logs in or is added to Ektron 
CMS400.NET.

See Also: ”The Active Directory Setup Screen” on page 763

The first time the user information is copied, the AD information 
overwrites all Ektron CMS400.NET information. To learn how 
information is updated from then on, see ”Copying User Group 
Information from AD to Ektron CMS400.NET” on page 749.

If two or more AD users have the same Ektron CMS400.NET user 
logon name but different domains (for example, JDoe in 
Eng.Example.com and JDoe in Mkt.Example.com) and that 
username (JDoe) also exists in Ektron CMS400.NET, the Active 
Directory Setup and Active Directory Status screens indicate this 
discrepancy by the following message:

CMS users need to be associated with Active Directory users. 

Click the message to proceed to the Associate Ektron 
CMS400.NET Users to Active Directory Users screen and 
associate an AD user with the Ektron CMS400.NET user.

See Also: ”Associating Ektron CMS400.NET Users with Active 
Directory Users” on page 768

Ektron CMS400.NET is Being Installed, so No User Database Exists

Go to the Search Active Directory for Users Screen and select AD 
users that will use Ektron CMS400.NET. When you add a user, the 
user information is copied from the AD to Ektron CMS400.NET.

See Also: ”The Search Active Directory for Users Screen” on 
page 774

NOTE You can only select AD users that do not already exist in Ektron CMS400.NET. 
Also, the Active Directory Setup screen can restrict AD integration to one domain. 
If it does, you can only search for users within that domain.

Automatically Copying AD User Information after Integration is Enabled

User information is copied from the AD to Ektron CMS400.NET 
when either of these events occurs:
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• the user logs in

• someone clicks the Refresh button ( ) on the user’s View 
User Information screen

See Also: ”The View User Information Screen” on page 772

If a user’s last name, first name, email field, or group membership 
changed in the AD, those changes are copied to Ektron 
CMS400.NET. However, if a user’s logon name changed in the 
AD, that change is not copied to Ektron CMS400.NET because 
Ektron CMS400.NET uses that field to identify the user. Instead, 
that discrepancy is flagged on the Active Directory Setup and 
Active Directory Status screens. You should proceed to the 
Associate Ektron CMS400.NET Users to Active Directory Users 
screen, where you can update the AD user associated with the 
Ektron CMS400.NET user.

See Also: ”Associating Ektron CMS400.NET Users with Active 
Directory Users” on page 768

Manually Adding AD User Information to Ektron CMS400.NET

Before using the AD integration feature, add all AD users that will 
use your Web site to Ektron CMS400.NET. This can be done 
automatically, as explained ”Automatically Copying AD User 
Information When Integration is First Enabled” on page 755. 

If you want to manually add an AD user to Ektron CMS400.NET, 
follow these steps.

1. From the left side of the Workarea, click Users.

2. Click the Add Users button ( ).
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3. The Search Active Directory for Users screen appears.

4. From the Domain pull-down list, select the domain from which 
you want to add a user.

5. Enter as much information as you know into the other fields.
6. Click the Search button.
7. A new screen displays all users that satisfy the search criteria. 
8. Click the check box under the Add column to add users to 

Ektron CMS400.NET.

9. Click the Save button ( ).

Editing User Information in Ektron CMS400.NET

Because Ektron CMS400.NET does not write to the AD, you can 
only change the User Language and Disable email Notifications 
fields within the Ektron CMS400.NET Edit User screen. You must 
edit all other user fields from the AD.

Deleting Users

If a user is deleted in AD, Ektron CMS400.NET does not 
automatically delete the user. However, the user’s login fails 
because he cannot be authenticated.

The user remains in Ektron CMS400.NET, and the discrepancy is 
flagged on the Active Directory Setup and Active Directory Status 
screens. You should delete the user from Ektron CMS400.NET 
using the Delete User function.

See Also: ”Deleting a User” on page 669
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NOTE If you mistakenly delete all users with administrative privileges, you can still sign 
in using the builtin user’s username and password. For more information, see 
”BuiltIn User” on page 25.

Replacing a User

If you associate the wrong AD user with a Ektron CMS400.NET 
user, you can replace the user. If you do, all Ektron CMS400.NET 
privileges and workflow responsibilities assigned to the old user 
transfer to the new one.

Follow these steps to associate a Ektron CMS400.NET user with a 
new AD user.

1. From the left side of the Workarea, click Users.
2. Click the user you want to replace.
3. Click the Associate CMS User with Different AD User button 

( ).
4. Select a user to replace the user you selected in Step 2.

5. Click the Save button ( ).
When you complete this procedure, the first user is deleted from 
Ektron CMS400.NET.

The Screens of the Active Directory Feature in Active 
Directory Integration Mode

The Active Directory feature uses the following screens:

• ”The Edit Domains Screen” on page 760

• ”The Active Directory Setup Screen” on page 763

• ”The Active Directory Status Screen” on page 767

• ”The View Users Screen” on page 771

• ”The View User Groups Screen” on page 774

This section explains how to use each screen.
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The Edit Domains Screen

Use this screen to identify each network domain you will use with 
Ektron CMS400.NET’s Active Directory feature. You would use this 
when you want to define domains, as opposed to using auto 
discovery to find them.

This feature is described through the following subtopics.

• ”Enabling the Edit Domains Screen” on page 760

• ”Accessing the Edit Domains Screen” on page 760

• ”Fields of the Edit Domains Screen” on page 761

• ”How Domains are Used” on page 762

Enabling the Edit Domains Screen

To have the Edit Domains screen appear, set the following 
web.config file values as shown below.

Accessing the Edit Domains Screen

After you modify web.config as described above, access the Edit 
Domains screen by going to Workarea > Settings > 
Configuration > Active Directory > Domains.

Below is a sample of the screen.

web.config value Setting

ek_ADEnabled True

ek_ADAdvancedConfig True

ek_ADUsername blank (username entered in Edit Domains screen)

ek_ADPassword blank (username entered in Edit Domains screen)

ek_AUTH_Protocol LDAP
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The screen lets you add new domains, modify existing ones, or 
delete obsolete ones.

Fields of the Edit Domains Screen

When defining a domain, enter the following information.

Field Description

Domain
DNS

Enter the domain’s DNS. Contact your server administrator for this 
information. For example, corp.example.com.

NetBIOS If your NetBios is the same as your domain name, leave the checkbox 
box checked. Otherwise, uncheck the box and enter your NetBIOS 
setting. Contact your server administrator for this information.

Username Enter the name of the user with permission to sign on to the domain 
server. The name is in the format username@domainDNS. For example, 
jsmith@corp.example.com.
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How Domains are Used

Domains defined on this screen are referenced when defining the 
user group that maps to the hard coded Ektron CMS400.NET 
administrator group. See Also: ”The Screens of the Active 
Directory Feature in Active Directory Integration Mode” on 
page 759

While defining the user group, first select a domain. Ektron 
CMS400.NET creates a selection list of Active Directory user groups 
in that domain. In this way, you must choose a user group within 
the selected domain.

Password Enter the password of the user identified above. 

Domain 
Controller IP

Enter the IP address or DNS name of your domain controller. 

Note: If using Active Directory across a firewall, the IP address should be 
that of the firewall. On the firewall, traffic on port 389 (LDAP) should be 
allowed.

Field Description
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The Active Directory Setup Screen

The Active Directory Setup screen (illustrated below) lets you 
enable and disable the Active Directory feature, as well as 
determine other aspects of AD management, such as whether 
users and groups are automatically updated. To access the screen, 
click Settings > Configuration > Active Directory > Setup from 
the left panel of the Workarea.
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The following table describes the fields on the screen.

See Also: ”Messages Near the Top of the Active Directory Setup 
Screen” on page 766

Field Description For more information, see

Active Directory Installed

Disable Active 
Directory and 
LDAP 
Authentication

Disables the use of Active Directory and LDAP 
Authentication.

”Disabling AD Integration” on 
page 777

Enable LDAP 
Authentication

If enabled, you need to fill out the following five 
fields. These fields are explained in the LDAP 
Authentication chapter.

”Enabling LDAP” on page 793

LDAP Server Explained in LDAP Authentication chapter. ”Enabling LDAP” on page 793

Port Explained in LDAP Authentication chapter. ”Enabling LDAP” on page 793

Organization Explained in LDAP Authentication chapter. ”Enabling LDAP” on page 793

Domain Explained in LDAP Authentication chapter. ”Enabling LDAP” on page 793

Organizational 
Unit

Explained in LDAP Authentication chapter. ”Enabling LDAP” on page 793

Active Directory 
Authentication

If enabled, user authentication is functional, and 
you can enable the following three fields.

”User Authentication Only 
Mode” on page 778
For information on LDAP, see 
”LDAP Authentication” on 
page 791

Active Directory 
Integration

If enabled, the Active Directory feature is 
functional.

Note: Can only be enabled if Active Directory 
Authentication is enabled.

”Active Directory Integration” 
on page 745
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Auto Add User If enabled, user information is copied from the AD 
to Ektron CMS400.NET when that user logs in or 
when the user is added to Ektron CMS400.NET.

Note: Can only be enabled if Active Directory 
Integration is enabled.

”Associating User Information 
in AD with Ektron 
CMS400.NET” on page 755

Auto Add User 
To Group

If enabled, a user’s group membership is first 
copied from the AD when a user logs in or is 
added.

Note: Can only be enabled if Active Directory 
Integration is enabled.

”The Screens of the Active 
Directory Feature in Active 
Directory Integration Mode” on 
page 759

User Property Mapping

FirstName Enter the Active Directory Property that maps to 
the user’s first name in Ektron CMS400.NET. By 
default, this is set to givenName, but you can 
change it to any AD property.

MSDN Library (http://
msdn.microsoft.com/library/
default.asp)> Active Directory, 
ADSI and Directory Services > 
Directory Services > Active 
Directory > Active Directory 
Reference > Active Directory 
User Interface Mappings.

LastName Enter the Active Directory Property that maps to 
the user’s last name in Ektron CMS400.NET. By 
default, this is set to sn, but you can change it to 
any AD property.

same reference as FirstName 
(above)

EmailAddr1 Enter the Active Directory Property that maps to 
the user’s last name in Ektron CMS400.NET. By 
default, this is set to mail, but you can change it to 
any AD property.

same reference as FirstName 
(above)

Ektron CMS400.NET Administrator Group Mapping

AD Group 
Name @ AD 
Domain 

Enter the Active Directory user group and domain 
name that maps to the hard coded Ektron 
CMS400.NET administrator group. If you do not 
have an AD user group that includes all Ektron 
CMS400.NET administrators, you should create 
one and enter its name and domain here.

”Mapping the Administrator 
Group” on page 752

Field Description For more information, see



Implementing Active Directory Integration

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 766

Messages Near the Top of the Active Directory Setup Screen

Domain If you want to restrict the search of new users and 
groups to one AD domain, select that domain.
If you do, the Search Active Directory for Users 
and Search Active Directory for Groups screens 
let you search in the selected domain only.
Also, if any Ektron CMS400.NET user or group 
names include a domain (for example, 
admin@saturn.example.com) that is excluded by 
your selection, those users/groups are flagged on 
the Active Directory Setup and Active Directory 
Status screens because the names now include 
an invalid domain.

Field Description For more information, see

Message Explanation

Active Directory Authentication is Enabled and 
Requires More Configuration.

Some Ektron CMS400.NET users are not associated 
with AD users. Also, if you are using full active 
directory integration mode, user groups and/or user 
group relationships may not be associated.
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If you see either message, click it. You proceed to the Active 
Directory Status screen, which helps you resolve the 
discrepancies.

See Also: ”The Active Directory Status Screen” on page 767

The Active Directory Status Screen

Use the Active Directory Status screen to resolve the following 
discrepancies between Ektron CMS400.NET and AD.

• an Ektron CMS400.NET user needs to be associated with an 
AD user

• an Ektron CMS400.NET user group needs to be associated 
with an AD user group

• an Ektron CMS400.NET user’s group membership need to be 
associated with the same AD user’s group membership

To access the screen, click Configuration > Active Directory > 
Status from the left panel of the Workarea.

Active Directory Authentication is disabled, but 
needs further configuration

Some Ektron CMS400.NET users and/or groups are 
no longer unique.
This happens because, in the AD, users and groups 
can share a logon name as long as their domains are 
different.
But, when AD authentication is disabled, two Ektron 
CMS400.NET users or groups can no longer share a 
name -- each must be unique.

Message Explanation
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.

There are several reasons why such discrepancies may occur. To 
learn more about why 

• an Ektron CMS400.NET user is not associated with an AD 
user, read ”Associating User Information in AD with Ektron 
CMS400.NET” on page 755. 

• an Ektron CMS400.NET user’s group membership is not 
associated with the user’s AD group membership, read 
”Associating a User’s AD Group Information with Ektron 
CMS400.NET” on page 750

• an Ektron CMS400.NET group is not associated with an AD 
group, read ”The Screens of the Active Directory Feature in 
Active Directory Integration Mode” on page 759

If you click any link on the Active Directory Status screen, a new 
screen appears that allows you to resolve the discrepancy. For 
information on how to use these screens, see the following topics.

• ”Associating Ektron CMS400.NET Users with Active Directory 
Users” on page 768

• ”Associating User Group Membership with Active Directory 
User Group Membership” on page 770

• ”Associating Groups with Active Directory Groups” on 
page 770

Associating Ektron CMS400.NET Users with Active Directory Users

If you click CMS users need to be associated with Active 
Directory users on the Active Directory Status screen, the 
Associate Ektron CMS400.NET Users with Active Directory Users 
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screen appears (illustrated below). Use this screen to associate 
Ektron CMS400.NET users with AD users.

If a user with the same username exists in the AD, that name and 
domain appear by default in the AD Username and AD Domain 
fields. If the user exists in the more than one AD domain (as 
illustrated in the first example above), select a domain from the 
pull-down list.

If there is no default and you know the AD user name to associate 
with an Ektron CMS400.NET user, enter that in the AD Username 
and AD Domain fields. If you do not know the AD username, click 
Search to find the user in the AD.

If you decide to change the username in AD to match the Ektron 
CMS400.NET username, make the change in the AD. Then, click 

the Refresh button ( ) to update Ektron CMS400.NET and 
resolve the discrepancy.

Finally, if a user should not exist in Ektron CMS400.NET, click the 
box under the Delete column to delete the user from Ektron 
CMS400.NET.
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After you make all necessary changes, click the Save button ( ).

Associating User Group Membership with Active Directory User Group Membership

If you click CMS relationships need to be associated with 
Active Directory relationships on the Active Directory Status 
screen, the Associate Ektron CMS400.NET Relationships with 
Active Directory Relationships screen appears (illustrated below). 
Use this screen to coordinate Ektron CMS400.NET user group 
membership with AD user group membership.

The screen displays a user’s group membership that exists in 
Ektron CMS400.NET, but does not exist in the AD.

See Also: ”Associating a User’s AD Group Information with Ektron 
CMS400.NET” on page 750

After viewing the discrepancy on the screen, you have two 
choices:

• To associate the user with the same user group in AD, go to the 
AD and assign the user to the group. Then, return to this 

screen and click the Refresh button ( ) to update the user 
group information in Ektron CMS400.NET.

• To remove the user’s group membership in Ektron 
CMS400.NET, check the box under the Delete column and 

click the Save button ( ).

Associating Groups with Active Directory Groups

If you click CMS groups need to be associated with Active 
Directory groups on the Active Directory Status screen, the 
Associate Ektron CMS400.NET User Groups with Active Directory 
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Groups screen appears (illustrated below). Use this screen to 
associate Ektron CMS400.NET groups with AD groups.

If a group with the same groupname exists in the AD, that name 
appears by default in the AD Group Name field. If the group exists 
in the more than one domain within the AD, select a domain from 
the pull-down list.

If there is no default and you know the AD group name to 
associate with an Ektron CMS400.NET group, enter that in the AD 
Group Name and AD Domain fields. If you do not know the AD 
groupname, click Search to find the group in the AD.

Finally, if this group should not exist in the Ektron CMS400.NET 
database, click the box under the Delete column to delete the 
group from Ektron CMS400.NET.

After you make all necessary changes, click the Save button ( ) 
to save them.

The View Users Screen

The View Users screen (illustrated below) lists all users in the 
Ektron CMS400.NET database. To access the screen, click Users 
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from the left panel of the Workarea. To view more information for a 
user, click that user to move to the View User Information screen.

The View Users screen also provides a toolbar button ( ) that 
lets you add AD users to the Ektron CMS400.NET database. When 
you click it, the Search Active Directory for Users Screen appears.

The View User Information Screen

The View User Information Screen displays the user’s

• username and domain
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• first and last name

• language

• email address and whether the user receives email 
notifications

• user groups

If you are using user authentication mode, username and domain 
can only be edited in the AD. You can edit all other fields on this 
screen.

If you are using full AD Integration mode, you can only edit 
language and whether the user receives email notifications. You 
must edit the other fields in the AD.

The screen also displays the following buttons.

Button Description

Edit information on screen

Delete user

See Also: ”Deleting Users” on page 758

Retrieve latest information from AD into Ektron 
CMS400.NET

See Also: ”Copying User Group Information from AD 
to Ektron CMS400.NET” on page 749

Note: This toolbar button does not appear if you are 
using user authentication mode.

Replace user

See Also:  ”Replacing a User” on page 759

Return to previous screen



Implementing Active Directory Integration

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 774

The Search Active Directory for Users Screen

Use this screen to add AD users to Ektron CMS400.NET. To 
access the screen, click Users from the left panel of the Workarea, 

then click the Add button ( ).

Enter as much search criteria as you know to reduce the number of 
users that the search yields. For example, if you know that the 
user’s last name is Jackson and the user is in the planets domain, 
enter those criteria and you will get fewer hits.

When the Active Directory Users screen appears, click the box 
next to users that you want to create in Ektron CMS400.NET. 

Then, click the Save button ( ) to copy their information into 
Ektron CMS400.NET.

The View User Groups Screen

The View User Groups Screen displays all AD user groups that 
have been copied into Ektron CMS400.NET. (See ”Copying User 
Groups from AD to Ektron CMS400.NET” on page 749).



Implementing Active Directory Integration

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 775

To access the screen, click User Groups from the left panel of the 
Workarea.

To view more information for a group, click that group to move to 
the View Users in Group screen.

The View User Groups screen also provides a toolbar button ( ) 
that lets you add AD groups to the Ektron CMS400.NET database. 
When you click it, the Search Active Directory for Groups screen 
appears.

View Users in Group Screen

The View Users in Group Screen displays, for each user in the 
group

• username and domain

• first and last name

• language
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The screen also displays the following buttons.

The Search Active Directory for Groups Screen

Use this screen to add AD groups to Ektron CMS400.NET. Enter 
as much search criteria as you know to reduce the number of 
groups that the search yields.

NOTE You can only select AD groups that do not already exist in Ektron CMS400.NET. 
Also, the Active Directory Setup screen can restrict AD integration to one domain. 
If it does, you can only search for groups within that domain.

For example, if you know that a group begins with S and is in the 
planets domain, enter those criteria and you will get fewer hits.

Button Description

Replace group

See Also: ”Replacing a User Group” on page 754

Return to previous screen
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After you click Search, a new screen appears listing all AD groups 
that satisfy the search criteria. Click the box next to groups that you 
want to create in Ektron CMS400.NET. Then, click the Save button 
( ) to copy their information.

Disabling AD Integration
If you decide to disable AD authentication or integration, edit the 
Active Directory Setup screen and uncheck the box next to Enable 
Active Directory Authentication or Enable Active Directory 
Integration.

See Also: ”The Active Directory Setup Screen” on page 763

If you do this, and any users or groups share the same name within 
different domains, the following message appears on the screen.

Active Directory Authentication is disabled, but needs further 
configuration

For example, two users are named JJackson@example.net and 
JJackson@example.com. When AD was enabled, the domain 
names made the two users unique. However, when you disable 
integration, the domain names are dropped, so the user names are 
now identical. You need to make the users unique. 

If you click the message (above) on the Active Directory Setup 
screen, you move to the Active Directory Status screen. The 
following messages may appear.
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Click the message to proceed to the Make Ektron CMS400.NET 
Users Unique screen (illustrated below).

This screen lists all users whose user names are not unique and 
suggests a new, unique Ektron CMS400.NET username. The new 
name consists of the user name, underscore, at sign (@), 
underscore, the domain name. So, for example, 
JJackson@example.net would appear as 
JJackson_@_example.net.

The same is true for user groups. For example, if you had two 
groups name Account Operators, one in the example.com domain 
and another in the saturn.example.com domain, the Make Ektron 
CMS400.NET Groups Unique screen would look like this.

Ektron recommends that you accept the suggested new names. 
Click the Save ( ) button to do so.

One advantage of using the new name format is that, if you later 
decide to re-enable AD integration, the software can automatically 
associate the AD and Ektron CMS400.NET users or groups.

User Authentication Only Mode
In user authentication mode, the sharing between AD and Ektron 
CMS400.NET is limited to user logon name, domain, and password.
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The following topics explain how to work with user authentication 
mode.

• ”How Information is Transferred from Active Directory to Ektron 
CMS400.NET” on page 779

• ”Which Information is Transferred from Active Directory to 
CMS400.NET” on page 779

• ”User Groups” on page 780

• ”Adding User Information from AD to Ektron CMS400.NET” on 
page 780

• ”Editing User Information in Ektron CMS400.NET” on page 780

• ”Deleting Users” on page 781

• ”Replacing a User” on page 781

• ”The Screens of the Active Directory Feature in User 
Authentication Mode” on page 781

• ”Disabling AD Authentication” on page 781

How Information is Transferred from Active Directory to 
Ektron CMS400.NET

Ektron CMS400.NET does not write to the AD – it only reads from 
it. This results in the following changes to how the username, 
domain, and password are handled within Ektron CMS400.NET. 

• Changes to user logon name, domain and password must be 
made in the AD — you cannot update these fields in the Ektron 
CMS400.NET Edit User screens.

• When adding a new user to Ektron CMS400.NET, you can only 
select AD users. If the user does not exist in the AD, create the 
user there, and then import the user into Ektron CMS400.NET.

Which Information is Transferred from Active Directory to 
CMS400.NET

CMS refers to the following AD sign-in authentication information 
during sign-in: password, user logon name, and domain. Note that 
the password is not stored in CMS — CMS only refers to the 
password during sign-in.
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User Groups
User authentication mode has no effect on user groups. To learn 
more about user groups, see ”Managing User Groups” on 
page 670.

Adding User Information from AD to Ektron CMS400.NET
See ”Manually Adding AD User Information to Ektron 
CMS400.NET” on page 757

Changing the User Login Name in AD

If a user’s logon name changes in the AD, it no longer matches the 
Ektron CMS400.NET logon name. This discrepancy is flagged on 
the Active Directory Setup and Active Directory Status screens. 
You should proceed to the Associate Ektron CMS400.NET Users 
to Active Directory Users screen, where you can update the user 
information.

Alternatively, you could 

1. Go to the View User Information screen.
2. Select the user whose AD name changed.
3. Click the Associate the Ektron CMS400.NET user with 

Different AD user toolbar button ( ).
4. Select the AD user and domain.
See Also: ”Associating Ektron CMS400.NET Users with Active 
Directory Users” on page 768

Editing User Information in Ektron CMS400.NET
Ektron CMS400.NET does not write to the AD. This means that 
you can only change the Username and Domain fields from the 
AD.

You can change the First Name, Last Name, email Address, 
User Language and Disable email Notifications fields on the 
Ektron CMS400.NET Edit User screen.
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Deleting Users
See ”Deleting Users” on page 758

Replacing a User
See ”Replacing a User” on page 759

IMPORTANT! If you replace a user in user authentication-only mode, the user’s first name, last 
name, and email address are not overwritten with information in the active 
directory.

The Screens of the Active Directory Feature in User 
Authentication Mode

Since the scope of user authentication mode is limited, only some 
fields on the AD screens are used. For example, on the Active 
Directory setup screen, the only relevant fields are authentication 
and domain.

See Also: ”The Active Directory Setup Screen” on page 763

Also, on the Active Directory Status Screen, only one discrepancy 
message may appear: 

CMS user needs to be associated with an AD user

See Also: ”Associating Ektron CMS400.NET Users with Active 
Directory Users” on page 768

The View Users Screen works the same for both modes.

See Also: ”The View User Information Screen” on page 772

Disabling AD Authentication
See ”Disabling AD Integration” on page 777
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Logging into a System that Uses 
AD Integration

Because usernames and passwords are stored in the AD by 
domain, the AD sign on procedure requires you to select a domain 
name. So, if AD integration is enabled, the sign on screen includes 
a drop-down list that prompts the user to select a domain.

NOTE Your organization determines AD domain names.

For more information about logging in, see ”Logging Into an Ektron 
CMS400.NET Web Site” on page 6.

This feature is explained through the following topics.

• ”Single Sign On” on page 782

• ”Setting up Single Sign On” on page 783

Single Sign On 
You can implement a Single Sign On feature that lets a user 
bypass the Login screen. The feature retrieves the user’s Windows 
login information from the server to authenticate access to Ektron 
CMS400.NET.
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How Single Sign on Works
The feature uses a variable called User.Identity.Name. This holds 
the user's account/domain in Active Directory, and has the format 
[domain]\[username]. For example, EKTRON1\skearney. This variable is 
set when a user authenticates against a Windows server.

The user logs in to Ektron CMS400.NET by going to the site and 
clicking the login server control. If the variable is passed and Active 
Directory is enabled, the server control opens the autologin.aspx 
page. Next, the opening window refreshes just like a normal login, 
except the user is not prompted to enter a username, password, 
and domain. 

However, if the user‘s computer is not on a domain, not on the 
same domain as Ektron CMS400.NET, or does not include the 
Ektron CMS400.NET server as a trusted site, the following login 
screen appears.

If Active Directory is not enabled, the normal login.aspx page 
appears.

Setting up Single Sign On
The Single Sign On login process uses two files: autologin.aspx (in 
the workarea/SSO directory) and login.aspx (in the workarea directory). 
Once set up, user authentication is enabled from any domain that 
this server can reach. For example, if Ektron CMS400.NET is 
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located in a third level domain, users from third, second, and first 
level domains can authenticate.

Setting up Single Sign On involves these procedures.

• ”Modifying Web.config for Single Sign On” on page 784

• ”Adjusting Security Settings for the Site Root Folder” on 
page 784

• ”Adjusting Security Settings for autologin.aspx” on page 786

• ”Adjusting Security Settings for login.aspx” on page 789

• ”Adjusting the Login Server Control” on page 790

After completing these procedures, enable Active Directory within 
Ektron CMS400.NET (if it isn’t already enabled). See Also: 
”Disabling AD Integration” on page 777 

Ektron recommends turning on the auto add options (user and 
group). 

Modifying Web.config for Single Sign On
1. Open the web.config file, located on your site’s root folder.
2. Find the ek_AUTH_protocol element.
3. Change its value to GC. It should look like this:
<add key="ek_AUTH_Protocol" value="GC" />

4. Find the authentication element.
5. Change the value of the impersonate attribute to true. It should 

look like this:
<authentication mode="Windows" /> 

<identity impersonate="true" userName="" password=""/>

Adjusting Security Settings for the Site Root Folder
1. Go to Windows Control Panel > Administrative Tools > 

Internet Information Services. 
2. Within IIS, go to Web Sites > Default Web Site > CMS400 

Demo.
3. Right click the CMS400 Demo folder and select Properties.
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4. Click the File security tab then the Edit button.
5. Uncheck everything except Anonymous Access. The 

Account used for anonymous access should specify a 
domain account, preferably the root of the Active Directory 
tree.
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Adjusting Security Settings for autologin.aspx
1. Go to Windows Control Panel > Administrative Tools > 

Internet Information Services.
2. Within IIS, go to Web Sites > Default Web Site > your Web 

site’s root folder > Workarea > SSO > autologin.aspx.
3. Right click autologin.aspx and select Properties.
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4. Click the File security tab and the Edit button.
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5. Under Authenticated Access, uncheck all except Integrated 
Windows Authentication.
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As a result, autologin.aspx will pass credentials from the 
logged-in user's desktop.

Adjusting Security Settings for login.aspx
1. Within IIS > Web Sites > Default Web Site > your web site 

root > Workarea, right click login.aspx and select Properties.
2. Click the File security tab then the Edit button.
3. Uncheck everything except Anonymous Access. The 

Account used for anonymous access should specify a 
domain account, preferably the root of the Active Directory 
tree.
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Adjusting the Login Server Control
In Visual Studio.NET, open the Login server control and set the 
AutoLogin property to True. (Server Controls are explained in the 
Ektron CMS400.NET Developer’s Manual.)
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LDAP Authentication

LDAP is short for Lightweight Directory Access Protocol. It is a set 
of protocols that enable corporate directory entries to be arranged 
in a hierarchical structure which reflects geographic and 
organizational boundaries.

Ektron CMS400.NET’s LDAP feature lets you retrieve user Login 
information from an LDAP server to Ektron CMS400.NET. As a 
result, you can administer user information from one place, and 
users only need to remember one password/username 
combination to sign on to the network and Ektron CMS400.NET.

The hierarchical structure of LDAP authentication can look a few 
different ways. For example, if you had the following LDAP 
structure, the domain would typically span multiple countries.

NOTE Here is a list of the abbreviations: CN = Common Name, OU = Organizational 
Unit, O = Organization, DN = Distinguished Name.

CN=Pitchers Name, OU=Pitchers, O=Baseball Team, C=US, 
DN=example.com

By changing the order of C and DN, the hierarchy indicates that the 
domain example.com is located in the US.

CN=Pitchers Name, OU=Pitchers, O=Baseball Team, 
DN=example.com, C=US.

In some instances, it may be necessary to have an Organization 
appear below an Organizational Unit. This might happen if you 
have your Organization Unit has it own Organizations.

Below is a visual example of an LDAP hierarchical structure.
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This chapter covers the following topics:

• ”Using LDAP with Ektron CMS400.NET” on page 792

• ”LDAP Screen Descriptions” on page 804

• ”Disabling LDAP Authentication” on page 808

Using LDAP with Ektron CMS400.NET
NOTE Active Directory and LDAP are not the same. While they can perform some 

similar functions, LDAP when used with Ektron CMS400.NET only verifies user 
login information and creates the user in the everyone group. Active Directory can 
can be used to verify user login information only or it can become completely 
integrated with Ektron CMS400.NET. To learn more about using Active Directory 
with Ektron CMS400.NET, see ”Active Directory Feature” on page 741

The following sections explain how to use LDAP with Ektron 
CMS400.NET.

• ”Enabling LDAP” on page 793
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• ”Adding an Organizational Unit During Setup” on page 796

• ”Adding User Information from an LDAP Server to Ektron 
CMS400.NET” on page 797

• ”Editing User Information in Ektron CMS400.NET” on page 803

• ”Deleting Users” on page 804

Enabling LDAP
You enable LDAP through the Active Directory Setup screen. To 
enable the LDAP functionality in Ektron CMS400.NET, follow these 
steps.See Also:  ”The Active Directory Setup Screen” on page 804

IMPORTANT! Before enabling LDAP in Ektron CMS400.NET, make sure your LDAP server is 
set up and ready for use. Be sure to include an Ektron CMS400.NET 
administrator account for yourself. Once you enable LDAP, the only account 
available to access Ektron CMS400.NET without LDAP authentication is the 
BuiltIn account. For more information on the BuiltIn account, see ”BuiltIn User” on 
page 25.

1. In the webroot\siteroot\web.config file, change the following line:
<add key="ek_AUTH_Protocol" value="None"/>

becomes
<add key="ek_AUTH_Protocol" value="GC"/>

2. Save and close the Web.config file.
3. In the Workarea, navigate to the Settings > Configuration > 

Active Directory > Setup screen.

4. Click the Edit button ( ).

5. On the Active Directory Setup screen, choose Enable LDAP 
Authentication.

6. Fill in the following fields.
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Field Description For more 
information, see

Type Choose the type of LDAP authentication you are 
using. 

Note: Depending on your choices, the fields below 
may be required or disallowed.

The following choices are available:

• Active Directory (LDAP) - Domain allowed, Orga-
nization is not.

• Novell eDirectory/NDS - Organization allowed, 
Domain is not.

• Sun Iplanet/JSDS - Domain allowed, Organization 
is not.

• Other - Allows both Domain and Organization

”Using Active Directory 
for LDAP” on page 795

LDAP Server The IP Address or name of the LDAP server

Port The LDAP server port that Ektron CMS400.NET 
communicates with. 
If you are unsure, consult the documentation provided 
with your Directory Service (such as, Novell, iPlanet, 
Microsoft, or Red Hat).

Organization The name of your company or organization. For 
example, Ektron, Inc. 
This field can be blank if you enter a domain in the 
Domain field.

Domain The name of the domain you are using. For example, 
www.ektron.com. This should be the same name you 
used when you received your license key. 
This field can be blank if you enter an organization in 
the Organization field.

Path The next levels below your Organization or Domain. 
These can include multiple levels of Organizational 
Units. For example, Content Editors, Marketing, East 
Coast.
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7. Click the Save button ( ).

Using Active Directory for LDAP

In the webroot\siteroot\Web.Config file, add the Username and 
Password for ek_ADUsername and ek_ADPassword. For example:

<add key="ek_ADUsername" value="mwright@ektron.com" />

<add key="ek_ADPassword" value="mypasswordisthis" />

When using LDAP to connect to Active Directory, use the following 
settings in the Workarea.

NOTE LDAP using AD is NOT the same as AD integration. LDAP integration 
(independent of server type) does not support groups, only user authentication.

Add Enter your the path you would like access to in the text 
field and click the Add link. 
When adding Organizational Units, the paths are 
comma separated and run from specific to general. 
For example, ou=Amherst,ou=New Hampshire,o=US
Do not add individual Common Names here. Only add 
Organizational Units that contain the people who 
should have access to Ektron CMS400.NET.

Important: You can have additional Organizations 
below your Organization Units as long as the path on 
your LDAP server is the same.

”Adding an 
Organizational Unit 
During Setup” on 
page 796

To add a single individual 
from a different 
Organizational Unit, see 
”Adding User Information 
from an LDAP Server to 
Ektron CMS400.NET” on 
page 797

Delete Choose any Organizational Unit from the multi-
selection box and click the Delete link.

Field Description For more 
information, see

Field Needed Information

Type Active Directory (LDAP)

LDAP Server [IP Address of the AD domain controller]
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Adding an Organizational Unit During Setup
Things to consider when adding Organizational Units are:

• Should everyone in the OU have access to Ektron 
CMS400.NET?
Once LDAP is enabled, users are added to the everyone group 
upon login. While everyone in the OU has access to Ektron 
CMS400.NET, every user does not necessarily have 
permission to edit content. To control permissions, set up user 
groups, adding each user to a group, and assigning 
permissions to the group. For more information on user groups, 
see ”Managing Users & User Groups” on page 662. For more 
information on assigning permissions, see ”Setting 
Permissions” on page 716.

• Do users in other Organizational Units need access?
Sometimes, managers or editors are in a different OU. They 
need to be added manually, or you need to add their OU.

When adding an Organizational Unit, several entries might cover 
the same hierarchical path. For example, you might have:

• ou=Pitchers,ou=Players,o=Team

• ou=Players,o=Team

• o=Team
This allows you to authenticate users listed in Pitchers, Players, 
and Team.

Port 389

Organization [leave this blank]

Domain [dns name of the AD domain] 
For example: intra.ektron.com

Organizational Unit [any OUs that you want to draw users from] 
For example: Support,Users,Ektron Corporate also 
Engineering,Users,Ektron Corporate

Field Needed Information
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Adding User Information from an LDAP Server to Ektron 
CMS400.NET

Users at each level are automatically available for adding to Ektron 
CMS400.NET. You do not have to be at the OU or CN level to add 
a user. If a user is at the DC or OU level, they are available.

There are three ways to add LDAP user information to Ektron 
CMS400.NET. 

• Have the user log in after LDAP is enabled. As a result, the 
user appears in the Users list and is added to the Everyone 
group.

NOTE After a user logs in, some fields on the Add User screen can be filled in manually, 
such as first and last name. For a description of these fields, see ”Fill out the fields 
according to the table below.” on page 800.

• Search an LDAP server for LDAP users using the LDAP 
Search feature. See Also: ”Searching an LDAP Server for 
Users.” on page 797

• Add the user’s LDAP information manually. See Also: ”Steps to 
Manually Add an LDAP User” on page 799.

• A combination of browsing for the user, then manually 
completing the remaining fields. See Also: ”Using the Browse 
Feature to Add an LDAP User” on page 801

Searching an LDAP Server for Users.

The following steps explain how to search for a user on an LDAP 
server an add them to the CMS400.NET.

1. Enable LDAP by following the instructions in ”Enabling LDAP” 
on page 793.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).
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4. The Add a New User to the System screen appears.

5. Click the Browse LDAP button ( ).

6. The Search LDAP Users screen appears.

7. Enter search criterion for any of the categories to search.

• Username - the username of the user on the LDAP server.

• Firstname - the first name of the user on the LDAP server.

• Lastname - the last name of the user on the LDAP server

• Path - select a path from the drop down list. The paths that are 
available are the same paths that are enabled when 
configuring the CMS400.NET for use with your LDAP server. If 
you select a path and enter no other information, you get back 
all of the users in that path.

8. Click the Search button.
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9. The search returns any users that match the criteria entered.

10. Click the check box next to the user to be added.

11. Click the Save button ( )
12. The user is now added to Ektron CMS400.NET and added to 

the Everyone group. To learn about how to assign this user to a 
specific group, see ”Assigning Users To User Groups” on 
page 671.

Steps to Manually Add an LDAP User

The following steps explain how to add an LDAP user manually.

1. Enable LDAP by following the instructions in ”Enabling LDAP” 
on page 793.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).
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4. The Add a New User to the System screen appears.

5. Fill out the fields according to the table below.

Field Description

Username The username of the person logging in, as found on the LDAP 
server.

Path The path on the LDAP server to the user. For example:
ou=Amherst,ou=New Hampshire,o=US,dc=local

First Name The first name of the user.

Last Name The last name of the user.

Display Name The name of the user that is displayed in the Forums when using 
Discussion Boards feature. See Also:  ”Discussion Boards” on 
page 471
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6. Click Save ( ) to add LDAP users to Ektron CMS400.NET.

7. The View Users in Group Everyone screen appears, displaying 
the new user and the other Ektron CMS400.NET users. To 
learn about how to assign this user to a specific group, see 
”Assigning Users To User Groups” on page 671.

Using the Browse Feature to Add an LDAP User

The Browse LDAP feature provides a more friendly and intuitive 
way to find the username, domain/organization and organizational 
unit(s).

User Language Select the language in which the user will view Ektron CMS400.NET 
screens and messages. The language also determines the default 
value whenever a drop-down list of languages appears within Ektron 
CMS400.NET. 
The dropdown list of choices at this field is derived from the 
Language Settings screen, available from the Settings > 
Configuration folder. 
Do not confuse the system language with the user’s ability to create 
and edit foreign editions of content. This field does not prevent a 
user from working with multiple language content.
See Also: ”Multi-Language Support” on page 809

Note: If the selected language is not English, French or German, it is 
only supported after you download the Ektron CMS400.NET 
Language Support Program from Ektron and translate the Web site.

E-Mail Address Enter the email address of the user.

Forum Editor If you are using Discussion Boards feature, specify which editor this 
user uses when editing in the Forums. Choose from eWebEditPro or 
a Javascript Editor. For information on Discussion Boards, see 
”Discussion Boards” on page 471

Disable Email
Notification

Select to disable email notifications for this user. If you do, the user 
will not receive the automatic email notification described in 
”Automatic eMail Notification” on page 996. However, this field has 
no effect on the user’s ability to receive instant email.

Field Description
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IMPORTANT The default server IP/DNS name and port are taken from the settings specified in 
the Configuration > Setup page. These settings must be specified before 
connecting to the LDAP server. See Also: ”Enabling LDAP” on page 793

IMPORTANT An Organizational Unit that can see the user to be added must be specified in the 
Configuration > Setup page before using the browse feature. See Also: 
”Enabling LDAP” on page 793

1. Enable LDAP by following the instructions in ”Enabling LDAP” 
on page 793.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).

4. The Add a New User to the System screen appears.

5. Click the Browse LDAP button ( ).
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6. The LDAP Explorer appears.

7. Navigate the LDAP server’s folders by clicking on the folder 
images. Each folder represents an Organizational Unit (OU). 
When you choose an OU level, its users appear.

NOTE In the LDAP Explorer, the Path and Org/Domain fields update dynamically as you 
navigate through the LDAP tree.

8. Select a user.
9. The user is now added to Ektron CMS400.NET and added to 

the Everyone group. To learn about how to assign this user to a 
specific group, see ”Assigning Users To User Groups” on 
page 671.

Editing User Information in Ektron CMS400.NET
It is important to note that Ektron CMS400.NET does not write to the 
LDAP server. So, while you can change any fields when editing a 
user in Ektron CMS400.NET, you also need to make these 
changes in the LDAP server.

Steps to Edit an LDAP User’s Information

The following steps explain how to edit an LDAP user’s 
information.

1. In the Workarea, click Settings > Users.
2. In the Username column, click a user to edit.
3. The View User Information screen appears.

4. Click the Edit button ( ).
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5. Change the information as needed. For more information on 
the fields you can edit, see ”Fill out the fields according to the 
table below.” on page 800.

6. Click Save ( ).

Deleting Users
If a user is deleted in an LDAP server, Ektron CMS400.NET does 
not automatically delete the user. However, the user’s login fails 
because he cannot be authenticated.

In this case, you should delete the user from Ektron CMS400.NET 
using the Delete User function. See Also: ”Deleting a User” on 
page 669

NOTE If you mistakenly delete all users with administrative privileges, you can still sign 
in using the builtin user’s username and password. For more information, see 
”BuiltIn User” on page 25.

LDAP Screen Descriptions
The LDAP feature uses the following screens:

• ”The Active Directory Setup Screen” on page 804

• ”The View Users Screen” on page 805

This section explains how to use each screen.

The Active Directory Setup Screen
The Active Directory Setup screen (illustrated below) lets you 
enable and disable the Active Directory or LDAP features, as well 
as determine other aspects of AD management, such as whether 
users and groups are automatically updated. To access the screen, 
click Configuration -> Active Directory -> Setup from the left 
panel of the Workarea.
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For a description of the fields, see the Active Directory section 
”The Active Directory Setup Screen” on page 763.

The View Users Screen
The View Users screen (illustrated below) lists all users in the 
Ektron CMS400.NET database. To access the screen, click Users 
from the left panel of the Workarea. To view more information for a 
user, click that user to move to the View User Information screen.
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The View Users screen also provides a toolbar button ( ) that 
lets you add LDAP users manually to the Ektron CMS400.NET 
database. This is useful if you want to add a single user from an 
Organization that is does not have the same Organizational Unit as 
the rest of your users, and you do not want to add any other users 
from that Organization.
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The View User Information Screen

The View User Information Screen displays the user’s

• username

• Path

• first and last name

• language

• email address and whether the user receives email 
notifications

• whether the account is locked

• which Forum Editor the user is using

• user groups

• user properties (if any)
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The screen also displays the following buttons.

Disabling LDAP Authentication
If you decide to disable LDAP authentication or integration, edit the 
Active Directory Setup screen and select Disable Active 
Directory and LDAP Authentication.

See Also: ”The Active Directory Setup Screen” on page 804

Button Description

Edit information on screen

Delete user
See Also: ”Deleting Users” on page 804

Return to previous screen

Launches a help screen
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Multi-Language Support

There are several aspects to translating within Ektron 
CMS400.NET. They are listed below.

Working with Multi-Language Content
Ektron CMS400.NET supports the creation of content in any 
language supported by the Unicode standard. This section 
explains how to create and work with content in any language.

Overview
First, determine the languages in which your site’s content should 
appear (see ”Determining Which Languages are Available” on 
page 813). Then, for any content, you can provide editions in each 
supported language.

To provide multi-language content, you can either create new 
content or copy and edit existing content. For example, you can 
begin the creation of German content by copying English content 
into it, then translating that content into German and deleting the 
English content.

Type of Translation Seen by For more information, see

Content Content contributors; visitors to 
your site

”Working with Multi-Language 
Content” on page 809

Spell check dictionary Visitors to your site ”Set the Language of Spell 
Checking” on page 847

Special Character Encoding Visitors to your site ”Character Encoding” on 
page 847

Workarea screen labels, alt text, 
system messages

Content contributors ”Translating the Workarea” on 
page 848
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All editions of content have the same ID number but are 
differentiated by the language attribute. As a result, your Web page 
template can link to a single content item, but what is displayed is 
determined by the selected language. There are two ways that 
content’s language can be selected:

• a language cookie, which is created when a visitor enters your 
site and selects a language

• the link to another page includes the language (langType) 
parameter. For example, mytemplate.aspx?LangType=1033. 

NOTE For a list of the decimal values for each supported language, see ”Appendix C: 
List of Supported Languages” on page 1015.

The View Contents of Folder screen’s View field lets you choose a 
language then view and create content in that language. You can 
also view all content in the folder, regardless of language. This field 
makes to easy to find and work on content editions in a selected 
language.
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The View Contents of Folder screen also displays the language of 
each content item. This helps you distinguish them when viewing 
all content.

Finally, you can set up a separate approval chain for each edition 
of a content, and can assign collections and tasks in any supported 
language.

This section describes how to work with a multiple language Web 
site through the following topics.

• ”Enabling/Disabling Support for Multiple Language Content” on 
page 811

• ”Viewing Your Site in Another Language” on page 811

• ”Determining Which Languages are Available” on page 813

• ”The Default Language” on page 816

• ”Creating New Content” on page 817

• ”Translating Content” on page 818

• ”Additional Multi-Language Topics” on page 836

• ”Setting Up a Multilingual Web Site” on page 838

• ”Using a Language Other than American English as the 
Default” on page 842

• ”Resolving Conversion Issues” on page 843

Enabling/Disabling Support for Multiple Language Content
Support for multi-language content is enabled in the web.config 
file. To enable or disable it, follow these steps.

1. Open the file webroot\yourwebsite\web.config.
2. To enable multi-language content, set the value of 

ek_EnableMultilingual to 1. To disable it, set it to zero (0).
3. Save and close web.config.

Viewing Your Site in Another Language
It’s easy for your site visitors to view your site in any enabled 
language. On any screen, your developer can display a language 
drop-down list (circled in red below).
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(For more information about the LanguageSelect Server Control 
which displays this drop-down list, see the Ektron CMS400.NET 
Developer’s Manual.) On the sample site provided with Ektron 
CMS400.NET, this drop-down list appears in the lower left corner of 
the home page, but your developer can place it anywhere on any 
page.

Another way to indicate which language-edition of content to 
display is by adding the language parameter (langType) to the 
Quicklink. For example, products.aspx?LangType=1033 displays the 
English (US) edition of the products.aspx content. This syntax 
automatically sets the language cookie.

NOTE For a list of the decimal values for each supported language, see ”Appendix C: 
List of Supported Languages” on page 1015.



Multi-Language Support

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 813

See Also: ”What Happens if Chosen Language is Not Available” on 
page 813

What Happens if Chosen Language is Not Available
A visitor to your site uses one of the methods listed above to select 
a language. Ektron CMS400.NET uses the following criteria to 
determine which language edition to display for content.

1. If an edition of the content is available in the selected 
language, display that.

2. If option 1 is not available, display an edition of the content in 
the default language (defined in the 
ek_DefaultContentLanguage variable in web.config).

NOTE When Ektron CMS400.NET is installed, the default language is English.See 
Also:  ”The Default Language” on page 816

3. If neither edition is available, display nothing.

Determining Which Languages are Available
To determine which languages are available for creating content, 
go to the Workarea and click Settings > Configuration > 
Language Settings. The Language Settings screen lists all 
languages in which content can be created on your site.

NOTE Only members of the Administrator User Group can view, add, or edit language 
settings.

To change the list, follow these steps.

1. Click the Edit button ( ).

2. The Edit Language Setting screen appears.
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3. Each language has two check boxes. They are described 
below.

• To enable a language in the Workarea only, click ( ). If this 
column is checked, the language populates the language drop-
down lists within Ektron CMS400.NET, as shown below.
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• To enable a language in the Workarea and let site visitors 
select it when viewing the site, click ( ). 

So, you can enable languages in the  column when you are 
translating the site but are not ready to make those content items 
publicly available. When you complete the translation, check the 

 column.

NOTE
If you select , the check box in the  column is checked automatically. 
This is because, if you let users view the language on the site, it must be enabled 
in the Workarea.

NOTE The default content language on a dropdown list is determined in the 
ek_DefaultContentLanguage element of the web.config file.
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If you choose only one language on the Language Settings screen, 
fields that prompt the user to select a language do not appear in 
Ektron CMS400.NET. Instead, all content is created in that 
language.

The Default Language
The default language determines which edition of content to 
display when a visitor to your site does not select a language.

It is also used if a visitor selects a language other than the default, 
then navigates to page for which content does not exist in the 
selected language. In that case, Ektron CMS400.NET displays that 
content in the default language (if available).

Within Ektron CMS400.NET, the default language determines the 
default value on the language drop-down lists that appear on every 
page on which a user can select a language.

When you install Ektron CMS400.NET, the default language is 
English. 

Use the following procedure to change the default language for 
your multi-language Web site.

1. Open webroot\yourwebsite\web.config.
2. Set the value of ek_DefaultContentLanguage to the locale id of the 

default language. For example, 1031 for German.

NOTE For a list of locale ids, see ”Appendix C: List of Supported Languages” on 
page 1015.

3. Save and close web.config.
See Also: ”Using a Language Other than American English as the 
Default” on page 842

Disabling a Language
To disable any language, uncheck the accompanying checkbox on 
the Edit Language Setting screen. (For more information, see 
”Determining Which Languages are Available” on page 813.) 

If you want to disable the default language, you must first assign a 
new default language. See Also: ”The Default Language” on 
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page 816 explains what a default language is and how to assign 
one.

What Happens to Content When You Disable Its Language

If you disable a language for which content exists, that content 
remains in the database but no one can access it, either from 
within Ektron CMS400.NET or when visiting your site.

If you later enable that language, the content is once again 
available.

Creating New Content
To create content in a non-English language, follow these steps.

1. Navigate to the content folder in which you want to create the 
content. (You must have permission to add content to the 
folder.)

2. From the language drop-down list, select the language in which 
you want to create the content.

.
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If the desired language is not available, see ”Determining 
Which Languages are Available” on page 813.

3. Click the Add Content button ( ) and create the content as 
you would any content.See Also:  ”Adding Content” on page 73

4. In order to add metadata to a content, metadata specifications 
must have been created for the selected language.See Also:  
”Metadata” on page 116

Translating Content
When translating content into a foreign language, you have three 
options.

Translating Content Manually
Use this procedure when you want to initialize new foreign 
language content with content from a source language, then 
translate the content manually. This copying should facilitate the 
translation.

For example, an editor is translating content from French to 
German. The editor copies the French edition to new content 
whose language is German. As the editor translates the French 
edition into German, he deletes the French content. Any images in 
the content would usually remain, and all formatting (tables, 
bullets, etc.) is retained.

After signing in to Ektron CMS400.NET, you copy content into new 
content of a different language by either

Option For more information, see

Copy original content into a new content item in a 
new language. Then, translate content manually.

”Translating Content Manually” on 
page 818

Use the computer-based translation tool provided 
with Ektron CMS400.NET.

”Using Machine Translation” on page 820

Create an XLIFF or XHTML file from existing 
content. The files are sent to a translation agency 
and return translated in the new language(s). 
Then, you import the translated files into the CMS.

”Using the Language Export Feature” on 
page 824
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• navigating the Web site, or

• accessing the Workarea and navigating the folder structure

After copying the original content, translate it into the new 
language then delete the original text. Both procedures are 
described below.

Accessing Content via the Web Site

1. Navigate to a page on which you can select the site language. 
See Also: ”Viewing Your Site in Another Language” on 
page 811

2. Select the language into which you want to translate the 
content.

3. Navigate to content that you want to translate. You must have 
privileges to add content to this folder. See Also: ”Setting 
Permissions” on page 716

4. Right click within the content’s border and a small menu 
appears.

5. Click the Add New Language option ( ).

6. The original language content appears. Translate into the new 
language then delete the original content.

NOTE At this point, you can click the Translate Content button ( ) to have the software 
translate the content. You can then edit it as needed to perfect the translation.

7. In order to add metadata to content, metadata specifications 
must have been created for the selected language. See Also: 
”Metadata” on page 116

8. When you save the content, it is saved as the edition of that 
content in the selected language.

Accessing Content via its Content Folder

To copy content into a new content of a different language, follow 
these steps.

1. Go to the View Content screen for the content you want to 
translate. Its status must allow editing (it cannot be submitted 
or pending).
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2. From the View drop-down list, select a original language.
3. Click the content you want to translate.
4. It appears on the View Content screen.
5. Use the Add drop down list in the upper right corner to select 

the language into which you want to translate the content.

6. The original language content appears. Translate into the new 
language then delete the original content.

7. In order to add metadata to content, metadata specifications 
must have been created for the selected language.See Also:  
”Metadata” on page 116

8. When you save the content, it is saved as the edition of that 
content in the selected language.

Using Machine Translation
Ektron CMS400.NET includes a machine translation feature, which 
can automatically translate content from/to the following 
languages.

• English

• Dutch

• French

• German

• Italian

• Portuguese (Brazil)

• Spanish

NOTE Currently, machine translation is not supported for all languages in the Language 
Settings screen.
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Like most software-based translation, someone fluent in the new 
language should review the translated content to verify that the 
translation is appropriate within the context of the page.

The machine translation feature lets you choose a glossary (that is, 
a field, industry, or subject area). This helps the software find the 
best translation for a term or phrase with different meanings in 
different fields.

To use the machine translation feature, follow these steps.

Accessing Content via the Web Site

1. Navigate to a page on which you select the site language. See 
Also: ”Viewing Your Site in Another Language” on page 811

2. Select the language into which you want to translate.
3. Navigate to content you want to translate.

NOTE You must have privileges to add content to the folder.See Also:  ”Setting 
Permissions” on page 716

4. Right click within the content’s border. A menu appears.

5. Click the Add Content button ( ).

6. The original language content appears.
7. If the screen uses a Smart Form, select the text that you want 

to translate.

NOTE You cannot use Machine Translation to translate field names in a Smart Form. 
XLIFF files are a good way to translate XML field names.See Also:  ”Using the 
Language Export Feature” on page 824

8. Click the Translate Content button ( ).
9. The Translation screen appears.



Multi-Language Support

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 822

10. Select the source (old) and target (new) languages.
11. If the content should refer to a specific glossary, select one 

from the dropdown list.
12. Click the Translate button.
13. The translation appears. If it looks OK, press Paste Content.
14. The translated content replaces the original content in the 

editor. Modify as needed.
15. In order to add metadata to content, metadata specifications 

must have been created for the selected language.See Also:  
”Metadata” on page 116

16. When you save the content, it is saved as the edition of that 
content in the selected language.

Accessing Content via its Content Folder

To machine translate content by identifying its content folder, follow 
these steps.

1. Log into the Workarea.
2. Navigate to the content folder that contains the content you 

want to edit.
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3. Click View > Language and select an original language (that 
is, the language from which it will be translated).

4. Click the content you want to translate. Its status must allow 
editing (that is, its status cannot be submitted or pending).

5. It appears on the View Content screen.
6. Use the Add drop down list in the upper right corner to select a 

new language for the content. Ektron CMS400.NET must 
support for machine translation for the language (English, 
Dutch, French, German, Italian, Portuguese (Brazil), or 
Spanish).

7. The original language content appears. Edit the title if 
appropriate.

8. Click the Translate Content button ( ).

9. The Translation screen appears.

10. Select the source (old) and target (new) languages.
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11. If the content should refer to a specific glossary, select one 
from the dropdown list.

12. Click the Translate button.
13. The translation appears. If it looks OK, press Paste Content.
14. The translated content replaces the original content in the 

editor. Modify as needed.
15. In order to add metadata to content, metadata specifications 

must have been created for the selected language.See Also:  
”Metadata” on page 116

16. When you save the content, it is saved as the edition of that 
content in the selected language.

Using the Language Export Feature
The Language Export feature lets you copy content into XLIFF files 
that can be submitted to a translation agency. The agency 
translates the files and returns them. In the final stage, you import 
the translated content back into Ektron CMS400.NET.

The Language Export feature lets you translate the following kinds 
of CMS information.

• content, including summary, comments, and meta data

• forms, including response message, comments, and meta data

• all menus (you cannot choose individual menus)

• file assets (files managed by the DMS, including Office 
documents, Open Office documents, managed files, etc.)

The Language Export Feature is explained through the following 
topics.

• ”What is XLIFF?” on page 825

• ”Overview of Exporting/Importing Translation Files” on 
page 825

• ”Creating the .zip File” on page 826

• ”Importing Translated Files into Ektron CMS400.NET” on 
page 830
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• ”Applying Translated Metadata to Translated Content” on 
page 833

What is XLIFF?
XLIFF (XML Localization Interchange File Format) is a format 
that's used to exchange localization data between participants in a 
translation project. This special format enables translators to 
concentrate on the text to be translated, without worrying about 
text layout. The XLIFF standard is supported by a large group of 
localization service providers and localization tools providers.

To learn more about XLIFF, visit these Web sites:

• http://www-106.ibm.com/developerworks/xml/library/x-localis/ 

• http://www-106.ibm.com/developerworks/xml/library/x-localis2/

• http://www.xliff.org/ 

Supported Versions of XLIFF

Ektron CMS400.NET supports the following versions of the XLIFF 
standard: 1.0, 1.1, and 1.2. You specify the version you are 
exporting in the web.config file, using the ek_XliffVersion element. 
Any version listed above can be imported.

Overview of Exporting/Importing Translation Files
1. You select content to translate. You can select:

•a content item

•a folder (all content in the selected folder is selected; all 
subfolders of the selected folder may be included)

•all menus

2. Ektron CMS400.NET converts the selected content to XLIFF 
files. You can prepare the files for translation into several 
languages at once.
A separate .xlf file is created for each item. Then, all .xlf files for 
a language are compressed into one .zip file. A separate .zip 
file is created for each language.

3. Transmit the.zip files to a translation agency, which converts 
them into the new language(s). 

http://www-106.ibm.com/developerworks/xml/library/x-localis/
http://www-106.ibm.com/developerworks/xml/library/x-localis2/
http://www.xliff.org/


Multi-Language Support

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 826

4. The translation agency returns the files.
5. Import them into Ektron CMS400.NET. If the editions of the 

content do not exist in the target language, they are created.

Creating the .zip File
To create one or more .zip files for translation, follow these steps.

Note Only members of the Administrator User Group and those defined in the Manage 
Members for Role: XLIFF-Admin screen can create or import XLIFF files. See 
Also: ”Using the Roles Screens” on page 736.

1. To translate one content item, navigate to its folder then click it.
To translate all content in a folder (and, if desired, all of its 
subfolders), navigate to its View Contents of Folder screen.
To translate a menu, go to Modules > Menus.

2. Click the Export for Translation button ( ). (On the View 
Contents of Folder Screen, click Action > Export for 
Translation.)

3. The Export for Translation screen appears.
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NOTE The Include Subfolders field only appears if you click the Export for Translation 
button from the View Contents of Folder screen.

4. If you want to include content in all of the selected folder’s 
subfolders, check Include Subfolders. To translate just the 
selected folder, uncheck it.

5. The language of items being translated appears in the Source 
Language pull-down. If this is not the correct source language, 
click the down arrow and select the correct one.

6. All languages enabled in the Language Settings screen are 
selected under Target Language(s). (See Also: ”Determining 
Which Languages are Available” on page 813). 

7. To translate the content into all languages, proceed to the next 
step. 
To translate the content into some languages, uncheck the 
languages that you do not want. You can uncheck the box in 
the header row (illustrated below) to uncheck all, then only 
check the ones you want.

8. Click the box in the left column for each language into which 
you want to translate the content.

9. Click the Create XLIFF Files for Translation button ( ).
10. Ektron CMS400.NET creates one .zip file for each language. 

The .zip file includes an XLIFF file for each selected content 
item.

NOTE If any selected folder contains content in a target language whose edit date is 
more recent than the source language edition, that content is excluded from the 
.zip file. Ektron CMS400.NET assumes that, since a more recent target-language 
edition exists, you do not want to translate the corresponding source language 
edition.

The History section of the Export for Translation screen 
displays the translated files.
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The history lists the .zip file created for each language. (.zip 

files are indicated by the WinZip icon ( ).) To the right of the 
icon are

•the flag of the source language

•an arrow indicating the direction of the translation

•the flag and name of the destination language

•the size of the zip file

NOTE The top of the history window displays the most recently exported/imported files.

11. If you want to review the items in a zip file, click the plus button 
next to Extracted. When you do, each content item’s ID 
number, title, and last edit date appear.



Multi-Language Support

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 829

12. Click the blue text of a .zip file. The File Download window 
appears.

NOTE If you want to review the XLIFF files within the .zip file, click Open.

13. Click the Save button. The Save As window appears. Navigate 
to the folder where you want to place the zip file and click 
Save.

14. Transmit the files to the translation agency.
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NOTE When XLIFF files are returned by the translation agency, their extension must be 
.xlf. Other than that, the file name is not important.

File Naming Patterns

Importing Translated Files into Ektron CMS400.NET
To import the translated files into Ektron CMS400.NET, follow these 
steps.

NOTE Only members of the Administrator User Group and those defined in the Manage 
Members for Role: XLIFF-Admin screen can create or import XLIFF files. See 
Also: ”Using the Roles Screens” on page 736.

1. Go to Workarea > Modules > Import XLIFF Files.
2. Click the Browse button and navigate to the folder that 

contains the translated files.
3. Select the files to import.

File
Type

Pattern

XLIFF item identifier[item ID]_[new language hexadecimal code][two letter new language code].xlf

• item identifier options: 

- content: cont

- form: form

- menu: s

- menu item: s

• item ID varies, depending on whether the item is content, a form, a menu, or a menu item

- content: content ID number

- form: form ID number

- Menu: menu ID number

- Menu item: menu ID number

Zip xlf[timestamp in format yyyymmddThhmmss]_u[user ID] _ [new language hexadecimal code]-
[two letter language code].zip
The user ID indicates which user performed the export or import.
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4. Click the Upload and Import button ( ).
5. Ektron CMS400.NET creates new or updates existing foreign-

language editions of the imported content.
6. Information about the imported file appears in the history area 

of the Import XLIFF Files screen. You can click plus signs (+) to 
reveal increasing levels of information about the imported 
content.

When you import the file, the comment Translated appears next to 
it.

For each new edition:

• If the content title is the same as the source edition, the next 
available number is appended to the title to distinguish it from 
the source. For example: Henry Williams(1).
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• its status matches the status of the source content. Typically, its 
status is checked out. When imported, it can enter the approval 
process just like other content.

• its history indicates it was checked in at the time the report was 
run

• for content, the following properties are inherited from the 
original content:

- status

- Smart Form

- content searchable

- approval method

• date created and last edit date are captured from when the 
content is imported

• the last user to edit is captured by user who imported the file

After you import the translation files, Ektron CMS400.NET removes 
them from the file system.

NOTE If an error exists in any of the files, the erroneous files are moved into a 
subdirectory. The directory is created using a timestamp. For example: 
uploadedFiles\localization\merged\xlf20060208T141841_u1\error\.

Viewing Foreign Language Content

1. Navigate to the folder that contains the content.
2. Click View > Language and select the desired language.
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3. Only content in that folder and the selected language appears.
You can perform the same activities with this content as any other 
content.

Applying Translated Metadata to Translated Content

Unfortunately, translated metadata is ignored when importing 
XLIFF files. This section describes how to have translated 
metadata applied to the translated content.

Background Information

Although metadata exists in the XLIFF files, it does not appear in 
the content's metadata even if metadata is defined for that 
language. This is because metadata definitions have unique IDs 
across languages.

NOTE While a content ID is the same for a corresponding content block in other 
languages, the same is not true for metadata.
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As a result, the ID for the source language (for example, English) 
metadata is not automatically mapped to metadata for other 
languages (for example, Spanish). 

To solve this problem, create a mapping between the IDs of 
metadata definitions of different languages that are synonymous. 
For example, consider the following metadata definitions.

In this example, IDs 102 and 106 are synonymous as are 104 and 
108. Definition 110, however, only exists in Spanish.

The mapping is stored in an XML file. The mapping informs the 
XLIFF import process that metadata for ID 102 in English 
corresponds to ID 106 in Spanish and likewise with 104 and 108.

Setting up the Process to Apply Translated Metadata to Content

1. Open the folder site root/workarea/xslt/ and look for the file 
metadatadefinitions.xml. If it exists, go to step 2. If it does not, 
download it from Ektron at http://dev.ektron.com/uploadedFiles/
DevCenter/Support/KB_Articles/XliffMetadata.zip.

The zip file includes modified XSLT files that access the XML 
file.

2. Create metadata definitions in the other language(s). Be sure 
to use the same data type. 
To do this, log in, open the workarea, go to Settings > 
Configuration > Metadata Definition. 

ID Name Language

102 Paper form number en-US

104 Original page count en-US 

106 Número de papel de la forma es-ES

108 Cuenta de la página original es-ES

110 Estado de la minoría es-ES

http://dev.ektron.com/uploadedFiles/DevCenter/Support/KB_Articles/XliffMetadata.zip
http://dev.ektron.com/uploadedFiles/DevCenter/Support/KB_Articles/XliffMetadata.zip
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3. Make note of the definitions in the original language (for 
example, English). 

4. Switch to view another language (for example, Spanish) and 
add a new definition. Assign it the same data type and other 
properties as the original. Make note of the new ID numbers.
Create metadata definitions in all languages you wish to 
support. You may add other languages and define more 
metadata definitions at any time. 

5. Edit workarea/xslt/metadataDefinitions.xml. For each Metadata 
Definition, enter a <dd> element within the <dl> element. The 
<dd> element has the following form.

<dd title="Name of the metadata definition">

    <dfn id="ID" xml:lang="language-country code"/>

    <dfn id="ID" xml:lang="language-country code"/>

    :

</dd>

For example,

<dl>

    <dd title="Paper form number">

        <dfn id="102" xml:lang="en-US"/>

        <dfn id="106" xml:lang="es-ES"/>

    </dd>

    <dd title="Original page count">

        <dfn id="104" xml:lang="en-US"/>

        <dfn id="108" xml:lang="es-ES"/>

    </dd>

</dl>

The definition for ID 110 is not included because it applies to only 
one language.

Now that you have set up the xml file, the XLIFF import process 
accesses the metadataDefinitions.xml file to determine which 
definitions in the target language (for example, Spanish) 



Multi-Language Support

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 836

correspond to the definitions in the source language (for example, 
English).

Additional Multi-Language Topics
• ”Multi-Language Approval Chains” on page 836

• ”Working with Tasks in a Multi-Language System” on page 837

• ”Working with Collections in a Multi-Language System” on 
page 837

• ”Working with Calendars in a Multi-Language System” on 
page 837

• ”Working with Menus in a Multi-Language System” on 
page 837

• ”Creating an External Link to a Page of Foreign Content” on 
page 838

Multi-Language Approval Chains
Just as you can create separate editions of content for each 
enabled language, you can set up a language-specific approval 
chain and method. When determining a folder’s approval chain, 
first select a language then select users and groups with authority 
to approve content in that folder and that language.

The screen below shows the language selection drop-down list on 
the View Approvals screen.

Only users in the language-specific approval chain for a folder can 
approve content in that language. 
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You can also set a language-specific approval method. See Also:  
”The Approval Method” on page 732

Working with Tasks in a Multi-Language System
If you create content then add a task to it, the task can be in any 
enabled language. This would be helpful if, for example, you 
review English content then want to assign the task of translating it 
into another language in that language.

If you create a task then try to assign content to it, you can only 
choose from content in the language of the task.

Working with Collections in a Multi-Language System
In a multi-language Ektron CMS400.NET system, you can create a 
language-specific edition of each collection. For information about 
doing this, see the Ektron CMS400.NET User Manual section 
“Working with Collections.”

Working with Calendars in a Multi-Language System
Calendars can be created in any supported language. Once you 
enter the calendar and event information in the foreign language, 
the calendar display (that is, day and month names) automatically 
appears in that language. Also, regional conventions for first-last 
days of the week, and date and time formats are maintained.

For more information, see ”Creating a Foreign Language 
Calendar” on page 562.

Working with Menus in a Multi-Language System

NOTE If you are not familiar with the Ektron CMS400.NET’s menus feature, please read 
“Menu Feature” on page 618 and the Ektron CMS400.NET User Manual section 
“Working with Menus.” 
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You can create an edition of any menu in every supported 
language. When a site visitor selects a language, navigates to a 
page that has a menu and clicks the menu link, Ektron 
CMS400.NET displays the menu in the selected language if it is 
available. If a menu in that language is not available, nothing 
appears.

Before creating or translating a menu, it’s a good idea to create or 
translate all content that will be on the menu. In this way, you can 
link these content items to the new menu. However, after creating 
a menu, you can always add new items to it.

For details about translating menus, see the Ektron CMS400.NET 
User Manual section “Working with Menus”, “Managing Menus”, 
“Working with Menus in a Multi-Language System.”

Creating an External Link to a Page of Foreign Content
If another Web site links to a multilingual page on your site, the 
URL must include the language ID parameter. For example:

www.ektron.com/web-content-management-solutions.aspx?LangType=1036

Setting Up a Multilingual Web Site
Ektron CMS400.NET supports multi-lingual content. This section 
lists steps to follow when setting up such a site.

See Also: ”Creating Web Pages that Support Several Languages” 
on page 839

Step For details, see

1. In web.config, make sure multilin-
gual support is enabled.

”Enabling/Disabling Support for Multiple Language 
Content” on page 811
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Creating Web Pages that Support Several Languages

2. Set a default content language, one 
that will be used by the majority of 
your site’s content.
If you had a previous version of 
Ektron CMS400.NET  and selected 
a default language on the Database 
Upgrade Utility, be sure that default 
language matches the one in 
web.config.

”The Default Language” on page 816

3. Enable languages your site will 
support.

”Determining Which Languages are Available” on 
page 813

4. Add language selection function to 
templates.

”Viewing Your Site in Another Language” on page 811

5. Create a metadata definition for 
each supported language.

”Adding a Metadata Definition” on page 127

6. Create or translate content. • ”Creating New Content” on page 817

• ”Translating Content” on page 818

7. Change the language of content not 
in the default language.

Note: Only needed if Web site previously 
had multi-lingual content.

”Resolving Conversion Issues” on page 843

8. Set up approval chains for new 
content.

”Multi-Language Approval Chains” on page 836

9. Set up multilingual collections. ”Working with Collections in a Multi-Language System” 
on page 837

10. Set up multilingual menus. ”Working with Menus in a Multi-Language System” on 
page 837

11. Modify text on templates. ”Modifying Page Content Based on Language 
Selection” on page 840

12. Translate graphics. ”Modifying Images Based on Language Selection” on 
page 841

Step For details, see
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When thinking about setting up your Web site to support content in 
multiple languages, consider these three actions.

Modifying Page Content Based on Language Selection
If a template’s text should change according to a user’s language 
selection, use a case statement to provide the language-specific 
content. A good example of this is the template used on the RC 
international sample site (Illustrated below).

Assume you want to create editions of the menu that runs across 
the header (Home, Products, etc.) in three languages:

• English

• French

Action For more information, see

Create language-specific 
content, menus, collections

• ”Translating Content” on page 818

• ”Working with Collections in a Multi-Language Sys-
tem” on page 837 

• ”Working with Menus in a Multi-Language System” 
on page 837

After you create these items, have the page invoke that 
item dynamically. When Ektron CMS400.NET  receives 
a request to display an item that includes a language 
and item id number, it returns the language-specific 
edition. To learn about letting the user select a language 
from a Web page, see ”Viewing Your Site in Another 
Language” on page 811.

Adjust template content to user 
language

”Modifying Page Content Based on Language 
Selection” on page 840

Translate text in images ”Modifying Images Based on Language Selection” on 
page 841
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• German

To do so, follow these steps.

Note This procedure uses the header.asp file delivered with the RC international 
sample site as an example.

1. In the template file, declare each menu option a variable. For 
example:

Dim t_search, t_products, t_support, t_news, t_careers, t_calendar, t_home, t_login,  
t_site_lang, t_contact, t_copyright, calendar_id

2. Enter case statements that provide the value of each variable 
in each language. (1031 is the decimal code for German, 1036 
for French.) The following illustrates how to do this for the 
search menu option.

Select Case ContentLanguage

Case "1031"

t_search = "Suche"

Case "1036"

t_search = “Recherche"

Case else

t_search = "Search"

End Select

Now, when a user visits a page controlled by this template and 
selects French or German as the site language, the page is 
refreshed and the translated values appear on the template.

Modifying Images Based on Language Selection
Many Web page templates also include images that require 
translation. You can set up templates to invoke images in the user-
selected language by following these steps.

1. Add to the library each image that should change when the 
language changes. For example, if your company’s tag line is 
translated into three languages, upload the three images into 
the library.
It‘s a good idea to include the language in the title of the image. 
For example, tagline_English, tagline_French.
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2. Create a separate content block for each language-specific 
image. Each content block must have a unique ID number.

3. Insert the appropriate image into a content block for each 
language. For example, insert the tagline_English image into 
the English content block.

4. Insert the content blocks into the appropriate templates. For 
example, insert the English content block into the English 
template.

Using a Language Other than American English as 
the Default

Use this procedure if your site supports one language only, and it is 
not American English (1033).

To set your site’s default language to something other than 
American English, follow these steps. 

1. Install a new site. Do not log in at this point.
2. Open your site’s web.config file (located in your site root 

folder.) Set ek_EnableMultilingual to zero (0). Set 
ek_DefaultContentLanguage to the four digit locale id for the 
desired language. See ”Appendix C: List of Supported 
Languages” on page 1015

3. Log in to Ektron CMS400.NET.
4. Go to Settings > Configuration > Language Settings.
5. Enable the desired language, and disable all other languages.
6. Go to Settings > Configuration > Setup.
7. Make sure the desired language is the Default Application 

Language.
8. Go to Settings > Users > Edit User Information. Set the 

User Language to the desired language. Do not leave App 
Default as the value.

9. Repeat Step 7 for every Ektron CMS400.NET user.
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Resolving Conversion Issues
IMPORTANT! This section is only relevant to Web sites that upgrade to Ektron CMS400.NET 

Release 4.7 or higher and which, prior to the upgrade, had content in more than 
one language. If your site does not meet both criteria, you can ignore this section.

When you upgrade to 4.7 or higher, the Database Upgrade utility 
prompts you to select a language. All content in your site is then 
assigned that language. (Prior to Release 4.7, content did not have 
a language attribute.) If all content is not in the selected language, 
you must resolve that discrepancy.

For example, assume for the sake of simplicity that your pre-4.7 
Web site had four content items: three English and one French. 
During the database upgrade, you select English. Three content 
items are assigned the correct language, but the fourth content 
item, which should be assigned French, is also assigned English. 
You cannot simply change the content’s language assignment. 
When resolving the discrepancy, there are two possible scenarios.

Scenario 1
Prior to 4.7, your site had unique content in French (id number 4). 
To resolve this, copy the content to a new French edition with the 
same id number. Then, delete the English edition.

Before Upgrade

Content id Language 
attribute

Actual 
language

1 not available English

2 not available English

3 not available English

4 not available French
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After Upgrade

After Following Procedure Listed Below

Procedure for Scenario 1

To change a content item’s language, follow these steps.

NOTE Before beginning this procedure, make sure 

• the correct language for the content is enabled. See ”Determining Which 
Languages are Available” on page 813.

• metadata has been defined for the new language. See ”Adding a Metadata 
Definition” on page 127

Content id Language 
attribute

Actual 
language

1 English English

2 English English

3 English English

4 English French

Content id Language 
attribute

Actual 
language

1 English English

2 English English

3 English English

4 (deleted) English English

4 French French



Multi-Language Support

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 845

1. Within Ektron CMS400.NET, navigate to the View Content 
screen on content item 4.

2. From the Add drop-down list, select French.

3. Ektron CMS400.NET creates a French edition of the content.
4. Check in that edition of the content.
5. Delete the English edition of the content.

Scenario 2
Prior to 4.7, your site had English and French content (id numbers 
3 and 4) that presented the same content in each language. You 
want to leave the English content alone, create a French edition of 
that content with the same id number, then delete the French 
content.

The advantage of this solution is that both editions of the content 
have a single id number. So, when a site visitor selects a language 
and navigates to that page, Ektron CMS400.NET displays the 
edition of the content for the selected language.

To resolve this, create a French edition of the English content, 
copy the French content, then delete the French content.

Before Upgrade

Content id Language 
attribute

Actual 
language

1 not available English
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After Upgrade

After Following Procedure Listed Below

Procedure for Scenario 2

To solve the language conversion issue explained in scenario 2, 
follow these steps.

2 not available English

3 not available English

4 not available French

Content id Language 
attribute

Actual 
language

1 English English

2 English English

3 English English

4 English French

Content id Language 
attribute

Actual 
language

1 English English

2 English English

3 English English

3 French French

4 (deleted) na na
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NOTE Before beginning this procedure, make sure 

• the correct language for the content is enabled. See ”Determining Which 
Languages are Available” on page 813.

• metadata was defined for the new language. See ”Adding a Metadata 
Definition” on page 127

1. Within Ektron CMS400.NET, navigate to the View Content 
screen of content id 3.

2. From the Add drop-down list, select French.

3. Ektron CMS400.NET creates a French edition of content id 3.
4. Translate the title into French. 
5. Delete the English elements of content id 3 (content, summary, 

metadata, schedule, and comments).
6. Check in the French edition of content id 3.
7. Copy and paste all relevant elements of the French content (id 

4) into the French edition of content id 3 (content, summary, 
metadata, schedule, and comments).

8. Delete content id 4. See Also: ”Deleting Content” on page 82

Set the Language of Spell Checking
To specify which dictionary to reference when checking spelling, 
specify a language in Microsoft Word, version 2000 or later. To do 
this, open Word and select Tools > Language > Set Language.

Character Encoding
The following Ektron Knowledge Base articles describe issues 
surrounding the display of special characters within Ektron 
CMS400.NET. Note that these articles refer to eWebEditPro, 
Ektron’s WYSIWYG editor embedded within Ektron CMS400.NET.
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Wherever these articles contain references to eWebEditPro’s 
configuration data or file (config.xml), you should instead update 
the web.config file, located in your site’s root folder.

• HOWTO: produce UTF-8 (www.ektron.com/developers/
ewebeditpro_tutorials.cfm?id=403)

• INFO: Character Encoding (www.ektron.com/developers/
ewebeditprokb.cfm?id=1807)

• INFO: Encoding special characters (www.ektron.com/
developers/ewebeditprokb.cfm?id=384)

Translating the Workarea
When Ektron CMS400.NET is delivered, the Workarea is in English. 
If you want to translate it to another language, read this section.

NOTE Ektron provides American English strings in a text file. You must translate them.

Prerequisites
• The alphabetical, four-character identifier of the country/ 

language into which you are translating. See CultureInfo Class 
from the MSDN Web site (http://msdn2.microsoft.com/en-us/
library/system.globalization.cultureinfo(vs.71).aspx).

• The server that hosts Ektron CMS400.NET must have Visual 
Studio.NET

Procedure for Translating Workarea Strings
All Workarea text (that is, screen titles, Workarea menus, 
messages, alt text for buttons, etc.) is stored in a resource file. 
Resource files are installed to the siteroot\Workarea\resources 
directory.

NOTE Workarea images that include text are stored in the workarea/images/language 
folder. For example, Workarea\images\french_standard.

Ektron CMS400.NET provides a resource files for the following 
languages. The English resource file is complete. The others are 
partially complete.

http://msdn2.microsoft.com/en-us/library/system.globalization.cultureinfo(vs.71).aspx
http://www.ektron.com/developers/ewebeditpro_tutorials.cfm?id=403
http://www.ektron.com/developers/ewebeditpro_tutorials.cfm?id=403
http://www.ektron.com/developers/ewebeditprokb.cfm?id=1807
http://www.ektron.com/developers/ewebeditprokb.cfm?id=1807
http://www.ektron.com/developers/ewebeditprokb.cfm?id=384
http://www.ektron.com/developers/ewebeditprokb.cfm?id=384
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• German

• English (United States)

• Spanish

• French

• Italian

• Dutch - Netherlands

• Dutch - Belgium

Regardless of the list above, to translate your Workarea, translate 
the English file into the desired language.

Procedure Overview

A resource file is not human-readable. To make it so, use 
Microsoft’s resgen utility. Next, translate the human-readable, .txt 
version of the file. Here is a portion of it.

add menu title=Add Menu
lbl ad serverip=Domain Controller IP
alt: remove collection items text=Click here to remove items from 
this collection

Notice that, for each string in the file, an English description 
appears first. The description includes information about where the 
text appears. For example, btn text appears on a button. Next is an 
equal sign (=), then English text. 

Translate the text to the right of the equal sign. You can send the 
file to an agency or do it yourself.

Then, run the resgen utility on the .txt file again, indicating the 
translate-to language. This converts the file back to a machine-
readable format. Finally, move that file to the appropriate language 
folder under workarea/images, and enable the new language in the 
Workarea.

Step by Step Instructions

To perform this procedure, follow these steps.
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1. The resgen.exe utility is located in C:\Program Files\Microsoft 
Visual Studio 8\SDK\v2.0\Bin. Copy it to the your web 
site\Workarea\resources folder.

2. Go to Windows Start button > Microsoft Visual Studio 2005 
> Visual Studio Tools > Visual Studio 2005 Command 
Prompt to open a command window.

3. Within the command window, change the directory to the your 
web site\Workarea\resources folder. For example, cd 
C:\Inetpub\wwwroot\CMS400Min\Workarea\resources.

4. Insert the following text: resgen EKResource.en-US.resources 
anyfilename.txt

NOTE You can assign any name to the .txt file.

5. A .txt file of resource strings converted to a human-readable 
format is created in the resources directory. (You assigned its 
name in Step 4.) Open the file.

6. Replace any single backslashes (\) with a double backslash 
(\\).

7. Translate the text following every equal sign (=). Be careful not 
to change any occurrences of n surrounded by double 
backslashes (\\n\\).

NOTE You can send the file to a translation house or translate the strings yourself.

8. Save and close the .txt file.
9. Open the command window (as described in Step 2) and insert 

the following: resgen anyfilename.txt EKResource.two-character 
country code-two-character language code.resources
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Replace anyfilename.txt with the file you named in Step 4. In 
this example, the .txt file is named span_translation.txt.
For example, to indicate that the Workarea is being translated 
into the Spanish/Spain, enter resgen.exe span_translation.txt 
EKResource.es-ES.resources.

When the conversion is complete, Writing Resource File 
...Done appears in the command window.

10. The Workarea\resources folder includes several resource files. If 
one exists for the translate-to language, it is overwritten. If one 
does not exist, it is created.
To follow our example, the EkResource.es-ES.resources file was 
updated with changes you made in Step 7.

11. Move the updated resource file to the appropriate language 
folder under Workarea/images. To continue our example, move 
the file to the Workarea/images/spanish_traditional_Sort folder.
If a folder does not exist for the new language, create one 
under Workarea/images.

12. Enable the new language in the Language Settings screen. 
See ”Determining Which Languages are Available” on 
page 813

13. Make the new language the default language in the 
Configuration Setup screen. See ”Default Application 
Language” on page 19.
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Managing Ektron 
CMS400.NET

Mapping Feature

The Mapping feature displays a map that flags locations of interest 
to your site visitors. Using Ektron’s GeoMapping functionality, 
content can be tagged with longitude and latitude coordinates to 
leverage Microsoft® Virtual Earth™ and Google Earth.

Each location is a CMS content item to which map information was 
added. For example, if your site hosts a school district, each map 
location could represent one school in the district.

For information on installing and using the Mapping Feature, see 
the Ektron CMS400.NET Developer Manual section “Introduction to 
Ektron CMS400.NET Server Controls” > “Map Server Control.”
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Site Replication

Site Replication is Ektron CMS400.NET feature that moves an 
entire site between your staging and production servers. Because 
this feature is an extra-cost option, it is documented separately in 
the Ektron CMS400.NET Site Replication Manual. It is available 
from http://www.ektron.com/web-content-management-
solutions.aspx?id=4020.

http://www.ektron.com/web-content-management-solutions.aspx?id=4020
http://www.ektron.com/web-content-management-solutions.aspx?id=4020
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Content Analytics Feature

The Content Analytics feature lets you track statistics about visits 
to your Web site. You can use it to determine the following kinds of 
information:

• how often your content was viewed

• how many site visitors viewed for first time, and how many 
returned

• the most popular referral pages (that is, the Web page from 
which visitors clicked to arrive on your site)

Several options for selecting a date range let you compare activity 
across different weeks, months, and years.

This section explains the Content Analytics feature through the 
following subtopics.

• ”Enabling the Content Analytics Feature” on page 854

• ”Determining Which Templates are Tracked” on page 855

• ”Specifying the Frequency of Writing to the Database” on 
page 857

• ”The Statistical Data” on page 857

• ”Writing to the IIS Log” on page 859

• ”Content Analytics Reporting” on page 859

• ”Changing the Date Range of the Statistical Data” on page 865

Enabling the Content Analytics Feature
By default, the Content Analytics feature is enabled in the 
web.config file, under the <analyticsSettings> tag. To disable it, set 
the value of the enableAnalytics property to false.

<analyticsSettings>
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<!-- globally enables or disabled all visitor tracking -->

<add key="enableAnalytics" value="true" />

If this property is set to true, and you later change it to false, 
statistical data remains within Ektron CMS400.NET, but no 
additional data is collected.

Determining Which Templates are Tracked
Analytic data is tracked for every template that has a Content 
Analytics server control.

NOTE Ektron CMS400.NET can only track template views if the viewer’s browser’s 
cookies are enabled.

Inserting a Content Analytics Server Control
For details about dropping this server control onto a template, see 
the Ektron CMS400.NET Developer Manual section “Content 
Analytics Server Control.”

Tracking Templates vs. Individual Content Items
To track visitor activity to a template (for example, 
customerservice.aspx), drop the server control onto it. To track 
activity for a content item within that template, set the 
DefaultContentID property to the ID of that content.

NOTE You can only track one content item per template.

Display of Analytic Data on Template
If a user is logged in, each template that has a server control 
displays statistics for that template. So, you can immediately see 
how many times a template has been viewed, and by how many 
visitors (as illustrated below).

Best Practice
Drop the control onto an area that does not disrupt the template layout, 
such as the bottom.
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You can get a more detailed breakdown of activity for a template by 
viewing the Top Templates statistics. See Also: ”Top Templates” on 
page 864
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Specifying the Frequency of Writing to the 
Database

Once you set up the Content Analytics feature, your database is 
subject to a continuous barrage of write activity, generated by visits 
to your site.

To mitigate the effect of this activity on your database’s 
performance, you can hold visit activity in application server 
memory until a predetermined amount of data is collected. When 
that amount is collected, it is moved in one packet to the database. 
So, the database is “hit” much less frequently.

You can specify the amount of data saved in memory prior to being 
written to the database using these web.config file elements.

• recordsBeforeWrite - the number of unique template visits

• timeBeforeWrite - the number of seconds since the last time a 
database write occurred

When either element reaches the value set in web.config, all 
records stored in application server memory are written to the 
database. That event also resets the value of both elements to 
zero (0).

The Statistical Data
For every template view, the following statistical information is 
captured:

• url - the visited page

• content_id - the ID of the visited content. Only captured if a 
content block ID was entered in the server control’s 
DefaultContentID property. See Also: ”Tracking Templates vs. 
Individual Content Items” on page 855

• visitor_id - a unique GUID that identifies a visitor

• hit_date - date and time when a page view occurred

• referring_url - the URL a user was viewing before jumping to 
the visited page
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• visit_type - zero (0) indicates new visitor, 1 indicates returning 
visitor, 2 indicates all other views. See Also: ”Tracking Site 
Visitors” on page 858

In a session, the first page hit tracks the visit as zero (0) (if the 
user is new) or 1 (if the user previously visited the page). From 
then on, 2 is logged.

Tracking Site Visitors
The Content Analytics feature provides information about visits 
made by new versus returning visitors. To capture this data, the 
feature asks this question whenever a page is visited: is the user 
logged in as either a membership or regular user?

• If yes, capture the user ID with the statistical data

• If no, place a cookie on the visitor’s computer

So, the first time a user visits a page, either user information is 
captured or a cookie is created.

The next time the user visits that page, the feature checks the visit 
history for the user ID, or for a cookie. If either is found, the visit is 
considered a return.

New Visitor Statistical Tracking

The same user visit may be considered new on one view but not 
on another. For example, someone visits on January 30 (Monday) 
then again February 2 (Thursday). On the monthly statistics, that 
visitor is new, but on the weekly statistics, the February 2 hit would 
be a return visit (his second this week).

Now consider a second visitor, who browses to your site on the first 
and 20th of the month. These visits would appear on weekly 
statistics as two new visits, but on the monthly statistics, only the 
first visit would show up on that month's tally of new visitors. The 
second visit would add to the return visitor statistics.
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Writing to the IIS Log
In addition to writing Site Analytic data to the database, you can 
write it to the IIS log. To do this, enable the appendToIISLog element 
in the web.config file.

Note that if you set appendToIISLog to true, Site Analytic data is 
written to the IIS log, but does not appear in the Workarea. Only 
data written to the database appears in the Workarea.

Content Analytics Reporting
The Content Analytics feature has extensive reporting features 
which are based on drilling down from a top-level view of the entire 
site, to individual templates, all the way down to individual content 
items (if specified).

To access Content Analytics Reports, follow these steps.

Either 

1. Browse to a content item for which analytic data is being 
captured.

2. Right click the mouse.
3. Click View Template Activity to see analytic data for the 

current content item (to learn more about data captured for one 
content item, see ”Top Content” on page 863).

4. Click View Site Analytics to view analytic data for the entire 
Web site.
or

1. Go to Modules > Site Analytics to view analytic data for the 
entire Web site.

Five levels of reporting are available.

• ”Site Statistics” on page 860

• ”Site Activity” on page 861

• ”Top Content” on page 863

• ”Top Templates” on page 864

• ”Top Referrers” on page 865
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Summary of Statistical Data Available
The following table lists the kinds of analytic statistics that can be 
viewed at each level of the site.

Site Statistics
The Site Statistics screen offers an overview of all tracked activity 
within the selected date range. You see actual data for the 

• number of views

• number of visitors

• ratio of visitors per view

• number of new and returning visitors

• ratio of new to return visitors

Below this data are pie charts of the ratio of views to visitors and 
new vs. return visitors.

Type of Statistical Information Site-wide Template-
Level

Content-Level

Views of Any Template X X X

Visitors: New and Return X X X

Pie Chart of New vs. Return Visitors X X X

Pie Chart of Views/Visitors Ratio X X X

Bar Graph of Views/Visitors Ratio X X X

Visited Pages X

Visited Content Blocks X X

URLs from which Site Visitors Accessed 
Ektron CMS400.NET

X
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NOTE To understand how new and returning visitors are tracked, see ”Tracking Site 
Visitors” on page 858.

Site Activity
The Site Activity view shows relative activity during the selected 
time period. The red bar indicates views, and the blue bar indicates 
visitors.
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Site Activity Time Increments

The graph’s time increments are one level below the Quick View 
selection. For example, in the screen above, Quick View is set to 
Day. So, the statistics are broken down by hours of the day.

The following table lists the Site Activity time increments for each 
Quick View selection.
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Top Content
The Top Content View shows the most frequently-accessed 
content items on your Web site.

See Also: ”Tracking Templates vs. Individual Content Items” on 
page 855

You can click any content item to view 

Quick view time 
increment

Site Activity Graph display broken down by 
these units

day hourly

week daily

month weekly

year monthly
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• Content Statistics - statistics for that content item only (See 
Also: ”Site Statistics” on page 860)

• Content Activity - relative activity for that content item only 
(See Also: ”Site Activity” on page 861)

• Audit Content - all users who viewed the selected content 
item; to the right of each user are the date and time when the 
content was viewed

NOTE Only users who viewed the content after logging in appear on the list. Visitors to 
your site who do not log in affect statistics but are not tracked on this report.

Top Templates
The Top Templates View shows all viewed templates on your Web 
site, with the most frequently-accessed templates on top.

By default, the templates at the top of the list are those with the 
highest number of unique visitors. You can change the sort by 
clicking on any column header. For example, to sort the templates 
by the number of views, click Views.

You can click any template to view 
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• Template Statistics - statistics for that template only (See 
Also: ”Site Statistics” on page 860)

• Template Activity - relative activity for that template only (See 
Also: ”Site Activity” on page 861)

• Content in Template - if a content items was specified for the 
template in the Content Analytic server control, this view show 
statistics for the template. You can click the template to view 
Template Level activity. (See Also: ”Top Templates” on 
page 864)

Top Referrers
The Top Referrers View shows the Web pages from which your 
site was most frequently accessed.

Changing the Date Range of the Statistical Data
When you first view statistical data, the default date range is today 
(one day).
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If you view statistics for different date ranges, when you return to 
the screen, the last selected date range is the default selection. 
You can change it if needed.

Using Quick View Options

Use Quick View options to view analytic statistics for any of the 
following time periods.

• one day

• one week

• one month

• one year

When you click Quick View [week], [month] or [year], the current 
end date is used as the last day of the range. Here are some 
examples.

Using Jump To Options

Use Jump To options to view analytic statistics for a time period 
before and after the current date range. The time period is 
determined by the Quick View increment. For example, if the Quick 
View option is Day, you can jump to the previous day, the following 
day, or today.

Regardless of the Quick View increment, you can always view 
statistics for today.

Quick 
View 
Option

If end date is today, begin date is

Week one week earlier than today

Month one month earlier than today

Year one year earlier than today
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Quick 
View 
Option

“Jump to” options

Day • previous day

• next day

• today

Week • previous week

• next week

• today

Month • previous month

• next month

• today

Year • previous year

• next year

• today
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Community Management

A community is a group of people who network with each other to 
share information, ideas, likes and dislikes. Typically, people or 
members in the community are connected by a relationship. For 
example, they work for the same company, went to the same 
school, share the same values, or have a friendship.

When a person visits a community site, he can look around to see 
what type of information, people and groups are on the site. While 
the person can see limited information on the site, he needs to 
become a member of the site to see all information.

When a person signs up to be member, he defines information 
about himself. This is known as his member profile. Once a person 
becomes a member, he can

• search for other members and add them to his friends list

• invite non-members to join the community and become a friend

• join or create a community group

• add photos

• add documents

• leave messages on another member’s message board

• write a private message to another member

• keep a journal of his thoughts

• have a list of favorite CMS400.NET content links

• have a list of content he’s added

• write content reviews

• flag content

The Community Platform in CMS400.NET is a group of features 
that allow users to network socially on the site. Access to the 
community platform is available from the Web site or the 
Workarea. Only CMS400.NET users and administrators can 
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access their information via the Workarea. Membership Users, 
CMS400.NET users, and administrators can access their profile 
pages via a Web site.

As an Administrator, you can manage Community features from 
the Workarea. These features are described in the following topics:

• ”Accessing a Profile” on page 869

• ”Message Board Comments Associated with Content in the 
Workarea” on page 870

• ”Community Groups” on page 870

• ”Distributing Content to Another Ektron CMS400.NET Folder” 
on page 880

• ”Flagging” on page 892

• ”Email Invites For Community Management” on page 907

• ”Tags” on page 909

• Reviews - see ”Content Rating” on page 85

• ”Assigning Templates to Groups and Members” on page 914

Accessing a Profile
A Profile provides users with information about a user. 
Administrators can access user profiles from the Workarea. 
CMS400.NET users can access their profile from the Workarea or 
the Web site. Membership users can access their profile page from 
the Web site.

IMPORTANT! For CMS400.NET users, some profile information in the Workarea’s View User 
Information screen is not available on the Web site profile page. That information 
involves Workarea settings.

Profiles in the Workarea
In the Workarea, profiles are located in the following areas:

• For CMS400.NET Users - navigate to Settings > Users. See 
”Managing Users” on page 663
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• For Membership Users - navigate to Modules > Community 
Management > Memberships > Users. See the ”Working with 
Membership Users” on page 677

Message Board Comments Associated with 
Content in the Workarea

Message Board comments can be associated with content. This 
allows a user who views the content on the site to add comments 
about the content. 

NOTE Message Boards can also be associated with users and groups. See the User 
Manual section My Workspace > Message Board and the Developer Manual 
section “MessageBoard Server Control.”

IMPORTANT! Message Board comments are not the same as the Comments tab on the View 
Content screen. See Also: The User Manual section “Working with Folders and 
Content” > “Adding Content” > “Tabs on the Edit Content Screen” 

You can view these comments in the Workarea. To do so, follow 
these steps:

1. Click the Content folder button.
2. Navigate to the content block for which to view messages.
3. Click that content item. The View Content screen appears.

4. Click the View Content Reports button ( ).
5. Click the Messages tab.
6. A list of comments associated with the content appears.

Community Groups
IMPORTANT! Membership User Groups and Community Groups are two different concepts. 

Membership User Groups allow an administrator to create a group of membership 
users, thereby reducing the effort required to assign identical permissions to 
many users. See ”Membership User Groups” on page 686. Community Groups 
are explained below.

Community Groups are another aspect of a community sites. 
Being a part of a group allows you to meet people with a similar 
interest, for example, car racing. 



Community Management

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 871

Groups have features and functions similar to users. A Community 
Group can have its own Message Board, Discussion Board, show 
a list of members in the group, and keep a journal about the group. 
Community Groups can be managed from the Web site or the 
Workarea.

Community Groups can also be assigned to a Taxonomy. This 
allows users to browse and search for groups by category. 

You can also assign Tags to a community group. This allows users 
to find the group when searching via tag name. Tag information for 
a group appears in the Group’s profile on the Web site. In the 
Workarea, Tag information can be found on the View Community 
Group’s > Tag tab. From this tab, you can add a Default Group Tag 
or a new tag associated with the group.

See Also: 

• ”Community Groups in the Workarea” on page 871

• ”Managing Community Groups” on page 872

• ”Distributing Content to Another Ektron CMS400.NET Folder” 
on page 880

Community Groups in the Workarea
You can access community group information in the following 
areas of the Workarea:

• My Workspace > Community Groups - this area allows you 
to see what groups you belong to and remove yourself from 
them. See the User Manual section “My Workspace” > 
“Community Groups” for additional information.

• Modules > Community Management > Community Groups 
- this area allows you to see all groups that exist. If you are a 
Group’s Leader (Group’s Administrator), CMS400.NET 
Administrator or a CMS400.NET user with the Community 
Group Administrator role, you can define a group’s details or 
add and remove members from the group.
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Managing Community Groups
To view a list of all community groups in the Workarea, click the 
Modules folder > Community Management > Community 
Groups > Groups.

From this screen, the following actions and information are 
available.

• Information
- Group Name

- How many members are in the group

- The language of the group

- The ID of the group

- Whether the group is Public or Restricted

- The short description of the group

- The location of the group

• Actions
- ”Adding a New Community Group” on page 872

- ”Viewing a Community Group’s Details” on page 875

- ”Editing a Community Group’s Information” on page 875

- ”Assigning Tags to a Community Group” on page 875

- ”Viewing Members of a Community Group” on page 876

- ”Adding Members to a Community Group” on page 877

- ”Accepting/Declining Requests to Join a Community Group” 
on page 878

- ”Removing Members from a Community Group” on 
page 879

- ”Deleting a Community Group” on page 879

- ”Searching for a Community Group” on page 880

Adding a New Community Group

Administrators or CMS400.NET users with the Community Group 
Administrator role can add a new community group in the 
Workarea. After you create a group, you can add members to it. 
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See Also: ”Adding Members to a Community Group” on page 877 
To add a new community group, follow these steps:

1. Click Modules > Community Management > Community 
Groups > Groups.

2. Click the Add New Community Group button ( ).

3. The Add Community Group screen appears.
4. Use the table below to assist you with filling out this screen.

Field Description

Properties Tab

Group Name The name of the group.

Administrator A group administrator has privileges to delete a group or 
edit its properties.

Note: Members of the Administrators group and users 
assigned to the Community Group Admin role also have 
these privileges.

By default, the person who created the group is the group 
administrator. Click the Browse button if you want to 
select a different group administrator.

Membership Select whether the group is open to the public, or if 
members can only join when invited.

Image Upload an image to use as an avatar for the group.

Location The geographical location associated with the group.

Short Description A brief description of the group.

Description A fully detailed description of the group.

Enable Distribute Check this box if you want the group and system 
administrator to be able to distribute content to any 
Ektron CMS400.NET  folder. See Also: ”Distributing 
Content to Another Ektron CMS400.NET Folder” on 
page 880
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5. Click the Save button ( ).
6. The page refreshes, and the View All Community Groups 

screen appears.

Allowing Community Group members to Work with Folders

When you associate the CommunityDocuments or PhotoGallery 
server control with a community group, you can allow members of 
the group to add, remove and control the sharing of folders in 
these controls. To allow a member to work with Photo Gallery and 
Workspace folders, follow these steps.

1. In the Workarea, navigate to Modules > Community 
Management > Community Groups > Groups.

2. Click a community group.

3. Click the Edit button ( ).
4. Place a check mark in the Allow member to manage photo/

workspace folders check box.

Allow member to 
manage photo/
workspace folders

Checking this box allows members to add, remove and 
control the sharing of folders in a community group’s 
Photo Gallery or Document’s Workspace. See Also: 
”Allowing Community Group members to Work with 
Folders” on page 874.

Tags Tab

Group Tags From this screen, you can either create a new tag or select 
from a default list of community group tags. See Also: 
”Assigning Tags to a Community Group” on page 875.

Categories Tab

Category List The categories tab lists all of the categories associated 
with the community group.

Note: If you have not defined at least one taxonomy for 
community groups, this tab does not appear. See Also: 
”Creating a Taxonomy in the Workarea” on page 631.

Field Description
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5. Click the Save button ( ).

Viewing a Community Group’s Details

Any user with access to the Workarea can view a group’s details. 
However, they cannot see the members of the group. 

If a user is the Group Leader (Group’s Administrator), an 
Administrator, or CMS400.NET User with the Community Group 
Administrator role, he can edit the group’s information, add and 
remove members, or delete the group.

To view a group’s details, follow these steps.

1. Click Modules > Community Management > Community 
Groups > Groups.

2. Click the Group Name link.
3. The group’s detailed information appears.

Editing a Community Group’s Information

Editing a group’s information allows you change certain details 
about the group. Only the Group Leader (Group’s Administrator), 
Administrators, or CMS400.NET Users with the Community Group 
Administrator role can edit a group’s information.

To edit a group’s details, follow these steps:

1. Click Modules > Community Management > Community 
Groups > Groups.

2. Click the Group Name link.

3. Click the Edit button ( ).

4. Change any fields as needed. These fields are described in 
”Adding a New Community Group” on page 872.

5. Click the Save button ( ).

Assigning Tags to a Community Group

You can either create a new tag for a community group or select 
from a default list of group tags.
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See Also: ”Tags” on page 909

To create a new tag for a community group, follow these steps.

1. In the Workarea, navigate to the Modules > Community 
Group > Groups.

2. Click the community group for which to create a new tag.

3. Click the Edit button ( ).

4. Click the Tags tab.
5. Click the Click To Add A New Group Tag link.
6. Add a tag to the Name text box.
7. Select a Language.
8. Click Save.

9. Click the Save button ( ).
Once the Tag is saved, it appears in the Group Tags area with a 
check mark in the check box. Having a check mark in the check 
box means the tag is active for the community group.

To add a default tag to a community group, follow these steps.

1. In the Workarea, navigate to the Modules > Community 
Group > Groups.

2. Click the community group for which to create a new tag.

3. Click the Edit button ( ).

4. Click the Tags tab.
5. Place a check mark in the tag’s check box that you want to use.

6. Click the Save button ( ).

Viewing Members of a Community Group

Only the Group Leader (Group’s Administrator), Administrators or 
CMS400.NET Users with the Community Group Administrator role 
can view members of the group. In addition to viewing community 
group members, you can see add and remove members. You can 
also accept or decline members’ requests to join the group if the 
group’s membership is set to Restricted.
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See Also: 

• ”Adding Members to a Community Group” on page 877 

• ”Removing Members from a Community Group” on page 879

• ”Accepting/Declining Requests to Join a Community Group” on 
page 878

To add members to a group, follow these steps:

1. Click Modules > Community Management > Community 
Groups > Groups.

2. Click the Group Name link.

3. Click the View Community Group Members button ( ).
4. A list of group members appears.

Adding Members to a Community Group

Only the Group Leader (Group’s Administrator), Administrators or 
CMS400.NET Users with the Community Group Administrator role 
can add members to a group.

To add members to a group, follow these steps:

1. Click Modules > Community Management > Community 
Groups > Groups.

2. Click the Group Name link.

3. Click the View Community Group Members button ( ).
4. The View Community Group Members for the group screen 

appears.

5. Click the Add User(s) button ( ).

6. The Add Members screen appears.
7. Using the drop down box, select the type of name for which to 

search.
8. Enter a name in the text box.
9. Click the Search button.

TIP! If you leave the text box blank and click the Search button, all results for the name 
type are returned.
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10. The results are returned.
11. Place a check mark in the box next to each member to add.

12. Click the Add button ( ).
13. The View Community Group Members screen appears with 

all members of the group.

Accepting/Declining Requests to Join a Community Group

If a group’s membership is set to Restricted (on the Add or Edit 
Community Group screen), users must request to join the group. If 
membership is set to Open, on the other hand, users join a group 
immediately.

Use the Pending tab on the View Community Group Members to 
accept or decline a user’s request to join a group. Only a Group 
Leader (Group’s Administrator), Administrators, or Ektron 
CMS400.NET users with the Community Group Administrator role 
can accept new members to a group.

To accept or decline members’ request to join a group, follow these 
steps.

1. From the Ektron CMS400.NET Workarea, go to Modules > 
Community Management > Community Groups > Groups.

2. Click the group for which you want to accept or decline 
requests to join.

3. Click the View Community Group Members button ( ).

4. Click the Pending tab.
5. Check the box next to each member whose request you want 

to approve or decline. 
6. To approve the selected members’ request to join, click the 

approve button ( ). 

To decline the request, click the decline button ( ).
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Removing Members from a Community Group

Only the Group Leader (Group’s Administrator), Administrators, or 
CMS400.NET Users with the Community Group Administrator role 
can remove members from a group.

To remove members from a group, follow these steps.

1. Click Modules > Community Management > Community 
Groups > Groups.

2. Click the Group Name link.

3. Click the View Community Group Members button ( ).
4. The View Community Group Members for the group screen 

appears.
5. Place a check mark in the box next to members you want to 

remove.

6. Click the Remove button ( ).
7. A dialog box appears asking you to confirm you are removing 

the selected members.
8. Click OK to remove the members.
9. The page refreshes, and the selected members are removed.

Deleting a Community Group

Only the Group Leader (Group’s Administrator), Administrators or 
CMS400.NET Users with the Community Group Administrator role 
can delete a group.

To remove a community group, follow these steps:

1. Click Modules > Community Management > Community 
Groups > Groups.

2. Click the Group Name link.

3. Click the Delete button ( ).
4. A dialog box appears asking you to confirm that the community 

group will be deleted.
5. Click OK.
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6. The page refreshes and the View All Community Groups 
screen appear.

Searching for a Community Group

You can search for a Community Group in the Workarea by using 
the Search box located at the top of the View All Community 
Groups page. To search for Community Groups, click Modules > 
Community Management > Community Groups > Groups. 
Enter text in the search box and click the Search button. A list of 
Community Groups that match the search term appears.

Distributing Content to Another Ektron 
CMS400.NET Folder

Ektron CMS400.NET supports the distribution of Community 
Documents to any CMS folder. (A community document is either 
HTML content or an asset created via the Community Documents 
server control.)

For example, your Marketing Department uses the Community 
Documents server control to create and edit content. After 
completing a press release, they use the Distribute menu option 
to copy it from the private collaboration folder to a public content 
folder. Once there, the document can pass through an approval 
chain or be published immediately.

The Distribute option can insert new content or overwrite existing 
content in any folder.
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The Distribute Option is more fully explained through these topics.

• ”Enabling the Distribute Option” on page 881

• ”Distributing a Community Document” on page 882

Enabling the Distribute Option
Only a member of the Ektron CMS400.NET Administrators group 
can enable the Distribute option. Do this for every Community 
Group that will use it. You can do so from the Workarea or after 
logging in to the Web site.

From the Workarea

1. From the Ektron CMS400.NET Workarea, go to Modules > 
Community Management > Community Groups > Groups.

2. Click the group for which you want to enable the Distribute 
option.

3. Click the Edit button ( ) .
4. Check the Enable Distribute check box.

5. Click the Save button ( ).
From the Web Site
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1. Log into a site that uses the Community Management features 
as a CMS administrator or a Group Administrator.

2. Navigate to a Web page that hosts a Group Profile page.
3. Click the Edit Group link (circled below).

4. Check the Enable Distribute check box.

5. Click the Save button ( ).

Distributing a Community Document
There are two procedures for distributing a community document 
the first time. When doing so, ask yourself the following question.

IMPORTANT! After a community document is distributed the first time, the original document is 
forever linked to the destination document. You cannot break the link.

What are you doing? Read this procedures

Replacing an existing file in an Ektron 
CMS400.NET  folder. The file types must match.

”Distributing a New Community Document that 
Overwrites an Existing One” on page 887

Placing a file in an Ektron CMS400.NET  folder 
for the first time

”Distributing a New Community Document” on 
page 883
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If you want to later revise the document, you would typically edit it 
in the collaboration folder and select the Distribute option again. 
When you do, you are asked to confirm replacing the document in 
the destination folder. You are not allowed to select another folder. 

If you really must distribute it to another folder, delete the 
document in the destination folder. This action breaks the link 
between documents. Once the link is broken, you can distribute 
the document to another folder. 

”Distributing Content After the First Time” on page 891 explains 
how subsequent edits are handled.

Prerequisites

• You log in as one of the following

- Administrator of the group whose documents are being 
distributed

- Ektron CMS400.NET user assigned Community Group 
Administrator role for that group

- CMS administrator

• The content’s status is Approved.

• You have permission to add, delete, and restore content to the 
destination folder. (If you do not, the folder doesn’t appear on 
the folder selection screen.) See Also: ”Setting Permissions” on 
page 716

Distributing a New Community Document

When distributing a Community Document that does not exist in 
Ektron CMS400.NET for the first time, you identify a destination 
folder and, if required, metadata and taxonomy categories. This 
information is collected through a series of screens that guide you 
through the process.

NOTE If you are using Ektron CMS400.NET with Microsoft Sharepoint Integration, 
after selecting the folder (in Step 8), the document is copied to that folder even if 
you later click the screen’s Close button. See Also: ”Ektron’s Microsoft Office 
SharePoint Server Connector” on page 1005.

1. Log in to the Web site that contains content you want to 
distribute.
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2. Navigate to the Web page that contains content you want to 
distribute.

3. Click the triangle to the right of the content or asset you want to 
distribute.

4. Click Distribute from the dropdown menu.

5. The following screen appears.

6. Click in the top box, which begins I want to distribute a copy 
of this item.

7. The following screen appears



Community Management

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 885

8. Select the folder to which you want to distribute the content.
9. Click Next.
10. The following screen appears if metadata or a taxonomy 

category is required for the folder.



Community Management

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 886

11. Enter any required metadata or taxonomy. See the Ektron 
CMS400.NET User Manual section “Adding or Editing 
Metadata,” ”Metadata” on page 116, and ”Taxonomy” on 
page 626.

12. A confirmation screen appears. Click Done.
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13. Ektron CMS400.NET copies the selected document to the 
selected folder.

Distributing a New Community Document that Overwrites an Existing 
One

NOTE This process only occurs the first time you overwrite a document. For a 
description of subsequent updates, see ”Distributing Content After the First Time” 
on page 891.

During this procedure, you identify a destination folder and content 
to be replaced. Since the content’s type that you are distributing 
must match the content being replaced, you only see content 
whose types match.

Upon replacing, any metadata and taxonomy categories applied to 
the existing content are applied to the new. Also, the content title 
and ID number from the existing content are maintained -- they are 
not replaced by the title and ID number of the new content. Finally, 
the existing content’s summary is maintained and can be edited if 
needed.

This information is collected through a series of screens that guide 
you through the process.
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1. Log in to the Web site that contains the content you want to 
distribute.

2. Navigate to the page that contains that content.
3. Click the triangle to the right of the document you want to 

distribute.
4. Distribute appears on the dropdown menu.

5. Click Distribute.
6. The following screen appears.

NOTE The following screen only appears the first time you overwrite a file. To overwrite 
the file subsequently, see ”Distributing Content After the First Time” on page 891.
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7. Click the lower box, which begins I want to replace an 
existing item.

8. The following screen appears.
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9. Navigate to and select the content you want to replace. Only 
content whose type matches the document you selected in 
Step 3 appears.

10. Press Next.
11. A confirmation screen appears. Click Done.
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12. Ektron CMS400.NET overwrites the selected document with the 
one you selected in Step 3.

Distributing Content After the First Time

If you later try to Distribute the same document (whether you 
added a new document or overwrote an existing one), a screen 
like the following appears.
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You can copy the latest version of the document to the distribution 
folder by clicking in the gray box whose text begins I want to 
redistribute... However, you cannot distribute the document to 
another folder. (If you want to do so, first delete the document from 
the destination folder. Then, you can use either procedure to 
distribute the document to any folder.)

When distributing content after the first time, its metadata and 
taxonomy categories appear on the Metadata/Category screen by 
default. You can change them if desired. 

As with the replace option, existing content’s title and ID number 
are maintained -- they are not replaced by the new content’s title 
and ID number. And, the existing content’s summary is maintained 
and can be edited if needed.

Flagging
Flagging Content enables a site visitor who views a piece of 
content to flag content and provide feedback. It allows you to 
define a list of flags and apply the choices to a folder. Lists can be 
centered on content that is not appropriate for all viewers. For 
example:

• Sexually Explicit

• Mature (over 18 only) content

• Graphic Violence

• Hate Speech

While some sites use flagging to allow notification of inappropriate 
content, it can also be used to indicate if a content item is above 
average. This would help an organization to create a 
recommended content list. Below is an example list:

• Loved This Content

• Hated This Content

• I Could Take It or Leave It

After you create a flag definition and assign it to a folder, all content 
in that folder can be flagged. For a user to be able to flag content, a 
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developer must add a ContentFlagging server control to a Web 
page on the site and assign it the ID of the content to be flagged. 
See the Developer’s Manual section “Introduction to Server 
Controls” > “ContentFlagging Server Control” for additional 
Information.

Having a way to flag content is a necessity for sites with a large 
quantity of site visitor-generated content. Content flagging can 
spread the moderation of your site to your site visitors Flagging 
can also help site visitors feel vested in the site.

Flagged content appears in the following Workarea locations.

• Content Flags list on the Smart Desktop

• Modules > Community Management > Flagging > Flagged 
Content

• a content item’s View Content Reports > Flagging tab

This section contains the following topics.

• ”Flagging Definitions” on page 893

• ”Flagged Content” on page 897

Flagging Definitions
The Flagging Definitions screen is located in the Workarea > 
Modules > Community Management > Flagging. From this screen 
you can, view a list of existing flagging definitions, work with them, 
or create new definitions. In addition, the list of Flagging definitions 
can be filtered by language.

This screen contains the following information about a flagging 
definition.

Field Description

ID The ID of the flagging definition.

Name The name of the flagging definition.
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This section contains the following topics.

• ”Adding a Flagging Definition” on page 894

• ”Edit a Flagging Definition” on page 895

• ”Deleting a Flagging Definition” on page 895

• ”Assigning a Flagging Definition to a Folder” on page 895

• ”Seeing Which Flagging Definition is Assigned to a Content 
Item” on page 897

Adding a Flagging Definition

To create a flagging definition, follow these steps.

1. In the Workarea, navigate to Modules > Community 
Management > Flagging > Flagging Definitions.

2. Select a language with which the flagging definition will be 
associated.

3. Click the Add button ( ).
4. The Add Flagging Definition screen appears.
5. Enter a Name and Description for the flagging definition.

6. Click the Option button ( ) to add a flag to this flagging 
definition.

Description A description of the flagging definition.

Language An image of a national flag associated with the language. 
For example, American English appears as .

Items The number of flags in a definition. For example, if you 
have a flag definition for these movie ratings:

• G

• PG

• PG-13

• R

The items count for this flag definition would be four.

Field Description
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7. Continue to click the Option button to add additional flags.
8. If necessary, change the order of the flags by clicking the 

Sorting buttons ( ). If you create a flag you want to 
remove, click the Remove button ( ).

9. Click the Save button ( ).

Edit a Flagging Definition

To edit a flagging definition, follow these steps.

1. In the Workarea, navigate to Modules > Community 
Management > Flagging > Flagging Definition.

2. Click the flagging definition Name link or the ID link.
3. Edit the available fields.

4. Click the Save button ( ).

Deleting a Flagging Definition

When you no longer want to use a flagging definition, delete it. 
When a flagging definition is deleted, it is removed from all folders 
with which it is associated.

To delete a flagging definition, follow these steps.

1. In the Workarea, navigate to Modules > Community 
Management > Flagging > Flagging Definition.

2. Click the flagging definition Name link or the ID link.

3. Click the Delete button ( ).

Assigning a Flagging Definition to a Folder

Once you have created a flagging definition, you can assign it to 
one or more folders. All content in the folders will have the selected 
flagging definitions applied to it.

To assign a flagging definition to a folder, follow these steps.

1. Create a flagging definition, as explained in ”Adding a Flagging 
Definition” on page 894.
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2. Click the Content folder bar.
3. Navigate to the folder where the content to be flagged is 

located.
4. Select View > Folder Properties from the View menu.

5. The View Properties screen appears.

6. Click the Edit button ( ).

7. Find the Flagging area.
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8. Make sure the Inherit Parent Flagging Configuration check 
box is not checked.

9. Select an available flagging definition from the Flagging drop 
down.

10. Click the Save button ( ).

Seeing Which Flagging Definition is Assigned to a Content Item

To see which flagging definition is assigned to a content item, 
follow these steps.

1. In the Workarea, navigate to the content item.
2. Click the content’s title.

3. Click the Edit Properties button ( ).
4. The View Properties screen appears.
5. The name of the flagging definition appears next to the 

Flagging Definitions title.

Flagged Content
The Flagged Content areas of the Workarea allow you to view and 
manage content that’s been flagged and the flags themselves. 
There are three places in the Workarea to work with flagged 
content:

• on the Smart Desktop. This area deals with the most recent 
content flags associated with any content. See ”Content Flags 
on the Smart Desktop” on page 898

• in Modules > Community Management > Flagging > 
Flagged Content. This screen is for all flagged content. See 
”Flagged Content in Modules > Community Management” on 
page 899.
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• a tab on the Content Reports screen for a content item. This 
tab displays a list of content flags for a specific content item -
See ”Viewing a Content Item’s Flags” on page 904.

Flagged content is more fully explained through the following 
topics.

• ”Content Flags on the Smart Desktop” on page 898

• ”Flagged Content in Modules > Community Management” on 
page 899

• ”Viewing a Content Item’s Flags” on page 904

• ”Viewing a Flag’s Details” on page 905

• ”Editing a Flag’s Details” on page 906

• ”Deleting a Flag” on page 907

Content Flags on the Smart Desktop

This area lists the ten most recent content flags that have been 
added. From this area, you can view a flag by clicking on its Title 
link. To view all recent flags, click the View recent flags link. 
Clicking this link takes you to the Content Reports: Recent Flags 
screen. See Also: ”Flagged Content in Modules > Community 
Management” on page 899
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Flagged Content in Modules > Community Management

The Flagged Content area in Modules > Community 
Management > Flagged Content allows you to display a list of 
flags. By default, the list shows flags for the last ten days. You can 
change this by entering a new number in the Show flags for the 
last # days field.
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The information for each flag is explained in this table.

.

From this screen, you can perform the following actions:

• View the details of a submitted content flag - see ”Viewing a 
Flag’s Details” on page 905

Field Description

Title The title of the content block being flagged. Clicking this 
link brings you to a detailed description of the content’s 
flag.

Display Name The name of the user who flagged the content as it is 
displayed on the Web site.

Date The date the content was flagged.

Flag The specific flag from the flagging definition for this 
content.

Comment Any comments added by the user who flagged the 
content.



Community Management

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 901

• Generate a Flagged Content report - see ”Generating a 
Flagged Content Report” on page 901

• Print a list of flagged content - see ”Printing a List of Flagged 
Content” on page 902

• Email a list of flagged content - see ”Email a List of Flagged 
Content” on page 902

• Filter flagged content by folder - see ”Filtering Flagged Content 
by Folder” on page 903

• Filter flagged content by language - ”Filtering Flagged Content 
by Language” on page 903

Generating a Flagged Content Report

By default the Content Reports: Recent Flags screen shows 
content flagged within the last ten days. To generate a different 
report, follow these steps.

1. In the Workarea, navigate to Modules > Community 
Management > Flagging > Flagged Content.

2. In the Showing flags for the last # days field, enter a new 
number of days for which to show Flagged Content.

3. Click the Report button ( ).
4. The page refreshes, and the list contains the new report.
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Printing a List of Flagged Content

On the Content Reports: Recent Flags screen, you can output the 
flagged content report to a printer by clicking the Print button ( ). 
This creates an HTML version of the list that opens in a browser. 
From the browser, you can print the list by using the browser print 
functionality.

Email a List of Flagged Content

You can email the a list of flagged content to any other 
CMS400.NET user. This does not include membership users. To 
email a flagged content list, follow these steps. 

1. In the Workarea, navigate to Modules > Community 
Management > Flagging > Flagged Content.

2. Either create a new Flagged Content report or use the existing 
one.

3. Click the Email button ( ).
4. The Select user email report screen appears.

5. Place a check next to each user to whom you want to email the 
report.

6. Click the Email button ( ).
7. If necessary, enter your email address and click the Email 

button ( ) again.
8. The list of flagged content is sent.
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Filtering Flagged Content by Folder

From the Content Reports: Recent Flag screen, you can filter 
flagged content by folder. This allows you to see only flagged 
content for a specific folder. To filter flagged content by folder, 
follow these steps.

1. In the Workarea, navigate to Modules > Community 
Management > Flagging > Flagged Content.

2. Click the Filter button ( )
3. The Select Folder screen appears.

4. Select a folder.

5. Click the Save button ( ).

6. The page refreshes, and any flagged content in the folder is 
shown.

NOTE Only flagged content that falls within the time frame for the Showing flags for the 
past # days field is shown. For example, if the field is set to five when you filter by 
a folder, only content that’s been flagged in the last five days appears.

Filtering Flagged Content by Language

To see flagged content for a specific language, select the language 
from the Language drop down box. When the page refreshes, only 
flagged content associated with the language appears.
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Viewing a Content Item’s Flags

You can also view flags for a specific content item. This allows you 
to see only flags associated with that content item. Flags for a 
content item can be found on the Content Report screen > 
Flagging tab. From this screen, you can filter the flags by a date 
range or see all flags associated with the content. In addition, this 
screen contains a purge button which allows you to remove all 
flags associated with this content. This subsection contains the 
following topics:

• ”Getting Flags for a Content Item” on page 904

• ”Purging Flags for a Content Item” on page 905

Getting Flags for a Content Item

Follow the steps below to get flags for a content item.

1. In the Workarea, find the content block for which to retrieve 
content flags.

2. Click the title of the content block.
3. The View Content screen appears.

4. Click the Content Reports button ( ).
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5. Click the Select Date button ( ) next to Start Date to select a 
start date.

6. Click the Select Date button ( ) next to End Date to select an 
end date.

NOTE To retrieve all flags for a content item, leave the Start Date and End Date blank.

NOTE To remove a Start Date or End Date, click the Delete Date button ( ).

7. Click the Get Flags button.
8. A list of flags is displayed.

Purging Flags for a Content Item

If you need to delete flags for a content item, follow these steps.

1. In the Workarea, find the content block for which to purge 
content flags.

2. Click the title of the content block.
3. The View Content screen appears.

4. Click the Content Reports button ( ).

5. Click the Select Date button ( ) next to Start Date to select a 
start date.

6. Click the Select Date button ( ) next to End Date to select an 
end date.

NOTE To purge all flags for a content item, leave the Start Date and End Date blank.

NOTE To remove a Start Date or End Date, click the Delete Date button ( ).

7. Click the Purge Flags button.
8. The flags are removed.

Viewing a Flag’s Details

Viewing a flag’s detail information allows you to read the entire 
comment if it is truncated in one of the lists. You can also edit or 
delete the flag from this screen.
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To view detailed flag and comment information, follow these steps.

1. Navigate to one of these area in the Workarea:

- Smart Desktop > Content Flags
- Modules > Community Management > Flagging > 

Flagged Content
- Content Reports > Flagging tab for a content item

2. Click either a flag’s content title or the flag’s date.
3. The flag’s detail information appears.
See Also: ”Editing a Flag’s Details” on page 906; ”Deleting a Flag” 
on page 907

Editing a Flag’s Details

Editing a flag allows you to change the flag’s selection or the 
comments for a flagged content item. This can be useful if a user 
selects the wrong flag by mistake or you want edit a particular 
flag’s comments. For example, a user selects the “Offensive 
Content” flag and he meant to click the “Copyright Violation” tag.

To edit a flag or its comment information, follow these steps.

1. Navigate to one of these area in the Workarea:

- Smart Desktop > Content Flags
- Modules > Community Management > Flagging > 

Flagged Content
- Content Reports > Flagging tab for a content item

2. Click either a flag’s content title or the flag’s date.
3. The flag’s detail information appears.

4. Click the Edit button ( ).
5. Change the flag or edit the comments.

6. Click the Save button ( ).
7. The flag’s information is changed.
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Deleting a Flag

When you do not need a flag, you can delete it from the system. 
When you do, the flag is permanently removed.

To delete a flag, follow these steps.

NOTE To remove all flags associated with a specific content item, see ”Purging Flags for 
a Content Item” on page 905.

1. Navigate to one of these area in the Workarea:

- Smart Desktop > Content Flags
- Modules > Community Management > Flagging > 

Flagged Content
- Content Reports > Flagging tab for a content item

2. Click either a flag’s content title or the flag’s date.
3. The flag’s detail information appears.

4. Click the Delete button ( ).
5. A dialog appears asking you to confirm the deletion.
6. Click OK.

Email Invites For Community Management
The Community Platform’s email notification feature enables 
Ektron CMS400.NET to generate email that invites a user to join 
the site, a community group or become a colleague of another 
user.

For example, a message might be sent when someone in a 
community group wants another user to join the group.

Creating the Email Message
You can create an email message to be sent when a user invites 
another user to join a group, the site or invite them to be a friend. A 
simple editor lets you apply some XHTML formatting the message.
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Including Variables in the Default Message

The messages can include variables that retrieve information 
about the person who’s sending the invite or the link to join a group 
and display it in the message text. The variables are surrounded 
by at signs (@). For example:

@appSenderName@ is used to display the name of the user sending the 
invite.

In the email, this text might read:

Alan Administrator has invited you to join the Marketing Community 
Group.

You can use the following variables in the body of an email 
notifications.

To create a message, follow these steps.

1. In the Workarea, go to Modules > Community Management 
> Messages.

2. Click the Add button ( ).

3. Enter a title that describes the message.

Variable Displays this information in the email

@appOptionalText@ Text that the user types into the Optional Text box on the Invite server 
control.

@appSenderName@ The name of the person sending the invitation

@appFriendDisplayName@ The name of the person to which the invite is being sent.

@appInvitedEmail@ The email address of the person being invited.

@appInviteId@ Used for appending the invite ID to the registration URL. For example:
Click <a href=http://www.example.com/
register.aspx&fInvId=@appInviteId@>here</a> to accept.

@appGroupName@ The name of the group a person is being invited to join.
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4. At the Type field, select either FriendInvitation, SiteInvitation 
or GroupInvitation.

5. Select whether to make the email message a Default message.
6. In the Subject box, add a subject for the email.
7. In the editor, enter the message text. Use the variables listed in 

the table above to retrieve information about the about the 
invitation and display it in the message.

8. Click the Save button ( ).

Tags
NOTE This section discusses Tags for use with the Community Platform. Information on 

tagging blog entries can be found in the User Manual section “Blogs” > “Blog 
Post” > “Adding A Blog Post” > “Tags on the Summary Page.” 

Tags are keywords that are associated with a user or group in 
CMS400.NET. A tag usually describes the user or group in some 
way. This allows for tag-based searches. 

For example, if you want to let users and groups associate 
themselves with their favorite race car driver, you might create a 
default system tag for each driver’s name or create tags called 
race, car, or racing.

In addition to default system tags, users and community group 
leaders can create their own tags. This allows for a more diverse 
and creative list of tags.

On the Web site, tags for a user or group can be found in their 
profiles. This helps site visitors quickly understand what the user or 
group is about.

Tags in the Workarea are located in the following locations.

• The User Information screen for a given user or membership 
user. See the User Manual section “Ektron CMS400.NET 
System Management” > “Updating Your User Profile” > 
“Viewing Your Profile.” 

• The Community Group
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• The Community Management area located in Modules > 
Community Management > Tags - see ”Working With Tags” 
on page 910.

Working With Tags
Administrators can manage tags from the Community 
Management > Tags area. This screen displays a list of Default 
Group Tags and Default User Tags and allows you to filter the list 
by language. By clicking on the tag’s name, you can see details 
about it. See Also: ”Viewing a Tag’s Details” on page 910

This screen displays the following information about a tag.

Tags are grouped into two categories, Default Group Tags and 
Default User Tags. Default group tags are assigned to community 
groups. Default user tags are assigned to users and membership.

Tags are further explained through the following topics.

• ”Viewing a Tag’s Details” on page 910

• ”Default Group Tags” on page 911

• ”Default User Tags” on page 913

• ”Tags” on page 909

Viewing a Tag’s Details

When you click a tag’s Name link, you can view the details of tag. 
The tag’s details appear on the View Tag screen. This screen 

Field Description

ID The integer ID of the tag.

Name The title of the tag.

Times Used The number of times a tag has been selected by a user or 
group.

Language The language assigned to the tag. This appears as a 
national flag associated with the language. For example, 
American English appears as .



Community Management

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 911

allows you to delete the Tag and provides the following information 
about the tag.

Deleting a Tag From the View Tag Screen

You can delete any tag from the tag list by clicking on the tags 
Name link and clicking the Delete button ( ). Once clicked, a 
dialog box appears asking you to confirm the deletion. Click OK 
and the tag is removed from the system.

Once a tag is deleted, it is removed from all groups and users. In 
addition, all information associated with the tag is removed. For 
example, how many times the tag is used or whether the tag is 
associated with a user or a group.

Default Group Tags

The Default Group Tags link allows you to add and remove tags 
that are assigned to community groups.

Field Description

ID The integer ID of the tag.

Language The language assigned to the tag.

Name The title of the tag.

Tagged Type Shows whether the tag belongs to a community group or a 
user. See Also: ”Default Group Tags” on page 911 and 
”Default User Tags” on page 913

Times Used The number of times this tag has been selected by a user 
or group.
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Adding a Default Group Tag

To add a tag to the Default Group Tags, follow these steps.

1. In the Workarea, navigate to Community Management > 
Tags > Default Group Tags.

2. Add the tag in the available text box. If no text box is available, 
click the Add button ( ).

3. Select a language for the tag.

4. Click the Save button ( ).
The page refreshes, and you return to the Tags list.

Removing a Default Group Tag

There are two ways to remove a default group tag from the 
Workarea. The first, is from the View Tags screen. This is 
described in ”Deleting a Tag From the View Tag Screen” on 
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page 911. The second is by clicking the Remove button ( ) found 
on the Default Group Tags screen.

Default User Tags

The Default User Tags screen allows you to add and remove tags 
that are assigned to user.

Adding a Default User Tag

To add a tag to the Default User Tags, follow these steps.

1. In the Workarea, navigate to Modules > Community 
Management > Tags > Default User Tags.

2. Add the tag in the available text box. If no text box is available, 
click the Add button ( ).

3. Select a language for the tag.

4. Click the Save button ( ).
5. The page refreshes, and you are returned to the Tags list.
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Removing a Default User Tag

There are two ways to remove a default user tag from the 
Workarea.

• from the View Tags screen. This is described in ”Deleting a Tag 
From the View Tag Screen” on page 911. 

• by clicking the Remove button ( ) on the Default User Tags 
screen

Assigning Templates to Groups and Members
As mentioned in ”Community Management” on page 868, Ektron 
CMS400.NET ‘s Community Management feature supports both 
community and individual member pages. Like other Ektron 
CMS400.NET content, Community Management content appears 
on a dynamic Web page. Page templates determine each page’s 
layout and location of elements (menus, content, blogs, etc.). 
Below is a sample Community Management template. See Also: 
”Creating/Updating Templates” on page 64

Sample Group Template within Visual Studio.NET

Sample Group Template on a Web Page
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The Community Management feature includes six templates:

• Community Group

- documents

- photos

- journal

• User

- documents

- photos

- journal
Ektron CMS400.NET provides a sample for each template. You can 
use the sample or create your own. If you begin with a sample 
template and modify it, be sure to save it under a different name to 
prevent it from being overwritten when you upgrade.

The Templates Screen
Use the Templates screen to assign templates to Community 
Management pages.
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The following table explains the fields on the Templates screen.

Field Page that displays template

Group Templates

Community Document Page hosts the CommunityDocuments Server Control; 
ObjectType property is set to Group

Photo Gallery Page hosts the PhotoGallery Server Control; 
ObjectType property is set to Group

Journal Page hosts the Blog Server Control, and the blog was 
created for a group page

User Templates

Community Document Page hosts the CommunityDocuments Server Control; 
ObjectType property is set to User

Photo Gallery Page hosts the PhotoGallery Server Control; 
ObjectType property is set to User
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Journal Page hosts the Blog Server Control, and the blog was 
created for a user page

Field Page that displays template
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Support for Mult iple Sites

Ektron CMS400.NET’s Multi-site Support feature lets you set up and 
manage several Web sites under one CMS. For example:

• www.example.com

• support.example.com

• forums.example.com

All sites share a single database. The Multi-site Support feature 
does not support multiple databases.

Multisite support is explained through the following topics.

• ”Advantages of Multiple Sites” on page 918

• ”Prerequisites” on page 918

• ”Using Multiple Sites” on page 919

• ”Installing the Multi-site Support Feature” on page 919

• ”Using Site Replication in a Multisite Environment” on page 930

Advantages of Multiple Sites
• The URL can indicate the nature of the site to visitors.

• All sites can share 

- common content, but appear within their own site and 
templates

- the library of images and files. These files can be stored 
once, yet authors can insert them into content from any 
site.

Prerequisites
• The server must run Windows Server 2003 or 2005
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NOTE Windows XP supports only one Web site.

• All sites must reside on the same server

Using Multiple Sites
Within the Workarea, sites appear under Ektron CMS400.NET’s 
folder structure but the icon is a globe (see illustration below). So, 
an author can create and edit content in the additional site the 
same way he creates/edits content in the root site.

Authors log into a root site then begin editing content in the 
additional site. Regardless of which site he is using, an author can 
use the library to insert hyperlinks, images, files, and quicklinks.

When a folder has a production domain assigned to it, it is a 
domain folder. Links to content in a domain folder are activated via 
linkit.aspx, which redirects to the appropriate domain name and 
uses the appropriate template for the folder or content.

WARNING! You cannot create a hyperlink within content, a collection, menu, etc. to a form 
that resides in another site.

Installing the Multi-site Support Feature
There are three major steps to setting up each new site.

• ”Step 1: Create New Folders in the File System” on page 920

• ”Step 2: Create New Sites in IIS” on page 921
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• ”Step 3: Assign Multi-site Capabilities in Ektron CMS400.NET” 
on page 928

Step 1: Create New Folders in the File System
1. Using Windows Explorer, create a new folder for each site.

2. Copy the following CMS files and folders from the original CMS 
site to your new multisite folder.

•all individual files (not subdirectories)

•these subdirectories: 

- bin

- WorkArea

- App_Code 

3. Within each new site folder, open the web.config file and 
update the ek_sitePath and WSPath elements with your CMS site 
path.
For example, if your CMS site is in the Web site root, enter 
slash (/). If it is in a subdirectory of the Web site, enter the 
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subdirectory name. For example, If your web site root is 
C:\inetpub\wwwroot and you have a subdirectory called 
CMS400Min, enter CMS400Min as the site path.

Step 2: Create New Sites in IIS
Follow these steps to create each new site in IIS.

1. Go to Start > Programs > Administrative Tools > Internet 
Services Manager.

2. Right click the Web Sites folder and click New > Web Site.
3. A wizard screen appears. Click Next.
4. Enter a name for the new site.
5. On the IP Address and Port Settings screen, enter the IP 

address of your new Web site or the host header. Press Next.
6. On the Web Site Home Directory screen, browse to the new 

site’s folder. You created it in ”Step 1: Create New Folders in 
the File System” on page 920.

7. On the Web Site Access Permission screen, make sure that 
Read and Write are checked.

8. You are notified that you have completed the new site.
9. Make the new site an application. To do this, right click the site, 

and select Properties. Then, click the Home Directory tab. 
Under Application Settings area, click the Create button then 
click OK.
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10. Set Execute permissions to Scripts only.

Create Virtual Folders in IIS

In IIS, for each new Web site, create one new virtual folder for the 
following shared folders:

• assets

• privateassets

• uploadedfiles

• uploadedimages

These folders are created when you install Ektron CMS400.NET. If 
you did a normal installation, they reside under the site directory. 
For example, C:\Inetpub\wwwroot\your site root\uploadedimages.

To create virtual versions of these folders, follow these steps.
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1. In IIS, select the new site folder you created in ”Step 2: Create 
New Sites in IIS” on page 921.

2. Right click the mouse and select New > Virtual Directory.

3. Identify the corresponding subfolder in the root folder.
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4. Assign Read and Write permissions to the virtual directory.

5. Follow this procedure for all four folders: assets, privateassets, 
uploadedfiles, uploadedimages.



Support for Multiple Sites

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 925

Set File System Permissions on New Folders

To do this, follow these steps:

1. Using Windows Explorer, navigate to the new folder(s) you 
created in ”Step 1: Create New Folders in the File System” on 
page 920.

2. Right click the folder and click Properties.
3. Click the Security tab.
4. Click the Advanced button.
5. Click the check box next to Allow Inheritable Permissions 

from the Parent to Propagate… 

Install the aspnet_isapi.dll File

Follow this procedure to install the aspnet_isapi.dll file for every 
new site.

1. Open IIS.
2. Navigate to an Ektron CMS400.NET Web site.
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3. Right click the site and select Properties.
4. On the Properties screen’s Home Directory tab, click the 

Configuration button.

5. The Application Configuration screen appears.
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6. In the Wildcard application maps area, click Insert.
7. The Application Extension Mapping screen appears.

8. Browse to 
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll.

9. Uncheck the Verify that file exists check box.
10. Click OK.
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Step 3: Assign Multi-site Capabilities in Ektron CMS400.NET

NOTE If the server is used as a staging server with the Site Replication Feature, go to 
the Ektron CMS400.NET Workarea then Settings > Configuration > Setup. 
Edit the setup screen and make sure the This is a staging server checkbox is 
checked. See Also: The Ektron CMS400.NET SIte Replication Manual

1. In the Ektron CMS400.NET Workarea, create a new top-level 
folder for each site. Each folder must reside within the site root 
folder.

2. Assign folder properties as you did for the root folder.
3. The Multi-Site Configuration fields appear on the lower section 

of the screen (illustrated below).
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4. Check the Domain for this folder checkbox.
5. In the Production Domain field, insert your domain.
6. Save the screen.

NOTE The Staging Domain field appears only if This is a staging server is checked on 
the Configuration >Setup screen.

Within Ektron CMS400.NET, the new domains are indicated by 
a globe icon.



Support for Multiple Sites

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 930

Using Site Replication in a Multisite Environment
See “Using Site Replication with Multiple Sites” in the Ektron 
CMS400.NET Site Replication Manual.
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Web Alert Feature

The Web Alert feature enables Ektron CMS400.NET to generate 
email for a list of registered users whenever new content appears 
on your site, or existing content is updated.

For example, anyone may register to be notified whenever new 
information about your product is published. As soon as the page 
is published on your site, registered users receive an email 
announcement with a link to the new/updated page. The recipient 
clicks the link and immediately accesses the page.

As a result, a self-selected group of users can be instantly notified 
of changes on your Web site relating to their interests. Once the 
system is set up, you don’t need to do anything -- everything 
happens in the background.

NOTE Only members of the Administrator User Group and users identified on the 
Manage Members for Role: Folder User Admin screen can work with Web Alerts.
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Sample Web Alert email

This chapter explains the Web Alerts feature through the following 
topics.

• ”How Web Alert Works” on page 933

• ”Server Configuration” on page 934

• ”Enabling the Web Alert Feature” on page 936
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• ”Setting Up the Message Queue and Asynchronous Processor” 
on page 937

• ”Creating the email Message” on page 946

• ”Defining Subscriptions” on page 953

• ”Assigning Web Alert Information to Folders and Content” on 
page 956

• ”How Users Sign up for Subscriptions” on page 963

How Web Alert Works
The following explains how Web Alert email works.

1. Content is published.
2. Ektron CMS400.NET checks the This is a staging server 

checkbox on the Configuration > Application Setup screen. If it 
is unchecked, proceed to the next step. If the box is checked, 
no Web alerts will be issued for this server.

3. Ektron CMS400.NET checks to see if any subscriptions are 
assigned to the folder or content. (Subscriptions can be 
assigned at the folder or content level.)
If no subscriptions are assigned, the Web Alerts tab does not 
appear when editing content.

4. If any subscription is assigned, Ektron CMS400.NET checks to 
see if an email should be created for this content. The settings 
appear under Web Alerts tab.
For example, some content only triggers an email when it is 
first published, while other items always generate an email.

5. If an email should be generated, Ektron CMS400.NET builds the 
email content by retrieving information from fields on the Folder 
Properties screen. These are identified under the Web Alert 
Contents section of the Web Alerts tab.

6. Ektron CMS400.NET determines which subscription lists should 
receive the email. These are identified on the Available Web 
Alerts area of the Web Alerts tab. Each list contains the email 
address of every subscribed user.
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Server Configuration
The following illustration depicts a typical Web server configuration 
you would use with the Web Alerts feature.

• Firewall - the Ektron CMS400.NET business tier must have 
Web access to the asynchronous server. The business tier 
maintains the CMS files. This configuration enables proper 
communication between Ektron CMS400.NET and the 
asynchronous processor.
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- The asynchronous processor must have port 25 (SMTP) 
access to a valid mail server to send emails

- The mail server (omitted from the illustration) must be 
allowed to send out port 25 (SMTP) traffic and can be on 
the Async server

• Queuing - Message queuing must be installed on the Async 
server.
You must create a message queue on the Async machine and 
record its name. The message queue is specified in the 
exe.config file for the service, and in the web.config file for the 
Web Service interface.

• CMS - The web.config file includes a key for the location of the 
asynchronous processor. This needs to be verified as working.

• Other - IIS must be installed on the asynchronous processor. 
IIS allows a Web service call to schedule a file download and 
send commands.
Ektron recommends that the Async machine only allow HTTP 
traffic from Ektron CMS400.NET servers. This provides 
additional security on the Async processor.

Verifying Connections
• You can verify the Web service > queue connection by 

- leaving the Ektron asynchronous processor service off, 
submitting content with notifications, and verifying that a 
message arrived in the queue

- turning on journaling for the queue. Submit a message in the 
queue. The Ektron asynchronous processor service picks it 
up and places it in the journaled messages.

- turning on logging for the Ektron asynchronous processor 
service

• To verify the CMS > Web service connection, open the 
asynchronous processor location inside a Web browser and 
test the Web services.
To verify the writing of files, ensure that Ektron CMS400.NET 
has write access to the [sitepath]subscriptions directory and 
submit content that will trigger notifications. This action places 
a file inside that directory.
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• To verify that the Ektron asynchronous processor service can 
download a file, open a Web browser on the Async machine 
and connect to the location of the notification command files. 
Attempt to download one.

Enabling the Web Alert Feature
Enabling the Web Alert feature involves the following steps.This 
section explains each step in detail

Step Description For more information, see

1. Set up message queue 
and asynchronous pro-
cessor.

”Setting Up the Message Queue 
and Asynchronous Processor” 
on page 937

2. Create messages. Define components of the email to be 
sent to subscribers.

”Creating the email Message” 
on page 946

3. Define subscriptions. Categories of information on your site. 
Site visitors can subscribe to be notified 
when content in a category is added or 
updated.

”Defining Subscriptions” on 
page 953

4. Assign Web Alert 
information to folders 
and content.

Assign Web Alert information to folders 
and content items which, when 
published, trigger emails.
For each folder or content item to which 
you assign subscriptions, determine

• activities that trigger emails (for 
example, only upon initial publication 
of content)

• the content of the email

• the subscription list(s) to whom the 
email is sent

”Assigning Web Alert 
Information to Folders and 
Content” on page 956

5. Create and publish site 
visitor registration 
page.

Create a new Web form and drop the 
membership server control onto it. Then, 
publish that form on your Web site.

Note: This task is typically done by a 
developer.

Developer’s Manual > 
“Introduction to Ektron 
CMS400.NET Server Controls 
“> “Membership Server Control”
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Setting Up the Message Queue and Asynchronous 
Processor

After installing Ektron CMS400.NET version 5.1 or higher, you need 
to set up the Microsoft Message Queuing and the Ektron 
Asynchronous Processor. It is assumed that the following 
directories and files are installed on your server:

• C:\Program 
Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_Service\

• C:\inetpub\wwwroot\your site 
root\bin\EktronAsyncProcessorWS.dll

• C:\inetpub\wwwroot\your site 
root\Workarea\webservices\EktronAsyncProcessorWS.asmx

NOTE If you need to move Web services file, use the Asynchronous Processor 
Location field in the Configuration > Setup screen to specify the new folder 
location.

1. On the server that hosts Ektron CMS400.NET, go to Control 
Panel > Add/Remove programs > Add/Remove Windows 
Components.

2. If it is not checked, check Message Queuing Services.

6. Site visitors subscribe 
to lists of interest.

Someone signs up to be notified when 
changes in a selected subscription 
(category) are published on your Web 
site.

”How Users Sign up for 
Subscriptions” on page 963

7. CMS users can also 
subscribe.

”CMS User Subscription Sign 
Up” on page 967

8. Subscribers are 
automatically notified 
when content is 
updated.

Web content is either first published or 
updated. If at least one subscription is 
assigned to the content or its folder, email 
is sent according to pre-defined criteria 
for the folder.

Step Description For more information, see
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NOTE On Windows 2003, it is within the Application Server Components group.

3. If Message Queuing Services was checked when you viewed 
it, go to step 4.
If it was not checked, click Next. A wizard creates the 
component.

NOTE The rest of this procedure employs a wizard that saves you several manual steps. 
If you have a problem using the wizard, or prefer to install Web Alerts manually so 
you can track the files being installed to your server, see ”Manual Steps for Setting 
up the Message Queue and Asynchronous Processor” on page 943.

4. From the Windows Start Menu, click All Programs > Ektron > 
CMS400 > Utilities > Web Alerts Setup. 

5. The Web Alert Wizard setup screen appears.
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6. Press Next. The wizard begins installing the Web Alerts 
feature.
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7. The following screen appears.
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8. Enter the username and password that will be used to send 
and receive email.

9. At the Log File Name field, enter the name of the file that will 
track Web Alert activities. If you enter nothing, the file is named 
listener.log.
The file resides in the C:\Program 
Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_Service 
folder. It is also available from the Workarea. See 
”Asynchronous Log File Reporting” on page 945.

10. If you want a very detailed log file, click Logfile Verbose.
11. Press Next. The following screen appears.
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12. Either insert or browse to the folder that contains your 
web.config file. This is your site root folder. Then press Next.

13. If your Asynchronous Processor service is not running, the 
following message appears.

14. If you see this message, press OK then click Finish.
15. Go to Control Panel > Administrative Tools > Computer 

Management > Services and Applications > Services. Start 
the Ektron Async Processor Service.
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Manual Steps for Setting up the Message Queue and Asynchronous 
Processor

This section describes manual steps for setting up the Message 
Queue and Asynchronous Processor. You can use this procedure 
if you had a problem using the wizard, or you want to know which 
files are being installed to your server.

1. Go to Control Panel > Administrative Tools > Computer 
Management > Services and Applications > Message 
Queuing.

2. Right click the Private Queues folder and select New > Private 
Queue.

3. Create a private queue named msmq_web.
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4. Right click msmq_web and select Properties.

5. Go to the Security tab. You can give the Everyone group Full 
Control if you are in a testing environment. If you are on a 
production server or want better security, give the local system 
account (the account which the EktronAsyncProcessor Service 
runs as) the following permissions:

•Delete

•Receive Message

•Peek Message

•Send Message

Give the ASP.NET account (the account that the Web services 
interface runs as) Send Message permission.

6. Click OK.
7. Open the following file: 

C:\Program 
Files\Ektron\CMS400v52\EktronAsyncProcessor_Service\RegEktron.S
ervices.EktronAsyncProcessor.bat 

8. Review and update as necessary the paths to the .NET 
directory and Ektron.Services.EktronAsyncProcessor.exe file.

WARNING! Update the paths to the .NET Directory and the .exe file if necessary.

9. Execute the .bat file.
Or, from a command line or Start Menu > Run, enter: 
C:\Windows\Microsoft.NET\Framework\v2.0.50727\installutil 
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“C:\program 
Files\Ektron\CMS400v75\EktronAsyncProcessor_Service\Ektron.Serv

ices.EktronAsyncProcessor.exe”
10. Open the following file and enter your SMTP connection 

settings: C:\Program 
Files\Ektron\CMS400v75\EktronAsyncProcessor_Service\Ektron.Serv

ices.EktronAsyncProcessor.exe.config.
11. Go to Control Panel > Administrative Tools > Computer 

Management > Services and Applications > Services. Start 
the Ektron Async Processor Service.

Asynchronous Log File Reporting
Once the Message Queuing and Asynchronous Process are set up 
and running, you can access a log report about the Asynchronous 
process. This report shows any problems with the Asynchronous 
Processor.
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In addition to viewing the report, you can email it to any 
CMS400.NET user. See ”emailing Reports” on page 152.

To access the Asynchronous Process log, follow these steps.

1. In the Workarea’s Smart Desktop, click the Reports folder.
2. Click the Asynchronous Log File link.
3. Any problems appear on the screen.

Creating the email Message

This section has the following topics.

• ”Predefining Message Components” on page 946

• ”Combining Message Components to Create the Message” on 
page 950

• ”Previewing the email Message” on page 951

Predefining Message Components
Before you can create an email message, define the following 
information.
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• default message text

• opt out message

• unsubscribe message

• “from” address

You can define as many as you want of each item. You must, 
however, define at least one opt-out message, unsubscribe 
message, and “from” address to use the Web Alert feature.

These message components are later inserted into an email 
message that is sent to your subscribers. See Also: ”Creating the 
email Message” on page 946

Creating Default Message Text

You can create one or more default messages to contain the text of 
the email. A simple editor lets you apply some XHTML formatting 
the message.

Including Variables in the Default Message

The default message can include variables that retrieve 
information about the content and display it in the message text. 
The variables are surrounded by at signs (@). For example

The following content was recently updated: @AppContentLink@

In the email, this text might read:

The following content was recently updated: The Effect of Coumadin 
on Cardiac Patients

You can use the following variables in the body of a Web Alert 
message.

Variable Displays this information in the email

@appContentTitle@ The title of the content block.

@appCRLF@ A carriage return. Moves the text down one line.



Web Alert Feature

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 948

To create default message text, follow these steps.

1. In the Workarea, go to Settings > Configuration > Web 
Alerts > Messages.

2. Click the Add button ( ).

3. Enter a title that describes the message.
4. At the Type field, select DefaultMessage.
5. In the editor, enter the message text.

6. Click the Save button ( ).

Creating Opt Out Message Text

An Opt-Out message appears as the first line of every email. It 
directs the reader to the Unsubscribe message at the bottom. Here 
is an example: 

You have subscribed to receive alerts from the Ektron CMS400.NET 
email alert system. See below for removal instructions.

You can add variables to the Opt Out text. See Also: ”Including 
Variables in the Default Message” on page 947

@appContentLink@ The link to the content block on the Web site.

Note: You must be logged in to see the changes.

@appContentURL@ The URL of the content, from the quicklink and domain.

@appSubscriptionNames@ Comma separated list of subscriptions that a user 
selected.

@appComment@ The comments for the content block.

@appSubmitterFirstName@ The first name of the user who submitted the content 
block.

@appSubmitterLastName@ The last name of the user who submitted the content 
block.

Variable Displays this information in the email
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To create Opt-Out message text, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Messages.

2. Click the Add button ( ).

3. Enter a title that describes the Opt-Out message.
4. At the Type field, select OptOut.
5. In the editor, enter the message text.

6. Click the Save button ( ).

Creating Unsubscribe Message Text

An Unsubscribe message lets the person receiving the email 
remove himself from the subscription list. 

You can add variables to the Unsubscribe text. See Also: 
”Including Variables in the Default Message” on page 947

To create Unsubscribe message text, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Messages.

2. Click the Add email Message button ( ).

3. Enter a title that describes the Unsubscribe message.
4. At the Type field, select Unsubscribe.
5. In the editor, enter the message text.

6. Click the Save button ( ).

Creating “From” Addresses

Any email generated by the Web Alert feature must have a “from” 
address. To create one or more “from” addresses, follow these 
steps.

1. Go to Settings > Configuration > Web Alerts > Email From 
List.



Web Alert Feature

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 950

2. Click the Add email From Address button ( ).
3. Enter an email address that will be used in the From field of 

messages generated by the Web Alert feature.

4. Click the Save button ( ).

Combining Message Components to Create the Message
You create the content of an email message by configuring the 
following components. Some are required. Then, when content is 
published, Ektron CMS400.NET retrieves the field values to create 
the email Web Alert.

NOTE To set or modify this information, you must have permission to edit the folder.

Component Comment Required?

1. Subject line Plain text you enter on the Web Alerts tab of the Folder 
Properties screen

No

2. From address See ”Creating “From” Addresses” on page 949 Yes

3. Opt out message See ”Creating Opt Out Message Text” on page 948 Yes

4. Default message See ”Creating Default Message Text” on page 947 No

5. Content Summary The Summary of the content item whose creation or 
change generates the email.

Note: The Summary can include variables that retrieve 
information about the content item. See ”Including 
Variables in the Default Message” on page 947

No
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The elements appear within the email in the sequence shown 
above.

Previewing the email Message
You can preview the email message at any time by clicking the 
preview button, which appears to the right of the Web Alert 
Contents: label on the Web Alerts tab (see below).

6. Any CMS content 
item

Identify CMS content to include within the email content.

• To identify an existing content item, click Select 
next to the Use Content checkbox. Then, navigate 
to the content item.

Note: If the content item is an Office document or a 
managed file, a link to that item appears within the email 
message, not the item itself.

• To insert this content item (that is, the one whose 
creation or change triggers this Web Alert), click 
Use Current. 

• To create a new content block to insert into this 
message, click Select next to the Use Content 
checkbox. When the folder navigation window 
appears, click the Add Content button ( ). Then, 
see ”Adding HTML Content” on page 74.

No

7. Unsubscribe 
message

See ”Creating Unsubscribe Message Text” on page 949 Yes

Component Comment Required?
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The button appears on the Web Alerts tab for folders as well as 
content.

When you click the preview button, a new window displays the 
body of the email message. (The components used in an email 
message are listed in ”Combining Message Components to Create 
the Message” on page 950.) 

After previewing the message, you can change any message 
components and click the button again to review the updated 
message. You don’t need to save or check in the content to update 
the preview.



Web Alert Feature

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 953

Defining Subscriptions

Create a subscription for each type of information site visitors 
might want to be notified about. For example, if your site sells 
electronics, you could set up one subscription for televisions, 
another for computers, and a third for stereo equipment. Site 
visitors can then subscribe to appropriate areas of interest.

CMS and membership users can also sign up for subscriptions.

To create one or more subscriptions, follow these steps.

1. Go to Settings > Configuration > Web Alerts > 
Subscriptions.

2. Click the Add Subscription button (shown below).

3. Enter a name for the subscription. The name should indicate 
the kind of information that it will cover.

4. Use the Enabled check box to indicate if the subscription is 
currently active.

5. Press the Save button ( ).

Effect on Custom User Properties
When you create the first subscription, a new entry is automatically 
created in the Custom User Properties screen. By default, its name 
is Subscriptions, and its type is Category. This occurs because 
all custom user properties appear on the Site Visitor Registration 
screen. In this way, users visiting that page can select areas of 
interest about which to be notified when content is updated.
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The default name (Subscriptions) appears on the Site Visitor 
Registration screen. You may want to change it to something more 
helpful, such as Select Areas of Interest. To do this, select the 
Subscriptions entry and edit the Label field in the Custom User 
Properties screen.

The following graphic illustrates the relationship among the 
Subscriptions, Custom Properties, and Site Visitor Registration 
screens.
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If you add more subscriptions later, they have no effect on the 
Subscriptions entry in the Custom User Properties screen -- that 
single entry covers all subscriptions.

Using Subscriptions in a Multi-Language System
When you create a subscription, a version of it is created for every 
enabled language in your system. You can edit the subscription 
name and Enabled values for any language but the ID number 
cannot be changed.

To translate any subscription, follow these steps.

1. Go to Settings > Configuration > Subscriptions.
2. From the View Languages dropdown list, select the language 

into which you want to translate the subscription.
3. Click the subscription that you want to translate.

4. Click the Edit button ( ).

5. Enter the translation for the subscription name. If desired, you 
can check or uncheck the Enabled checkbox. Only enabled 
subscriptions appear on the Site Visitor Registration screen.

6. Click the Save button ( ).
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Assigning Web Alert Information to Folders and 
Content

After creating predefined messages (as explained in ”Predefining 
Message Components” on page 946) and subscriptions (as 
explained in ”Defining Subscriptions” on page 953), you need to 
identify which folders include content that, when updated, trigger a 
Web Alert. For example, new product announcements are placed 
in the Marketing folder.

NOTE In order to set or modify Web Alert information, you must have permission to edit 
the folder.

For each folder, you can assign the following kinds of message 
information.

• whether Web Alert information is inherited from a parent folder 
or customized

• whether a folder’s Web Alert information is inherited by all 
content items in the folder

• when email is sent: always, only on initial publication, or never

• the content of the Web Alert email

• the subscriptions assigned to the folder. These determine 
which recipients receive email when content in this folder is 
created or updated.

Customizing Web Alert Information for a Folder
Like other folder-level information in Ektron CMS400.NET, Web 
Alert information is inherited from a parent folder. By default, all 
folders inherit these settings from the root (Content) folder. 

However, inheritance can be broken and customized at any folder 
level or even the content level. Breaking inheritance means that 
custom settings can be made at any folder level. Subsequent 
changes to Web Alert settings at the parent level are ignored.

See Also: ”Assigning Web Alert Information to Content” on 
page 960

To view, enter, or modify folder-level Web Alert information, follow 
these steps.
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1. Navigate to the folder whose Web Alert information you want to 
edit.

2. Click View > Folder Properties.
3. Click the Web Alerts tab.
4. Scroll down to view the Web Alert options.
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5. To change any value, click the Edit Properties button ( ).

6. The following table describes the fields.
Web Alert Fields

Field
Group

Description

Web Alert Settings:
Break Inheritance

To inherit Web Alert settings (described below) from this folder’s 
parent folder, leave this box (Break Inheritance) empty.
To assign custom Web Alert settings for this folder, check this box 
and use the fields below to customize the settings.

Web Alert Options Check when Web Alert emails are sent as content in this folder is 
published.

• Notify Always - send email whenever any content is published. 
It doesn’t matter if the content is being published for the first 
time or being updated.

• Notify only on Initial Publication - send email the first time 
content is published. After that, email is not sent.

• Notify Never - email is never sent for content in this folder.

Web Alert Subject Enter the subject line of the email.

Web Alert email From Address Select the address of the person from whom the email will be sent. 
See Also: ”Creating “From” Addresses” on page 949

Web Alert Contents Check any or all of the following components to determine the text of 
the email. See Also: ”Combining Message Components to Create 
the Message” on page 950

• OptOut Message - see ”Creating Opt Out Message Text” on 
page 948

• Use Default message - see ”Creating Default Message Text” on 
page 947

• Use Summary - include the content summary in the email

• Use Content - see ”Any CMS content item” on page 951

• Unsubscribe message - See ”Creating Unsubscribe Message 
Text” on page 949

The components appears within the email in the order listed above.
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Assigning Web Alert Information to Content
You can customize Web Alert settings for any content item. If you 
do, you break the inheritance from its folder. This means that any 
subsequent changes to the folder settings do not affect the 
content’s Web Alert settings. From then on, its settings are 
independent of the folder’s settings.

See Also: ”Web Alert Feature” on page 931

EXCEPTION! If all subscriptions are unchecked for a folder, the Web Alert feature is disabled for 
all content in the folder. This applies even if unique Web Alert information has 
been assigned to content.

To customize the Web Alert settings for any content item, follow 
these steps.

1. Navigate to the folder that contains the content.
2. Click the content. The View Content screen appears.

3. Click the Edit button ( ).

4. Click the Web Alerts tab.

NOTE The Web Alerts tab only appears if required messages, “from” email addresses, 
and at least one subscription are assigned to the content’s folder.

5. The Web Alert settings for the content appear.

Available Web Alerts All enabled subscriptions set up in the Subscriptions screen appear. 
Check those to be notified when content in this folder is added or 
updated.
See Also: ”Defining Subscriptions” on page 953

Note: If you uncheck all subscriptions, you disable the Web Alert 
feature for this folder and all of its content. This applies even if 
unique subscription information has been assigned to content items 
within the folder.

Field
Group

Description
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The following table describes the settings.
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Field
Group

Description

Web Alert Options Check when Web Alert emails are sent as this content is published.

• Notify Always - send email whenever content is published. It 
doesn’t matter if the content is being published for the first time 
or being updated.

• Suspend Next Notification (override) - Check this box if you 
want to suspend the next email to be sent for this content. You 
might use this feature is you notice a small error in the content 
and don’t want to notify all subscribers that the page was 
updated.
Important! - This setting only applies until the next time this 
content is published. When that happens, this box is 
automatically unchecked.

• Notify only on Initial Publication - send email the first time 
content is published. After that, email is not sent.

• Send Next Notification (override) - Send an email to all sub-
scribers the next time this content is published. Use this check-
box to send a one-time mailing to all subscribers about content 
that has already been published.
Important! - This setting only applies until the next time this 
content is published. When that happens, this box is 
automatically unchecked.

• Notify Never - email is never sent when content in this folder is 
published.

Web Alert Subject Same as for a content folder. See ”Web Alert Subject” on page 959

Web Alert email From Address Same as for a content folder. See ”Web Alert email From Address” 
on page 959

Web Alert Contents Same as for a content folder. See ”Web Alert Contents” on page 959

Available Web Alerts Only Web Alerts assigned to the folder appear. Check ones that you 
want to assign to this content item. For more information, see 
”Available Web Alerts” on page 960.
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Inheriting Content-Level Web Alert Information from Its Folder

If you customized Web Alert information for content items and later 
decide to standardize that information for all content in a folder, use 
the Restore Web Alert Inheritance toolbar button ( ).

This button copies folder-level Web Alert information to every 
content item in the folder, replacing whatever content-level 
information exists. In this way, all content in a folder will have the 
same Web Alert information.

How Content that is Dragged and Dropped is Handled
Web Alert emails are not generated for files that are dragged and 
dropped into Ektron CMS400.NET and immediately published. To 
generate email for these files, you must manually publish them.

Like HTML content, these files must reside in a folder for which the 
Web Alert feature is enabled.

How Users Sign up for Subscriptions
Once subscriptions are set up, you create a page on your Web site 
to let site visitors subscribe to areas of interest. An example of that 
page is below.

NOTE The email address collected on the screen is used for the membership Username 
field.
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To place this form on a Web page, your developer inserts a 
Membership Server Control. For more information, see the Ektron 
CMS400.NET Developer Manual chapter “Introduction to Ektron 
CMS400.NET Server Controls” > ”Membership Server Control.”

Any user who subscribes via the above screen becomes an Ektron 
CMS400.NET membership user, and is automatically added to the 
All Members user group. For more information, see ”Membership 
Users and Groups” on page 675.

What happens next depends on the Enable Verify email check 
box in the Application Setup screen (shown below).

• ”What Happens if Verification email is Not Used” on page 965

• ”What Happens if Verification email is Used” on page 965

• ”Setting up Other Web Pages for Site Visitor” on page 967

• ”CMS User Subscription Sign Up” on page 967
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What Happens if Verification email is Not Used
If the Enable Verify email checkbox is not checked, everyone who 
signs up automatically becomes a membership user. 

What Happens if Verification email is Used
Typically, when managing a self-subscribe list, you want new users 
to confirm their interest in being on the list. This prevents people 
from being subscribed by someone else without their permission.

If the Enable Verify email checkbox is checked, everyone who 
signs up is placed on the Users Not Verified list. (To see this list, go 
to Workarea > Modules > Community Management > 
Memberships > Users Not Verified.)

These people then receive an email. You define the content of this 
email in Workarea > Modules > Community Management > 
Messages. The email should direct the unverified user to a new 
Web page that asks him to confirm his interest in signing up for the 
subscription. (See ”The Verification Message” on page 965.) New 
users are activated when the subscriber confirms his interest.

To create such a page, your Web developer creates or updates a 
Web Form using the Membership Server Control. For this purpose, 
set the control’s DisplayMode property to AccountActivate.

NOTE Users can also be manually activated or removed via the View Not Verified Users 
screen. For more information, see ”The View Not Verified Users Screen” on 
page 966.

The Verification Message

By default, Ektron CMS400.NET supplies a generic message asking 
the user to confirm his password and directing him to the 
acitvatemyaccount.aspx page on your Web site. If you want to 
customize that message, follow these steps.

1. Go to Workarea > Modules > Community Management > 
Messages.

2. Click the Add button ( ).
3. Assign a title to the message, such as Verification Message.
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4. Click to place a check mark in the Default box.
5. Enter the text of the confirmation message you want the 

subscriber to receive. Be sure to place a link to the 
confirmation page. After the URL of that page, you must add 
this text: @appQueryLink@. For example: 

Welcome to example.Com. You have registered to be notified of 
updates to our site. 

Before we can do this, you need to activate your account. To do so, 
please visit http://www.example.com/workarea/
activateuser.aspx@appQueryLink@.

If you want the message to include the user’s name and email 
address, use the following variables to retrieve that 
information:

•name - @appEmail@

•email address - @appActivateId@
For example:
Your user name is @appEmail@.

Your account id is @appActivateId@

The View Not Verified Users Screen

All users who have signed up for a subscription but who have not 
yet verified that subscription appear on the View Not Verified Users 
Screen. This screen is available via Modules > Community 
Management > Memberships > Users not Verified.

After viewing membership users on the screen, you can manually 
activate their account. To do so, selecting one or more users then 
click the Activate button ( ). Alternatively, you can delete 
members by selecting one or more and clicking the Delete button 
( ).

NOTE The ek_PageSize setting in the web.config file determines the maximum number 
of users that can appear on a page before it “breaks.” When a page breaks, 
additional entries appear on another screen, and the following text appears near 
the bottom of the list: 
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

To select all members, click the check box in the header line, next 
to Username (circled below).
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You can also change the way membership users are sorted, or use 
the Search button to find users that match your criteria (for 
example, users whose username includes example.com.) These 
features are explained in ”Sorting Membership Users” on page 682 
and ”Searching for Membership Users” on page 682.

Setting up Other Web Pages for Site Visitor
You can set up other Web pages that let the subscriber perform the 
following actions:

• Activate their account

• Reset their password

• Unsubscribe

To create these pages on your web site, place the membership 
server control on the page. Then use the control’s DisplayMode 
property to determine the kind of screen you want to place. For 
example, to create a screen that lets the user reset his password, 
set the Membership server control’s DisplayMode property to 
ResetPassword.

For more information, see the documentation for the Membership 
server control in the Ektron CMS400.NET Developer’s Manual.

CMS User Subscription Sign Up
CMS users can also subscribe to any subscription list. This would 
be particularly useful on an intranet where, for example, 
employees are notified when job-related information is updated.

Another example would be for your internet site. The manager of 
the Marketing Department could sign up to be notified whenever 
Marketing content is added or updated.
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To do so, users go to Settings > User Profile > Edit User (see 
illustration). 
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Ektron Windows Service

Ektron CMS400.NET provides a Windows Service to handle 
background processing functions. This section explains the 
service, including

• the CMS functions it performs

• how it propagates updates to the connection string and site 
path

• where it resides in IIS and the file system

• its activity log

Functions Performed by the Ektron Windows 
Service

The Ektron Windows Service performs the following processes.

• ”XML Indexing” on page 205

• ”Load Balancing Assets” on page 993

• ”PDF Generation” on page 324

• ”Bad Links Report” on page 170

• Publication of content scheduled to go live at a future time, 
and removal of content scheduled to expire. See Ektron 
CMS400.NET User Manual section “Scheduling Content to 
Begin and End”

• When a new metadata definition is created, the Windows 
service applies it to all content in the CMS database. 
However, the metadata definition is only activated for the 
content when it is enabled for the content’s folder. See Also: 
”Metadata” on page 116

In addition, the Ektron Windows Service propagates updates 
made to the database connection string or the site path in the 
web.config file. The service copies the new value to the 
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data.config and sitedb.config files (respectively). These are located 
in C:\Program Files\Ektron\EktronWindowsService20. Any CMS 
components that reference these values can retrieve the current 
information from these files.

IMPORTANT! Do not edit the data.config and sitedb.config files. They are dynamically 
generated by Ektron CMS400.NET. If these files have incorrect values, edit the 
web.config file, which is used to generate them.

The following topics explain various aspects of using the Ektron 
Windows Service.

• ”Setting up Asset Load Balancing” on page 995

• ”Changing the Update Time” on page 970

• ”Preventing Configuration Information from Being Updated” on 
page 970

• ”Changing the Name of the data.config File” on page 970

• ”Changing the http Port” on page 971

• ”Disabling PDF Generation” on page 971

• ”Disabling XML Indexing” on page 971

• ”Viewing in IIS” on page 972

• ”Viewing in the File System” on page 974

Changing the Update Time
The update of the data.config and sitedb.config files occurs once a 
day at a time prescribed in the C:\Program 
Files\Ektron\EktronWindowsService20\Ektron.ASM.EktronServices.exe.c

onfig file’s updateTime value. If desired, you can change this time.

Preventing Configuration Information from Being Updated
You can prevent the information in the data.config and 
sitedb.config files from being changed by the automatic daily 
update. To do so, surround them with <preserve> tags.

Changing the Name of the data.config File
If your server already has a file named data.config, and you want 
to change the name of the one in C:\Program 
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Files\Ektron\EktronWindowsService20 to avoid confusion, follow these 
steps.

1. Open Ektron.ASM.EktronServices.exe.config.
2. Find this line: <connectionStrings configSource="data.config"/>.
3. Replace data.config with the new file name. For example: 

<connectionStrings configSource="Ektron_data.config" />

4. Save Ektron.ASM.EktronServices.exe.config.

Changing the http Port
If your Web site is already using port 6060, follow these steps to 
change the port number used by the Ektron Windows Web 
Service. 

1. Open Ektron.ASM.EktronServices.exe.config.
2. Find this line: <add key="HttpServicePort" value="6060"/>. 
3. Change the value to the port number you will use for the Ektron 

Windows Service.

Disabling PDF Generation
By default, PDF generation is enabled. If you want to disable it 
within the Ektron Windows Services configuration file, follow these 
steps.

1. On the server to which you installed Ektron CMS400.NET, open 
C:\Program Files\Ektron\EktronWindowsService20.

2. Open Ektron.ASM.EktronServices20.exe.config.
3. Find this line:

<add name="PdfFileRead" 
type="Ektron.ASM.EktronServices.PdfFileManagerRead.PdfFileManagerReadService, 
Ektron.ASM.EktronServices20" IntervalSeconds="101" Enabled="true" />

4. Set enabled to false.

Disabling XML Indexing
If you want to disable XML indexing, follow these steps.

1. Open Ektron.ASM.EktronServices.exe.config.
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2. Find these lines:
<add name="XmlIndexing" type="Ektron.ASM.EktronServices.XmlIndexing.IndexingService, 
Ektron.ASM.EktronServices" Enabled="true" />

3. Change the value of enabled to false.

Viewing the Ektron Windows Service

Viewing in IIS
The Windows Service starts automatically when Ektron 
CMS400.NET is installed, and again whenever the server is 
restarted.

1. To see the status of the service, go to Computer Management 
> Services and Applications > Services. 
Look for Ektron Windows Services. You can see its status in 
the Status column.
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The Activity Log

The service has an Activity Log, which tracks all related events. To 
see it, go to Computer Management > System Tools > Event 
Viewer > Ektron Log.

To view detail for any event, double click it.

A common source of errors is that the service cannot find Ektron 
CMS400.NET sites, because they have not been created yet, as 
shown in the sample below.



Ektron Windows Service

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 974

Viewing in the File System
On your file system, the Ektron Windows Service is located in 
C:\Program Files\Ektron\EktronWindowsService20. Within that folder, 
the Ektron.ASM.EktronServices.exe.config file runs the Ektron 
Windows service.
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Web Services

Web Services are reusable software components that can be 
consumed over the Web by means of standard Internet 
technologies. Mechanisms exist to publish and discover Web 
Services on the Web, allowing users to locate and integrate 
them into their applications. 

A Web Service is comprised of one or more methods that 
expose functionality. A Web Service can be thought of as an 
Application Program(ming) Interface (API), the one big 
difference being, consumers can access the service using 
Simple Object Access Protocol (SOAP) over HTTP. 

SOAP is an XML based lightweight protocol that defines the 
message format for Web Services, which allows 
heterogeneous systems to communicate with each other in a 
standard way. Seeing Web Services are based on ubiquitous 
technologies, they have been quickly accepted for the 
interchange of data. 

For information about implementing Ektron CMS400.NET’s 
Web services support for your Web site, refer to Web Services 
in the Ektron CMS400.NET Developer’s Reference Manual.
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Setting up a Virtual Staging 
Server

NOTE This section explains how to move individual content items and assets 
between staging and production servers. If you want to move an entire Web 
site, use Ektron CMS400.NET’s Site Replication feature. It is documented 
in the Ektron CMS400.NET Site Replication Manual.

This section explains how to set up a virtual staging and 
production server configuration. As you can see below, it 
consists of two physical servers, with the production server 
outside Ektron CMS400.NET’s Load Balancing feature moves 
the content and assets from staging to production.

After you set this up, content contributors create, test, and 
modify content on the staging server. Preview Mode lets 
everyone view and modify proposed changes on the staging 
server. No editing is done on the Production server, which is 
typically located outside the firewall.

Ektron CMS400.NET lets you control the approval process. 
Once content is approved, the Load Balancing software moves 
it to the production server, where it is immediately available to 
site visitors.
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NOTE Load Balancing pushes a copy of every content item and asset to the production 
server. However, content on production only becomes visible to site visitors after it 
is approved.

The advantages of using a Virtual Staging configuration are

• simplicity of maintaining content

• ability to preview before content is published

• instant publishing to production

• approvals to community data

• staging and production servers share one database

• as library items and assets are updated on the staging server, 
Load Balancing automatically pushes the changes to the 
production server

At the same time, the following information collected on the 
production server is updated on the staging server:

- new Blog and Discussion Forum comments

- Poll/survey results

- site analytic information

- assets

- content rating data

Setting up a Virtual Staging Configuration

Miscellaneous Considerations
• Login Control - For Ektron CMS400.NET users, editors and 

approvers, place a login control only on pages that reside on 
the staging server. This prevents the creation or editing of 
content on the production server.
Only membership users should be allowed to log in to the 
production server.

• Content Analytics – disable this feature in the staging server’s 
web.config file. (See ”Enabling the Content Analytics Feature” 
on page 854.) If you do not, your usage statistics may be 
skewed.
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• Configure Web Alerts on the production server only. When 
member users receive Web alerts, the link should point to the 
production server. See ”Setting Up the Message Queue and 
Asynchronous Processor” on page 937 .

• If you haven’t already done so, set up workflow permissions 
for folders on the staging server. See ”Setting Approval Chains” 
on page 726 and ”Setting Permissions” on page 716.

Set Up Instructions
Prerequisite:Ektron CMS400.NET Version 7.5 is installed on 
both servers

1. Install a minimal site on the staging server. During installation, 
create a database.

2. Install a minimal site on the production server. Do not create a 
database on the production server.

3. Set up database security that will allow the two servers to read 
and write to each other.

4. Open the web.config file for both sites.

- in the staging server’s web.config file, copy the section 
beginning and ending with <connectionStrings>

<connectionStrings>
    <!--FOR SQLSERVER-->
<add name="Ektron.DbConnection" providerName="System.Data.SqlClient" 
connectionString="server=WS10080;database=virtual_test;Integrated Security=False;user=abc;pwd=xyz;" /> 
</connectionStrings>

- in the production server’s web.config file, replace the 
<connectionStrings> tag with the information copied from the 
staging server

As a result, both sites reference the same database.
5. Set up library load balancing. See ”Set Up Two Ektron 

CMS400.NET Web Sites” on page 984. This will ensure that, 
as items are added or changed in the library on the staging 
server, they are also added to the production server’s library 
and vice versa.

6. Set up load balancing for your assets. See ”Load Balancing 
Assets” on page 993. This will ensure that, as assets are 
added or changed in Ektron CMS400.NET on the staging server, 
they are also updated on the production server and vice versa.

.



Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 980

Load Balancing

Load Balancing has two purposes:

• Provides redundancy for your Web site - if one server fails, 
a second can still handle requests

• Balances requests - distributes requests across multiple 
servers

To enable load balancing, set up several servers that include 
the same files. Then, purchase load balancing equipment to 
evenly distribute requests for content among the servers. 
Whenever an image or file gets uploaded to your Web site, 
regardless of the Web server the user is working on, the asset 
is replicated on both servers.

The client browser is unaware that more than one server is 
involved. All URLs point to a single Web site. The load balance 
software resolves them.

Ektron provides different strategies for load balancing library 
images and files and DMS assets. See 

• ”Load Balancing Library Images and Files” on page 980

• ”Load Balancing Assets” on page 993

Load Balancing Library Images and Files
Ideally, your load balancing strategy involves automatic 
replication of files in each directory specified by Ektron 
CMS400.NET to all servers.

The easiest way to enable Load Balancing involves using 
Ektron’s Site Replication Feature (see ”Using Site Replication 
for Load Balancing” on page 981). If your site has not 
purchased that option, an alternative is to create virtual 
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directories and set up load balance paths (see ”Configuring Load 
Balancing without Site Replication” on page 982).

See Also: 

• ”Using Site Replication for Load Balancing” on page 981

• ”Configuring Load Balancing without Site Replication” on 
page 982

• ”Ektron CMS400.NET on Three Servers” on page 992

Using Site Replication for Load Balancing
The easiest way to configure Ektron CMS400.NET for this setup is 
illustrated below. Have all content authoring, editing, and review 
occur on a staging server. Then, when new content is ready to go 
live, use the Site Replication feature to copy content from staging 
to production server.
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For more information about Site Replication, see the Ektron 
CMS400.NET Site Replication Manual.

Configuring Load Balancing without Site 
Replication

If your site has not purchased Site Replication software, enabling 
load balancing requires additional set-up outside of Ektron 
CMS400.NET. To set this up, you perform three tasks.

Instructions are provided for a configuration that involves both two 
and three Web servers.
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Task Directions for 2 Web 
Servers

Directions for 3 Web 
Servers

1. Set up Ektron 
CMS400.NET on multiple 
Web servers, sharing one 
database

”Set Up Two Ektron 
CMS400.NET Web Sites” on 
page 984

”Setting Up Multiple Web Sites” 
on page 992

2. Create virtual directories to 
uploadedimages and 
uploadedfiles folders

”Set Up Virtual Directories for 
Two Web Sites” on page 985

”Setting Up Virtual Directories 
for Three Sites” on page 992

3. Set load balance paths in 
Ektron CMS400.NET

”Setting Up Load Balance Paths 
in Ektron CMS400.NET” on 
page 990

”Setting Up Load Balancing for 
Three Servers” on page 993
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Set Up Two Ektron CMS400.NET Web Sites
The following diagram illustrates how to set up IIS consoles for 
load balancing two Ektron CMS400.NET Web servers.

Both servers point to the same database, and two virtual 
directories are set up in each Web server’s IIS console. To set this 
up, follow these steps.

1. Install Ektron CMS400.NET on each Web server.

NOTE The Ektron CMS400.NET Setup Manual has installation instructions.

2. Select one database as the master. Each Web site points to 
this database for content, users, and load balance paths.

3. By default, the <connectionStrings> element of the web.config 
file contains connection information to the sample database. 
Replace the sample values with your server, database name, 
and login information
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Set Up Virtual Directories for Two Web Sites
Through Internet Information Services (IIS) on both Web servers, 
create a virtual directory for each image and file folder used with 
your load balancing model. For our example, create the following 
virtual directories on all Web servers.

These identical, virtual directories must exist in the IIS console of 
each Web server in your load balancing model. 

Why Must Virtual Directory Names Be Identical?

Virtual directory names must be identical because load balance 
paths are stored in one database. IIS resolves the path to the 
virtual directory stored on the server being used.

For example, a load balance path is called LB_Images1. Ektron 
CMS400.NET talks to IIS and resolves the path for the virtual 
directory LB_Images1, which is \\{Computer1}\UploadedImages.

If the Web site is accessed from another Web server, the load 
balance path LB_Images1 points to the physical directory 
\\{Computer2}\UploadedImages.

IMPORTANT! For load balancing to work correctly, the virtual directories on each Web server 
must be identical.

Creating a Virtual Directory

This section explains how to create a virtual directory in IIS. Follow 
this procedure for all servers being load balanced.

1. Open Windows Explorer and navigate to your Web site’s 
uploadedimages and uploadedfiles folders.

Virtual Directory Points to

LB_Images1 UploadedImages folder installed on the second Ektron CMS400.NET Web 
server.

LB_Files1 UploadedFiles folder installed on the second Ektron CMS400.NET Web 
server.
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2. Select each folder, right click the mouse, and select 
Properties.

3. Click the Sharing tab, select Share this folder, and press OK.

4. Access your IIS management console.

5. In the folder tree on the left side of the console, navigate to the 
Ektron CMS400.NET Site root folder. In this example, it is 
CMS400Demo.
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6. In the toolbar at the top of the screen, go to 
Action > New > Virtual Directory.
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7. The Virtual Directory Creation Wizard is displayed.

8. Click Next to proceed.
9. The Virtual Directory Alias screen is displayed.

10. Enter an alias for the virtual directory. For example, 
LB_Images1. You will use this name to reference the virtual 
directory in Ektron CMS400.NET.

11. Click Next.
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12. The Web Site Content Directory screen is displayed.

13. Enter the path to the directory to be used for the virtual 
directory.

NOTE The path must follow the UNC syntax, that is \\{ComputerName}\{FilePath}. For 
example, \\Ws10080\uploadedfiles.

14. Click Next to continue.
15. Enter a user and his password that will be used to access the 

virtual folders. To see a list of possible users, click the Browse 
then Advanced buttons.

16. Check off permissions for the virtual folder.
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NOTE At a minimum, the IIS user needs Read and Write permissions.

17. Click Next to complete the wizard.
18. A confirmation indicates that you have created a virtual 

directory. Click the Finish button.
19. The IIS console is displayed with the virtual directory added to 

the specified location.
20. Repeat the above steps for each virtual directory you need to 

create on each Web server running Ektron CMS400.NET.

NOTE Remember, the names of the virtual directories on each server must be identical!

Setting Up Load Balance Paths in Ektron CMS400.NET
In this section, you set up load balance paths in Ektron 
CMS400.NET that point to the LB_Images1 and LB_Files1 virtual 
directories created earlier.

NOTE For additional information about working with load balance paths in Ektron 
CMS400.NET, see ”Load Balancing” on page 178.

To add a load balance path in Ektron CMS400.NET, follow these 
steps.

1. Navigate to your site root folder.
2. Open the web.config.file.
3. Set impersonate to true.
<identity impersonate="true" userName="" password=""/>

4. Save web.config.
5. Log in as an administrator to the Ektron CMS400.NET Workarea 

that you worked with in ”Set Up Two Ektron CMS400.NET Web 
Sites” on page 984.

6. Go to Library > View Properties > Load Balance ( ).
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7. Click the Add button ( ).

8. The Add a Library Load Balancing Path screen is displayed.

9. Use the following table to help you complete the screen.

10. Click the Save button ( ) to add the load balance folder to the 
Ektron CMS400.NET library.
The View Library Load Balance Settings screen appears with 
the changes. Notice the green check, which indicates that IIS 
on the local Web server resolved the virtual directory and 
located its physical folder.

11. To further verify the load balance path is working successfully, 
go to the View Library Load Balance Setting screen in the 
Workarea for the other Ektron CMS400.NET Web server.

Field Description

Images/Files Specify if the load balance path folder is for images or files.

Load Balance Path Enter the path to the virtual directories on your server. (These were set 
up in ”Creating a Virtual Directory” on page 985.)

Make Relative If the folder (or virtual folder) resides under your Ektron CMS400.NET 
site root, check the box to make the path relative to that. Otherwise, 
remove the check.
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Notice that the two Web path names are identical, but the 
physical paths are different. This proves that IIS resolves each 
differently.

Ektron CMS400.NET on Three Servers
This section examines a Web site driven by Ektron CMS400.NET 
and three Web servers through the following topics.

• ”Setting Up Multiple Web Sites” on page 992

• ”Setting Up Virtual Directories for Three Sites” on page 992

• ”Setting Up Load Balancing for Three Servers” on page 993

Setting Up Multiple Web Sites
To run an identical Ektron CMS400.NET Web site on three 
machines, you must use the same database for each site. To do 
so, follow instructions in ”Set Up Two Ektron CMS400.NET Web 
Sites” on page 984.

Setting Up Virtual Directories for Three Sites
Through Internet Information Services (IIS) on all three Web 
servers, create virtual directories for each image or file folder to be 
used with your load balancing model. For our example, we create 
virtual directories on all Ektron CMS400.NET Web servers.

Virtual Directory Description

LB_Images1 Virtual directory that points to the UploadedImages folder installed on the 
second Ektron CMS400.NET Web server.

LB_Files1 Virtual directory that points to the UploadedFiles folder installed on the second 
Ektron CMS400.NET Web server.

LB_Images2 Virtual directory that points to the UploadedImages folder installed on the third 
Ektron CMS400.NET Web server.

LB_Files2 Virtual directory that points to the UploadedFiles folder installed on the third 
Ektron CMS400.NET Web server.
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These virtual directories must exist in the IIS console for each Web 
server machine in your load balancing model.

Creating a Virtual Directory

See ”Creating a Virtual Directory” on page 985

Setting Up Load Balancing for Three Servers
After setting up virtual directories on all Web servers, you’re ready 
to create load balance paths in Ektron CMS400.NET.

See ”Setting Up Load Balance Paths in Ektron CMS400.NET” on 
page 990

Load Balancing Assets
Ektron CMS400.NET lets you balance requests to view or work with 
assets among two or more servers. To achieve this, each server 
has its own copy of every asset.
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To accomplish this, Ektron CMS400.NET initially stores every new 
asset in the database. An Ektron service constantly checks to see 
if all database assets also exist on each server’s file system. To 
learn about this service, see ”Ektron Windows Service” on 
page 969.

If an asset does not exist on any server in the cluster, it is copied 
from the database to the server’s file system. Once there, the 
asset is available for requests to work with it. After an asset is 
copied to all servers, Ektron CMS400.NET removes it from the 
database.

There is no limit to the number of servers or databases that can be 
load balanced.
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Setting up Asset Load Balancing
To set up load balancing for assets, follow these steps on both the 
staging and production server.

1. Within the site root folder, open the AssetManagement.config 
file. Change the value of the LoadBalanced element to 1.

2. Open the following file using a word processor such as 
Notepad

C:\Program Files\Ektron\EktronWindowsService20\Ektron.ASM.EktronServices20.exe.config

3. Find the following tag: <add key="LoadBalanced" value="0" />. 
Change the value to 1.

4. Find the following tag <add key="LoadBalServerCount" value="2"/>. 
Make sure the value is set to the number of servers in your 
load balance cluster. This number must be the same for all 
servers in the cluster.

5. After updating these files for each server in the load balance 
cluster, sign on to Ektron CMS400.NET. This action sets up the 
load balance software in the database.
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email  Features

Configuring SMTP Server
For information about configuring Microsoft’s SMTP service for 
your Ektron CMS400.NET Web server, please refer to Configuring 
Email Notifications, in the Ektron CMS400.NET Setup Manual.

Automatic eMail Notification
Ektron CMS400.NET has an automated email system that sends 
emails to the proper users when an action has been, or needs to 
be, performed. Emails are generated when any of the following 
actions takes place.

In order for users to be notified of these actions, the following 
criteria must be met:

• Valid system email address

• Enabled email notification

• User email address

• User email notification enabled

These values are set in the Edit User screen. See Also: ”Managing 
Users” on page 663

email sent to When content is 

Next approver Submitted to be published

Next approver Submitted to be deleted

Author Published to Web site

Author Declined to be published or deleted
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The Tasks feature also has automatic email notification. For more 
information, see ”Email Notification” on page 391.

Content of Automatic email
The automatic emails are stored in and received from the 
database. Each email consists of one string for the subject and one 
for the body. Ektron CMS400.NET does not currently support HTML 
emails, but the messages are fully customizable. To learn about 
customizing them, see Customizing Ektron CMS400.NET emails in 
the Ektron CMS400.NET Setup Manual.

Instant eMail
In addition to automatic email, Ektron CMS400.NET lets you send 
email instantly to a user or user group from many screens. Your 
ability to send instant mail is indicated by either

• a small mail icon next to a user or group name, as indicated in 
red below

• a small mail icon on the toolbar (see second image below)
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When you click such a user/group name or email icon, the email 
screen appears, as shown below. Once you complete the screen 
and click Send, an email is sent to designated users.

Conditions for Instant eMail
• The user who is using Ektron CMS400.NET must have a valid 

from email address set up in the user profile. If not, email icons 
do not appear in Ektron CMS400.NET.
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• The email software must be configured for your server. See 
”Configuring SMTP Server” on page 996

Where Instant email is Available
Instant email is available from several screens that display users 
and user groups. Typically, you click a user name or the email icon 
to launch an email. Screens in the following Ektron CMS400.NET 
features support instant email.

• Smart Desktop

• Tasks

• Approvals

• Reports

• User and user group setup

Wherever instant email is available, an email icon appears (circled 
in the illustration below).
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Modifying Instant eMail
When the email screen appears, the following information is 
copied from Ektron CMS400.NET into the email.

Field Source of Default Information Editable?

To User you selected to receive the email. If the user does 
not have valid email address, an error message 
appears. If you then insert a valid email address, the 
email is sent.
If you specify a group to receive the message, as long 
as one group member has a valid email address, all 
group members with valid addresses receive the email.

Yes.
If desired, you 
can add 
recipients by 
typing them 
into this field.

From User who signed on to Ektron CMS400.NET . No

Subject If the email message is linked to content, its title 
appears.
The screen section below provides an example of 
content (Trinity In-Line Pipe) that is linked to a 
message.

Yes

Body of 
message

If the email message is linked to content, a link to the 
content appears.

Yes
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Font Manager

As an administrator, you can add, edit, and delete fonts to and from 
the Ektron CMS400.NET application. By adding fonts, you are 
allowing the content contributors to use them when creating 
content. Administrators can also edit the name of a font, and delete 
a font from the system.

Minimizing the number of available fonts makes the Web site look 
more uniform.

Below is the Font Manager screen.

NOTE Only members of the Administrator User Group can view, add, or edit fonts.

Adding Fonts
To add a font to the application, follow these steps.

1. From the left frame of the Workarea, click Settings > 
Configuration > Fonts.
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2. Click the Add Font button ( ).

3. The add font screen is displayed.

4. Enter the font name or family into the text field provided.

5. Click the Save button ( .)

The new font is available to use when adding or editing content.

Viewing Fonts
When viewing fonts, you can also edit or delete them.

To view a font:

1. Access the font manager in your Workarea as described in 
”Adding Fonts” on page 1001.



Font Manager

Ektron CMS400.NET Administrator Manual,  Version 7.5,  Revis ion 10 1003

2. Click the font you want to view.

3. The view font screen is displayed.

Edit Fonts
When you edit a font, the font or family name is changed. Editing 
does not change any fonts in existing content.

To edit a font name, follow these steps.

1. Access the view font screen, as described in ”Viewing Fonts” 
on page 1002.

2. Click the Edit button ( ).

3. The Edit Font screen is displayed.

4. Edit the font name or family in the text field specified.

5. When finished, click the Update button ( ).
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Delete Fonts
By deleting a font from the system, you are taking away the 
content contributors’ use of that font in their content. To delete a 
font, follow these steps.

1. Access the view font screen, as described in ”Viewing Fonts” 
on page 1002.

2. Click the Delete button ( ).

3. A message is displayed.

4. Click OK to delete the font.
5. The screen is refreshed, and the updated fonts table is 

displayed.

NOTE When you delete a font from Ektron CMS400.NET, you do not delete it from your 
computer.
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Ektron’s Microsoft Office 
SharePoint Server Connector

Distributing Content From SharePoint to an 
Ektron CMS400.NET Folder

Using this tool, Ektron’s customers can take full advantage of 
SharePoint’s collaborative workspace to create documents. 
These documents can then be delivered to a public facing Web 
site, corporate intranet or extranet enabled with all the latest 
search, navigation, Web 2.0 and social networking functionality 
provided by Ektron CMS400.NET

Ektron CMS400.NET supports the distribution of SharePoint 
content to any CMS400.NET folder. For example, your 
Marketing Department uses Microsoft SharePoint to create and 
edit content. After completing a press release, they use the 
Publish to Ektron CMS menu option to copy it from 
SharePoint to a content folder. Once there, the document can 
pass through an approval chain or be published immediately.

Enabling Ektron's SharePoint Connector
To enable Ektron's SharePoint Connector in Microsoft 
SharePoint, simply copy the SharePoint_To_CMS.exe file from 
C:\Program Files\Ektron\CMS400v75\Utilities to your SharePoint 
server and follow the on screen dialog.

Distributing SharePoint Content to CMS400.NET
Once the SharePoint Connector is setup on a SharePoint 
server, navigate to a content item and click the dropdown arrow 
next to the content's title. A menu appears with the item 
Publish to Ektron CMS. Clicking this item starts a simple 
wizard that publishes the document into your CMS400.NET 
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site's folder structure and taxonomy-based information 
architecture. This information is collected through a series of 
screens that guide you through the process.

After SharePoint content is distributed to CMS400.NET the first 
time, the original content is forever linked to the destination 
content. You cannot break the link. However, deleting the 
destination content in CMS400.NET allows you to select a new 
folder when you republish the content from SharePoint. 

NOTE If you delete the destination content, you will not be able to access history 
revisions of the content in CMS400.NET. 

If you want to later revise the document, you would typically edit it 
in SharePoint and select the Publish to Ektron CMS option again. 
When you do, you are asked to confirm replacing the document in 
the destination folder. You are not allowed to select another folder.

Prerequisites
When you click the Publish to Ektron CMS menu item, it will 
check to see if you can log into CMS400.NET using Active 
Directory. If so you will be logged in. If not, you will be prompted for 
your username and password. You must have the following 
permissions:

• Add

• Delete

• Restore Content.

If you do not have these permissions, the folder doesn't appear on 
the folder selection screen.
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Additional Information

Supporting Documents
You can find more detailed information about Ektron CMS400.NET 
in the following manuals:

• Ektron CMS400.NET Developer’s Reference Manual

• Ektron CMS400.NET User Manual

• Ektron CMS400.NET Quick Start Manual

• Ektron CMS400.NET Setup Manual

Support
If you are experiencing trouble with any aspect of Ektron 
CMS400.NET, please contact the Ektron Support Team via our 
Web Site: http://dev.ektron.com/support.aspx

Sales
For questions and answers about purchasing Ektron CMS400.NET 
from Ektron, contact the sales department at sales@ektron.com. 

Information
For general information about Ektron and its products, send an 
email to info@ektron.com.

http://dev.ektron.com/support.aspx
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Appendix A: Unicode 
Support

Ektron CMS400.NET supports Unicode characters in

• the editor

- source view, from the editor

• dialog boxes

IMPORTANT! To see Unicode characters, each client’s Windows installation must include 
Asian and bidirectional languages. To install them, go to Control Panel > 
Regional and Language Options > Languages. Check both boxes under 
Supplemental language support (see illustration below).
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Unicode Support in the Ektron CMS400.NET Editor
Ektron CMS400.NET is practically 100% compliant with the Unicode 
standard. It is only lacking in the following areas.

• Dialog box title bars - If the client does not support Unicode 
characters, the title bar displays English.

• The toolbar - If the client does not support Unicode characters, 
drop-down lists on the toolbar display question marks (?).

NOTE A client fully supports Unicode characters if the Unicode language is the same as 
the Windows default language.

• Toolbar dropdown lists on Korean systems - Korean 
characters in a drop-down list may appear as question marks 
(?) unless one of the following conditions is true:

- The Arial Unicode MS font is installed. Since this is installed 
with MS Office, most clients have it.
or

- The default system language is Korean.

Unicode Support in Source View
Ektron CMS400.NET also supports Unicode characters in while 
viewing HTML source code, as illustrated below. 
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For more information about working with HTML source code, see 
the Ektron CMS400.NET User Manual chapter “Working with 
HTML.” 

Unicode Support in Dialog Boxes
Ektron CMS400.NET supports Unicode in text boxes within dialogs 
even if the Operating System (OS) language does not match the 
Unicode language. For example, a content contributor author 
wants to edit in Korean and Japanese without switching the OS 
language.

Here is an example of such a dialog.
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Appendix B: Browser Issues

This section explains how to use Ektron CMS400.NET with different 
browsers.

Netscape 8
To make sure the Netscape 8 browser works properly with Ektron 
CMS400.NET, follow these steps.

1. From the verb strip at the top of the Netscape 8 screen, click 
Tools > Options.

2. Select the Tab Browsing screen.
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3. After Open links from other applications in, check a new 
window.

4. Makes sure the following options are unchecked.

•Open non-requested pop-ups in a new tab
•Open a new tab instead of a new window

5. Click OK to save the options.
6. Return to Ektron CMS400.NET running in the Netscape 8 

browser.
7. Right click the triangle icon to the left of the tab (circled in red 

below).

8. Click Show Site Controls.
9. The Site Controls screen appears.
10. Click the Advanced tab.
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11. Make sure Open requested pop-ups in new tab is 
unchecked.
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Appendix C: List of 
Supported Languages

NOTE Within Ektron CMS400.NET screens, languages are by indicated by a flag. If you 
want to change the images, they are contained in the Workarea/images/
application/flags/ directory. The file name format is flagNNNN.gif, where NNNN 
is the language’s locale id value. For example, flag0409.gif is for English (US).

NOTE Each language also has an alphabetic code (for example, en-US) and a 
hexadecimal value (for example, 040a). To obtain these values, sign on to Ektron 
CMS400.NET Workarea and go to Settings > Configuration > Language 
Settings screen.

Language Locale id 
value

Afrikaans 1078

Albanian 1052

Alsatian 1156

Amharic 1118

Arabic (Algeria) 5121

Arabic (Bahrain) 15361

Arabic (Egypt) 3073

Arabic (Iraq) 2049

Arabic (Jordan) 11265

Arabic (Kuwait) 13313
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Arabic (Lebanon) 12289

Arabic (Libya) 4097

Arabic (Morocco) 6145

Arabic (Oman) 8193

Arabic (Qatar) 16385

Arabic (Saudi Arabia) 1025

Arabic (Syria) 10241

Arabic (Tunisia) 7169

Arabic (U.A.E.) 14337

Arabic (Yemen) 9217

Azeri (Cyrillic) 2092

Azeri (Latin) 1068

Bashkir 1133

Basque 1069

Belarussian 1059

Bengali 1093

Bosnian (Cyrillic) 8218

Bosnian (Latin) 5146

Breton 1150

Bulgarian 1026

Burmese 1109

Catalan 1027

Chinese (Hong Kong SAR PRC) 3076
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Chinese (Macau SAR) 5124

Chinese (PRC) 2052

Chinese (Singapore) 4100

Chinese (Taiwan) 1028

Corsican 1155

Croatian (Latin) 4122

Croatian 1050

Czech 1029

Danish 1030

Dari 1164

Divehi 1125

Dutch (Belgium) 2067

Dutch (Netherlands) 1043

English (Australian) 3081

English (Belize) 10249

English (Canadian) 4105

English (Caribbean) 9225

English (India) 16393

English (Ireland) 6153

English (Jamaica) 8201

English (New Zealand) 5129

English (Philippines) 13321

English (South Africa) 7177
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English (Trinidad) 11273

English (United Kingdom) 2057

English (US) 1033

English (Zimbabwe) 12297

Estonian 1061

Faeroese 1080

Farsi 1065

Filipino 1124

Finnish 1035

French (Belgian) 2060

French (Canadian) 3084

French (Luxembourg) 5132

French (Monaco) 6156

French (Standard) 1036

French (Switzerland) 4108

Frisian 1122

Gaelic (Ireland) 2108

Georgian 1079

Galician (Spain) 1110

German (Austria) 3079

German (Liechtenstein) 5127

German (Luxembourg) 4103

German (Standard) 1031
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German (Switzerland) 2055

Greek 1032

Greenlandic 1135

Gujarati (India) 1095

Hausa 1128

Hebrew 1037

Hindi (India) 1081

Hungarian 1038

Icelandic 1039

Indonesian 1057

Inuktitut (Latin) 2141

Inuktitut (Syllabics) 1117

Irish 2108

Italian (Standard) 1040

Italian (Switzerland) 2064

Japanese 1041

Kannada (India) 1099

Kashmiri (India) 2144

Kazakh 1087

Khmer 1107

K'iche 1158

Kinyarwanda 1159

Konkani 1111
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Korean 1042

Korean (Johab) 2066

Kyrgyz 1088

Lao 1108

Latvian 1062

Lithuanian 1063

Lithuanian (Classic) 2087

Macedonian 1071

Malay (Brunei Darussalam) 2110

Malay (Malaysian) 1086

Manipuri 1112

Marathi 1102

Norwegian (Bokmal) 1044

Norwegian (Nynorsk) 2068

Polish 1045

Portuguese (Brazil) 1046

Portuguese (Standard) 2070

Punjabi (Gurmukhi - India) 1094

Romanian 1048

Russian 1049

Serbian (Cyrillic) 3098

Serbian (Latin) 2074

Sindhi 1113
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Slovak 1051

Slovenian 1060

Spanish (Argentina) 11274

Spanish (Bolivia) 16394

Spanish (Chile) 13322

Spanish (Columbia) 9218

Spanish (Costa Rica) 5130

Spanish (Dominican Republic) 7178

Spanish (Ecuador) 12298

Spanish (El Salvador) 17418

Spanish (Guatemala) 4106

Spanish (Honduras) 18442

Spanish (Mexican) 2058

Spanish (Modern Sort) 3082

Spanish (Nicaragua) 19466

Spanish (Panama) 6154

Spanish (Peru) 10250

Spanish (Puerto Rico) 20490

Spanish (Traditional Sort) 1034

Spanish (Uruguay) 14346

Spanish (Venezuela) 8202

Sutu 1072

Swahili (Kenya) 1089
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Swedish 1053

Swedish (Finland) 2077

Tamil (India) 1097

Tatar (Tatarstan) 1092

Telugu (India) 1098

Thai 1054

Turkish 1055

Ukrainian 1058

Urdu (India) 2080

Urdu (Pakistan) 1056

Uzbek (Cyrillic) 2115

Uzbek (Latin) 1091

Vietnamese 1066

Welsh (United Kingdom) 1106
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Index

A
accessibility

dialogs that allow input 104
making content comply with 

standards 99
active directory

integration 745
data transfer from AD to CMS 746
disabling 777
login procedure 782
user groups

752
adding 754
adding user to 754
associating AD info with

CMS 750
copying to CMS 749
deleting 754
introduction 749
removing users 753
replacing 754

user information
deleting 758
editing 758
replacing 759
transfer to CMS 755

screens
setup screen 763, 804
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view user groups 774
view users screen 771, 805

user authentication only mode 778
adding user information to 

CMS 780
changing user login name 780
data transfer 779
disabling 781
editing user information 780
screens 781
setup guidelines 742
users

deleting 781
replacing 781

administrator privileges, list 739
advanced permissions 720
aliasing, URL see URL aliasing
analytics, content, see content analytics
Application Setup screen

default application language 19
enable application mail m

essages 20
license key 19
maximum summary size 20

modifying 18
system email address 20
viewing 18
work page size 21

approval chain
approvers

adding 729
deleting 731

creating 728
editing approval order 730
editing for content block 732
examples 727
inheritance from parent folder 727
introduction 726
multi-language content 836
viewing

for content 732
for folder 728

approval method
changing 733
description 732

approve
content

from approval report 156
archiving, tasks 391
asset management configuration, 

updating 310
assetmanagement.config file 312
assets

load balancing, see load balanc-
ing, assets

Asynchronous Log File 945
authentication, LDAP see LDAP authen-

tication

B
bad links report 170
breadcrumbs

adding 54
editing 59
inheritance and 54
overview 53
removing item 61
reordering items 57

builtin user 25
business rules

overview 592
permissions 605
rulesets

adding new rule 598
adding rule 602
changing sequence of rules 597
creating 594

deleting 598
editing 596
editing rule 604
removing a rule 596
viewing rule 604
working with 595

selecting a rule 593
button text, display in title bar 22

C
calculated field, data designer 262
calendar field, data designer 271
calendars

accessing Workarea after 
viewing 552

content folder assignment 556
creating 553

foreign language 562
deleting 559
display weekends 557
displaying on Web page 562
editing 558
event type label 555
event types

adding 560
available 555
deleting 561
editing name 561
enabling 559
introduction 559
required 555
viewing 560

introduction 550
location label 554
permissions 552
start and end time labels 554
toolbar buttons 551

case sensitive passwords 6
catalog

indexing
full scan 410
incremental scan 410

character encoding 847
checked in content

report 157
checked out content

report 158
choices field, data designer 251
collections

approval system, setting up 610
approval system, which users can 

approve 611
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assigning users permission to edit 
via the Roles screen 736

deleting
how approvals affect 612

introduction 606
permissions 607

community folders
adding assets 48
adding content 48
creating 44
editing assets 49
editing content 45
overview 43
permissions 44
viewing content 45

content
adding

HTML content block 74
programmatically 143

approval chain, editing 732
assigning permissions 724
automatic notification of 

activity 996
blocks, recognizing 14
copying 78
deleting 82
editing 78
folder see folder, content
history 82
moving 78

one content block 79
several blocks at once 80

multi-language see multi-lan-
guage content

private 692
purging historical versions 49
rating feature 85

limiting visitors to one rating 86
viewing report 86

reports 145
checked in content 157
checked out content 158
content pending start date 160
content to expire 163
expired content 162
new content 159
refresh reminder 161
submitted content 159

restoring historical versions 81
review feature

inserting server control 86
scheduling 82
tasks, assigning 83
template, assigning 71
to expire report 163
viewing 77
workflow 83

XML content block, adding 75
content analytics

data available 857
determining which pages are 

tracked 855
enabling 854
overview 854
reporting 859

changing date range 865
site activity 861
site statistics 860
top content 863
top pages 863, 864
top referrers 865

writing data to database 857
control panel

discussion boards 542
copy content 78
custom user properties

adding 698
changing order 709
deleting 708
editing 707
input field types 702
overview 696
validation 703
with non-English languages 711

custom validation, data designer 291

D
data design package

editing 198
data designer

calculated field 262
calendar field 271
checkbox field 243
choices field 251
custom validation 291
deleting a field from screen 217
design mode vs. data entry m

ode 214
field types 216
File Link Field 280
group box field 230
how eWebEditPro+XML changes 

when using 212
image only field 278
plain text field 244
rich area field 249
select list field 255
steps for designing a screen 214
using 211
walkthrough of screen design 220

decline
content

from approval report 156

default application language, setup in-
formation 19

discussion boards
category

creating 485
editing 484

changing page size 484
control panel 542, 544

deleting a private message 545
viewing user profile 546

creating 477
deleting 483
editing 483
elements

hierarchy 472
forums

creating 488
deleting 491
editing 490
inserting server control 529
locking 490
moderating from control panel 548
outputting as RSS 539
ranking users 491

implementing 476
locking 480
overview 471
permissions

assigning 518
editing users and user groups 524
for membership users 522
granting to users and user 

groups 523
initialization of 521
list of 521
revoking for users and user 

groups 524
post reporting

setting up 517
posts

adding a reply 503
approving 504
attaching images and files 506
deleting 506
editing 506
replacing words 510
replying to 504
searching 508

private message 541
deleting 545

restricting IP address 516
searching 508
sort order 484
subscriptions

deleting 541
reviewing 541
submitting 540
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taxonomy, assigning 481
terms and conditions 485
topics

adding to forum 497
approving 502
deleting 503
editing title 502
overview 496
priority, announcement 499
priority, normal 500
priority, setting 499
priority, sticky 499
sorting 531
viewing 500

user profile, contents 537
user profile, suppression by adm

inistrators 539
user profile, suppression by 

users 538
viewing 483
Web site

approving 530, 534
deleting post 535
editing post 534
posting a reply 532
quoting a post 532
reporting a post 536
suppressing user information 530, 

536
using on 530

display button text in title bar 22
distribute option 880
Do Not Force All Approvers 733
document management feature

asset management 
configuration 310

file types 313
introduction 310
PDF generation

enabling/disabling 327
local 326

permissions 314
Dublin Core metadata 124

E
email

automatic
content 997
notification of content activity 996

configuring SMTP server 996
disabling notification for a 

user 666
features 996
instant 997

conditions 998
modifying 1000

system address 20

emailing workflow reports 152
enable application mail messages 

setting 20
event types

calendar see calendars, event 
types

F
file extensions

library folder property 177
File Link Field, data designer 280
file types

determining which ones are 
allowed 313

file upload path
library folder property 177

flagging
content 897

report 901
definitions 893

assigning to folder 895
introduction 892

flags, as language identifiers, 
changing 1015

folder
assigning smart forms 51
assigning to a menu 621
assigning Web Alerts 956
content

accessing 29
applying

style sheet 38
template 38

creating on server to match CMS 
folders 24

deleting 43
fields displayed on 30
managing 28
properties 36

toolbar 40
searching 62
toolbar buttons 31

permissions
setting 720

font buttons, enabling 26
fonts

adding 1001
deleting 1004
editing 1003
managing 62, 1001
viewing 1002

Force All Approvers 733
foreign language calendar 562
forms

HTML
implementing on Web page 300
introduction 297

permissions 297
preparing server for email 299
sending data as XML 301
XML email structure 303

forums, discussion boards, see discus-
sion boards > forums

H
height, screen, adjusting 21
http port, changing in Ektron Web Servic-

es file 971

I
image extensions

library folder property 177
image only field

data designer 278
image upload path

library folder property 177
images

login, changing 10
indexing catalog

full scan 410
incremental scan 410

indexing service
restart 408

indexing, XML see XML indexing
inheritance

breaking 718
restoring 718

IP address, restricting for a forum 516

L
landing page after login, setting 22
language export feature, see multi-lan-

guage content
language, foreign see multi-language 

content
languages

supported, list 1015
LDAP authentication

Active Directory Setup screen 804
adding organizational unit 796
adding user information from 

LDAP server to CMS 400 797
deleting users 804
disabling 808
editing user information in CMS 

400 803
enabling 793
overview 791
using with CMS400.NET 792
view users screen 805

library
folders
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creating 175
properties 176

items
actions that can be performed 178

permissions 175
using with WebImageFX 182

license key
modifying 19

links, bad, report 170
load balancing 178

accessing screen 179
adding new folder 180
assets 993

setting up 995
configuring 982

two machines 984
introduction 980
library images and files 980
library path

deleting 181
entering 181

setting up multiple sites 984
setting up paths in CMS400 990
setting up virtual directories for 

two sites 985
setting up virtual directories on 3 

servers 992
three machines 992
using Site Replication for 981

lock
discussion boards 480
discussion forum 490

locked user account, unlocking 8
locking out a user 9
login

attempts, disabling 9
determining page that appears 

after 22
images, changing 10
locking out a user 9
preventing all users from 9
preventing CMS users from 9
restricting number of attempts 7

M
mail messages, enabling 20
maximum content size, setting 20
maximum summary size, setting 20
membership module

accessing 677
membership user groups 686

adding 687
adding users 688
deleting 689
deleting users 689
name, editing 689
viewing users 688

membership users
activating 966
adding 678
deleting 686
editing 683
permissions, assigning 690
unverified, confirmation m

essage 965
unverified, viewing 966
viewing 681

menus
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